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Read This First!

Security Devices
Coda systems are fitted with either a DAT or an Exabyte tape IO sub-system or an optical disk
IO sub-system. Both of the sub-systems are covered in this manual. The sets of instructions and
descriptions of the sub-systems are grouped together by task (Using DA System).

You should read the following information before using the system.

• The Coda system uses a hardware security device (dongle) to prevent illicit copying of the
system’s software. (The security device is enclosed within the Coda system and under normal
circumstances you should be unaware of its presence.) Notwithstanding any other agree-
ments, the security device is the only proof Coda Technologies will accept of legal software
ownership. Under no circumstances will a replacement security device be issued unless the
original is returned.

Loss of the dongle means loss of the software!

DAT Tapes
• Coda systems which are fitted with DAT drives use Digital Data Storage (DDS) certified

Digital Audio Tapes (DAT). Do not use audio DAT tapes: they will not function correctly.

• Use only DAT tapes with one of the following markings:

• We recommend that you use DAT tapes by the following manufacturers: TDK, HP, Verbatim
and Fujifilm.

Optical Disks
• We recommend that you use Maxoptix ISO 14517, rewritable, 2.6 GB polycarbonate disks

with 1024 bytes per sector – Maxoptix part no. 3015385 R/W – for systems fitted with optical
disk drives, though other major manufacturers’ rewritable disks can be used, provided that
they comply with ISO/IEC 14517.

Warnings
• Do not look inside the optical disk drive or use a mirror to look inside the drive. The laser can

cause eye damage.

Cautions
Connecting the System:

• Failure to ensure that the input voltage of the power supply unit is set correctly for the AC
supply voltage may damage the unit.

• Connecting a monitor that cannot operate at the required resolution – an 80Hz refresh rate
whilst displaying 1040x780 non-interlaced pixels – may damage the monitor.

• If the DA System was in transit and has recently been unpacked, or if it has been brought from
a cool area to a warm one, leave it for some time (at least an hour) to reach ambient temper-
ature before powering up. This prevents condensation from forming within the system, which
may seriously damage the electronics and the drive mechanism.

Powering Down & Packing Up

• The DA System system must be shut down – by selecting Shutdown from the File menu.
Failure to do so may cause the system to malfunction.
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• Before powering down the system, make sure that no tapes or disks have been left in the
drives. Failure to do so may result in damage to the tapes or disks or to the drives.

Updating Software

• The DA System system must be shut down – by selecting Shutdown from the File menu –
at the end of installing a software update. Failure to do so may cause the system to
malfunction.

Tape System

• The status of the write-protect tab on the tape must not be changed while the tape is in the
tape drive. Doing so can lead to damage to the tape or the tape drive.

• Do not press the tape eject button whilst recording. Doing so may result in data loss. The
recording session should be closed via the recording pop-up before ejecting the tape.

Optical Disk System

• If the drive emits noises or vibrations, immediately eject the media and turn off the power to
the drive.

• The drive must perform a self diagnosis for about 6 seconds immediately after powering on.
If an optical disk cartridge is inserted during self diagnosis, the loading time will be delayed
until the self diagnosis is complete.

• The drive does not require user maintenance. If the drive does not operate properly, do not
try to fix it yourself. Contact Coda Technologies.
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Introduction
1 Welcome

Congratulations on buying or hiring the CODA-DA System data acquisition system. Your
investment in the DA System will make working with your sonar data easier and faster.

The DA System provides automated interpretation tools and a suite of interactive enhancement
and event-marking tools, all of which are designed to improve data interpretation and report
generation. Whether you are new to digital sonar acquisition, an experienced data processor or a
professional geophysicist, you will find the DA System a reliable and versatile system for
acquiring, displaying, processing and interpreting sonar data.

The DA System has been developed by:

Coda Technologies Ltd
Admiral House
29-30 Maritime Street
EDINBURGH
EH6 6SE
UK

tel: +44 131 553 1380
fax: +44 131 554 7143

e-mail: coda@coda-technologies.com
www: http://www.coda-technologies.com

Coda’s Technical Support service is available 24 hours a day:
USA – tel: 1 888 340 CODA
Rest of the World – tel: +44 131 553 7003.
See ‘Technical Support’ on the inside front cover for full details.

Coda’s American subsidiary is:
Coda Technologies Inc.
9800 Richmond Avenue
Suite 480
Houston
Texas 77042
USA

tel: 1 713 780 3223
fax: 1 713 780 3280

1.1 The DA System
The DA System system can be used either as a stand-alone module for acquiring and processing
data or as the data input system for one of Coda’s processing and automated interpretation
modules: GeoKit, Pipeline Inspection (PI100), TrackPlot, TrackPlot Plus and Mosaic.

The DA200 retains the acclaimed look and feel of the DA100 system. The main difference
between the two systems is that the DA200 can accept dual independent input triggers whereas
the DA100 accepts only a single trigger. The DA50 provides the look and feel of the DA100,
restricted to two acquisition channels, in a portable and compact form.

The data acquisition and playback system of the DA System is sophisticated, yet easy to use. It
can be used to acquire data from both sidescan sonar and sub-bottom profilers, to manipulate
and display this data, and to record the data to tape or optical disk. Previously recorded data can
be played back rapidly through the system for later viewing or manipulation. The system allows
you to record data in a high-resolution digital format which does not degrade with time, and it
can output the data to on-line data-processing systems. Furthermore, it provides fast access to
data on tape or disk for post-processing or data quality assessment.

Broadly speaking, the DA System operates in one of two modes: data acquisition mode or data
playback mode.
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In acquisition mode, a number of sonar inputs are connected to the system. Each input can be
digitally sampled and recorded to tape or disk. Sampled data can be manipulated in various ways
before being displayed on a scrolling screen. Two input data channels can be displayed simulta-
neously in one window, up to four windows of data can be displayed at any one time; the
channels selected for display may be changed at any time. Data recorded to tape or disk consists
of all of the original sampled data with no processing applied, and any additional information
input to the system (for example, navigation data). This means that the original data is always
available and that no information is lost in any processing steps.

In playback mode, data previously recorded to tape or disk can be manipulated and displayed in
the same way as in acquisition mode. The playback speed can be varied from zero (paused) to
typically two or three times the original acquisition rate. The format, time and channels recorded
to the tape or disk are shown when the media is first loaded. You can select channels for display;
the display channels can be changed at any time.

In both modes, the DA System provides a number of processing options and several powerful
tools which enable you to configure the setup to best suit your needs. These features include
multi-resolution data display, scrolling speed adjustment, single or dual channel waterfall or
horizontal displays, slant-range correction, TVG and TVF enhancement, image enhancement,
zoom facilities, real-time cursor navigation position, and on-screen measurement.

The DA System is available with a number of options, including a tape or optical disk system,
single drive or dual drives (for continuous recording), and a GPIB port (for real-time data output
to thermal recorders).

1.2 About this Manual
This manual is designed to help you get the most out of the DA System system, whatever your
level of experience.

• Part I: The Introduction and Basics – contains basic information about Coda systems’ display
features and types of pointers, as well as the terminology used in Coda manuals. If you are
new to the DA System, we recommend that you read this section before using the system.
The Quick Start will refresh your memory about operating procedures, if you are an experi-
enced operator of the DA System in data acquisition and playback modes. 

• Part II: Using the DA System – contains operating instructions for the DA System. They
explain HOW TO DO SOMETHING (for example, image enhancement, tape recording), through
step-by-step instructions, and give hints on how to get the best out of the system. These
sections are intended for users at any level of experience. Is also describes in detail the
external parts of the DA System system, the areas of the DA System display and the various
menus and menu items available with the system. They explain WHAT CAN BE DONE (for
example, the range of adjustment that is possible for TVG correction). Reading through these
sections reveals the true power and flexibility of the system.

• Part III: Technical Details – contains technical information about the DA System system.

• Part IV: Getting Help – gives details of our Technical Support service and explains how to
solve the most common problems you might encounter using the DA System.

• Part V: Appendices – contains information about additional menus, navigation data and
formats; provides examples of acquisition setups; and explains how to test the DA System.
It also explains what you need to know about using the tape or optical disk drives.

• Part VI: Checklists – contains checklists for mobilising the DA System and additional
software modules; acquiring and recording data; inputting navigation data and corrected
navigation data; saving and loading tag files; and using tag and reporting setups during data
interpretation.

• Part VII: Glossary & Conversions – contains a table of useful conversions; a full list of the
terminology used in this manual; and a software defect report form, product feedback form
and manual feedback form.
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1.2.1 Conventions Used in this Manual

As you read this manual, bear in mind the following conventions:

• Italics indicates words or phrases that are explained in the Glossary and modes of operation.

• This font identifies menu items and data control buttons. When two or three menu items are
joined by an arrow you must select the first item and then the second or third; for example,
File→Open Acquisition means that you must click on File on the Menu Bar and then, in the
pull-down menu that appears, click on Open Acquisition.

• Keyboard keys appear within greater and lesser symbols. When key names are joined by a
hyphen (-) you must hold down the first key, press the other key and then release both keys.
For example, <Control-z> means you must hold down <Control> and press <z>.

• British English spelling is used throughout this manual.

• To keep instructions brief, we refer to clicking or pressing a MOUSE button, rather than a
MOUSE OR TRACKBALL button. If your system comes with the optional trackball, click or
press the appropriate button. If no button is specified, use the left button.

• The graphics for the single trigger systems (DA50 and DA100) are identical to those of the
DA200.
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2 Quick Start

This section includes a quick-start procedure, which summarises the basic instructions for
operating the DA System in data acquisition and playback modes. It also contains a list of tips
and shortcuts to help you work more quickly and efficiently. 

If you have used the DA System before, use this section to remind yourself about the operating
procedure. If you are new to the DA System, read through the list of tips and shortcuts, as they
will save you time, but work through the operating instructions in Part II before referring to the
quick-start procedure.

2.1 Quick-Start Procedure

2.1.1 Setting up the DA System
1. Remove the system from its packaging.

2. Connect the power supply, monitor, keyboard and mouse or trackball cables to the system;
if using a printer, also connect the printer cable and power on the printer. For data acquisition,
connect the sonar data, trigger and navigation data inputs to the system.

3. Power up the system and wait for its user interface screen to appear.

2.1.2 Acquiring Survey Data
1. Select File→Open Acquisition or click on the Open Acquision icon to initialise acquisition

mode.

2. In the Channels 1-4 tab, click on the Active on/off switches of the data channels to be
digitised, and toggle on the Device Active/Inactive button in the Open Acquisition pop-up.
Set the voltage range and the description of the channels to be digitised. In the Triggers tab,
set the number and source of the triggers to be used. When all the parameters have been set,
click on the OK button.

3. Click on the Play button in the Data Control Area to start the data display.

4. In the Scale Display Data pop-up, configure the display scale and range. Do this either by
clicking on the Auto button or by using the Shift and Scale arrow buttons to make adjust-
ments manually. The blue band (range of screen values) should cover the green trace
(incoming data). The green trace can be adjusted using the Channel Voltage range in the
Open Acquisition pop-up.

5. Select Settings→Fix Lines and select the navigation/survey data items to be displayed on
the fix lines.

6. Select File→Raw Nav Input to initialise navigation input. In the Nav Input Settings pop-up,
select the navigation string and input port to be used. Click on the Nav input on one-of
selection switch. Click on the OK button.

7. Select Processing→Fish Height and configure the fish height.

8. Record data:

• To start recording, insert a blank DDS or DDS2 standard DAT tape or a Coda-formatted
optical disk into the appropriate drive; if using continuous record, insert tapes or disks in
both drives. Click on the Recording On toggle in the Data Control Area. In the Record
Set-up pop-up, select continuous record (if required), the channels to be recorded, the
recording format and the drive on which to start recording. Click on the Recording On
toggle of the appropriate drive to switch it on, then click on the OK button.

• To stop recording, click on the Recording Off button in the Data Control Area. In the
Record Set-up pop-up, click on the Record toggle to switch it off, then click on the OK
button. Eject the tape (if the system has not already done so) or eject the optical disk and
write-protect it. Label the tape or disk using the start and stop recording times and fix
information from the information window.
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2.1.3 Playing Back Survey Data
1. Insert a previously recorded tape or optical disk into the appropriate drive.

2. Select File→Open Playback or click on the Open Playback icon to initialise playback mode. 

3. In the Open Playback pop-up, click on the appropriate drive’s tab form (if it is not selected
already). Then, do one of the following:

• If you are using a tape system, check the File Information window to make sure that you
have the correct file and recorded channels. If not, use the appropriate action buttons to
find them. Then, click on the OK button.

• If you are using an optical disk system, select a file from the Files window. Check the
File Information window to make sure that you have the correct file and recorded
channels. Then, click on the OK button.

4. Click on the Play button in the Data Control Area to view the selected channels.

5. If required, select Processing→Fish Height and configure the fish height.

6. If required, select Settings→Playback Speed and set the rate at which the system replays
the data.

7. In the Scale Display Data pop-up, configure the display scale and range. Do this either by
clicking on the Auto button or by using the Shift and Scale arrow buttons to make adjust-
ments manually. The blue band (range of screen values) should cover the green trace
(incoming data).

8. Set up the display, using the Processing menu options, such as TVG Enhancement or Slant-
Range Correction, and use the appropriate data control buttons, such as Fast Forward or
Goto.
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3 The User Interface

Coda’s systems use menus, pop-up windows, text-entry boxes, icons, key shortcuts and so on in
a similar way to other windows applications. If you are familiar with Microsoft Windows®, or
the X Windows system, you will immediately find the operation of Coda’s systems familiar. If
you are not familiar with other windows applications, you will find the main features and terms
explained below.

3.1 The Main Display
The main display has seven areas, as shown in Figure 3-1, this page. Six of the areas – Title Bar,
Menu Bar, Tool Bar, Data Display Area, General Information Area and Data Control Area – are
identical for all Coda systems and software modules. The Application Specific Area, however,
changes according to the application being used. The functions of all six areas in the DA System
are explained in the following sections.

Figure 3-1 The Main Display in Playback Mode

3.1.1 The Title Bar
The DA System provides additional commands through its Title Bar menu. You use this pull-
down menu when you want to test navigation loopback data, change the size of the main display
and restart the programme, see Section 12.2.

Figure 3-2 The DA System Title Bar

3.1.2 The Menu Bar

Figure 3-3 The Menu Bar

Menu Bar

Title Bar

Tool Bar

Data Display Area

Application Specific Area

Status Bar
Status Bar
Settings Button

General Information Area

Data Control Area



DRAFT
22 May 2001 for version 2.1        

In
tr

od
uc

tio
n

The Menu Bar lies across the top of the screen throughout operation of the DA System. It
displays eight menu options: File, Display, Settings, Tagging, Reporting, Applications,
Processing and Help. When you click on any of these options (that is, you move the pointer over
an option and then click the left mouse button), a pull-down menu appears. The functions of the
various menu options are explained in Part II.

3.1.2.1 Tear-off Menus
The pull-down menus can be detached from the Menu Bar and moved around the screen; they
remain on screen until dismissed. To detach a pull-down menu, select the dotted tear-off strip at
the top of the menu; this changes the menu to a pop-up window. To move the window, press and
drag it to another part of the screen (that is, move the pointer over the window’s titlebar, press
the left mouse button and hold it down while you drag the pointer to the desired position, then
release the mouse button). To dismiss the window, double-click on the button in the top left
corner of the window, or position the pointer over the window and press <Escape>.

3.1.3 Tool Bar

Figure 3-4 The DA System Tool Bar

Directly below the Menu Bar is a Tool Bar. The icons included in the Tool Bar allow you to
perform a number of operations within the window without opening the relevant menus. 

3.1.4 Trackplot/Mosaic
This option, which is used to display visually the track and image data of the survey, is available
as an additional software module. If you have bought this module, refer to the CODA Trackplot/
Mosaic Manual. For further information, contact Coda Technologies.

3.2 Multiple Windows

Figure 3-5 The Main Display Area in Playback Mode, showing two Data Display windows

Depending on how your system is configured, it is possible to activate a number of data display
windows. When you switch your Coda system on, the default is one data display window
configured as a dual channel vertically scrolling down display.
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3.2.1 Opening a Data Display Window

Figure 3-6 The Open New Window pop-up window

When you select Windows→Open New Window in any open Data Display window, the Open
New Window pop-up appears (see Figure 3-6, this page). This allows you to choose parameters
for the new window.

• Window Type: This scrolling option list can be set to either Horizontal Window or Vertical
Window indicating the angle at which the data will scroll.

• Number of Channels: The scrolling option list can be set for either 1 or 2 channels.

• Scroll Direction: This scrolling option list can be set for either Left or Right for a horizontal
window or Up or Down for a vertical window

3.2.2 Menu Bar Options

Author Note - not for publication!: different applications to
be listed in Appendix L

When more than one data display window is open, the Menu Bar options can apply to that
particular window, or to the whole system, or to an input channel.  A list of the different appli-
cations is in Appendix L

• When Menu Bar- Window options are selected, the selection will apply to the window from
which the pop-up was called.  The same pop-up function can be called once for each data
display window open.

• Menu Bar - System options apply globally.  Although system options can be called from any
open data display window, if a pop-up is already open calling it from another open data
display window will only have the effect of  bring the open pop-up to the foreground of the
main display.

• Menu Bar- Input Channel options apply to input channels and can be displayed in one or a
number of windows.  Although channel options can be called from any open data display
window, if a pop-up is already open calling it from another open data display window will
only have the effect of  bring the open pop-up to the foreground of the main display.

3.2.3 Data Display Window Identification
The Title Bar of each open window indicates the format of that window. If more than one
window is open with the same format, a number will be added to the description.The description
in the Title Bar is repeated in the associated tab of the General Information Area (see Figure 3-
5, page 22).

3.2.4 Colour Coding
In addition to labels describing the format of each display window, a colour coding system is
used to identify which channel or channels are being displayed in each window and which
channel data is being displayed in each General Information Area tab.  

The following aspects of the Data Display Area can be seen in Figure 3-5, page 22.
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• The channel colours are indicated on a bar on each channel icon on the Channels tab of the
Application Specific Area.

• The channels being displayed in each data display window are indicated by coloured buttons
on the top right hand side of the Menu Bar of each data display window.

• The channel to which the information in the General Information Area refers is indicated by
the colour of its border.

3.2.5 Window Polling
Pressing the <Alt> and <Tab> keys at the same time will bring each window or iconised window
to the foreground of the main display in turn, each click will bring the back-most window to the
front.

3.3 Menu Features

3.3.1 One-of Selection Switch

Figure 3-7 One-of Selection Switches

The diamond button (or toggle) is a one-of selection switch for a group of options, only one of
which can be selected at a time. To change the selection, click on another diamond button. In the
example above, from the Report Setup Options menu, the green diamond indicates that the Tab
option has been selected; the Space and Comma options are automatically deselected.

3.3.2 On/Off Switch

Figure 3-8 On/Off Switches

The square button is an on/off switch. When the square is grey the option is disabled (or off);
when the square is green the option is enabled (or on). More than one on/off switch can be
enabled. To toggle from one setting to another, click on the square button. In the example above,
also from the Report Setup Options menu, the Enclose text in double quotes has been
selected.

3.3.3 Option Selection Button

Figure 3-9 An Option Selection Button

The option selection button displays a currently held value and indicates that other values can be
selected.  In Figure 3-9, this page from the File→Open Acquisition menu, the Trigger is set to
Trig A. Click on the option button to display a list of other options (in this case, Active Triggers)
and then drag the pointer to another trigger to select that trigger for the channel.

3.3.4 Spin Box

Figure 3-10 A Spin Box
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Spin boxes appear in pop-ups where you are required to specify a numerical setting. You can
either click in the box and type the required numbers or use the up and down arrows to change
to the correct setting. Pressing and dragging on the horizontal bar between the up and down
arrows allows you to alter the value, too – if you drag upwards, the value will increase, and if
you drag downwards the value will decrease.

3.3.5 Scrolling Option List

Figure 3-11 A Scrolling Option List

Scrolling option lists consist of a text area and a down arrow. They provide a flexible method of
choosing from a list of available options. Click on the down arrow to display the list of options.
You can then move through the list by typing the first letters of your chosen option or by using
the up and down arrows on your keyboard. Each option will be highlighted as you scroll onto it.
To select the highlighted option, either press the space bar or <Enter>, or click on it with the
mouse. To reset your selection, use either the left or right arrow on your keyboard. You can then
begin making our selection again. To scroll directly to your chosen option, click in the text box
and use the keyboard arrows to move to your choice. To dismiss the list, either press <Esc> or
click outside the list area.

3.3.6 Scroll Bar

Figure 3-12 A Scroll Bar

The scroll bar appears at the bottom or on the side of some pop-ups and indicates that only part
of a list of items is currently being displayed. To view other items in the list, click on the arrows
in the scroll bar or press and drag the scroll box in the scroll bar up or down, or to the left or right.

3.3.7 Tab Forms

Figure 3-13 A Tab Form

Some pop-ups have several tab forms; for example, the Tag Setup pop-up from the Tagging
menu has eight tab forms (see Figure 3-13, this page). A tab form contains a number of related
items of information or selections and has a labelled tab at the top; they are arranged so that they
overlap each other. To select a tab form, click on its tab. This brings the form to the front of the
pile; the information can then be read and changes made to it. When a tab label is greyed out it
cannot be accessed.
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3.3.8 Pop-up Selector

Figure 3-14 Pop-up Window Selectors

The three-point ellipsis (...) is appended to some menu items and indicates that selection of the
item will cause a pop-up window to appear; the window will contain further selections associated
with the menu item. This hierarchical structure enables the comprehensive functions of the DA
System to be accessed in a way that is logical and easy to understand. In the example above, from
the Settings menu, selecting Playback Speed will open a pop-up which contains three possible
settings for the speed at which data can be replayed.

3.3.9 Pop-up Action Buttons

Figure 3-15 Pop-up Action Buttons

Action buttons are positioned at the bottom of pop-ups; they are used either to confirm changes
made within the pop-up or to cancel those changes. Click on the OK button to confirm the
changes and dismiss the pop-up from the screen; click on the Apply button to confirm the
changes but retain the pop-up on screen. Click on the Cancel button to cancel the changes and
leave the previous settings as the current definition.

Additional action buttons are displayed on some pop-ups:

Figure 3-16 Store and Factory Action Buttons

Click on the Store button to store the settings of the current pop-up as the default setting. Click
on the Factory button to reset the settings to Coda Technologies’ original settings. To revert to
the Factory settings as the default setting after the default setting has been changed, click on the
Factory button and then the Store button.

Figure 3-17 Load and Save Action Buttons

Click on the Load button to load previously saved settings for the current pop-up. Click on the
Save button to save the current pop-up settings to file for reloading at a later date. 
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3.3.10 File Selection Window

Figure 3-18  A File Selection Window

The File Selection Window is used to select a file or a group of files from a directory in the DA
System file system (for example, for the input of corrected navigation data). The File Type Filter
item shows the search pattern being used to select which files are listed in the Files item. This
uses a similar pattern matching procedure to MS-DOS or Unix, so all files can be listed by
entering * or *.*, or only those files with (for example) a .TXT ending can be listed by entering
*.TXT. To select one of the files in the File list, use the scroll bars as necessary to move through
the list and either click on the required file name (using the left mouse button) and press the
RIGHT ARROW, or double click on the selection.  Continue to select until all required files are
listed in the Select Corrected Nav Files list and then Create New Group.  Existing groups can
be edited in the same way by using the Load Group button and then adding or subtracting files.

To remove a nav file from the hard disk, select the file to be deleted and click on the <Delete>
icon. A window is popped up asking for confirmation. Click the Yes button to delete the file, or
the No button to abort the delete.

3.3.11 Load Settings
Figure 3-19, page 28, shows an example of a Load Settings pop-up; this pop-up appears when
you click on the Load button in the Format tab form of the Reporting→Report Setup menu.
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Figure 3-19 A Load Settings Pop-up Window

Click on the Select Default button to make the default file the selected file; the name of the
default file appears beside the Default Filename label. Click on the Select Factory Default
button to reset the pop-up to Coda Technologies’ original setting; the string ‘FACTORY
DEFAULT SELECTED’ appears in the File Name text-entry box at the bottom of the pop-up.

Click on the Drive option button to select the drive from which to load the settings file; only Hard
Disk is currently available.

Use the Project scrolling option list to search for correct project and the Set-up Files scrolling
optin list to search and veiw particular settings files. To select a settings file from the list, click
on the file name.  Altwernatively, if you know the file name, move the pointer onto the Set-up
Files text-entry box and type the file name.

Click on the Delete button to remove the currently selected file from the hard disk. In the window
that appears asking for confirmation, click on the Yes button to delete the file or the No button
to abort the delete. If the file to be deleted is the default file, a window appears asking for confir-
mation.

Note: All settings files have a ‘.set’ ending. Files cannot be loaded if the directory is not shown. Trying to do
so results in an error.

Click on the Apply button or the OK button to load the settings stored in the file shown in the
File Name window. If no file has been selected, a warning window appears. Click on the Done
button to cancel any changes made to the settings and dismiss the Set-up - Report Set-up pop-
up.

3.3.12 Save Settings
Figure 3-20, page 29, shows an example of a Save Settings pop-up; this pop-up appears when
you click on the Save button in the Format tab form of the Reporting→Report Setup menu.
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Figure 3-20 A Save Settings Pop-up Window

Click on the Make Default button to make the selected file the default file; the name of the file
appears beside the Default Filename label. If no file is selected, the settings are saved to a file
called ‘unnamed.default.set’.

Click on the Drive option button to select the drive to which to save the setting file; only Hard
Disk is currently available.

Use the Set-up Files scrolling option list to search and view particular settings files.  To select
a settings file from the list, click on the file name; the Save As text entry box is updated to display
the selected file.  Alternatively, if you know the file name, or you wish to use a new one, move
the pointer into the Save As text-entry box and type the file name.
Click on the Delete button to remove the currently selected file from the hard disk. In the window
that appears asking for confirmation, click on the Yes button to delete the file or the No button
to abort the delete. If the file to be deleted is the default file, a window appears asking for confir-
mation.

Note: All settings files have a ‘.set’ ending. Files cannot be saved if the directory is not shown. Trying to do
so results in an error. 

Click on the Apply button or the OK button to save the current settings to the file shown in the
File Name window. If no file has been selected, a warning window appears. Click on the Done
button to cancel changes made to the settings and dismiss the Save Settings pop-up window.

3.4 Message Window

Figure 3-21 The Message Window

A Message Window appears at the bottom right of the DA System display. This gives time-
stamped CODA system information. As they appear, messages are colour coded, red for errors,
blue for warnings and black for information. Once a new message appears, the older one disap-
pears and is stored in black in the list of messages created since your system was started up. You
can scroll through this list by clicking on the down arrow at the side of the window.
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3.5 Status Bar Settings

Figure 3-22 The Status Bar Settings Button

This button is on the bottom right of the Message Window (see Figure 3-1, page 21). Clicking
on it produces the Status Bar Setup Window (see Figure 3-23, this page, Figure 3-24, page 30
and Figure 3-25, page 31). In this pop-up you can specify how you want information in the status
bar to be displayed, whether you want the system to sound a Beep and produce separate Pop-ups
detailing the message, for how long you want the pop-up to remain and the size of the message
Log File. Each tab form gives a description of the effect of selecting items within the pop-up. 

Figure 3-23 The Status Bar Setup Window showing Beep settings

Figure 3-24 The Status Bar Setup Window showing Popups settings
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Figure 3-25 The Status Bar Setup Window showing Clear Time settings

Figure 3-26 The Status Bar Setup Window showing Log File Size setting

3.6 Pointer Types
Twelve mouse pointers are used in the DA System.

The arrow pointer is the pointer type most commonly used in the DA System.

The pencil pointer is used to create tags.
Keyboard shortcuts: <F1> to <F12>

The crosshair pointer is used to make on-screen measurements and appears when 
the DA System is in measure mode.
Keyboard shortcut: <Control-s>

The zoom pointer appears when the DA System is in zoom mode.
Keyboard shortcut: <Control-z>

The move pointer is used to move tags.
Keyboard shortcut: <m>

The watch pointer appears when the system is waiting for an operation to complete.

The automatic tracking pointer is used to reset the bottom tracking position. 
Keyboard shortcut: <b>
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When the pointer is in a particular mode – for example, for moving or deleting tags – you must
complete the operation, or deselect the mode, before selecting another pointer mode. If you fail
to do so, a warning pop-up appears on screen, reminding you that a pointer operation is already
in progress. Click on the OK button to dismiss the pop-up and then complete the pointer
operation, or deselect the mode, before continuing to the next pointer operation. Deselecting a
mode usually involves repeating the action for selecting the mode.

3.7 Terminology
The most common computer terms used in this manual are defined below. A more complete list
of terms can be found in the Glossary at the end of this manual.

The text-entry pointer appears when the pointer is placed in a text-entry box and is 
used to enter text in the selected field of a pop-up.

The Centre On pointer appears after selecting the Centre On icon from the tool bar. 
Click on a point on the screen you wish to view at the centre of your window.

The Fix Zoom pointer appears after selecting Fix Zoom from the tool bar. Click on 
a point on the screen you wish to be the centre of the zoom.

The Pan Grab pointer appears after selecting the Pan Grab icon from the tool bar. 
Click and hold on a point on the screen, the move the mouse around to move the 
image. Release the mouse button when the image is in the desired position.

The Egg Timer pointer appears only when the CODA system is initialising. It is not 
seen during any other operations.

Apply this button applies the settings or options selected and retains the pop-up 
window on screen.

Cancel this button cancels any items or options selected and dismisses the pop-up 
window; the previous settings are retained.

click press down and release the appropriate mouse button. If no button is 
specified, use the left button.

double-click press and release the appropriate mouse button twice in rapid succession. If 
no button is specified, use the left button.

information 
window

a window that provides information during acquisition or playback; this 
information cannot be edited. It can be displayed for any length of time, and 
is dismissed by clicking on the OK or Done button.

Menu Bar the area at the top of the main display in which eight menu options are 
permanently displayed: File, Display, Settings, Tagging, Reporting,
Applications, Processing and Help. Selecting any of the options causes
a pull-down menu to appear.

OK this button selects and applies the settings or options selected and dismisses 
the pop-up window from the screen.

pop-up menu an option selection menu with a specific user-alterable value or parameter.

pop-up
window

a general term applied to a window that automatically appears when a menu 
item or control function is selected; it may be a text-entry box (in which you 
type your requirement), or an area of information (which requires no action 
on your part). In this manual this phrase is abbreviated to pop-up.
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3.8 Restart
This shuts down the software of the DA System system and causes the program to restart. It does
not cause the DA System to reboot. The short-cut key is <Control-c>, as indicated on the menu.
A box pops up, asking for confirmation that the system is to restart; click Yes or No as appro-
priate.

3.9 Key Shortcuts
Many of the common commands can be carried out using key shortcuts. A key shortcut is a single
keystroke or a combination of keystrokes that executes a command.

The <Alt> key can be used to activate pull-down menus. To do this, press and hold down the
<Alt> key and then press the key of the underlined letter in the required option in the Menu Bar.
For example, pressing <Alt-f> causes the File menu to appear. An item from the pull-down menu
can be selected by pressing the key for the underlined letter of the required menu item’s name.

A list of other keyboard shortcuts can be displayed on screen by selecting Help→Key Shortcuts
(see Figure 3-27, this page. The number of shortcut keys available, however, depends on the
module of the DA System being used.

press and 
drag

position the pointer over an object, press the left mouse button and hold it 
down while you drag the object to the desired position, then release the 
mouse button. If no button is specified, the left button should be used.

pull-down 
menu

a pop-up that appears directly beneath an option in the Menu Bar when that 
option is selected.

scroll bar the means by which all the items in a list appearing in a menu or pop-up 
window may be examined.

select click the left mouse button on the appropriate item (such as a menu item, 
toggle or value selection).

select a 
menu item

click the left mouse button on a Menu Bar option, and then release the 
mouse button over an item in the pull-down menu that appears below the 
Menu Bar option.

tab form a form that contains a number of related items of information or selections 
and has a labelled tab at the top. As tab forms overlap, the required tab form 
may have to be brought to the front of the pile by clicking on its tab.

tear-off 
menu

a pull-down menu that can be detached from the Menu Bar for permanent 
display.

text-entry 
box

an area in a window for entering text or numerical values. Click within the 
rectangular area and type text or edit the text using the keyboard.

toggle switch from one setting to another, usually between on and off. A toggle 
switch is a switch that has just two positions.

toolkit a pop-up that contains various tools for processing the data, for example 
TVG and Image Enhancement. Each pop-up contains an interactive graph 
and several smart icons.
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Figure 3-27 The Key Shortcuts Pop-up window

Some keyboard shortcuts are also listed in the pop-up menus; for example, <Control-z> appears
in more than one pop-up. However, note that these shortcuts are only available when the pointer
is in the Data Display Area.
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Part II: Using the DA System
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4  The System Hardware

4.1 DA100/200Hardware

4.1.1 The Front Panel

Figure 4-1 The DA200 Front Panel (DAT tape version)

Figure 4-1, this page, shows the typical layout of the DA System’s front panel when a DAT tape
system is installed. Read this whilst examining your system, noting the location of the following
parts:

• Floppy disk drive: The drive’s LED is lit while the system is using the drive. Do not remove
a floppy disk or turn off the system when the LED is on. Doing so may damage the data on
the disk.

• Power switch: Do not turn off the power until the DA System has been shut down correctly
(see Section 13.2). On some systems the Power switch is located to the left of the Reset
switch.

• Soft Power switch: On older DA Systems only. This switch can be used to turn on the system.
It should only be used to turn off the system after the system has been shut down correctly.

• Reset switch: Do not use this switch unless the DA System has been shut down correctly; it
can then be used to turn on the system again.

• System cooling fans: The DA System has two system cooling fans. It may be worth checking
occasionally to see if dust has built up on the grill in front of the fans, which might impair
performance. If the grill needs cleaning, remove the two screws from the front of the grill,
pull off the grill and remove any dust or dirt. When you have done that, put back the grill and
secure it in position with the two screws.

4.1.1.1 Tape Drives
Figure 4-1, this page, shows the front panel of a 4mm DAT tape drive. In a twin-tape system,
upper tape drive unit is Tape 1. The units usually have two LEDs (one green and one amber),
though 8mm Exabyte tape units have three.

• The left-hand green LED should flash periodically when data is being recorded or played

System Cooling Fans
Grill Power Switch

Green LED
Amber LED

Tape Eject Button

Disk Eject ButtonGreen Floppy Disk LED
Reset SwitchGreen Power LED

Red SCSI LED
Media Drive Bay
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back from tape.
• The right-hand amber LED should not come on during normal operation, and indicates a fault

status.

See Appendix H for further information on interpreting the DAT drive LED display, and for
information on interpreting the LEDs of 8mm Exabyte tape units.

4.1.1.2 Magneto-Optical Disk Drives

Figure 4-2 Close-up of Magneto-Optical Disk

Figure 4-2, this page, shows the front panel of a magneto-optical disk. The upper optical disk
drive is referred to as Optical 1.

• Eject disk button: This button has no effect while the disk is still mounted. To remove a
cartridge from the drive, first click on the Unmount button in the appropriate pop-up and then
press the eject button.

• LEDs: The left LED shows the media status and the right LED shows the status of the drive

• Optical Disk Eject tool: Some, non Star, optical disk drives have a small hole through which
a manual ejection tool can be inserted to force ejection of the disk in the event of a problem
with the drive. This tool hangs – with the system keys – from a strap which is attached to one
of the handles. It may be used in the last resort to remove a cartridge which the drive has
failed to eject. However, this should only be attempted after the system has been shut down.
Use only gentle pressure to attempt to remove the disk, as the ejection mechanism is easily
damaged.Star series optical drives can be manually ejected: It is first essential to make sure
the power to your DA System is switched off. Remove the rubber eject button and turn the
inside shaft counter clockwise with a flat bladed screwdriver until the disk is fully ejected.

Eject Disk ButtonShutter Door

LEDs
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4.1.2 The Back Panel

Figure 4-3 The DA System Back Panel and Cable Connectors

Figure 4-3, this page, shows the typical layout of the DA System’s back panel. It identifies the
connectors, serial ports and other item. Use this illustration to acquaint yourself with the cable
connections before you try to connect the system, using the instructions below. Note the location
of the following parts, which are identified from left to right:

• Voltage selector switch: In older DA Systems only. Newer systems automatically select the
correct voltage. This is located between the AC In and AC Out sockets. It has two settings:
240V and 110/120V. The DA System is delivered with the input voltage (mains voltage) of
its power supply unit (PSU) set to 240V. If the local/onboard supply is 110/120V, the voltage
selector switch must be set accordingly. Failure to do so would result in damage to the PSU.
If this switch is not present, then the system has an auto-switching power supply, and no
manual switching between mains voltages is necessary.

Caution: Always confirm that the system voltage has been set correctly before
switching on the system for the first time - incorrect voltage selection can damage
the power supply unit.

• Keyboard socket: Figure 4-3, this page, shows a DA System fitted with two PS/2 connectors.
If the system that you are using has two PS/2 connectors, you must use the lower one to
connect the keyboard. Other DA System systems are fitted with either a single PS/2 or a
single non-PS/2 connector for connecting the keyboard, depending on hardware.

• USBs: Some systems are fitted with two USB connectors; however, they are not currently
supported.

• COM2 is a male D-type RS-232 serial port and is used for connecting the navigation data
input to the back panel. For most applications, a simple two-wire connection (data in at pin 2
and signal ground at pin 5 if a 9-way connector is fitted, or data in at pin 2 and signal ground
at pin 7 if a 25-way connector is fitted) is all that is required for trouble-free setup and
operation.

• COM1 is a 9-way D-type male RS-232 serial port which is used for connecting the mouse or
trackball to the back panel. The mouse or trackball is an integral component of the DA
System system and should always be connected before powering up the system.

PSU Cooling Fan

Mains
AC In

AC Out
(to Monitor)

Input & Output Triggers

Analogue Input
Channels (BNC)

LPT 1

Com 1
Com 2

Keyboard

Monitor
Signal

SCSI

Network
CardSocket

PS2 Mouse Socket
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• LPT1: This port is a 25-way D-type female interface. It is compatible with a wide range of
thermal printers. An additional GPIB interface is also available as an optional extra for
compatibility with those thermal printers which use a GPIB interface. Contact Coda Technol-
ogies for further information.

• Monitor signal connector: The monitor signal is available from a 15-way, high-density
D-type connector, as widely used in PC compatibles. The monitor used must be capable of
an 80Hz refresh rate whilst displaying 1040 x 780 non-interlaced pixels. 

For instructions on how to connect the system components together, and how to power up the
system, refer to Section 4.3 and Section 4.4.

4.2 DA50 Hardware

4.2.1 The Front Panel

Figure 4-4 The DA50 Front

Figure 4-4, this page, shows the typical layout of the DA50’s front panel. Read this whilst
examining your system, noting the location of the following parts:

• Power switch: Do not turn off the power until the DA50 has been shut down correctly (see
Section 13.2). On some systems the Power switch is located to the left of the Reset switch.

• Display screen: Integral to the system.

• Keyboard and mouse connections: These connections should be made by removing the cover
at the back of they keyboard and plugging int he two connectors stored under the cover.

• Keyboard and Glide Pad: Integral to the system.

Power LED
HDD LED

Power Switch

Mouse Socket

Keyboard Socket

Glide Pad
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4.2.2 The Side Panel

4.2.2.1 The Side Panel of the DA50

Figure 4-5 The DA50 Side Panel Showing Interface Connections

Figure 4-5, this page shows the typical layout of the DA50 side panel. Read this while examining
your system, noting the location of the following parts:

• COM2 is a male D-type RS-232 serial port and is used for connecting the navigation data
input to the back panel. For most applications, a simple two-wire connection (data in at pin 2
and signal ground at pin 5 if a 9-way connector is fitted, or data in at pin 2 and signal ground
at pin 7 if a 25-way connector is fitted) is all that is required for trouble-free setup and
operation.

• LPT1: This port is a 25-way D-type female interface. It is compatible with a wide range of
printers. An additional GPIB Centronics-type interface is also available for compatibility
with thermal printers.

• Monitor signal connector: By using the VGA splitter cable provided with your DA System,
a monitor can be connected to the unit as well as the integral screen.

4.2.2.2 The Side Panel of the DA50 with Magneto Optical Drive

Figure 4-6 The DA50 System Side Panel Showing Magneto Optical Drive Bay

Figure 4-6, this page shows the typical layout of the DA50 side panel when a Magneto Optical
drive is installed. Read this while examining your system, noting the location of the following
parts:

External Keyboard

Com 2
LPT 1

Network Card

Trigger & Channel BNCs

SCSI

Floppy Drive

Eject Button

Media Status LED

Drive Status LED

Magneto Optical Drive

Eject Button
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• Optical Disk drive: Two LEDs indicate the status of the disk, the status of the drive and fault
reporting.

• Eject button: this button has no affect when the disk is still mounted. To remove a cartridge
from the drive, first click on the Unmount button in the appropriate pop-up and then press the
eject button.

• Optical Disk Eject tool: Some, non Star, optical disk drives have a small hole through which
a manual ejection tool can be inserted to force ejection of the disk in the event of a problem
with the drive. This tool hangs – with the system keys – from a strap which is attached to one
of the handles. It may be used in the last resort to remove a cartridge which the drive has
failed to eject. However, this should only be attempted after the system has been shut down.
Use only gentle pressure to attempt to remove the disk, as the ejection mechanism is easily
damaged.

• Star drives can be manually ejected: It is first essential to make sure the power to your DA
System is switched off. Remove the rubber eject button and turn the inside shaft counter
clockwise with a flat bladed screwdriver until the disk is fully ejected.

• Floppy disk drive: The drive’s LED is lit while the system is using the drive. Do not remove
a floppy disk or turn off the system when the LED is on. Doing so may damage the data on
the disk.

4.2.2.3 The Side Panel of the DA50 showing DAT Drive Bay

Figure 4-7 Side Panel of the DA50 Showing DAT Drive Bay

Figure 4-7, this page shows the typical layout of the DA50 side panel when a DAT drive is
installed. Read this while examining your system, noting the location of the following parts:

• COM2 is a male D-type RS-232 serial port and is used for connecting the navigation data
input to the back panel. For most applications, a simple two-wire connection (data in at pin
2 and signal ground at pin 7 if a 25-way connector is fitted) is all that is required for trouble-
free setup and operation.

• LPT1: This port is a 25-way D-type femal interface. It is compatible with a wide range of
printer. An additional GPIB Centronics-type interface is also available for compatibility with
thermal printers.

• Monitor signal connector: By using the VGA splitter cable provided with your DA System,
a monitor can be connected to the unit as well as the integral screen.
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• Tape Drive: The units usually have two LEDS (one gree and one amber) though 8mm
Exabyte tape units ahve three. The left hand green LED should flash periodically when data
is being recorded or played back from tape. The right hand amber LED should not come on
during normal operation, and indicates a fault status. See Appendix H for further information
on interpreting the DAT drive LED display, and for information on interpreting the LEds of
8mm Exabyte tape units.

4.3 Connecting the System

Caution: Failure to ensure that the input voltage of the power supply unit is set correctly
for the AC supply voltage may damage the unit.

1. If your DA System has a voltage selector switch (see Section 4.1.2), make sure that the
voltage selector switch is set correctly for the local/onboard supply.
The input voltage (mains voltage) of the power supply unit (PSU) is preset to 240V. If the
local/onboard supply is 110/120V, the voltage selector switch must be set accordingly.

2. Plug the power cable into the Mains AC In socket.

Caution: Connecting a monitor that cannot operate at the required resolution – an 80Hz
refresh rate whilst displaying 1040 x 780 non-interlaced pixels – may damage the
monitor.

3. For DA100/200 systems only. Plug the monitor power cable into the AC Out socket and the
monitor signal cable into the monitor signal socket.

4. Plug the keyboard cable into the keyboard socket.
On systems which have two PS/2 sockets, the keyboard cable must be plugged into the
LOWER one. 

Caution: Do not attempt to plug in another mouse type, (for example a Microsoft
mouse) as this might not work using the default system settings. Contact Coda Technol-
ogies if you need to use a different type of mouse.

5. For DA100/200 systems only. Plug the mouse or trackball cable into the serial port labelled
COM1.

6. If required, connect a printer to the parallel port labelled LPT1.

For data acquisition only:

7. Connect the analogue sonar signals to the BNC connectors. These are labelled CH1 to CH4
in the DA100/200 and CH1 and CH2 in the DA50/25.

8. Connect the trigger signal:

• If an external trigger is to be used, the trigger signal should be connected to the trigger
input BNC sockets labelled TRIG A IN (or TRIG B IN for DA200 systems, which have
two trigger inputs). For sub-bottom profilers, the trigger input should be the output of the
heave compensation unit, where fitted.

• If the DA System is being used as the trigger source for external sonar equipment, the
trigger signal should be connected through BNC connectors to the trigger output sockets
labelled TRIG A OUT (or TRIG B OUT for DA200 systems, which have two trigger
outputs).
The system generates a TTL level output signal, whose period can be adjusted manually
(see File→Open Acquisition→Triggers).

9. Connect the navigation data input to the serial port labelled COM2.
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4.4 Powering Up the System

Caution: If the DA System was in transit and has recently been unpacked, or if it has
been brought from a cool area to a warm one, leave it for some time (at least an hour)
to reach ambient temperature before powering up. This prevents condensation from
forming within the system, which may seriously damage the electronics and the drive
mechanism.

• If using a printer through LPT1, ensure it is connected to, and powered up before the Coda
system. 

• Power up the system and wait for the Coda Technologies screen.
The system automatically starts up and initialises the DA System display interface.

• A pop-up will appear on the screen giving details of the release status of the software on your
DA System. You can also view this at any time by selecting the Release Info option from
the Help menu.



DRAFT
May 2001 for version 2.1         45

U
sing the D

A
 

S
ystem

5 Acquiring and Recording Survey Data

The DA System can be used to acquire survey data from both sidescan sonar and sub-bottom
profilers and other seismic sources, and to record the data to tape or disk. This section explains
how to initialise the acquisition system, how to initialise the navigation input, how to set the fish
height and how to record the data. If you have used the Coda system before, Section 2 Quick
Start provides a summary of these procedures.

Before starting data acquisition you should carry out some or all of the off-line tests that are
described in Section 12; they enable you to check the system for ‘sane’ operation without using
external inputs from sidescan units or navigation computers. Then, carry out the tasks in the
Mobilisation Checklist in Appendix M, to make sure that the system is correctly integrated with
the survey spread.

The DA System can acquire survey data from both analogue and digital sources. Your dongle
(part of the DA System’s hardware) will be pre-programmed by Coda to meet your requirements
for either analogue or digital acquisition. The following chapter contains information on both
Analogue and Digital acquisition. Refer to either Section 5.2.1 for Analogue Acquisition or
Section 5.2.2 for Digital Acquisition.

Figure 5-1, page 46, shows the procedures for using the DA System – from connecting the
system and powering up, to acquiring data, powering down and getting the system ready for
transportation. Each of these procedures is described in detail in this part of the manual. If you
are unfamiliar with the operation of the DA System system, we recommend that you read through
this section thoroughly before using the system for on-line acquisition.
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Figure 5-1 Flow Chart of DA System Operations

Obtaining High Quality Sonar Data
There are 6 keys to obtaining high quality survey data, which should be tackled in the following
order:

1. Mobilisation

2. Data Acquisition

3. QC by viewing the data

4. Navigation inputs

5. Bottom Tracking

6. Recording to tape or disk.

The following sections deal with each of these 6 issues in turn.

5.1 Getting High Quality Data, Step 1: Mobilisation
A recent review of all the Technical Support cases which Coda Technologies has dealt with over
the past 2 years revealed that over 80% of data gathering problems could have be isolated by the
user when the survey spread was being mobilised, reducing lost survey time and improving the
quality of data obtained.
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To help to spot such problems during mobilisation, we have created a checklist which will ensure
that when you arrive on site, you’re ready to collect the data of the best possible quality. This
checklist is presented in Part VI, and should be followed for every mobilisation.

The key issues dealt with in the mobilisation checklist include:

• Ensuring that each item of equipment the DA system will be connected to is fully operational.

• Checking that the sonar data can be acquired correctly with satisfactory noise performance.

• Checking the correct operation and updating of online navigation.

• Checking that the system records correctly, and that enough disks or tapes are available to
complete the survey.

5.2 Getting High Quality Data, Step 2: Data Acquisition

5.2.1 Acquiring Analogue Data

Figure 5-2 The Open Acquisition Pop-up Window showing the Channels Tab Form

5.2.1.1 Triggering Analogue Data Acquisition
Select File→Open Acquisition to bring up the Acquisition Setup popup, then select the
Analogue tab and the Triggers tab to show the trigger setup window (Figure 5-3, page 48). The
DA200 System has two independent triggers, which can be set to either internal or external,
while other Coda acquisition systems have a single internal or external trigger. An external
trigger is one which is derived from another piece of equipment – a sub-bottom profiler or
sidescan sonar, for example. The internal trigger can be used when no external trigger is
available, or if the DA System is to be used to generate the master trigger for use by other
equipment.
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Figure 5-3  The Triggers Tab Form of the Open Acquisition Pop-Up Window

The Triggers tab form can be used to specify the details of the triggers (see Figure 5-3, this
page). The settings can be changed as follows:

• Trigger Source: these can be set to INTernal or EXTernal by clicking on the option selection
button and choosing the appropriate option. When external triggering is used, sampling starts
whenever a pulse is received on the TRIG IN input. When set to internal trigger, the text-entry
box can be used to define the frequency of the trigger produced by the DA System, or it can
be configured automatically when Auto Period is on. No connection to TRIG IN is required.
The Period of the trigger is set as described below.

If an internal trigger is selected, all subsequent fields will be available. When an External
trigger is selected, only the Active Edge is available; the remaining fields will be greyed out.

• Active Edge: a toggle to indicate whether digitisation of the sonar data starts after a positive
(rising) edge, or a negative (falling) edge.

• Auto Period: this toggle can be used to set the internal trigger period; it automatically calcu-
lates the longest period for the trigger and adds ‘dead’ time.

• Period (ms): this field sets the period (in milliseconds) of the trigger produced at the TRIG
OUT connector. When internal trigger is selected, this field will show the trigger period in
seconds (default 74 milliseconds or 13.5 triggers/second). This can be altered by typing a new
entry in the spin box. This field is greyed out if an external trigger is selected.

• Pulse Width (ms): (DA200 only) a spin box which is used to set the width, in milliseconds,
of the internal trigger pulse. This field is greyed out if an external trigger is selected.

• Pulse Polarity: (DA200 only) two toggles which set the polarity of the internally generated
trigger pulse. The options are either Low or High. A High polarity setting implies that the
pulse is high for the time specified by Pulse Width. The remainder of the pulse (Period
minus Pulse Width) is at a low level. For a Low setting, the reverse is true.
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When you have set all the parameters activate the device. To do this you need to check to Device
Active/Inactive box at the top of the tab.

5.2.1.2 Acquiring Analogue Sidescan Data
The File→Open Acquisition pop-up selects data acquisition mode and allows the acquisition
parameters to be set. Select the Analogue tab form to set up analogue acquisition (Figure 5-3,
page 48). This is the only menu that has a direct effect on the quality of digitised data; therefore,
it is important to make sure that the correct options and values are selected.

Select the parameters for each of the data channels to be digitised:

• Active is used to select the channels to be digitised by the system. A channel is selected by
clicking on the on/off switch beside its number. Activating a channel changes its on/off
switch from grey to green and makes its parameters available for selection. The parameters
are unavailable (greyed out) for channels that are not active.

• Trigger shows the triggers to be used with specific channels. The triggers available are
shown in the Triggers tab form (see Figure 5-3, page 48). 

Trigger defaults to Trig A where the selected Description is SS Port or SS Stbd, and
defaults to Trig B when the Description is Seismic.

• Voltage is used to select the voltage range of the active channels. Each channel can have a
different voltage range. The voltage range is changed by clicking on the option buttons of the
active channels and selecting a new value. The options available depend on the digitisation
option purchased, but the typical range is ±1.25V, ±2.5V, ±5V and ±10V. Selecting the
voltage range that most closely matches the range of the input signal is the best option. 

The setting for the input voltage range is crucial to the acquisition of high-quality data. When
acquisition has started, it is worth examining the Scale Display Data oscilloscope trace to
ensure that the voltage range is set appropriately. No useful information is usually held in the
outgoing pulse of sidescan sonar or sub-bottom profilers; the outgoing pulse may be clipped,
allowing a smaller input voltage range to be selected than would otherwise be the case. For
sidescan sonar operations, it is best not to finalise the input voltage range until the towfish is
positioned at a typical survey altitude from the seabed, so that the voltage range of the
received signal can be assessed.

• Description is used to select the source of the input data. The description is changed by
clicking on the option buttons for the active channels. The options available are: Sidescan
Port (SS Port), Sidescan Starboard (SS Stbd), Seismic, and Other. Each sonar type has its
own set of input fields.

Neighbouring sidescan channels which share the same trigger, which are of the same sonar
type (for example, standard sidescan) and which are in the order ‘SS Port’ followed by ‘SS
Starboard’ are linked, and the word ‘linked’ will be printed between the Active on/off
switches for the two channels. This means that changes in one channel’s true range are
automatically copied to the other channel.

• Sonar Type is used to set the type of input sonar. The options available depend on the
Description setting (see above).

Setting Description to either Sidescan Port (SS Port) or Sidescan Starboard (SS Stbd)
provides three options in the Sonar Type field: Standard SS, Widescan SS or Custom SS.

Standard Sidescan

• True Range (m): This spin box is used to define the across-track swathe size for the data
channel. The actual true range of the sidescan is dependent on its altitude; the true range
selected will be correct for any fish altitude from 0 to 40% of the true range. The DA System
will automatically calculate the sample frequency and the number of samples per ping
required for the given range. If your DA System is a DA200, different sample frequencies
can be selected for each trigger.

If you’re using an external trigger, it is necessary to ensure that the range settings on the DA
System are compatible with the sonar processing unit. If you set the range on the DA System
to be the same as that on the sidescan processing unit, you may find that the outer edges of
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the sidescan swathe are not being digitised, or (more critical for your data quality), that the
Coda system is digitising for so long after each trigger that it misses the next trigger - effec-
tively halving your along-track resolution.

To get range settings which match the trigger rate of your sidescan processing unit, set the
range on the processing unit, then increase the range setting on the Coda system until the ping
rate (which is displayed in the General Information Area) drops to half the rate you would
expect for the range setting on the processing unit (e.g. if the range setting on the processing
unit is 100m, then the expected ping rate is about 6.5 per second; adjust the range on the Coda
system to the point where the ping rate in the GIA drops to about 3 per second). At this point,
you know that the Coda system is sampling for too long after each external trigger, and is
missing every second trigger. Decrease the range setting in the Open Acquisition popup until
the trigger rate returns to the expected value, then decrease it by a further 1m to allow for any
variation in trigger timing. 

Using this procedure, you have ensured that you’re getting the maximum across-track and
along-track resolution from your sidescan sonar. 

Ultra Widescan

• True Range (m): This option button is used to define the across-track swathe size for the data
channel. A True Range can be selected from the following options: 50m, 100m, 150m,
200m, 250m, 300m, 350m and 400m. The actual true range of the sidescan is dependent on
its altitude; the true range selected will be correct for any fish altitude from 0 to 40% of the
true range. The DA System will automatically calculate the sample frequency and the number
of samples per ping required for the given range.

Custom Sidescan

• This allows you to alter the acquisition settings at a very low level, and requires an in-depth
understanding of the Coda system’s software. Most users will not need to use this set of
options; for those who do, Appendix A gives some detailed examples.

To view the incoming data on the channels selected, click on the Play button in the Data Control
Area. When you press the Play button, the Scale Display Data pop-up appears on screen and
can be used to optimise the display.

Note: Make sure that all parameters are selected correctly, as they determine how the data is recorded.
Incorrect parameters may reduce the quality of the data and the accuracy of auxiliary information, such as
position and fish height.

5.2.1.3 Acquiring Analogue Shallow Seismic Data
The File Open Acquisition pop-up selects data acquisition mode and allows the acquisition
parameters to be set. Select the Analogue tab form to set up analogue acquisition (Figure 5-3,
page 48). This is the only menu that has a direct effect on the quality of digitised data; therefore,
it is important to make sure that the correct options and values are selected.

• Active is used to select the channels to be digitised by the system. A channel is selected by
clicking on the on/off switch beside its number. Activating a channel changes its on/off
switch from grey to green and makes its parameters available for selection. The parameters
are unavailable (greyed out) for channels that are not active. The default active channels are
data channels 1 and 2 (for single trigger systems) or 1, 2 and 3 (for the dual trigger systems).

• Trigger shows the triggers to be used with specific channels. The triggers available are
shown in the Triggers tab form (see Figure 5-3, page 48). 

On the DA System, Trigger defaults to Trig A where the selected Description is SS Port or
SS Stbd, and defaults to Trig B when the Description is Seismic.

• Voltage is used to select the voltage range of the active channels. Each channel can have a
different voltage range. The voltage range is changed by clicking on the option buttons of the
active channels and selecting a new value. The options available depend on the digitisation
option purchased, but the typical range is ±1.25V, ±2.5V, ±5V and ±10V. Selecting the
voltage range that most closely matches the range of the input signal is the best option. The
setting for the input voltage range is crucial to the acquisition of high-quality data. When
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acquisition has started, it is worth examining the Scale Display Data oscilloscope trace to
ensure that the voltage range is set appropriately. No useful information is usually held in the
outgoing pulse of sidescan sonar or sub-bottom profilers; the outgoing pulse may be clipped,
allowing a smaller input voltage range to be selected than would otherwise be the case. For
sidescan sonar operations, it is best not to finalise the input voltage range until the towfish is
positioned at a typical survey altitude from the seabed, so that the voltage range of the
received signal can be assessed.

• Description is used to select the source of the input data. The description is changed by
clicking on the option buttons for the active channels. The options available are: Sidescan
Port (SS Port), Sidescan Starboard (SS Stbd), Seismic, and Other. Each sonar type has its
own set of input fields.

• Sonar Type is used to set the type of input sonar. The options available depend on the
Description setting. Setting Description to Seismic provides two options in the Sonar Type

field: Standard SBP, or Custom SBP.

Standard SBP

• Digitised Sweep Time (ms): a spin box for supplying the time over which the signal is
sampled. This is two-way travel time.

• Start Delay (ms): the delay in seconds between receiving the trigger and starting to acquire
data. This can be used (for example) to reduce the length of the sampled water column. The
default start delay is 0 milliseconds, but can be increased for each data channel in the appro-
priate spin box.

• Total Sweep Time (ms): a label showing the calculated sweep time for the given input
values. This is two-way travel time.

Custom SBP

• This allows you to alter the acquisition settings at a very low level, and requires an in-depth
understanding of the Coda system’s software. Most users will not need to use this set of
options; for those who do, Appendix A gives some detailed examples.

To view the incoming data on the channels selected, click on the Play button in the Data Control
Area. When you press the Play button, the Scale Display Data pop-up appears on screen and
can be used to optimise the display.

Note: Make sure that all parameters are selected correctly, as they determine how the data is recorded.
Incorrect parameters may reduce the quality of the data and the accuracy of auxiliary information, such as
position and fish height.

5.2.1.4 Other Channels
When Other is selected, there is no valid Sonar Type. Do not use this setting, except for signals
which you do not wish to view on the scrolling display.
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5.2.2 Acquiring Data from a Digital Sonar

5.2.2.1 Edgetech DF1000

Figure 5-4 The Digital Tab Form of the Open Acquisition Window showing the setup for an 
Edgetech DF1000 towfish

Figure 5-4, this page shows the Open Acquisition Digital Tab Form for an Edgetech DF1000
digital towfish. 

First, select the Sonar Range for which the data will be collected. This is the true range for each
channel or swathe over which the sonar will collect data. The available ranges are; 25m, 50m,
75m, 100m, 150m, 200m, 300m, 400m and 600m.

The channel selection option gives the choice of frequencies to be acquired by the fish. Each
channel can operate at either 100kHz or 500kHz. It is possible to gather data for all 4 channels
at once, namely Port and Starboard at both 100kHz and 500kHz. If you only wish to collect data
for 2 channels rather than 4, simply select the channels you require. It is not possible to select
data acquisition for only one channel.

The input channel numbers for the DF1000 data are fixed. The Coda display channels are as
follows:

• Port 100kHz - Input Channel 1

• Starboard 100kHz - Input Channel 2

• Port 500kHz - Input Channel 3

• Starboard 500kHz - Input Channel 4

The DF1000 towfish has an optional feature of providing instrumentation data. The towfish can
supply data for the heading, towfish depth and towfish voltage. It is possible to store the values
as part of the navigation data. These values can be stored by selection the appropriate toggle
buttons in the Nav Decode frame.
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If water depth is being received from the Navigation Input through the COM2 port then towfish
depth is ignored. However if water depth is not being received through this port, then it is calcu-
lated by adding towfish depth to fish height to derive the water depth. These fields can then be
reported, see Report Generation Section 10.10.2. The towfish depth may be used to calculate
water depth, for the report.

If navigation data is currently being received using Navigation Input then selecting the DF1000
values will override the values received from Navigation Input.

The Device Active/Inactive toggle button is used to either switch on or switch off DF1000 acqui-
sition.

Use the Diagnostic Aid toggle button if you want to send information from the DCI card of your
sonar device to the DA System Status Bar.

5.2.2.2 Edgetech ACI

Figure 5-5 The Digital Tab Form of the Open Acquisition Window showing the setup for an 
Edgetech ACI272T and AC272TD towfish

Figure 5-5, this page shows the Open Acquisition Digital Tab Form for an Edgetech ACI 272T
and ACI 272TD digital towfish.

First select the digital device type to be used, ACI 272TD (dual frequency) or ACI 272T (single
frequency).

Select the Sonar Range for which the data will be collected. This is the true range for each
channel or swathe over which the sonar will collect data. The available ranges are; 25m, 50m,
75m, 100m, 150m, 200m, 300m, 400m and 600m.

Select the frequencies option to be acquired by the fish either 100kHz or 500kHz (100kHz only
on ACI 272T).

Select the gain for the port and starboard channels, these range from -12dB to +12dB.
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Use the Diagnostic Aid toggle buttons if you want to send information from the ACI card of your
sonar device to the DA System Status Bar or to generate a test signal.

5.2.3 Acquiring Data over a Local Area Network

Figure 5-6 Open Acquisition pop-up showing Network Acquisition

5.2.3.1 Networking to an Edgetech MIDAS XSTAR system

Note: Before Starting please read through instructions and ensure that you are confident that you can
complete the configuration before attempting to change anything.

Both the Coda system and the XSTAR system must have the same network address (the first
three entries in an IP address). The simplest way to do this is to change the Coda system’s IP
address to the XSTAR network as follows:

1. Choose a free IP address on the XSTAR’s network.

2. Select the Change IP Address option from the Coda system’s Maintenance Menu and use
this free IP address (see Section 12.3.4). When finished, your system will reboot.

3. When the system has rebooted, check you have added your Coda system to the network.
Select Maintenance Menu→X Terminal. In the X Terminal screen, type “ping(IP Address)”.
If you get a reply from other machines on the network, you have successfully added your
Coda system to the XSTAR network

Now configure the MIDAS XSTAR software to tell it how to connect to the CODA system.

1. Edit the /etc/hosts file on the MIDAS system to add the Coda entry.

2. Right click on the Menu Bar with your mouse and select Shells→Shell Tool.

3. At the prompt, obtain root permissions by typing su <return> and enter the root password.
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Note: The Root Password is documented in your DA System’s Technical Manual, Software Build
printout. Contact Coda Technologies for further information.

4. When the system’s name appears in the display, type /usr/bin/textedit /etc/hosts. This will
bring up an editor. 

5. Add the Coda system entry in the editor and save this file by right clicking the mouse over
the menu area of textedit and then selecting the appropriate menu.

6. Exit the editor, by right clicking on the Title Bar and selecting Quit. At the shell prompt type
exit. This will exit su mode.

7. Now edit the ethernet.txt file by typing /usr/bin/textedit /home/bottom/ethernet.txt.

8. The first line of this specifies the Coda host to connect to. Enter this appropriately. 

9. The second line specifies the port to connect to. Set this to 49999. 

10. Save this file and quit the editor.

11. Reboot the MIDAS XSTAR. Type shutdown 0 at the prompt (you may need to su to do this).
At the boot prompt type boot.

You should now be able to ping the Coda system from the MIDAS XSTAR. You should also be
able to output data using the ethernet option from the MIDAS Menu. It is advisable to output raw
data to the Coda so that the data is retained at its full resolution. 

Note: The ethernet output button must be clicked twice for data to be sent to the Coda system.

5.2.3.2 Networking to an Edgetech FSIU Interface System
Both the Coda system and the FSIU system must have the same network address (the first

three entries in an IP address). The simplest way to do this is to change the Coda system’s IP

address to the FSIU network as follows:

1. Choose a free IP address and obtain the sub-net mask on the FSIU’s network.

2. Select the Change IP Address option from the Coda system’s Maintenance Menu and use
this free IP address and sub-net mask (see Section 12.3.4). When finished, your system will
reboot.

3. On the Network tab of the of the Acquisition pop-up, seeFigure 5-7, page 56, enter, in
Network IP Address, the IP address of the FSIU.

4. Press Test Connection.  This activates a ping test on the FSIU IP address to check the
integrity of the network connection.  If successful the system will return the message “IP
(address) is alive”.

5. Use the Lock button to prevent accidental change and save the set-up using the Save button.
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Figure 5-7 The Network Tab Form of the Open Acquisition Window showing an Edgetech FSIU 
system on initial opening.

Figure 5-7, this page shows the Open Acquisition Network Tab Form with the Edgetech FSIU
Network Device Type selected.  When initially viewed, the Network tab will only display the
Connect to FSIU, Port Number, Show Status, Reset FSIU, Derive ping Timestamp and Set
System Time items.
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Figure 5-8 The Network Tab Form of the Open Acquisition Window showing the set-up for an 
Edgetech FSIU system

Figure 5-8, this page shows the Open Acquisition Network tab form with the Edgetech FSIU
Network Device Type selected after clicking on the Connect to FSIU button.  This will establish
a connection with the FSIU unit and interrogate the subsystems on the unit.  The results of the
interrogation will then determine the number and type of device tabs to be displayed on the form.

The Reset FSIU button causes a reset message to be sent to the FSIU and for the tab area to be
cleared. Re-clicking the Connect to FSIU button will cause the tab area to be redrawn. 

5.2.3.2.1 Edgetech FSIU Sidescan
The Sidescan tabs are shown in Figure 5-8, this page. There are two separate tabs, one for high
frequency sidescan and one for the low frequency sidescan.  The tabs allow the user to activate
the subsystem, select the type of  pulse and trigger and the range.

The Pulse Type is obtained by interrogating the FSIU unit (this is done at the same time as the
interrogation for subsystems). Selecting a different Pulse Type from the scrolling option list
causes the Pulse Type Information area to be updated with the information of the newly selected
pulse type.

The Trigger scrolling option list gives the choice of  internal, external, coupled or gated trigger
types.

• Internal trigger is internal to the FSIU unit and not to the Coda system. When Internal is
selected the Trigger Divisor and Trigger Delay fields are greyed-out

• When External is selected, the Trigger Divisor is greyed out.  The Delay field can also be
used for External triggers, specifying the delay from the trigger

• When Coupled trigger is selected, the trigger can be coupled to another subsystem e.g. SBP.
Each option for coupling subsystems will be displayed in the list as, for example, Coupled
SB-0512. In Coupled mode, the Divisor and Delay fields can be used

• In Gated mode, the external trigger is used as a trigger inhibit, with the time of inhibit being

Network1

Device Active/Inactive

 EdgeTech FSIUNetworked Device Type:

Network IP Address: 194 . 70 . 215 . 130 Lock Test Connection

Sidescan SS-75 Sub-bottom SB-0512 BathymetrySidescan SS-410

Connect to FSIU Port Number:  1600

Pulse Type Information

Centre Frequency: 75kHz
Pulse Bandwidth: 7.5kHz
Pulse Length: 13ms

Subsystem Active/Inactive

Pulse Type:  75_3k_5k

Trigger:  Internal

Trigger Divisor:  1

Trigger Delay (us):  0

Range (m):  50 Nav Decode:  Use FSIU Values

 FSIU System TimeSet FSIU System Time:Derive ping Timestamp from:

(GJH7HFK

 FSIU System Time

Reset FSIU
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controlled by the value in the Inhibit Time field. This field replaces the Trigger Delay field
when the Trigger Type is set to Gated.

• The Divisor field acts to subdivide the master (coupled) trigger.

• The Delay field can be used to further delay this trigger from the master. 

The Navigation Decode scrolling option list allows the following choices:

• When Use FSIU Values is selected the position (E, N), heading, heave, pitch, roll, yaw,
depth, fish offset, layback, speed, course and temperature are all set from the FSIU.

• When Use Coda Navigation Values is selected the navigation values from the Coda
navigation string are used.

5.2.3.2.2 Edgetech FSIU Sub-Bottom

Figure 5-9 The FSIU Sub-bottom Tab Form of the Network Tab Form 

The Sub-bottom tab is shown in Figure 5-9, this page. The tab allows you to activate the
subsystem, select the type of pulse, trigger, gain, and power and also select the sweep time
parameters.

The Pulse Type is obtained by interrogating the FSIU unit (this is done at the same time as the
interrogation for subsystems). Selecting a different Pulse Type from the scrolling option list
causes the Pulse Type Information area to be updated with the information of the newly selected
pulse type.

The Trigger scrolling option list gives the choice of  internal, external, coupled or gated trigger
types.

• Internal trigger is internal to the FSIU unit and not to the Coda system. When Internal is
selected the Trigger Divisor and Trigger Delay fields are greyed-out.

• When External is selected, the Trigger Divisor is greyed out.  The Delay field can also be
used for External triggers, specifying the delay from the trigger.

• When Coupled trigger is selected, the trigger can be coupled to another subsystem e.g. SSS.
Each option for coupling subsystems will be displayed in the list as, for example, Coupled
SS-410. In Coupled mode, the Divisor and Delay fields can be used.

• In Gated mode, the external trigger is used as a trigger inhibit, with the time of inhibit being
controlled by the value in the Inhibit Time field. This field replaces the Trigger Delay field
when the Trigger Type is set to Gated.

• The Divisor field acts to subdivide the master (coupled) trigger

• The Delay field can be used to further delay this trigger from the master 

Sub-bottom SB-0512

Subsystem Active/Inactive

Pulse Type:  Pulse ID: 500

Trigger:  Internal

Gain:  Auto

Pulse Power (%):  100

Sweep Time (ms):  100

Start Delay (ms):  0

100Total Sweep (ms):

Trigger Divisor:  1

Trigger Delay (us):  0

Pulse Type Information

Min: 1000Hz,  Max: 5000Hz
Duration: 2mS
FS 1kHz to 5kHz pulse, 40ms,
uncompensated

 Use FSIU ValuesNav Decode:



DRAFT
May 2001 for version 2.1         59

U
sing the D

A
 

S
ystem

The Gain option allows a pre-selected gain to be applied to the received data. Selecting the value
Auto will cause the FSIU to choose the optimum gain.

• Pulse Power allows the user to select the outgoing pulse power as a percentage.

• The Sweep Time spin box allow the user to set the two way sweep time.

• The Start Delay spin box allow the user  to set an initial period over which no data is gathered

• The Total Sweep field automatically calculates the sum of the Sweep Time and Start Delay
spin boxes.

The Navigation Decode scrolling option list allows the following choices:

• When Use FSIU Values is selected the position (E, N), fish offset, layback, pitch, roll,
heading, temperature, course, annotation text, and speed are all set from the FSIU.

• When Use Coda Navigation Values is selected the navigation values from the Coda
navigation string are used. 

Edgetech FSIU Common Features
Below the tabbed area are parameters common to all sensors on the FSIU.

• The Derive Ping Timestamp From scrolling option list allows the user to select where the
ping timestamp is derived from. The choices are either FSIU System Time, FSIU Navigation
Time or Coda Navigation Time. When the option is set to Coda Navigation Time, the actual
value will depend on whether the Coda system is time-synched with a nav computer or using
its own system time.

• The Set FSIU System Time scrolling option list allows the System Time of the FSIU to be
set. When set to FSIU System Time, the time is left unchanged, when set to FSIU Navigation
Time, the FSIU time will be set by the navigation time. When set to Coda System Time, the
Coda time will be used. The time updated occurs each time OK or Apply is selected in the
Open Acquisition dialog.

5.2.3.3  Networking to a Reson Seabat 8125 Interface System

Figure 5-10 The Network Tab Form of the Open Acquisition Window showing the Reson Seabat 
8125 system.
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The Seabat 8125 is a 455 kHz Ultra High Resolution Focused Multibeam Echosounder (MBES)
system. It can output data either on an RS-232 port or on an Ethernet port. The Coda interface
decodes sidescan data transmitted from the Ethernet Port.

Note: The Ethernet protocol used in data transmission is UDP, which is a connectionless protocol. It does not
guarantee delivery or correct order and can be severely affected by heavy network traffic. For this reason, it
is recommended that the Reson Seabat 8125 and Coda System have their own private network and are linked
simply by a crossover cable.

Both the Coda system and the Reson Seabat 8125 system must have the same network address
(the first three entries in an IP address). It is very simple to configure IP addresses in the Seabat
8125 system, so it is recommended that the IP address of the Coda system stays constant, and the
local and remote addresses are configured on the Seabat 8125.

However if the Coda IP address is to be changed to that of the Reson network, carry out the
following:

1. Choose a free IP address and obtain the sub-net mask on the Reson Seabat 8125 network.

2. Select the Change IP Address option from the Coda system’s Maintenance menu and use
this free IP address and sub-net mask (see Section 12.3.4). When finished, your system will
reboot.

3. On the Network tab of the of the Acquisition pop-up, see Figure 5-10, page 59, enter, in
Network IP Address, the IP address of the Reson Seabat 8125.

4. Press Test Connection. This activates a ping test on the Reson Seabat 8125 IP address to
check the integrity of the network connection. If successful the system will return the
message “IP (address) is alive”.

5. Use the Lock button to prevent accidental change and save the set-up using the Save button.

On the Reson Seabat 8125, it is possible to configure the UDP base port number. Get the details
of this port number and enter it in the Network Tab Form, Port Number spin box, see Figure 5-
10, page 59.

The final selection can be made in the Derive Ping Time Stamp From spin box to either Coda
Nav Time or Reson Seabat System Time, see Figure 5-10, page 59.

5.3 Getting High Quality Data, Step 3: QC by Viewing the Data
It’s obviously important to be able to see the data, and check that it looks correct - without any
obvious noise problems, for example. This section gives a brief summary of how to get your data
scrolling on the screen so that you can QC it. For more complete information, refer to Section 6. 

5.3.1 Choosing Which Channels to View
Coda’s acquisition system can collect up to 8 channels of data and can display all of these on the
display simultaneously (depending on the system specification).  Up to two channels that use the
same trigger can be viewed at the same time in the same window.

Figure 5-11 Application Specific Area, Channels Tab

The Channels tab of the Application Specific Area (Figure 5-11, this page) displays the channels
that have been activated in the Open Acquisition pop-up.
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The default display window is a vertical scrolling dual channel display and the system will pick
the most appropriate channels to display.  In the above example the system has picked Analogue
Ch1 Port and Analogue Ch2 Starboard side scan channels, this is indicated by the icon next to
these channels showing a pair of spectacles.  Analogue Ch3 Seismic is not selected, indicated
by its icon showing an open window.

Author Note - not for publication!: these bullets need checking

The Application Specific Area also shows, by red or green LEDs the status of  recording, nav.
input and bottom tracking as follows:

• Recording: shows green when the channel has been selected for recording and red when not.

• Nav. Input: shows green when navigation input has been assigned, red when not.

• Bottom Tracking: shows green when automatic bottom tracking has been selected for that
channel, red when not.

To view more channels in another window simply click on the non-displayed icon and an appro-
priate window will be opened, in the above example if the Analogue Ch3 Seismic icon were to
be clicked this would open a horizontally scrolling single channel window.  Alternatively open
a new window, Window→Open New Window, and set the Window Type, Number of Channels
and Scroll Direction, (Figure 5-12, this page) to suit the requirements of the channel or channels
to be displayed.  Clicking  OK will open the new window and the system will select the most
appropriate channel or channels to be displayed; in the example given in Figure 5-12, this page,
Ch3 Seismic will be selected automatically if the window is set up for one horizontal channel.

Figure 5-12 Open New Window Pop-up Window

If you need to change the channel or channels being displayed  in a window select
Display→Display Input Channels (Figure 5-13, this page) and select the required channels.

Figure 5-13 Display Input Channel Pop-up Window

5.3.2 Setting Offset and Gain for Each Channel
As the system acquires 12-bit data, but must use 8 bits for display, you must select which part of
the data range to see. The system offers a number of mechanisms for doing this (see Section 7),
but at this point, all you need to do is ensure that the data looks correct, without any fine tuning
of the display. 

To do this:

1. Press the Play button in the Tape/Disk controls area (this has the same graphic as a Video or
Tape recorder play button).
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2. A pop-up window labelled Scale Display Data will appear; it will automatically adjust the
offset and gain applied to your data, using different defaults for sidescan and shallow seismic
data. Click on Done in this pop-up to dismiss it.

3. Now check that your data looks correct; if you need to fine tune the display, refer to Section
7 for detailed instructions.

5.4 Getting High Quality Data, Step 4: Navigation Inputs
Navigation input to the system is initialised by selecting File→Raw Nav Input. This option is
available only if the acquisition system has already been set up (see Section 5.2); in playback
mode it is greyed out.

Figure 5-14 The Raw Nav Input Selection Pop-up Window

5.4.1 Setting Up RS232 Communication
1. Ensure that the serial port you are using to acquire navigation data is connected to your

navigation computer or GPS set.

2. The Input Device to be used for the navigation data can be chosen by clicking on the appro-
priate device tab (usually COM2). Navigation input is connected to the DA System via a
serial port. The Serial Setup button may be used to pop up the COM Setup window, which
allows the baud rate, the number of data bits, the number of stop bits, the parity and the
method of flow control to be selected. These should be set to match those of the serial device
sending the navigation data to the DA System. Selections are made by clicking on the appro-
priate toggle buttons; when a suitable selection has been made, click on the OK button in the
COM Setup window. Figure 5-15, page 63 shows a COM Setup pop-up window.
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Figure 5-15 COM Setup Pop-up Window

3. Use the Display Raw Nav String option of the File→Raw Nav Input→Nav String Decode
tab pop-up to ensure that you are receiving RS232 navigation data correctly and to confirm
that its format is correct. This option pops up a window which displays the ASCII characters
as they are read in from the selected serial input port, and before they are formatted by the
system. Figure 5-16, this page, shows an example of the unformatted serial input for the Coda
navigation string.

Figure 5-16 Display of Unformatted Serial Input, for Coda Navigation String

5.4.2  Checking the Format of the Incoming Nav Data
1. Use an internal or external trigger (or digital or network device connection) to allow data to

scroll on the screen. You will not be able to QC the navigation without scrolling data, though
you do not need to have any input apart from the trigger connected.

2. Select the Nav Input Format by scrolling through the list of formats available. The format
chosen should match that of the navigation data which will be input to the DA System. The
list may be scrolled to allow those items off the bottom or top of the display window to be
seen. Edit should be selected if the format you need is not in the list and a new navigation
library entry is required. A description of the format for navigation data is given in Appendix
B.

3. To check that the navigation variables are being updated and what their current values are,
click on the Nav input on button, the Apply button and then the Nav QC. This option can be
selected when testing the navigation input with a new RS-232 navigation string, or when
checking that navigation equipment is delivering a correctly formatted navigation string. If
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the output of the Nav QC is unsatisfactory (with variables updated incorrectly or not updated
at all), click on Nav input off and  Apply and view the raw navigation data being delivered
to the system (see 5.4.1).

Figure 5-17 The Nav QC Pop-up Window

•  If the data being read in from the serial port by the DA System is not recognisable as the data
sent by the navigation system, the serial port setup is incorrect. The parity, number of data
bits, number of stop bits, handshaking, and baud rate for the navigation interface may all be
changed using the Serial Setup item in the Raw Nav Input pop-up. The hardware specifi-
cation for the RS-232 navigation interface is given in Section 14.

• If the data displayed in this window matches that sent by the navigation system, the data is
being passed through the RS-232 port but it is being interpreted incorrectly. The problem is
likely to be caused by an incorrect navigation format being selected in the Raw Nav Input
pop-up. If the wrong format has been selected from the list of navigation library entries, make
another selection from the list; if the incoming format is not compatible with any of the
navigation library entries, then a new navigation library entry is required. Edit Nav Format
can be selected to add a new navigation library entry, or to rectify faults in an existing one.
Full details of the syntax for library entries are given in Appendix D.

5.4.3 Setting Up Navigation Input
Selecting the File→Raw Nav Input menu item brings up the Raw Nav Input settings pop-up, and
the Nav String Decode tab enables the appropriate RS-232 navigation string and serial input port
to be selected (see Figure 5-9, page 58).

To initialise navigation input:

1. Check that the RS232 port is set up correctly, and that the incoming navigation string has the
expected format (see Section 5.4.1 above).

2. Select the appropriate navigation library format from the list, and QC it to ensure it is being
decoded correctly (see Section 5.4.2 above).
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3. If necessary, set the Clock Synchronisation. 

The Clock Synchronisation setting defaults to Use nav string. This allows the system to
use the date and time obtained from the navigation computer as a time stamp for its data; this
is essential when generating corrected navigation data (see Section 6.6). If no time infor-
mation is available from the nav string, or if it is not desirable to synchronise with the
navigation computer, set the Clock Synchronisation to Use system time. The Coda
system’s time can be set via the Maintenance Menu (see Section 12.3).

If  Turn nav input on is selected, and Nav is set in the Clock Sync, when the DA System
time has synchronised a “Nav clock Synchronised OK” message appears on the message bar
and the clock face in the General Information Area turns from red to green

If Nav is set in the Clock Synchronisation but synchronisation has been lost, then clock face
in the General Information Area turns from green to red to indicate that the DA System’s
clock is not synchronised with the navigation data.

Note that the time displayed in the General Information Area may not match the current time
on the navigation computer or GPS receiver. This is because the time displayed in the GIA
is the time for the ping at the top of the display; if data has been buffered for any reason, this
ping will have a time somewhat later than the GPS or nav computer time.

4. If required, click on the Auto Fix Line tab and set the time interval between fix marks.  By
default, this setting is off and the DA System takes in fix marks via the navigation input.  For
the DA System to generate fix marks automatically, select the Auto fix marks on toggle and
set the time interval in seconds between the fix marks. Fix marks are numbered from one by
default but can be set to a preferred number, as can the increment rate.  Fix marks are reset
to one each time the navigation input is restarted.

5. The Nav position reference scrolling option list on the Nav String Decode tab allows you
to select either Fish reference or Ship reference. When Fish is selected, the Coda system
expects the position received over the nav string to be the towfish position, and layback and
offset settings in the Settings→Parameters window have no effect. When Ship is selected,
layback and cross-track offset may be entered to allow the DA System to calculate a derived
fish position (see Section 6.6.4.). The setting of the Nav position reference is indicated in
the General Information Area by a picture of a fish or a ship or in the Display→Survey Data
pop-up.

6. In the Raw Nav Input→Nav String Decode tab frame, click on Nav input on and then click
on Apply.  Navigation input is then read and merged with the sonar data being digitised and
recorded. If Nav input on has not been selected when recording starts, a warning appears.

Note: Navigation data is only displayed or updated when Nav input on is selected in the Raw Nav
Input→Nav String Decode tab pop-up. It is not displayed when Display Raw Nav String is
selected, or when Turn nav input off is selected.

When navigation input is turned on, the system monitors input from the navigation input
device.If no navigation input is received within a given number of seconds (specified as part
of the navigation format – for Coda format it is 30 seconds), a message appears on the screen
warning that navigation input has not been detected. This warning continues to pop up at
regular intervals until navigation input is once more detected or navigation input is switched
off. To turn the input off, the Raw Nav Input→Nav String Decode tab menu item should be
reselected and Nav input off clicked, followed by selecting the OK at the bottom of the pop-
up.
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Figure 5-18 The Navigation Input Selection Pop-up Window

5.4.4 Other Navigation Parameters in Acquisition Mode

Figure 5-19 The Navigation Parameter Settings Pop-up Window

The Settings→Navigation Parameters pop-up is used to enter a number of parameters which
are normally input automatically via the navigation input string supplied to the system from the
RS-232 port (see Section 5.4.1). However, if a fixed format navigation string is being used, it
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may be difficult to obtain some parameters in this manner. The Nav Parameter pop-up therefore
provides the means to manually enter values for parameters that may not be provided by onboard
navigation facilities.

In acquisition mode, the values entered for these parameters are recorded to tape or optical disk
along with the other navigation data. They are also displayed to screen via the Display→Survey
Data pop-up. 

Note that entering parameter values in the pop-up overrides any corresponding parameter values
supplied from the nav input.

In playback mode, parameters entered in this pop-up override the corresponding recorded values.

5.4.4.1 Survey and Line Name
The Settings→Navigation Parameters pop-up contains the Survey Name/Description text-
entry box which is used to store text data for one survey with a chosen name or description of up
to 48 characters. If no name or description is entered, and no name is available from the RS232
Nav String the Survey Name in the Survey Data pop-up is shown as ‘Unknown’.

Line Name is used to mark specific parts of a survey with a name of up to 16 characters in length.
This is most useful in acquisition mode to mark on the data which sections were within specific
survey run lines. Usually it is more convenient if this is available as part of an RS232 navigation
string.

5.4.4.2 Setting Towfish Layback and Offset
When Layback and Fish Cross-Track Offset are entered in the text-entry boxes, the DA System
is able to use the ship’s position to estimate the position of the towfish.

Figure 5-20 Diagram showing Cross-Track Offset and Layback

The Layback value is the along track distance in metres from the ship position to the fish
position, and the Fish Cross-Track Offset is the distance (also in metres) cross-track, from the
ship position to the fish position (see Figure 5-20, this page). A positive offset indicates an offset
to the right (starboard), and a negative offset indicates the offset is to the left (port).

5.4.4.3 Setting the UTM Zone
The Settings→Navigation Parameters→UTM Zone selector can be used to enter the UTM zone
number for converting positions from Eastings and Northings to lat/long co-ordinates. The value
can either be taken from the nav string by clicking on the Input via nav string item or it can be
entered manually by clicking on the User Input and typing the zone number in the text-entry box.

5.5 Getting High Quality Data, Step 5: Bottom Tracking
The Processing→Fish Height pop-up (see Figure 5-21, page 68) enables you to select the
source of the fish height to be used during data acquisition and playback. The fish height is used
to determine the seabed return position, which is used in feature height calculations and in slant-
range correction.

Cross-track

Offset

Ship H
eading

Ship Position X

Towfish Position

Layb
ack
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In acquisition mode, the resulting fish heights are recorded to the data storage device with the
raw data.

In playback mode, previously recorded values may be used, or they may be reviewed using one
of the bottom detection algorithms available in the Fish Height/Seabed Tracking pop-up.

The Fish Height Record File utility is provided to allow the user to store the results of this
review. Where the user iterates on “difficult” data to obtain better fish height results, the record
file can be updated with the new values.

On playback of a data file which has a fish height record file, the system will automatically apply
this file to the data set if the enabling toggle Remember/Use Previous Position is selected.
(Section 5.5.1.4)

5.5.1 Setting Up Bottom Tracking

Figure 5-21 Fish Height Setup Popup Window for Sidescan Data

The Channel tab forms are used to select which channel or channels to apply the fish height-
setting to.

5.5.1.1 Fish Height Source - Selection
For selection of fish height source there are eight options on the scrolling options list. The first
item will be either From Telemetry Data if the system is in acquisition mode or Keep Existing
if the system is in playback mode.

Figure 5-22 Fish Height Source Selection - Keep Existing

The other standard options are :
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Figure 5-23 Fish Height Source Selection - Standard Options

Note: Advanced Edge Detection is only available for Sidescan.

• From Telemetry Data (acquisition mode only) - receiving the towfish height as part of the
navigation data, based on the towfish altimeter reading – is usually the best option if data
from this source is available. If this is not the case, an Auto-Tracking algorithm should be
used. This setting gives additional options for influencing the automatic bottom tracking
algorithm; these options enable you to enter minimum and maximum fish height, alter the
sensitivity of the  algorithm, and interactively reset the tracking algorithm if necessary. On
occasion, however, the characteristics of the seabed or water column may result in unpre-
dictable performance by the automated bottom tracking algorithm, in which case the Fixed
Fish Height setting should be used.

• From Telemetry Data is available only in acquisition mode and causes the height to be read
from the nav string; this setting can be used if an altimeter is fitted to the towfish, and the
altitude is being sent from the towfish to the navigation computer. If no height is entered via
the nav string, fish height will be set to 0.

• The option Keep Existing can only be selected in playback mode and causes the previously
recorded fish height to be used. The fish height input will vary depending on system settings,
it can be via Corrected Navigation, Fish Height Record File or Existing Value from Raw
Acquisition File (see Section 5.5.1.6).

• Selecting Fixed Fish Height causes the fish height to be set to a user-defined height. The
height can be entered in metres, milliseconds or samples, using the scrolling options list. It
remains fixed at this value until you choose a different fish height setting or change the value
of the fixed fish height.

• Copy Fish Height from Another Channel allows the fish height value to be copied from
another channel, using the scrolling options list. For example, channel 1 could be set to Auto-
Tracking : Threshold Algorithm and channel 2 then set to copy the height from channel 1.
This could be useful when the data in channel 2 is too noisy for automatic tracking to work
reliably.

• Use Fish Height Settings From AnotherChannel allows pop-up settings to be copied from
another channel. In this case, the fish height will still be computed independently for each
channel since it is not the fish height value but the computational parameters that are being
copied across. Note that this is distinct from Copy Fish Height from Channel where the final
computed fish height value is being copied.

Automatic Tracking offers four methods for automatic detection:

• Thresholding: This method which sets a threshold amplitude for the bottom return and is the
preferred method of detection because it is highly configurable for varying conditions.

• Power Density: This method automatically sets its own thresholds and looks for the greatest
energy in the search window.

• Edge Detection: This method automatically sets it own thresholds and looks for the fastest
edge in the search window.

• Advanced Edge: This is the conventional bottom tracking for sidescan data available in
earlier releases of the Coda software and is only available for sidescan.
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5.5.1.2 Fish Height Source - Method Properties
Each selection of fish height source will display its associated Method Properties worksheet. In
the example below (see Figure 5-24, this page) the Method Properties for Auto-Tracking :
Threshold Algorithm are shown.

Figure 5-24 Fish Height Setup Pop-up Window for Sidescan Data

Method Properties - Static Limits

Figure 5-25 Method Properties Worksheet - Static Limits

• Search Limits Type defines the type of searching window used. Static applies a fixed
position search window to the data. The window extends between Minimum Search Limit
and Maximum Search Limit.

• Minimum Search Limit defines the lower search limit from the seabed. The units can be
entered in metres, samples or milliseconds. The minimum height may be used to “mask out”
noisy data at the start of the sonar trace.

• Maximum Search Limit defines the upper search limit from the seabed. The units can be
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entered in metres, samples or milliseconds.

Method Properties - Moving Window

Figure 5-26 Method Properties Worksheet - Moving Window

• Search Limits Type defines the type of searching window used. Moving Window applies a
active position search window to the data. The window width is defined by Search Window
Width.

• Search Window Width defines the width of the window in which the search for the bottom
return will take place, it keeps bracketing the bottom return as the return is tracked. The units
can be entered as metres, samples or milliseconds.

Method Properties - Tracking (Threshold )

Figure 5-27 Method Properties Worksheet - Tracking (Threshold )

• Polarity allows the choice of positive or negative going edges.

• Threshold Value sets a threshold amplitude for the bottom return as a percentage of the full
scale value of the signal amplitude.

• Offset Bottom Position allows a fixed offset to be applied to the fish height. A positive value
indicates that the fish height will be increased.

Method Properties - Tracking (Power Density, Edge Detection, Advanced
Edge)

Figure 5-28 Method Properties Worksheet - Tracking ( Power Density, Edge Detection & 
Advanced Edge )
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• Sensitivity: this parameter relates the trade-off between detection ability and sensitivity to
noise. When sensitivity is low, the algorithm is less sensitive to noise but not as good at
tracking weak bottom returns. Conversely, when sensitivity is high, the algorithm is more
sensitive to noise but better at tracking poor bottom returns.

• Offset Bottom Position allows a fixed offset to be applied to the fish height. A positive value
indicates that the fish height will be increased.

Method Properties - Noise Reduction

Figure 5-29 Method Properties Worksheet - Noise Reduction ( Threshold, Power Density & Edge 
Detection )

• Band Pass Filter Low Edge defines the low frequency 3dB cut off point for the filter.

• Band Pass Filter High Edge defines the high frequency 3dB cut off point for the filter.

• Noise Reduction is not an available option for Advanced Edge Detection.

Method Properties - Smoothing

Figure 5-30 Method Properties Worksheet - Smoothing ( Threshold, Power Density, Edge 
Detection )

• Smooth Bottom Tracking Over defines the number of pings the bottom tracking should be
smoothed over in the along track direction.

• Smoothing is not an available option for Advanced Edge Detection.

Common Functionality
Display Processed Data works in the Threshold, Power Density and  Edge Detection
algorithms. It displays the characteristics of the detection envelope instead of the bottom return.
When this option is selected, a warning message will be displayed in the Scale Display Data
window.

The Reset Bottom Position button in the Fish Height/Seabed Tracking pop-up or the Reset
Seabed Position icon allows you to reset the bottom position. Clicking on the button - or using
the key shortcut <b> - changes the arrow pointer to the automatic tracking pointer. This allows
you to reset the tracking algorithm by clicking with the left mouse button over the appropriate
bottom position in the data display.
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5.5.1.3 Fish Height Alarms

Fish height alarms are only available in acquisition mode. The user can set the fish height in
terms of metres, msec and samples from the scrolling options list. 

Figure 5-31 Fish Height Alarm Worksheet

The alarm is an audible double beep every ten seconds when the fish height exceeds either the
Maximum or Minimum limits. In addition the status bar is updated to report alarm condition.

Figure 5-32 Status Bar - Fish Height Alarm Message

5.5.1.4 Fish Height - Recomputed File
During a survey, set up and acquire the fish height with the raw data (See Section 13.1.1). 

If this has not been possible or the resulting fish height is unsatisfactory, perhaps due to environ-
mental conditions, review the fish height values in playback mode. 

The Read/Write Fish Height Values utility is provided to allow you to store the results of this
review. On future playbacks of the data the record file if available, will be used by the Coda
system as the fish height source for data processing in preference to the fish height recorded with
the raw data at the time of acquisition.

Note: Fish Height in Corrected Nav will always take precendence.

Figure 5-33 Fish Height Recomputed File Worksheet

To create a Fish Height File, select and configure the desired fish height source from the
scrolling options list (see Section 5.5.1.1) There are seven Fish Height Sources that can be used
as inputs to the record file.

The first fish height source, Keep Existing (playback mode only), is used to retrieve recorded
fish height during playback of data (see below).

Figure 5-34 Fish Height Source Selection

In addition to the fish source, the Read/Write bottom position to/from Disk utility must be
activated (see Figure 5-33, this page). When the raw data file is played back, you can review the
quality of the seabed tracking and manipulate the source settings to obtain the best response.
During this stage, fish height for each ping is stored in the record file.
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There are no restrictions on the data playback sequence; any iteration through the data set to
recompute the fish height will store a new set of values in the record file. 

The Fish Height file is updated if more than 1 second has elapsed AND the seabed value has
changed by > 2% for a non-flat seabed 

OR

Updated every 5 seconds for a flat seabed.

5.5.1.5 Fish Height - Play Back Fish Height File
To play back a data file using the Fish Height File, you must select Keep Existing (playback
mode only) as the fish height source. The Remember/Use Previous Bottom Position toggle
must also be selected. The system will automatically detect the Record File and apply it to the
data set being played back.

In playback, the fish height can be applied to a data set via a corrected navigation file, a fish
height file or simply by reading fish height values recorded in acquisition. The Coda system will
detect which inputs are available on the system and apply a status to each one thus determining
which input will be used for fish height. The pre-defined status from highest to lowest is
Corrected Navigation, Fish Height Record File and Keep Existing.Therefore, a Corrected
Navigation file which contains fish height will be used in preference to all other inputs. If this is
not available then the system will check for the availability of the Fish Height File. If this is not
available, the system will revert to reading the acquired fish height value from the data file.

The Fish Height file can be switched off by deselecting the Remember/Use Previous Bottom
Position toggle. This will prevent a Fish Height file being created or from being accessed in
playback mode. In this condition, the system will revert to reading the acquired fish height value
from the data file.

The fish height record files are stored in /home/dp100/fish_alt/, and each recorded data file has
a directory of fish altitude files which has the same name as the tag files for that recording (this
will be the data and time of the start of the recording). If you are transferring fish altitude files
between machines, be sure to copy the appropriate directory and all its contecnts, rather than
isolated fish altitude files.

5.5.1.6 Fish Height - Additional options

Figure 5-35 Fish Height - Additional Options

Preview Settings Automatically allows the user to monitor real-time the effect on Fish Height/
Seabed Tracking of changes made to Method Properties. By selecting Cancel, the user can
revert to previous settings. By selecting OK or Apply the user confirms the changes made to the
Method Properties.

Clicking on the Copy Settings to All Channels button copies the settings from the current
channel.

Clicking on the Display Bottom Position button produces the Display Bottom Position pop-up.

The action buttons at the bottom of the pop-up include the option to Load previous settings or
Save current settings so that they can be used in future.

5.5.2 Setting Up Sub Bottom Profiling

5.5.2.1 Showing the Seabed Position
The Display→Bottom Position Line menu item produces the Display Bottom Position pop-up.
This pop-up is used to choose which data channel will display an orange line in the display,
indicating the position of the seabed return in the display area, namely the left or right channel,
or both channels. To select a data channel, click on the appropriate Left Channel or Right
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Channeltoggle.

Figure 5-36 The Display Bottom Position Pop-up

The Bottom Position Line shows where the Coda system believes the seabed to be, from the
settings in the Processing→Fish Height Setup pop-up (see Section 5.5.2.2). The Bottom
Position Line is displayed in the correct position even when sub-sampling or offsets are applied
to either of the displayed channels (see Section 7.4).

5.5.2.2 Setting Up Bottom Tracking

Figure 5-37 Fish Height Settings Pop-up Window for Seismic Data

From Telemetry Data - receiving the towfish height as part of the navigation data, based on the
towfish altimeter reading - is usually the best option if data from this source is available. If it is
not, Automatic tracking should be used. This setting gives additional options for influencing the
automatic bottom tracking algorithm; these options enable you to enter minimum and maximum
fish height, alter the sensitivity of the algorithm and interactively reset the tracking algorithm if
necessary. On occasion, however, the characteristics of the seabed or water column result in
unpredictable performance by the automated bottom tracking algorithm, in which case the Fixed
Fish Height setting should be used.

The Channel tab forms are used to select which channel or channels to apply the fish height
setting to.
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From Telemetry Data is available only in acquisition mode and causes the height to be read from
the nav string; this setting can be used if an altimeter is fitted to the towfish, and the altitude is
being sent from the towfish to the navigation computer. If no height is entered via the nav string,
fish height will be set to 0.

The option Keep Existing Value can only be selected in playback mode and causes the previ-
ously recorded fish height to be used.

Selecting Fixed Fish Height causes the fish height to be set to a user-defined height. The height
can be entered in metres, milliseconds or samples, using the option selection button. It remains
fixed at this value until you choose a different fish height setting or change the value of the fixed
fish height.

Copy Fish Height from Other Channel allows the fish height value to be copied from another
channel, using the option selection button. For example, channel 1 could be set to Automatic
Tracking and channel 2 then set to copy the height from channel 1. This can be useful when the
data in channel 2 is too noisy for automatic tracking to work reliably.

Automatic Tracking offers three methods for automatic detection:

• Edge Detection. This method automatically sets it own thresholds and looks for the fastest
edge in the search window. It is most suited to hard seafloor and high frequency shallow
seismic sonar.

• Power Density. This method automatically sets its own thresholds and looks for the greatest
energy in the search window. It is most suited to lower frequency profilers.

• Thresholding. This method which sets a threshold amplitude for the bottom return and is the
preferred method of detection because it is highly configurable for varying conditions.

Figure 5-38 Fish Height Setting Method (Seismic and Other sonar)

Clicking on the Method Setup button pops up the Automatic Tracking Setup pop-up. The setup
options are:

Figure 5-39 Automatic Tracking Setup: Seismic Limits, Static

• Minimum Expected Fish Height defines the lower search limit from the seabed. The units
can be entered in metres, samples or milliseconds. The minimum height may be used to
“mask out” noisy data at the start of the sonar trace.

• Maximum Expected Fish Height defines the upper search limit from the seabed. The units
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can be entered in metres, samples or milliseconds.

Figure 5-40 Automatic Tracking Setup Seismic Limits, Adaptive

• Search Window Width defines the width of the window in which the search for the bottom
return will take place, it keeps bracketing the bottom return as the return is tracked. The units
can be entered as metres, samples or milliseconds.

Figure 5-41 Automatic Tracking Setup: Seismic Tracking (Thresholding)

• Sensitivity: this parameter relates the trade-off between detection ability and sensitivity to
noise. When sensitivity is low, the algorithm is less sensitive to noise but not as good at
tracking weak bottom returns. Conversely, when sensitivity is high, the algorithm is more
sensitive to noise but better at tracking poor bottom returns.

• Offset Bottom Position allows a fixed offset to be applied to the fish height. A positive value
indicates that the fish height will be increased.

Figure 5-42 Automatic Tracking Setup: Seismic Filtering
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• Band Pass Filter Low Edge defines the low frequency 3dB cut off point for the filter

• Band Pass Filter High Edge defines the high frequency 3dB cut off point for the filter

Figure 5-43 Automatic Tracking Setup: Seismic Smoothing

• Smooth Bottom Tracking Over defines the number of pings the bottom tracking should be
smoothed over in the along track direction.

The Display Bottom Processed Data works in the Power Density mode and displays the
characteristics of the detection envelope instead of the bottom return. When this option is
selected, a warning message will be displayed in the Scale Display Data window.

The Reset Bottom Position button in the Fish Height Settings pop-up or the Reset Seabed
Position icon allows you to reset the bottom position. Clicking on the button - or using the key
shortcut <d> - changes the arrow pointer to the automatic tracking pointer. This allows you to
reset the tracking algorithm by clicking with the left mouse button over the appropriate bottom
position in the data display. Clicking again on the button causes the pointer to revert to its
previous mode.

Clicking on the Copy Settings to All Channels button copies the settings from the current
channel.

Clicking on the Display Bottom Position button produces the Display Bottom Position pop-up
Figure 5-36, page 75.

The action buttons at the bottom of the pop-up include the option to Load previous settings or
Save current settings so that they can be used in future. The name of the settings file appears at
the top of the pop-up. If an asterisk (*) appears at the same time it means the settings have been
altered from those saved to the hard disk.

5.5.2.3 Automatic Tracking Hints (Seismic)
If the data is prone to noise, particularly in the water column, the automatic tracking will
performless well.

1. Select Display→Bottom Position Line to display the bottom tracking line.
2. In the Fish Height Settings pop-up, click on the tab of the appropriate channel and then click
on the Automatic Tracking toggle.
For best results, try the various detection modes in the follow order:

Thresholding
1. Toggle the Thresholding button.

2. Click on the Method Set-up button and select the Limits tab.

3. Select the Adaptive toggle and set the Search Window width to 10% of the line length.

4. Click on the Tracking tab and select the edge you with to track.

5. Set the Threshold Value to just above the mean signal level for a positive edge or just below
the mean signal level for a negative edge.
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6. If the water column is noisy, enter Filter characteristics to enhance the signal.

7. If the bottom lock is jittering, apply enough Smoothing to compensate (starting with a low
level).

8. Remember to use the Apply button to confirm the changes before dismissing the pop-up.

Power Density
1. Set up is similar to Thresholding, but Sensitivity (not Threshold Value) is applied in

Tracking. A high sensitivity will enable detection of faint bottom returns, but will be more
sensitive to noise.

2. Use the Offset Bottom Position spin box to adjust the track to the beginning of the bottom-
return.

Edge Detection
1. This is very similar in application to Power Density, but detects the largest edge rather than

peak power in the search window.

Improving Bottom Tracking
The systems described above are very versatile and, with practice, can be a very powerful tool
to track automatically the bottom in a wide variety of conditions and circumstances.

If the bottom tracking line deviates from the true bottom position, try one of the following:

1. 1. Redirect the automatic tracking using the Reset Bottom Position button, or the key
shortcut <b>.

2. If the bottom tracking is persistently positioned ABOVE the true bottom position, REDUCE
the automatic tracking Sensitivity or use Offset Bottom Position.

3. If the bottom tracking line is persistently positioned BELOW the true bottom position,
INCREASE the automatic tracking Sensitivity or use Offset Bottom Position.

5.5.3 The Tape/Disk Controls in Acquisition Mode
The Tape/Disk control buttons are analogous to those of a video tape or audio recorder, though
their functions change according to the mode being used, acquisition mode or playback mode.
This section describes the functionality of the buttons in acquisition mode - for details of their
effect in playback mode, refer to Section 6.7.

5.5.3.1 The Record Button
This button controls all the record functions of the system. When it is selected, a pop-up
appears. Section 5.5.3 has described how to start and stop recording to tape and disk.

Note that the record button turns from red to green when recording is taking place, and that
recording is started and stopped by the popup which appears if the record button is pressed.
Pressing the record button accidentally during recording will not have any effect.

5.5.3.2 Play
During acquisition this button starts the display scrolling; it has no effect on the
recording of data. During playback this button controls the reading of data from tape or

optical disk and its display on screen.

When the Play button is pressed after File→Open Playback or File→Open Acquisition have
been selected, the Scale Display Data pop-up appears in the display area to enable you to
optimise the display.

5.5.3.3 Stop
During acquisition this button stops the display of data, not the recording of data.
(Recording of data is started and stopped using the pop-up accessed from the Record

button, described in Section 5.5.3.1.) Thus, when this button is selected, incoming data from the
acquisition system continues to be read and recorded, but it is discarded without being displayed.
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5.5.3.4 Pause
 key shortcut: <Spacebar>

During acquisition this button has no effect on recorded data; it simply pauses the
display of data on the screen. If, however, the pause is so long that the display buffer fills

up, the display automatically starts scrolling again. This auto pause release feature ensures that
all incoming data can be seen on the display. Clicking on the Pause button again also starts the
data scrolling. Alternatively, if the pointer is in the Data Display Area, the space bar can be used
to pause and release the data.

5.5.3.5 Goto
This button has no effect during acquisition. 

5.5.3.6 Fast Forward/Cue
This button has no effect during acquisition.

5.5.3.7 Rewind/Review
This button has no effect during acquisition.

5.6 Tips for Recording High-Quality Data
• Check for green light on record button, to indicate the recording has started. 

• Check for blue (not red) time in GIA, indicating that the system is syncing to nav time.

• Check that nav string has all possible values and they’re being decoded correctly.

• Check bottom tracking is on and working satisfactorily.

• Check that ping rate is as expected, based on sidescan range or seismic ping rate.

• Check that voltage range is correct, without clipping data of interest.

5.7 The Application Specific Area in Acquisition Mode
The Application Specific Area, which lies near the bottom right of the display screen, is shown
in Figure 5-44, this pageand Figure 5-45, this page.  Different views are displayed by selecting
the appropriate tab. See also Section 5.3.

5.7.1 The Application Specific Area in Acquisition Mode 1

Figure 5-44 The Application Specific Area - Channels Tab in Acquisition Mode

When the DA System is in Acquisition mode the Channel tab in the Application Specific Area
shows information on the number and type of channels open and whether the channel is being
recorded, has Nav Input applied and has Bottom Tracking applied (Figure 5-44, this page). This
is indicated in each case by a red status indicator for “off” or a green status indicator for “on”.
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5.7.2 The Application Specific Area in Acquisition Mode 2

Figure 5-45 The Application Specific Area - Device Tab in Acquisition Mode

When the DA System is in Acquisition mode, the Devices tab in the Application Specific Area,
shows information on the tape devices or disk devices, present and activated on the system (see
Figure 5-45, this page).  A status indicator for each device indicates which device is recording
(green) and which are not (red).  For tape and optical drives there is a device icon which can be
used to eject the media from the drive and in the case of optical drives and local disks there is an
indication of free disk space.

5.8 The General Information Area in Acquisition Mode
The General Information Area, which lies near the bottom left of the display screen, is shown in
Figure 5-46, page 81 and Figure 5-47, page 82. There are two modes, selected by the button in
the bottom right hand corner of the area, and they provides the information listed below for
which ever window is selected on the tab bar. 

5.8.1 The General Information Area in Acquisition Mode 1

Figure 5-46 The General Information Area in Acquisition Mode 1

• Position: The position of either the fish or the vessel in either Lat/Long or UTM appears at
the top of the display and shows the position of the newest ping in the window. A symbol of
a fish or a vessel appear in the middle of the position to indicate the position reference point.

• date/time: the present date and time. (The date is displayed as dd-mm-yy.)

• Nav Sync: A clock face displayed between date and time shows green when the navigation
data is in sync and has a red cross on the face when not in sync.

• fish alt: shows the distance of the towfish above the seabed when the data was acquired.

• heading: shows the direction in which the vessel or towfish is heading. 

• line: the line name which is either taken from the Nav String or entered by the user.

• range: displays either the true range in meters for a side scan window or sweep time in msecs
for a seismic window.

• cursor (pointer): the position directly under the cursor on the screen; namely, Eastings,
Northings and Kp. The information is colour coded to indicate the channel over which the
cursor is positioned, channel colour is indicated in the top right of the display window. The
position is fully geo-corrected and is calculated using the navigation data stored with each
ping. If the fish height is known, the position is automatically slant-range corrected.
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Positions that are off-track are calculated using the geographical ping position, heading and
across-track distance from the position. For accurate off-track positions it is essential that the
heading is correct.

Note: To calculate an off-track position lat/long is converted to UTM, the position is calculated and then this
position is converted back from UTM to lat/long.

The format in which the cursor information is displayed can be changed from eastings and
northings to lat/long – and vice versa – by clicking on the appropriate one-of selection button in
the Display Nav Basis Type frame of the Nav Data Settings pop-up.

5.8.2 The General Information Area in Acquisition Mode 2

Figure 5-47 The General Information Area in Playback Mode 2

• Position: The position of either the fish or the vessel in either Lat/Long or UTM appears at
the top of the display and shows the position of the newest ping in the window. A symbol of
a fish or a vessel appear in the middle of the position to indicate the position reference point.

• date/time: the present date and time. (The date is displayed as dd-mm-yy.)

• Nav Sync: A clock face displayed between date and time shows green when the navigation
data is in sync and has a red cross on the face when not in sync.

• pings/s: the rate (pings per second) at which the trigger is running

• ping no: the number of the ping being displayed in the top line of the Data Display Window.
It is continuously updated while data is scrolling.

• survey: displays the survey description as entered in the Nav Parameters pop-up

• Kp: the kilometre post number of the newest ping in the display window.

• cursor (pointer): the position directly under the cursor on the screen; namely, Eastings,
Northings and Kp. The information is colour coded to indicate the channel over which the
cursor is positioned, channel colour is indicated in the top right of the display window. The
position is fully geo-corrected and is calculated using the navigation data stored with each
ping. If the fish height is known, the position is automatically slant-range corrected.

Positions that are off-track are calculated using the geographical ping position, heading and
across-track distance from the position. For accurate off-track positions it is essential that the
heading is correct.

Note: To calculate an off-track position lat/long is converted to UTM, the position is calculated and then this
position is converted back from UTM to lat/long.

The format in which the cursor information is displayed can be changed from eastings and
northings to lat/long – and vice versa – by clicking on the appropriate one-of selection button in
the Display Nav Basis Type frame of the Nav Data Settings pop-up.
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6 Playing Back Survey Data

This section describes how to use the system to replay previously recorded data tapes or disks.
It includes descriptions of how to initiate playback mode, how to use the Goto command to move
to a specific point in the data and how to incorporate corrected navigation data. Features which
can be used in both acquisition and playback modes are not dealt with in this section, but are
discussed in Section 7.

We recommend that you practice using the DA System in playback mode to become familiar
with the look and feel of the interface. A sample tape or disk of data acquired using the DA
System is provided for this purpose, and a summary of the procedure is given in below.

6.1 Summary of the Playback Procedure

Author Note - not for publication!: Flow chart not yet checked
and updated.

Figure 6-1, page 84, shows a summary of the procedure for playing back survey data using the
DA System – from connecting the system, powering up and playing back data, to powering down
and getting the system ready for transportation. The cross references within the flow diagram
indicate which section to go to for more details on the procedure and screen dumps of the relevant
display areas, menus and menu items. 
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Figure 6-1 Flow Chart of DA System Operations
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6.2 Playing Back Data, Step 1: Starting Playback
To play back data, you must first put the system in playback mode. This is done by selecting the
Open Playback menu item. You can then use the appropriate data controls and adjust the
settings, such as the speed of playback, as required.

Note: Playback mode cannot be started whilst a recording session is active. The recording session should be
stopped via the Recording Popup. If previously in acquisition mode a confirmation prompt will appear when
opening playback. Clicking Yes will open playback and terminate the current acquisition session.

6.2.1 Starting Playback on a Tape System
1. Insert a tape of previously recorded data into the tape drive.

In a twin-tape system the upper drive is Tape 1; the lower drive is Tape 2.

Figure 6-2 Open Playback Pop-up Window

2. Select File→Open Playback.
The system automatically begins to read the tape (or the tape in Tape 1 in a twin-tape
system), and the Open Playback pop-up appears, displaying information about the files
recorded to that tape. For a dual tape system, two tab forms will be present in the pop-up -
Tape 1 and Tape 2; only the Tape 1 tab will be present in single tape systems. To produce a
list of all files on the tape, select Catalogue Tape. The location of the file list will be
displayed in the File Information area of the pop-up.

• If an error message appears when the system tries to read the tape (for example, ‘Tape
Not Ready’), click on the Reopen Tape button to make another attempt to read the tape.

•  If the file details indicate that the wrong tape has been inserted, click on the Eject Tape
button, insert another tape, and then click on the Reopen Tape button. 

• If the tape needs rewinding, click on the Rewind Tape button. When the tape has
rewound, click on the Reopen Tape button to allow it to be read.

Note: The tape drive automatically rewinds tapes after recording has stopped and before ejecting
them, so a newly recorded tape inserted into the tape drive will not need rewinding. For some tape
formats (for example, SDEF), however, some of the information needed for playback is found at
the start of each file (recording session) on the tape. Tapes of such formats are rewound automat-
ically to the beginning of the current file to retrieve this information.

3. If the tape that you wish to access is in the lower drive of a twin-tape system, click on the
Tape 2 tab.

4. Locate the file that you want to open.
A file is defined by the beginning and end of a data recording session. The file name and
details appear in the File Information window.

• If you can’t immediately locate a file, you can use the Goto File spin box in the Open
Playback pop-up to search for it. Enter an absolute value either by typing a number in the
text-entry box or by using the up and down arrow buttons. The number of the file relates
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to its place on the tape; for example, type ‘3’ to go to the third file on tape. Alternatively,
enter a relative value in the text-entry box by prefixing a number with ‘-’ or ‘+’; for
example, type ‘+3’ to go forward three files or ‘-3’ to move back three files from the
current position. 

6.2.2 Starting Playback on an Optical Disk System
When this menu item is selected, the system automatically begins to read the selected disk, and
the Open Playback pop-up appears. The pop-ups for the single-drive system and the dual-drive
system are almost identical, with a File Information window, a Files search pattern area and four
action buttons at the bottom of the pop-up; however, the dual-drive system has two tab forms
instead of one (see Figure 6-3, this page).

Figure 6-3 Open Playback Pop-up Window 

1. Insert a disk of previously recorded data into the disk drive.
In a twin-tape system the upper drive is Optical 1; the lower drive is Optical 2.

2. Select File→Open Playback.
The system automatically begins to read the disk (or the last accessed disk in a dual-drive
system), and the Open Playback pop-up appears. It displays information about the files
recorded to that disk.

• If the file details indicate that the wrong disk has been inserted, click on the eject icon for
the drive in the Application Specific Area and insert another disk.

3. If the disk that you wish to access is in the lower drive of a dual-drive system, click on the
Optical 2 tab.

4. Select the file that you want to open by clicking on the name of that file in the Files window.
Use the scroll bars if necessary to move through the list of files until the name of the file that
you want to open is visible.

The name of the selected file appears in the File Name window and details of that file appear
in the Files Information window. Note that files recorded in Coda format have a ‘.cod’
extension, while those recorded in SEG-Y format have a ‘.sgy’ extension.

6.2.3 Starting Playback on a Local Disk
When this menu item is selected, the system automatically begins to read the selected disk, and
the Open Playback pop-up appears. The pop-up for the Local Disks has a File Information
window, and a Files search pattern area and there is a separate tab for each Local Disk that is
mounted. 
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Figure 6-4 Open Playback Pop-up Window

1. Insert a disk of previously recorded data into the disk drive. In a twin-tape system the upper
drive is Optical 1; the lower drive is Optical 2.

2. Select File→Open Playback. The system automatically begins to read the disk (or the last
accessed disk in a dual-drive system), and the Open Playback pop-up appears. It displays
information about the files recorded to that disk. If the file details indicate that the wrong disk
has been inserted, click on the Unmount button, eject the disk and insert another disk.

3. If the disk that you wish to access is in the lower drive of a dual-drive system, click on the
Optical 2 tab.

4. Select the file that you want to open by clicking on the name of that file in the Files window.
Use the scroll bars if necessary to move through the list of files until the name of the file that
you want to open is visible. The name of the selected file appears in the File Name window
and details of that file appear in the Files Information window. Note that files recorded in
Coda format have a ‘.cod’ extension, while those recorded in SEG-Y format have a ‘.sgy’
extension.

6.3 Playing Back Data, Step2: Viewing the Data
This section gives a brief summary of how to get your data scrolling on the screen. For more
complete information, refer to Section 7.

6.3.1 Choosing Which Channels to View
Coda’s acquisition systems can collect up to 8 channels of data and display all of these simulta-
neously (depending on the system specification). Up to two channels which use the same trigger
may be viewed at the same time in the same window.

Figure 6-5 The Application Specific Area of the DA System, showing the Channels Tab

The Channel tab of the Application Specific Area displays the channels available from the media
being played back.
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The default display window is a vertical scrolling dual channel display and the system will pick
the most appropriate channels to play back. In Figure 6-5, this page, the system has picked
Analogue Ch1 and Analogue Ch2 Starboard Sidescan channels. This is indicated by the icon next
to these channels showing a pair of spectacles. Analogue Ch 3 Seismic is not selected; indicated
by its icon showing an open window.

To view more channels in another window, simply click on the non-displayed icon. The system
will open an appropriate window in the display. In the above example, clicking on the Analgue
Ch3 Seismic icon would open a horizontal single channel window.

6.3.2 Setting Offset and Gain
As the system acquires 12-bit data, but must use 8 bits for display, you must select which part of
the data range to see. The system offers a number of mechanisms for doing this (see Section 7),
but at this point, all you need to do is ensure that the data looks correct, without any fine tuning
of the display.

To do this:

1. Press the Play button in the Tape/Disk controls area (this has the same graphic as a Video or
Tape recorder play button).

2. In the window of interest, choose Settings→Scale Display Data. The Scale Display Data
pop-up will appear, it will automatically adjust the offset and gain applied to your data, using
different defaults for sidescan and shallow seismic data. Click on Done in this pop-up to
dismiss it.

3. Now check that your data looks correct; if you need to fine tune the display, refer to Section
7 for detailed instructions.

6.4 Playing Back Data, Step 3: Controlling Playback Speed
From the display window you have open, using the Settings→Playback Speed popup previ-
ously acquired data can be replayed at different speeds, controlling the length of time for which
data remains displayed on screen during scrolling.

Figure 6-6 The Playback Speed Settings Pop-up Window

The Playback Speed Setting has three modes: Real-Time, Fast as Possible, and Fixed Rate
(see Figure 6-6, this page);

• Real-Time playback simulates acquisition speed and replays the data at the rate at which it
was acquired.

• Fast as Possible means the data is replayed as fast as possible. The maximum achievable
ping rate depends on the speed of the optical disk drive used or on the speed of the tape unit
used and the format of the tape.

• Fixed Rate allows you to select the number of pings, the default is 5 pings/sec. This can be
changed by clicking the mouse in the pings/sec text-entry box below the fixed rate option and
entering the ping rate required.

Setting the ping rate above the fastest possible ping rate causes the data to play back at the fastest
possible ping rate.
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For a fixed rate of playback the pings/sec display in the General Information Area shows small
fluctuations about the fixed value.

6.5 Playing Back Data, Step 4: Bottom Tracking
It is vital for any measuring that you carry out on your data, or any interpretation using Coda-PI
or GeoKit, that the position of the seabed is accurately known by the system. This applies equally
to sidescan and shallow seismic data. Bottom tracking settings may have been incorrect during
acquisition, so it is important to check where the bottom tracking line is being drawn - that it
matches the actual seabed position. Use Display→Display Preferences and the Display
Toggles pop-up to turn on display of this line. You must do this with each display window open.
If the position of the line does not match the actual seabed position, then review Section 5.5,
which describes how to set up bottom tracking; this will allow you to ensure that the system
accurately tracks the seabed during data replay.

6.6 Playing Back Data, Step 5: Corrected Navigation

6.6.1 Incorporating Corrected Navigation Data
The DA System acquires ‘raw’ position information from a vessel’s navigation computer;
however, the accuracy of this data varies and a degree of jitter is likely to be present in the
estimated towfish position. To overcome this, the DA System can incorporate processed
(corrected) navigation data (see Appendix C for a definition of the format of this data). When
sonar data is played back, the position information stored on tape or optical disk is modified
using the processed navigation data, so that the positions reported are as accurate as possible.

The positional data stored on tape or optical disk is not modified; therefore, the processed
navigation file must be present and readable by the system, either on floppy or hard disk, if
corrected positions are required.

This option is only available in playback mode. As no corrected navigation data is available
during data acquisition, the item appears greyed out and cannot be selected.

The heading is used to calculate off-track positions, so it is essential that corrected easting,
northing AND heading are included in the corrected navigation file to ensure accurate reporting
of positions off the survey track.

To incorporate corrected navigation data:

1. Select File→Corrected Nav Input.
The Corrected Nav Input pop-up appears, see Figure 6-7, page 89. This pop-up can be
selected from any open window, but cannot be duplicated if already displayed.

Figure 6-7 The Corrected Nav Input Pop-up Window

2. Click on the spectacles icon to show all available files. The Carrected Navigations Contents
pop-up will appear (see 
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Figure 6-8 The Corrected Navigation Contents Pop-up Window

3. Choose one of the following options:

• Click on Floppy in the drop down list. In the text entry box that appears, type a DOS
filename.This file is copied to the system’s hard disk to increase the speed with which the
data file can be read, and is also added to the Corrected Nav Group Files list. A number
of files may be added to this list.

• Click on Hard Disk. In the window that appears, select a file from the directory on the
hard disk to add to the Corrected Nav Group Files list.

Note: Copying data from floppy disk takes much longer if the system is being used for acquisition
or playback. To complete the copying operation as quickly as possible, pause the screen display
while copying data.

4. Save the selection. Click on the Save button. The Save Setup - Corrected Nav Contents
pop-up will appear (see Figure 6-9, page 90). Enter a new name in the Save As data entry
window and click on the OK button.

Figure 6-9 The Save Setup - Corrected Navigation Contents Pop-up Window

5. Dismiss the Corrected Navigation Contents pop-up, select the required Corrected Nav
Group name from the scrolling list option in the Corrected Navigation pop-up and click OK.

Note: The times in the corrected nav file must coincide with the times from the displayed data for nav. correc-
tions to be applied successfully.
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Note: Selecting the corrected nav file will not automatically turn on corrected nav for the data set. This should
be selected from Settings Nav Data Type pop-up (see Section 6.6.2).

6.6.2 Selecting Raw or Corrected Navigation

Figure 6-10 The Nav Data Type Pop-up Window

The Settings→Nav Data Type pop-up is used to choose whether to use Raw or Corrected
navigation information when in playback mode, or when producing a report from a tag database
file. Raw navigation data is the navigation information stored on tape or optical disk, with the
sonar data; corrected navigation data is derived from an ASCII file downloaded onto the DA
System (see Section 5.4). Selecting Corrected navigation data in this pop-up has no effect if the
file selected to correct the data in the Corrected Nav Input window (see Section 5.4) contains
data which is in an incorrect format, or which does not correspond to the data being read from
tape or optical disk. In either of these cases, the raw navigation data continues to be used (and
this fact is displayed in the Survey Data window).

If Corrected Nav Data Type is selected in playback mode the DA System uses corrected
navigation data. This is displayed in, for example, the Survey Data pop-up, and the General
Information Area, in addition to being stored to the tag database. 

To apply the corrected navigation data, select Settings→Nav Data Type, click on the Corrected
one-of selection button and then click on the OK button. The system uses the most recently
selected file of corrected navigation data (either from hard disk or floppy) to correct the
navigation information in the data being read from tape or disk.

• If the corrected navigation file does not correspond to the data on the tape or disk (for
example, if the times do not match), an error message appears stating that no correction of
the navigation data from the tape or disk can be performed.

• To check if correction of the navigation data is being carried out on data from a tape or disk
that is being played, select Display→Survey Data and see if the Nav Data field is set to
Corrected or Raw. It should be set to Corrected when the navigation data is being corrected.

•  If corrected nav is applied to a field this will be indicated in the survey data popup by a letter
‘C’ next to the value.

6.6.3 Choosing UTM or Lat/Long Coordinate Display
The Settings→Nav Type pop-up contains the Display Nav Basis Type selector, which allows
you to display nav data in either UTM or Lat/Long format, irrespective of the original nav format
input at acquisition time.

For data originally input as UTM, the correct UTM zone must also be present to convert the
values to lat/long (see Figure 6-11, this page). Conversion to and from lat/long and UTM
assumes lat/long values use the WGS84 spheroid.
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6.6.4 Other Navigation Parameters

Figure 6-11 The Navigation Parameter Settings Pop-up Window

The Settings→Navigation Parameters pop-up is used to enter a number of parameters which
are normally input automatically via the navigation input string. In general, navigation param-
eters are supplied to the system via a nav input string from the RS-232 port (see Section 5.4.1).
However, if a fixed format navigation string is being used, it may be difficult to obtain some
parameters in this manner. The Navigation Parameter Settings pop-up therefore provides the
means to manually enter values for parameters that may not be provided by onboard navigation
facilities.

In playback mode, parameters entered in this pop-up override the corresponding recorded values.

6.6.4.1 Survey and Line Name
The Settings→Navigation Parameters contains the Survey Name/Description text-entry box
which is used to store text data for one survey with a chosen name or description of up to 48
characters. If no name or description is entered, and no name is available from the RS232 Nav
String the Survey Name in the Survey Data pop-up is shown as ‘Unknown’.

Line Name is used to mark specific parts of a survey with a name of up to 16 characters in length.
This is most useful in acquisition mode to mark on the data which sections were within specific
survey run lines. Usually it is more convenient if this is available as part of an RS232 navigation
string.

6.6.4.2 Setting Towfish Layback and Offset
When Layback and Fish Cross-Track Offset are entered in the text-entry boxes, the DA System
is able to use the ship’s position to estimate the position of the towfish.
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Figure 6-12 Diagram showing Cross-Track Offset and Layback

The Layback value is the along track distance in metres from the ship position to the fish
position, and the Fish Cross-Track Offset is the distance (also in metres) cross-track, from the
ship position to the fish position (see Figure 6-12, this page). A positive offset indicates an offset
to the right (starboard), and a negative offset indicates the offset is to the left (port).

6.6.4.3 Setting the UTM Zone
The Settings→Navigation Parameters→UTM Zone selector can be used to enter the UTM zone
number for converting positions from Eastings and Northings to lat/long co-ordinates. The value
can either be taken from the nav string by clicking on the Input via nav string item or it can be
entered manually by clicking on the User Input and typing the zone number in the text-entry box.

Note:  Fix Number is not currently affected by corrected nav files.

6.7 The Tape/Disk Controls in Playback Mode
The Tape/Disk control buttons are analogous to those of a video tape or audio recorder, though
their functions change according to the mode being used, acquisition mode or playback mode.

6.7.1 Playing the Tape or Disk
During playback this button controls the reading of data from tape or optical disk and its
display on screen.

6.7.2 Stopping the Tape or Disk
During playback this button stops the screen display scrolling, and stops data being read
from tape or disk into the display buffer; it also stops Fast Forward/Cue and Rewind/

Review operations.

6.7.3 Pausing Replay
 key shortcut: <Spacebar>

During playback this button stops the display from scrolling, allowing other operations
– zooming, tagging or making on-screen measurements – to be carried out more easily;

it does not stop data being read from the tape or disk into the display buffer. Clicking on the
Pause button again also starts the data scrolling. Alternatively, if the pointer is in the Data
Display Area, the space bar can be used to pause and release the data.

6.7.4 Goto
Clicking on this button brings up the following window:

Cross-track

Offset

Ship H
eading

Ship Position X

Towfish Position

Layb
ack
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Figure 6-13 The Goto Menu (tape version)

This menu allows you to move to a specific point in the data, using one of the options explained
below.

6.7.4.1 Goto to a Position on a File or Tape
A file is defined by the beginning and end of data recording sessions. If you are using the optical
disk system, only the first two options are available; the other four options are greyed out.

• Beginning of File moves the tape or disk to the start of the current recording session.

• End of File moves the tape or disk to the end of the current recording session.

• Next File moves the tape to the start of the next recording session.

• Previous File moves the tape to the start of the previous recording session.

• Beginning of Tape rewinds the tape to the beginning.

• Start of Blank Tape moves the tape to the end of the last recorded data block. Data can then
be written to a blank section of tape – assuming the tape is not write-protected – during the
next recording session.

6.7.4.2 Goto to a Specific Tag
• Next Tag finds the next tag in the recording session. The tape or disk moves to a point about

4 seconds before the time the next tag will appear at the top of the screen. This is to ensure
that the tag is visible in the first full screen of data after the goto command. If the tag is within
4 seconds of being displayed when the command is used, or if the tag is already visible on
screen, the message ‘Next tag is just off screen’ appears, and no goto is performed.

• Next Tag Node moves the tape or disk to the next tag node in the recording session. The tape
or disk moves to a point about 4 seconds before the time the next tag will appear at the top of
the screen. This is to ensure that the tag is visible in the first full screen of data after the goto
command.

• Previous Tag moves the tape or disk to the previous tag in the current recording session. To
ensure that the tag is clearly visible in the first full screen of data after the goto command, the
goto moves to a point about 4 seconds before the time the tag event occurred.

• Previous Tag Node moves the tape or disk to the previous tag node in the current recording
session. To ensure that the tag is clearly visible in the first full screen of data after the goto
command, the goto moves to a point about 4 seconds before the time the tag event occurred.

• Attributes (see Figure 6-13, page 94).

• Tag ID moves the tape or disk forwards or backwards to a specific tag and type the
tag’s ID number in the text-entry box. Only the digits of the code – no letters or
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punctuation – should be entered. The tag ID is printed when a report is generated. Cut
and paste the tag’s ID number using the Reporting menu. Select Reporting→Report
Generation→Text Window→Generate Report. In the Tag Report File window,
scroll to the Tag ID column and double-click on the tag’s number to copy it. In the
Goto menu, place the pointer over the Tag ID box and click the MIDDLE mouse button
to paste the tag’s number. The tape or disk moves forwards or backwards to a point
about 4 seconds before the tag will appear on screen, so that the tag is visible in the
first full screen of data after the goto command.

• Anomaly ID can be used as an alternative to Tag Node ID, but moves the tape or disk
forwards or b ackwards to a specific anomaly.

6.7.4.3 Goto a Specific Time
Sometimes, particular points of interest in the data may not have a tag associated with them; in
me. Enter an absolute time (as a 24-hour clock value) by typing six digits without punctuation in
the box; for example, type 053400 to search for the time of 05:34:00. This command is restricted
to times in the same day as the current time on the data being replayed. For example, at 23:35:57
you cannot goto 01:13:00 on the following day; the system would search for 01:13:00 on the
same day, probably resulting in a failure of the goto command. Enter a relative time by prefixing
the time with ‘+’ or ‘-’ without punctuation; for example, type ‘+031712’ to move 3 hours 17
minutes and 12 seconds ahead in the data. This command allows you to move from one day to
another. If the system is unable to goto the time requested, it goes to the nearest time it can find
on the file. If that point is more than 5 seconds from the time specified, a warning pop-up appears.

6.7.4.4 Goto a Specific KP/Chainage
Click on Attribute and select Raw Kp (kilometre post) in the scrolling option list and in the text-
entry box enter the Kp value that you want to find. The Kp value is obtained from the navigation
stored with each ping – as the basis for the search. Specify either an absolute or a relative Kp
value. Enter an absolute Kp value by typing the number including punctuation in the box; for
example, type 345.12 to go to Kp345.12. The system searches forwards or backwards to find the
Kp requested. Enter a relative Kp value by prefixing the Kp value with ‘+’ or ‘-’. To use this
command, you must keep track of whether the Kp are increasing or decreasing as the data is
played. The system searches forwards or backwards to find the Kp requested. If the system is
unable to find the Kp requested, it goes to the nearest point it can find on the data. If that point
is more than 25 metres from the position requested, a warning pop-up window appears.

Note: Note: The Kp values used for goto commands are taken from the raw navigation data stored with each
ping.

6.7.4.5 Goto a Specific Fix Number
Click on Attribute and select Fix Number in the scrolling option list and in the text-entry box
enter the fix number that you want to find. This command uses the fix number from the tag
database entry. Again, specify either an absolute or a relative value. Enter an absolute fix number
by typing the number in the box. The system searches forwards or backwards to get to the fix
number requested. Enter a relative value by prefixing the fix number with ‘+’ or ‘-’ without
punctuation. The system searches forwards or backwards to find the specified number.

6.7.4.6 Goto a Specific Ping Number
Click on Attribute and select Ping number in the scrolling option list and in the text-entry box
enter the ping number that you want to find. Again, specify either an absolute or a relative value.
Enter an absolute fix number by typing the number in the box. The system searches forwards or
backwards to get to the fix number requested. Enter a relative value by prefixing the fix number
with ‘+’ or ‘-’ without punctuation. The system searches forwards or backwards to find the
specified number.
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6.7.5 Fast Forward/Cue
This button has two modes of operation during playback; they determine the speed of
movement through the data on tape or disk. If the Play button is depressed when this

button is pressed, cue mode is selected; a tape system will display every third line of incoming
data from a tape and an optical disk system will display every fifth line of incoming data from
disk, allowing fast searches through the data. If the Play button is not depressed when this button
is pressed, fast forward mode is selected; both a tape drive and an optical disk drive will move
the media forward repeatedly by 10 000 lines of data. Each mode of operation continues until the
Stop button is pressed. 

6.7.6 Rewind/Review
This button has two modes of operation during playback; they determine the speed of
rewind. If the Play button is depressed when this button is pressed, review mode is

selected; a tape drive will rewind a tape 250 lines at a time and an optical disk drive will rewind
a disk 7 lines at a time, stepping back through the data and displaying it on screen. If the Play
button is not depressed (in other words, data is not being played) when this button is pressed,
rewind mode is selected; both a tape drive and an optical disk drive will rewind the media 10 000
lines of data at a time. The data lines are not displayed on screen in this mode. Each mode of
operation continues until the Stop button is pressed.

6.8 Ejecting Tapes and Disks
1. Click on the Stop button in the Data Control Area.

2. Do one of the following:

• If you are using a tape system, press the Eject button on the front of the tape drive.

• If you are using an optical disk system, select File→Open Playback, click on the
Unmount button in the Open Playback pop-up, click on the OK button, and then press
the Eject button on the front of the disk drive.

6.9 Deleting Files from an Optical Disk
A file can be deleted by selecting it and clicking on the Delete button. This option is password
protected and you will be prompted for the correct installation password before the file can be
deleted. If an optical disk is read-only, the delete button will be greyed out.

It is not possible to delete single files from a tape; however, a tape or disk’s entire contents can
be erased (see Appendix H and Appendix I).

6.10 The General Information Area in Playback Mode
The General Information Area, which lies near the bottom left of the display screen, is shown
in Figure 6-14, page 96 and Figure 6-15, page 97 There are two modes, selected by the button in
the bottom right hand corner of the area, and they provides the information listed below for
which ever window is selected on the tab bar. See also Section 5.2.

6.10.1 The General Information in Playback Mode 1

Figure 6-14 The General Information Area in Playback Mode 1

• Position: The position of either the fish or the vessel in either Lat/Long or UTM appears at
the top of the display and shows the position of the newest ping in the window (see Section
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6.6.3).  A symbol of a fish or a vessel appear in the middle of the position to indicate the
position reference point.

• date/time: the date and time at which the data was recorded. (The date is displayed as dd-
mm-yy.)

• Nav Sync.:  A clock face displayed between date and time shows green when the navigation
date is in sync and red when it is not.

• fish alt: shows the distance of the towfish above the seabed when the data was acquired.

• heading: shows the direction in which the vessel or towfish was heading when the data was
acquired 

• line: the line name which is either taken from the Nav String or entered by the user (see
Section 6.6.4)

• range: displays either the true range in meters for a side scan window or sweep time in msecs
for a seismic window.

• cursor (pointer): the position directly under the cursor on the screen; namely, Eastings,
Northings and Kp. The information is colour coded to indicate the channel over which the
cursor is positioned, channel colour is indicated in the top right of the display window.  The
position is fully geo-corrected and is calculated using the navigation data stored with each
ping. If the fish height is known, the position is automatically slant-range corrected.
Similarly, if corrected navigation data mode is available, this can also be used to provide a
further stage of correction.

Positions that are off-track are calculated using the geographical ping position, heading and
across-track distance from the position, as shown in Figure 6-9, page 83. For accurate off-
track positions it is essential that the heading is correct.

Note: To calculate an off-track position lat/long is converted to UTM, the position is calculated and then
this position is converted back from UTM to lat/long.

The format in which the cursor information is displayed can be changed from eastings and
northings to lat/long – and vice versa – by clicking on the appropriate one-of selection button
in the Display Nav Basis Type frame of the Nav Data Settings pop-up.

6.10.2 The General Information Area in Playback Mode 2

Figure 6-15 The General Information Area in Playback Mode 2

• Position: The position of either the fish or the vessel in either Lat/Long or UTM appears at
the top of the display and shows the position of the newest ping in the window (see Section
6.6.3).  A symbol of a fish or a vessel appear in the middle of the position to indicate the
position reference point.

• date/time: the date and time at which the data was recorded. (The date is displayed as dd-
mm-yy.)

• Nav Sync.:  A clock face displayed between date and time shows green when the navigation
date is in sync and red when it is not.

• pings/s: the rate (pings per second) at which the display lines scroll down the screen. In
playback mode the rate can be changed using the Settings→Playback Speed pop-up.

• ping no.: the number of the ping being displayed in the top line of the Data Display Window.
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It is continuously updated while data is scrolling.

• survey: displays the survey description as entered in the Nav Parameters pop-up (see Section
6.6.4).

• Kp:  the kilometre post number of the newest ping in the display window.

• cursor (pointer): the position directly under the cursor on the screen; namely, Eastings,
Northings and Kp. The information is colour coded to indicate the channel over which the
cursor is positioned, channel colour is indicated in the top right of the display window.  The
position is fully geo-corrected and is calculated using the navigation data stored with each
ping. If the fish height is known, the position is automatically slant-range corrected.
Similarly, if corrected navigation data mode is available, this can also be used to provide a
further stage of correction. 

Positions that are off-track are calculated using the geographical ping position, heading and
across-track distance from the position, as shown in Figure 6-9, page 83. For accurate off-
track positions it is essential that the heading is correct.

Note: To calculate an off-track position lat/long is converted to UTM, the position is calculated and
then this position is converted back from UTM to lat/long.

The format in which the cursor information is displayed can be changed from eastings and
northings to lat/long – and vice versa – by clicking on the appropriate one-of selection button
in the Display Nav Basis Type frame of the Nav Data Settings pop-up.

6.11 The Application Specific Area - Devices in Playback Mode

Figure 6-16 The Application Specific Area - Channels Tab in Playback Mode (tape version)

Figure 6-17 The Application Specific Area - Device Tab in Playback Mode (optical disk version)

When the DA System is in playback mode, the Devices tab in the Application Specific Area,
shows information on the tape devices or disk devices, present on the system (see Figure 6-16,
page 98 and Figure 6-17, page 98).

If optical drives are fitted, this display indicates what file, if any, has been selected (see 6.2.2) by
displaying it along side the relevant device icon.

The icon acts as a media eject button by clicking on the relevant device icon.
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6.12 Using Other Coda Software Modules

Figure 6-18 The Applications Menu

The Applications menu allows you to select which Coda application you wish to run. The Appli-
cation Specific Area of the main display will change according to the application being used.

The only option available on the standard DA System system is Data Acquisition. For infor-
mation about the other software modules, contact Coda Technologies directly, or consult the
appropriate software module manual.

When an automated interpretation application is running (for example, automated pipeline
inspection), the letter ‘R’ is appended to the application menu item. This lets you switch between
application modules while remaining aware of which application is currently running.

GeoKit: The Geophysicist On-line Interpretation Toolkit provides a suite of on-screen and on-
line interpretation tools for site survey, route survey, search and recovery, and target detection.
The user configurable on-line event-marking tools are enhanced to allow interactive marking of
target objects, seabed features and sediment types in real time. The database facilities allow
flexible, comprehensive reports detailing locations, dimensions, seabed and target type,
surveyor’s comments and automatic calculations to be printed on screen, via a printer, or output
to a DOS format floppy disk for integration into a windows based charting package, GIS,
database, spreadsheet or word processor.

Pipeline Inspection: The PI100 Pipeline Inspection module is designed as a tool for surveying
sub-sea pipelines. It carries out automated pipeline tracking and span and burial detection, as
well as offering a comprehensive set of database annotation tools. This allows pipeline surveys
to be conducted without using thermal paper printouts of the survey.

TrackPlot: This module provides route planning and coverage information of the vessel and
towfish positions during hydrographic survey, displayed in real-time.

Mosaic: This module produces real time mosaicing of the seabed from sidescan sonar image
data. Mosaic includes annotation and manipulation tools and can be used to any scale and include
a built in tracking system.
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7 Processing Sonar Data for Display

The Processing functions are applied in the order they are turned on by the user with the
following exceptions: TVG is always applied last; Fish height/bottom tracking is always applied
to raw data, for example, it is first applied to a copy of the raw data; the swell value calculation
is always applied to raw data.

Note: Changes made in the Processing menu in playback mode affect only the data being displayed to the
screen; the data on the tape or optical disk is not affected in any way. Similarly in acquisition mode, processing
has no effect on data being recorded to tape or optical disk. Fish height and swell values, however, are
recorded alongside ping data and can be referenced in playback mode.

7.1 Choosing Which Data To View
The number of channels displayed can be changed from two channels (dual channel mode) to
one channel (single channel mode), using the Display menu. Selecting Left Data Channel or
Right Data Channel from this menu causes the display to show either the left or right display
channel respectively. To revert to dual channel mode, select Both Data Channels. Note,
however, that two separate channels can only be displayed in dual channel mode if they were
recorded on the same trigger.

7.2 Adjusting the Offset and Gain Applied to the Data
The Processing→Scale Display Data pop-up is used to select the portion of the input signal
range to be displayed to the screen. The input signal is digitised at a resolution of 12 bits (4096
discrete levels), whereas the display resolution is limited to 8 bits (256 colours or grey levels);
therefore, the 12-bit input data must be converted to 8 bits for display. Note that this conversion
applies only to displayed data; all data is recorded and all analysis and processing is performed
at the full input data resolution.

The Settings→Scale Display Data pop-up appears automatically across the screen when you
start acquiring data or when you start playing back data. It can, however, can be accessed through
the Settings menu whenever the data needs to be rescaled; for example, when a significant
change occurs in the voltage levels of the signal.

When Scale Data Display is selected, a window appears across the Data Display Area, showing
an oscilloscope trace and a number of controls (see Figure 7-1, page 101). 

7.2.1 Automated Scale and Offset Adjustment
The trace is displayed differently depending on which of the two Viewing Ranges is selected.
The default setting is Viewing Range to Input (as indicated by the green one-of selection button).

Figure 7-1 The Scale Display Data Pop-up Window showing the Screen Range 

When the Viewing Range is set to Input, the green oscilloscope trace shows the full resolution
of the signals after any processing. To view the raw input signal, select the Raw A-Scan pop-up
(see Section 8.7). The range of the window is set to the full input voltage range, as selected in
the acquisition parameters when in acquisition mode, or to the range over which the signal was
originally recorded when redisplayed in playback mode. 
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Figure 7-2 The Scale Display Data Pop-up Window showing the Input Range

Setting the Viewing Range to Input causes a blue rectangle to be displayed in the Scale Display
Data window (see Figure 7-2, this page). This rectangle shows the current range of the DA
System display. Without automatic scaling, the rectangle is typically at the bottom of the range,
is very narrow, and does not cover any of the input signal. In this instance, the data displayed to
the screen is almost white. To alter the effective range of the input data displayed to the screen,
use the Shift arrow keys on the screen to move the blue rectangle over to the bottom of the green
oscilloscope trace. Alternatively, click on Auto and the rectangle shifts to cover the input signal.

When the DA System is started in either acquisition or playback modes, the display data is scaled
automatically as the data begins to scroll. Auto scaling uses a statistical analysis of the energy of
the signal to ensure that the display range coincides with the range of the important information
in the input signal, thereby optimising the display. If the energy content of the signal changes
significantly in either acquisition or playback modes, the quality of the display deteriorates
because the display range does not coincide with the range which covers the important infor-
mation in the input signal. The data should be rescaled by clicking on the Auto button in the pop-
up.

The Reset button resets the display data parameters back to those at system initialisation.

The Shift, Scale, Auto and Reset conversion settings can be made to both display channels
simultaneously (the initial default), or to either channel individually. This is controlled by the
Apply To toggle. Setting the toggle to Both causes both display channels to be altered. Setting
to either Left or Right applies the conversion changes to the respective single data channel only.
This allows the two channels to display different portions of their respective input signals,
thereby allowing individual channel displays to be optimised. 

When suitable conversion parameters have been selected, the Scale Display Data window may
be dismissed by clicking on the Done button. The parameters may be altered at any time by re-
selecting the Scale Display Data menu item and re-scaling the data either automatically or
manually.

7.2.2 Manual Scale and Offset Adjustment
The pop-up shows an oscilloscope trace and a number of controls. It has two viewing ranges. The
default setting for Viewing Range is Input. It shows a green trace, which corresponds to the input
signal (acquisition) or the signal being read from the disk or tape (playback), and a blue
rectangle, which indicates the portion of the input signal that is on display in the Data Display
Area. 

To scale the display data manually, the Scale and Shift arrows should be used to move the input
signal until it coincides with the display range. This is represented in the Scale Display Data
pop-up by a solid blue rectangle (illustrating the display range) covering the desired range of the
incoming signal.

In addition to appearing when selected from the Settings menu, the Scale Display Data pop-up
appears when the Play button in the Data Control Area is pressed after changes have been made
to the acquisition setup or Open Playback has been selected from the File menu.

Setting the Viewing Range to Screen causes the oscilloscope trace to show the blue display data
range (that is, what is actually visible on the screen) rather than the input data range. The arrow
keys can, again, be used to alter the range being displayed. However, on this viewing range,
selecting the up and down Shift arrows on the screen causes the trace itself to be moved up or
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down respectively. The Scale arrow keys cause the trace to be scaled in size; the up Scale arrow
increasing the size, the down arrow reducing it. This viewing mode allows fine tuning for the
settings of input data to display data conversion.

Scale and Shift adjustments can be made for Both channels, or Left and Right independently,
as for Auto scaling. The Reset button resets the display data parameters back to those at system
initialisation.

When you have finished making your adjustments to the Scale and Shift values, dismiss the pop-
up by pressing the Done button.

7.3 Setting Time Varying Gain

Figure 7-3  The Time Varying GainToolkit Pop-up Window

The Processing→Time-Varying Gain (TVG) pop-up (Figure 7-3, this page) shows an inter-
active graph which allows the gain applied across the range of the displayed data to be altered.
The icons are used to: toggle between round or straight line curves in the graph; enter a gamma
value for the gain applied across the ping return; remove grips points from the graph; add grip
points; reset the gain back to 1; invert the TVG function; and apply the gain from the seabed,
rather than the start of ping.

The best TVG Enhancement curve is one which gives a consistent maximum data value across-
track. This is done by either reducing or increasing the gain for some parts of the scan. You can
see the effect of manipulating the TVG function by using the Scale Display Data pop-up.

The time-varying gain function can be used to alter the gain across the data trace and as a result
improve image quality across the data display. Selecting TVG Enhancement or the Setup TVG
Functionality icon pops up the Time Varying Gain (TVG) toolkit (see Figure 7-3, this page).

The TVG graph, however, is a graph of the gain applied across the range of the displayed data.
The function can be specified by moving the points on the TVG function curve to the required
shape. The steps are the same as the Image Enhancement toolkit.

The TVG toolkit contains eight smart icons, six of which look identical to those in the Image
Enhancement toolkit. They are used to:

• toggle between round or straight line curves in the graph

• enter an exponential function value (gamma) for the gain to be applied across the ping return

• remove grip points from the graph

• add grip points to the graph

• reset the gain back to one

• invert the TVG function

• apply TVG from start of ping or seabed (dependent on correct fish height tracking)

• apply an automatic gain profile to the signal.
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The Auto TVG function attempts to generate a TVG curve that yields a consistent signal in the
across-track direction. It does this by:

• Calculating a mean ping over the first ten pings since the Auto TVG button was pressed.

• Dividing this mean ping into a series of bins, starting from the current bottom position to the
end of the trace.

• Calculating the mean signal level for each bin.

• Calculating a gain factor for each bin so that when this gain factor is applied to the binned
data, the mean signal level in the bin is equal to the mean signal level calculated previously.

• Adjusting the minimum and maximum gain values so that the curve is scaled appropriately
on the graph.

• Interpolating, using a spline fit, between bin positions to produce a smooth curve.

To get good results from Auto TVG, the following points are important:

• There should be a reliable fish height position available to the system.

• Data should be scrolling.

• The Apply TVG from Drop Down option should be set to Minimum displayed value, to avoid
taking any dc offset into account.

After an Auto TVG function has been applied, it may be advisable to rescale the data using the
Scale Display Data pop-up to yield the best possible image (Figure 7-1, page 101).

In addition to these icons, the vertical scale gain can be varied to a maximum of 100dB by using
the Gain spin boxes; the entry in one box will be mirrored in the other.

Apply TVG from Drop Down will set the point from which TVG is applied to either Zero Volts
or Minimum display value. With Zero Volts, selected amplification will be applied to any dc
offset to the signal as well as the signal itself, whereas the Minimum display value will apply
the gain to the signal only. Distortion may occur if the Shift buttons on the Scale Display Data
pop-up (see Figure 7-1, page 101) are altered after setting the TVG.

The toolkit is similar to that of Image Enhancement (see Section 7.5); both contain an inter-
active graph and several smart icons.

Any processing applies to the incoming data at the top of the screen only, rather than the whole
Data Display Area. To apply TVG changes to the whole image, select Display→Refresh
Display. The Scale Display Data pop-up can also be used to see the effect TVG Enhancement
has on your data on a per ping basis (see Section 8.8).

Note: This processing is only applied to the displayed data. The data being recorded or stored on tape or
optical disk is not affected by any processing.

As with the Image Enhancement pop-up, changes to the graph are applied immediately to the
display data, although the graph settings are initially stored on a temporary basis. To cancel the
changes and dismiss the pop-up, click on the Cancel button. To save the changes, click on Apply
or OK. OK will dismiss the pop-up as well as saving the changes.
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7.4 Choosing Which Part of the Trace To View

Figure 7-4  The Left Display Channel Pop-up Window

The attributes of the Left Display Channel or Right Display Channel can be changed by
selecting this menu item (Settings→Left Display Channel). The pop-up is divided into Single
Channel Display settings, which apply when only one channel is displayed in the Data Display
Area, and the Dual Channel Display settings which are used when both data channels are
displayed.

The Offset is the number of samples from the start of the raw ping at which the screen display
begins: for example, if the raw ping is 2560 samples long, an offset of 400 will shift the line 400
samples to the right (for example, in order to ‘remove’ the water column). Negative offset values
are therefore invalid – the system will not accept them and will display an error message and ask
for the offset value to be changed. The visible effect of changing the offset value is to move the
data across the screen.

Figure 7-5 Offset and Sub-sampling of Incoming Data

Offset = 5

Line Start Line End

Sub-sampled Line

Full Resolution Line

Sub-sample = 3

White Sample
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The sub-sample rate determines how much of the full resolution line appears in the display by
ignoring a proportion of the samples and displaying the remainder. Data is usually recorded with
more samples per ping than can be displayed in the Data Display Area. The number of samples
displayed across the width of the screen is limited to a total of 1024 – usually 512 samples per
display channel; however, the number of raw data samples is typically much larger than 512 per
data channel – usually 2560 samples or more. 

By default, automatic sub-sampling is carried out to allow the whole of the incoming line of
data to be displayed, by using only one sample to represent the rest of its neighbours. If you’ve
entered an Offset value, the automatic sub-sample rate will be recalculated so that the whole of
the remainder of the line is displayed. 

Manual sub-sampling to change the default settings, can be selected by editing the text-entry
boxes. To display only every second sample the text-entry boxes should read ‘1 in 2’ samples,
for every sixth sample they should read ‘1 in 6’ samples and so on. Manual sub-sampling can be
used to view the data in more detail.

To view the data at full resolution, set manual sub-sampling to 1 in 1 samples. However, at levels
of detail higher than the automatic value, the full width of the data cannot be shown on the screen.
In this case, the offset parameter should be used to select the appropriate section of the data line
to be displayed.

Note: It is likely that different settings will be required for single and dual display modes.

Note: Zoom mode can also be used to display a section of data at full resolution (see Section 8.5).

Remember that the right and left data channels of sidescan data are displayed in from the centre
of the screen, so data in the right channel appears to shift in the opposite direction to data in the
left channel.

The DA System default settings are to display two channels of data simultaneously and to sub-
sample the full swathe of the incoming data to fit into the width of the Data Display Area. You
may, however, want to view only one channel or to view a specific section of a channel in more
detail. This is done by changing the settings in the Display and Settings menus.

The Display settings control the viewing mode: single channel mode displays either the left or
the right channel; dual channel mode displays both left and right channels. The Settings→Left
Display Channel and Setting→Right Display Channel pop-ups both contain two options –
offset and sub-sampling – which control the position and the resolution of the display data.

It is worth experimenting with these settings; if, for example, you wish to view only the pipeline
within a sidescan sonar swathe, you can centre the display channel on this region, allowing the
display of the pipeline to use the full digitised resolution.

7.5 Enhancing the Image
The DA System’s default waterfall display is monochrome and the shades of grey are directly
proportional to the data values. This may not, however, be the most useful way to display your
data. If your data has very low or high contrast, you can improve the contrast or change the
colour to reveal more details, using the Processing→ Image Enhancement toolkit. You can
also invert the image for printing, using the toolkit. Remember that changes to image
enhancement will not affect the data being recorded - just how the data appears on the screen.



DRAFT
May 2001 for version 2.1         107

U
sing the D

A
 

S
ystem

Figure 7-6 The Image Enhancement Pop-up Window

Enhancement is applied to the whole screen area for the channel selected, not just for incoming
data.

Image enhancements can be made to the Left, Right, or Both Channels of data. Each display
channel keeps its own interactive graph. If Both is selected Left and Right channels are assigned
the same graph. You can save your favourite settings using the Load and Save options.

To cancel any enhancements and restore the Data Display Area to its previous state, click on the
Cancel button. Enhancements can be applied with or without dismissing the toolkit window by
clicking on the OK or Apply button respectively.

Note that the Image Enhancement pop-up behaves differently to most other pop-ups in that it
allows the displayed data to be modified without the need to click on the Apply or OK buttons.
This allows you to experiment with changes to the settings, without losing your original settings. 

7.5.1 Contrast Adjustment by Gamma Correction
This smart icon pops up a text-entry box to input gamma enhancement values. A
gamma function is an exponential function; that is, its values increase in a non-linear
fashion. Its effect is similar to a television’s ‘contrast’ control. To decrease the contrast

(making the Data Display Area brighter) requires values greater than one, whereas to increase
contrast (making the display area generally darker) requires a value of less than one. Typing
<enter> in the text box, or clicking on OK causes the curve in the graph area of the toolkit
window to be redrawn according to the input value. Gamma values are a quick way of config-
uring the graph without having to move grip points.

In normal use, the best display quality is often obtained by using the Gamma Correction smart
icon to set a gamma value (contrast value) for the data, rather than by moving the grip points on
the graph. If the display is too dark, a gamma value of greater than 1 should be used (normally
between 1.3 and 2.0). A higher gamma value tends to make the display brighter, though it
decreases contrast. If the screen is too light, a gamma value of less than 1 should be used
(normally in the range of 0.5 to 0.9).

7.5.2 Colourmap Selection
Clicking on the Colourmap drop down gives a choice of 16 different colourmap options. These
can be used to map the incoming data values to different shades of colour.
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7.5.3 Inverting the Colourmap
To invert the data displayed to its ‘negative’ – that is, black becomes white and vice
versa – simply click on this smart icon. This tool is useful for switching to and from a
‘paper trace’ style display. 

7.5.4 Manipulating the Image Enhancement Graph
The Image Enhancement toolkit contains an interactive graph, six smart icons, left and right
output displays and five one-of selection switches. The graph plots the raw input data signal
(labelled Input) against the brightness of the display pixels (labelled Output). The icons are used
to: toggle between round or straight line curves in the graph; enter a gamma value for the
brightness of the data displayed; remove grips points from the graph; add grip points; reset the
graph; invert the displayed data to its ‘negative’; and change the colour mapping of the display.

7.5.4.1 Changing the Image Enhancement Graph
The Image Enhancement graph consists of lines joined by small square boxes, known as grip
points.There are four on the default version of the graph, one at either end and two in the central
portion. The grip points can be positioned by pressing and dragging on them to alter the shape
of the graph.

7.5.4.2 Choosing a Straight Line or Spline Fit
This icon is used to either apply a smoothing function (called a spline) between grip
points on the graph, or to apply no smoothing, resulting in straight lines between the
grip points. This determines how smoothly the grey levels change in the display. A
smooth curve gives a smooth transition between greyscales while a graph composed

of line segments can cause more abrupt changes in greyscale. Straight line functions are more
suited to thresholding or rectifying data to aid interpretation. Clicking on the spline icon toggles
the smoothing on and off.

7.5.4.3 Adding a Grip Point
This smart icon is used to add grip points to the graph. To add a grip point, click on the
icon. The pointer changes to an arrow with the extra grip point. Click the cursor at the
location on the graph where the grip point is to be added. The head of the arrow corre-

sponds to the location of the new grip point

7.5.4.4 Deleting a Grip Point
This smart icon is used to remove grip points from the graph. To remove a grip point,
click on the icon. The cursor changes to a pair of scissors. Click the cursor on the grip
point to be removed. The graph is redrawn without this grip point.

Note: The two end grip points cannot be deleted.

7.5.4.5 Resetting the Graph
This smart icon is used to reset the graph to a straight line with four grip points,
restoring the Data Display Area to its original state.
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7.5.4.6 A Practical Example: Rectifying the Data

Figure 7-7 Example of Seismic Return before Rectification

Figure 7-8 Example of Same Seismic Return with Full Wave Rectification

Full wave rectification can be simulated by applying the transfer characteristics in the Image
Enhancement graph shown in Figure 7-8, this page
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7.5.4.7 A Practical Example: Setting a Black Level

Figure 7-9 Example of Seismic Return before setting Black Level

Figure 7-10 Example of Same Seismic Return with Black Level Set

Setting the black level can be simulated by applying the transfer characteristics in the Image
Enhancement graph shown in Figure 7-10, this page. This also simulates half wave rectification.
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7.6 Refreshing the Display
When changes are made to items in the Settings or Display menus, their effect is seen from the
newest line of data being processed onwards. Selecting Refresh Display displays the effect of
such changes for the whole screen. The effect of any changes – for example, filtering – without
the data having to be replayed. Depending on the amount of processing being asked of the
system, the DA System may take up to 5 seconds to redraw the screen.

Note: There may be a few seconds’ delay between selecting this item and the screen being redrawn,
depending on the amount of processing being used by the system at the time.

7.7 Processing Sidescan Data

7.7.1 Removing Noise
‘Noise’ from natural sources (such as currents or marine life) or from man-made sources (such
as ships) may affect the quality of the raw data. It can obscure or degrade features of interest and
should therefore be minimised, if not eradicated.

7.7.1.1 Cross-Track Smoothing
The Processing→Cross-track Smoothing option removes unwanted spikes of ‘noise’ within a
ping in sidescan sonar data. It does this by locally averaging the data in each ping. You can
control the extent of smoothing, and therefore the extent of noise reduction, by selecting the size
of smoothing filter – small, medium or large, see Figure 7-11, this page.

Figure 7-11  The Cross-Track Smoothing Pop-up Window 

The size of the filter determines the extent to which the data is smoothed. The Small filter
reduces the magnitude of noise spikes to a lesser degree, but ensures that the image remains
sharp. By contrast, the Large filter reduces the noise spikes to the greatest extent, but renders the
image more blurred.

Note: None of the cross-track smoothing options performs any along-track smoothing.

Cross-track smoothing is more suitable for sidescan data than shallow seismic data. For
removing noise from shallow seismic data, use a combination of time-varying frequency
filtering, trace mixing and swell filtering.

Cross-track smoothing can be applied to the Left Channel, Right Channel, or Both Channels
together. At any time, the display can be restored to its previous state by clicking on the Cancel
button. The desired smoothing filter can be applied with or without dismissing the pop-up
window by clicking on the OK or Apply button, respectively. This processing is only applied to
the displayed data; the data being recorded or replayed is not affected by any processing.
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7.7.2 Eliminating Sonar Distortions
Geometric factors can distort the sonar image; for example, in sidescan sonar the height of the
sensor/towfish from the seabed gives a slanted view of the seabed; in seismic sonar the effect of
swell on the sensor produces swell on the image. There are two tools for eliminating these distor-
tions: slant-range correction for sidescan sonar and swell filtering for seismic sonar.

Before applying these options, make sure that the system has a valid bottom position; otherwise,
you will introduce further distortions. You can display the bottom position line either by clicking
on Bottom Position Line in the Display menu or by clicking on the Display Bottom Position
button in the Fish Height Settings pop-up (see Section 5.5). The bottom position line can be
displayed in either channel or both channels. The settings can be stored by clicking on the Store
button or reset to the factory defaults using on the Factory button.

7.7.2.1 Slant-Range Correction
Slant-range correction maps the incoming data samples to their actual across-track range from
the sonar transducer, rather than their slant range. It assumes that the seabed is flat, and performs
a geometric correction of the position of each incoming data sample, placing it at the correct
across-track range from the transducer. This has the effect of ‘stretching’ the samples nearest the
transducer (as there are fewer samples per unit distance across-track in this region), and
‘compressing’ the samples furthest from the transducer (as there are more samples per unit
distance across-track in this region). This also has the effect of shifting the data samples to
remove the water column.

For sidescan data, slant-range correction can be used to get a true range visualisation of the
seafloor. It removes the water column from the image. This can be particularly useful for
mosaicing sidescan imagery.

Processing→Slant Range Correction can be turned on or off by clicking on this menu item.
The on/off toggle beside the option changes to green indicating that the processing has been
switched on. Slant-range correction is only effective if a valid fish height is available. Fish height
can be recorded with the data or can be recalculated during playback (see Section 5.5).

Note: The use of slant range correction cannot add information about the scene being surveyed, but modifies
the data being displayed. The use of slant range correction is largely superseded by the provision in the DA
System of measurement tools which give true across- and along-track dimensions. Slant range is usually
turned on only in those situations where the DA System output is to be used by other devices which need slant
range corrected imagery; for example, hardcopy output devices.

7.8 Processing Shallow Seismic Data

7.8.1 Frequency Filtering
Frequency filtering can be used to remove or preserve certain frequencies from within a specified
range in a ping. Frequency filtering is primarily intended for the processing of sub-bottom
(seismic) data, though it may be used for sidescan sonar data.

The Time Varying Filtering pop-up allows you to design a suite of filters with which to process
data in both acquisition and playback. You can design up to four digital filters for each input
channel and you can choose from one of five types of filter. For each filter you can specify the
start and end positions between which the filter applies. The order of the filters remains the same
throughout operation.

You can also specify whether the filter is fixed or continuously varying with time. When the filter
is fixed, the same filter is applied to each data sample. When the filter is continuously time-
varying, the cut-off frequency of the filter is modified at each data sample, giving a smooth
varying filter.
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Figure 7-12  The Time Varying Filtering Pop-up Window

Figure 7-13 Frequency Design Parameters for Band Pass and Band Stop filters

The Time Varying Filtering pop-up shows two levels of tab forms and an action area. The first
level of tab forms is used to select which input channel to apply the filter to; the second level to
select an input channel’s filter number. The filters are always applied in ascending order. You
can choose from one of five filters: low pass (LP), high pass (HP), band pass (BP), band stop
(BS) and Zap. To select one of the filters, click on its one-of selection button. This has the effect
of changing the contents of the bottom frame in the pop-up, allowing you to enter the values for
the filter’s parameter set.
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Figure 7-14 Low Pass Filtering

• LP: Low-pass filtering removes high frequency information from the data. You can specify
both the cut-off frequency in Hertz and the order of the filter.

The cut-off frequency defines the (3dB) point at which frequencies in the data start to become
significantly attenuated. The cut-off frequency must always be less than half of the sample
frequency of the input (the Nyquist frequency). If too high a cut-off frequency is selected, a
warning message appears, giving the maximum frequency that can be used. The order of the
filter governs the rate of attenuation of the filter after the cut-off frequency (that is, the roll-
off rate). A higher order gives a steeper roll-off rate. The maximum allowable filter order is
four.

A low-pass filter can be continuously varying with time.

Figure 7-14, this page shows the Data Display Area with the Low Pass Filtering pop-up
window settings for the data displayed on the screen. The bottom half of the display shows
data before low pass filtering was applied, while the top half of the display shows the data
with the illustrated Low Pass Filtering settings applied.

Figure 7-15 High Pass Filtering
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• HP: High-pass filtering removes low frequency information from the data. The high-pass
filter is set up in much the same way as the low-pass filter with a cut-off frequency and filter
order. Again, the cut-off must be less than the Nyquist frequency and the filter order must be
between one and four inclusive.

A high-pass filter can be continuously varying with time.

Figure 7-15, page 114 shows the Data Display Area with the High Pass Filtering pop-up
window settings for the data displayed on the screen. The bottom half of the display shows
data before low pass filtering was applied, while the top half of the display shows the data
with the illustrated High Pass Filtering settings applied.

Figure 7-16 Band Pass Filtering

BP: Band-pass filtering attenuates frequencies below one frequency and above a second
frequency. You can enter lower and upper cut-off frequencies in Hertz and specify the order
of the filter.

The lower and upper cut-off frequencies define the (3dB) point at which frequencies in the
data start to become significantly attenuated. The cut-off frequencies must always be less
than half of the sample frequency of the input (the Nyquist frequency). The lower cut-off
frequency must always be less than the upper cut-off frequency. The order of the filter
governs the rate of attenuation of the filter after the lower cut-off frequency and prior to the
upper cut-off frequency (that is, the roll-off rate). A higher order gives steeper roll-off rates.
The maximum allowable filter order is four.

A band-pass filter CANNOT be continuously varying with time.

Figure 7-16, this page shows the Data Display Area with the Band Pass Filtering pop-up
window settings for the data displayed on the screen. The bottom half of the display shows
data before low pass filtering was applied, while the top half of the display shows the data
with the illustrated Band Pass Filtering settings applied.
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Figure 7-17 Band Stop Filtering

• BS: Band-stop filtering suppresses a range of frequencies in the data. The band-stop filter is
set-up in much the same way as the band-pass filter, with two cut-off frequencies and a filter
order. These cut-offs must be less than the Nyquist frequency and the order of the filter must
be between one and four inclusive.

A band-stop filter CANNOT be continuously varying with time.

Figure 7-17, this page shows the Data Display Area with the Band Stop Filtering pop-up
window settings for the data displayed on the screen. The bottom half of the display shows
data before low pass filtering was applied, while the top half of the display shows the data
with the illustrated Band Stop Filtering settings applied.

Figure 7-18 Band Zap Filtering

• Zap: Zap filtering suppresses all frequencies in the data, leaving the data between the start
and end positions at the (DC) level of 0 volts. There are no parameters to enter. Typically this
filter is used to remove noise in the water column.
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Figure 7-18, page 116 shows the Data Display Area with the Band Zap Filtering pop-up window
settings for the data displayed on the screen. The bottom half of the display shows data before
low pass filtering was applied, while the top half of the display shows the data with the illustrated
Band Zap Filtering settings applied.

In each filter tab, there is a Filter Active on/off toggle and three frames for setting up the type of
filter, the range of samples over which the filter is to be applied, and the filter’s parameters.

When you have selected the type of filter, you can select a range of samples over which the filter
is to be applied and the filter’s design parameters respectively.

To use frequency filtering:

1. Select Processing→Time Varying Filtering or click on the Setup TVF Functionality icon.
The Time Varying Filtering pop-up appears.

2. Click on the input channel that you wish to apply the filter to.

3. Click on Filter 1 tab.

4. Click on the Filter Active toggle.
This sensitises the rest of the tab form.

5. If required, click on the Continuously Time Varying Filter button.
This option is available only with low-pass filtering and high-pass filtering.

6. Select a type of filter: LP, HP, BP, BS or ZAP.
The contents of the Frequency Design Parameters (3dB,Hz) box change according to the
filter type selected.

7. Select which part of the ping you want the filter to apply to, for example from Sensor to
Seabed.
If seabed is selected, you must ensure that a valid bottom position is available to the system.

8. Specify cut-off frequencies and filter order for the filter type specified.

9. Repeat steps 3 to 8 for the number of filters you require for that channel.
The maximum number of filters per channel is four.

10. Repeat steps 2 to 8 for every input channel.

11. Click on the OK or Apply button.
The input channel tab and the filter tab turn green to indicate that a filter is active.

Alternatively, you can load previous settings, using the Load button. You can also save the
current settings, using the Save button. The name of the current setup file is displayed at the top
of the pop-up. If an asterisk appears beside the name it means that the settings have changed from
those saved to disk.

Continuously Time Varying Filters: This option is available only for low-pass and high-pass
filters. When this option is selected, you can enter start and end cut-off frequencies and the filter
order. The order and the start cut-off frequency defines the filter at the first sample to be
processed, whereas the filter for the last sample to be processed is defined by the filter order and
the end cut-off frequency. Between these samples the filter is designed by linearly interpolating
between the start and end cut-off frequencies.

Apply Filter Limits: This frame allows you to select the start and end points between which a
digital filter is applied.

For the start sample, specify one from Sensor, Seabed or Time. If Sensor is selected, the filter
is applied from the start of data onwards, whereas if Seabed is selected, the filter is only applied
from the seabed onwards. You must ensure that a valid fish height value is available to the system
(see Figure 5-21, page 68). Selecting Time allows you to apply the filter from a fixed time in the
data. This time is specified via the text-entry box as a two-way travel time in milliseconds. Time
selections always take account of any start delay in the input channel.
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For the end sample, specify one from the Seabed, End of Data or Time. The end sample must
always be after the start sample. If Seabed is selected, the filter is applied only up until the
estimated position of the seabed, whereas if End of Data is selected the filter is applied to all
subsequent data samples. Choosing Time allows you to apply the filter up until a fixed time in
the data. This time is specified via the text-entry box as a two-way travel time in milliseconds.

Note:  A valid fish height must be available if Seabed is specified as one of the limits.

7.8.2 Swell Filtering
For seismic data, you can remove periodic noise from the data in the along-track direction by
using the swell filtering option. This option is available in both acquisition and playback modes.

The Processing→Swell Filter Setup pop-up, which is accessed from the Processing menu, is
similar in look and feel to the Fish Height Settings pop-up (see Section 7.8.2.1). The default
setting is no value. The source of the swell filter can be set using: keep existing value; copy value
from another channel; bottom flattening or swell filter (either automatic or manual). The Bottom
Flattening option is the easiest option to use; however, it should only be used if you know that
you have a bottom that is reasonably flat; otherwise, seabed features may be lost. The Swell
Filter option has two methods: Manual and Automatic. Use the former method if you know the
frequency range of the swell. Use the latter to detect the frequency of the swell and remove it.
The action buttons at the bottom of the pop-up allow you to copy settings to all channels and to
display swell filtered data, allowing you to see effect of the swell filtering.

To use swell filtering:

1. Select Processing→Swell Filtering.
The Swell Filter Setup pop-up appears. The number of seismic channels available is
indicated by the number of tab forms.

2. Select the source of the swell filter to be used. Choose one of the following options:

• Select from Keeping Existing Value (Playback only), Copy Swell Value from Other
Channel, Bottom Flattening or Swell Filter. If you select Swell Filter, either click on the
Manual Setup button and enter the cut-off parameters in seconds or Hertz and click on
the OK or Apply button; or click on Automatic Setup and enter the minimum and
maximum expected swell in seconds or Hertz. When the swell is measured in seconds,
this is automatically recalculated to Hertz by the system. Also in the Automatic Setup,
if you want the system to recalculate the swell frequency as the survey progresses, click
on the appropriate toggle and input number of second between recalculations. If you want
the system to display lost swell warning messages, click on the appropriate button.

• Load settings from a previous file.
The name of the current setup file is displayed at the top of the Swell Filter Setup pop-up.

The settings from the current channel can be copied to other active channels by clicking on
the Copy Settings to All Channels button.

3. Click on the Display Swell Filtered Data button and in the pop-up that appears select the
channels to apply the swell filter to.

4. Click on the OK or Apply button.

7.8.2.1 Swell Filtered Output

Figure 7-19 The Display Swell Filtered Data Window
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This menu item allows the Swell Filtering options of the Processing menu to be applied to the
display of sub-bottom data (see Section 7.8.2.1). This option has no effect on sidescan data.
Swell filtered data may be displayed in either data channel by clicking on the appropriate toggle.
The toggle beside the selected channel label is green to indicate the selection. Alternatively, both
channels display swell filtered data if both the Left Channel and the Right Channel toggles are
selected. The pop-up action buttons include the option to Store the chosen selection for future
use, or to use the Factory setting (see Section 3.3.9.)

The swell filtering option can be used to eliminate unwanted periodic noise from acquired
seismic data in an along-track direction. The swell filter used is a configurable digital Butter-
worth band reject filter.

The Swell Filter Setup pop-up is accessed from the Processing menu; however, the pop-up can
be accessed only if there is an active seismic channel. The pop-up is similar in look and feel to
the Fish Height Settings pop-up.

Figure 7-20 Swell Filtering Setup Window

The Channel tab forms are used to select which data channel or channels to apply the swell filter
settings to.

None is the default setting, and no swell filtering is performed.

The Keep Existing Value option can be selected only in playback mode and causes the previ-
ously recorded swell filtering to be used. If, however, swell filtering was not used in recording
mode, then no swell filtering will take place.

Copy Swell Value From Other Channel allows the swell filter value to be copied from another
channel, using the option selection button.

Selecting the Bottom Flattening causes the system to assume that the seabed is completely flat.
It averages the bottom position over a number of pings and then shifts each line to re-align the
bottom position to this average value. You can recalculate this average bottom position by
clicking on the Average Bottom Position button. This option should be used with care: it
assumes that the seabed is flat, and so valid seabed features may be lost when this option is
applied.
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Swell Filter has two options: Manual and Automatic.

Clicking on the Manual Setup button produces the Manual Swell Filter Setup pop-up (see
Figure 7-21, page 120). Two parameters can be modified in this pop-up: Low Cut-Off and High
Cut-Off. These specify the 3dB band edges of the band reject swell filter. The values can be
specified in Hz or in seconds. Entering a value in seconds in the text-entry box and then applying
the change will recalculate the value to Hz.

Figure 7-21 Manual Swell Filter Setup

Clicking on the Automatic Setup button pops up the Automatic Swell Filter Setup pop-up (see
Figure 7-22, page 120). 

Figure 7-22 Auto Swell Filter Setup Window

The setup options are:

• Minimum Expected Swell and Maximum Expected Swell: these fields define the search
window over which the system will try and detect a swell frequency. The values can be
specified in Hz or in seconds

• Dynamically Recalculate Swell Every: clicking on this toggle causes the system to try and
determine the swell frequency every n seconds. If the toggle is disabled, the system calculates
the swell frequency when the swell filter is first applied and continues to apply this filter until
the filter is disabled.

We recommend enabling this toggle with the recalculation taking place every 30 seconds.

• Display Lost Swell Warning Messages: this toggle allows you to specify whether or not to
display lost swell warning messages. These occur if the system cannot determine a swell
frequency within the search window.

We recommend that this toggle is enabled.

Clicking on the Copy Settings To All Channels in the Swell Filter Setup pop-up copies the
settings from the current channel to all other active channels.

Clicking on the Display Swell Filtered Data button causes the Display Swell Filtered Data pop-
up to appear. Swell filtered data can be displayed in either data channel by clicking on the appro-
priate toggle. The swell filtered data can be compared to the original unfiltered data.
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The action buttons at the bottom of the pop-up include the option to Load previous settings or to
Save current settings so that they can be used in future. The name of the current setup file is
displayed at the top of the pop-up. If an asterisk appears beside the name it means that the settings
have changed from those saved to disk.

7.8.3 Changing Sub-bottom Velocity
The Settings→Sub Bottom Parameters Popup is used to change the sound velocity for
measurement in sub-bottom data. When using a sub-bottom profiler, it is important to have an
accurate prediction of the speed of sound in the seabed medium; otherwise, on-screen distance
measurements will be in error. You can change the default value – 1600m/s – using the Settings
menu.

Figure 7-23 The Sub-Bottom Sound Velocity Pop-up Window

Note: In calculations, this velocity is used throughout the ping, including the water column.

7.8.4 Trace Mixing and Anti Mixing
Trace mixing of shallow seismic data either enhances or removes features with a strong along-
track trend by averaging the raw data in neighbouring pings. It has two modes: mixing mode
(also known as stacking) which enhances features which persist between neighbouring pings;
and anti-mixing mode (also known as anti-stacking) which removes features such as noise. You
can control the extent of mixing or anti-mixing 

The trace mixing option mixes the signal amplitudes from neighbouring pings of data; that is,
trace mixing (also known as stacking) performs along-track smoothing. Choosing this option
from the Processing menu produces a pop-up which can be used to define the trace mixing
mode, the trace mix fold, and the trace mix run off. Mixing mode can be used to enhance infor-
mation that persists in the along-track direction. Anti-Mixing mode in contrast can be used to
suppress noise that persists in the along-track direction.

To use trace mixing:

1. Select Processing→Trace Mixing.
The Trace Mixing pop-up appears.

2. In the appropriate Channel tab, click on a one-of selection switch to choose the mixing mode:
Mixing or Anti-Mixing.

3. Do one of the following:

• If using the mixing mode, use the arrow buttons to input a Trace Mix Fold value and a
Trace Mix Run-Off value, or type the value in the text-entry box.

• Load previously saved settings.

4. Click on the OK or Apply button.
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Figure 7-24 The Trace Mixing Pop-up Window

In trace mixing, an input signal value is replaced by the sum of weighted values of itself and the
corresponding signal values in the neighbouring traces. In mixing mode, the sum of these
weighting coefficients is defined to be one, whereas in anti-mixing mode this sum is defined to
be zero.

The number of traces that are combined is defined by the trace mix fold. Equal numbers of traces
are used from either side of the input trace, hence a fold of three uses the input trace and those
traces immediately before and after it. With mixing mode and fold set, the weighting coefficients
are determined by the trace mix run-off. This value is defined as the absolute difference in value
between two neighbouring coefficients. Hence for a fold of 3 and a run-off of 0.25, the weighting
coefficients are 0.5 and 0.25 respectively.

The Channel tab forms can be used to set the parameters for each channel. The action buttons at
the bottom of the pop-up can be used to Load previous settings or the Save current settings.

This processing is only applied to the displayed data. The data being recorded or replayed is not
affected by trace mixing.

7.8.5 Seismic TVG
TVG can be used for seismic data to amplify the return of a signal with depth. The sub-bottom
will tend to attenuate the signal much more than the water column, so it may be necessary to use
a higher maximum gain setting than you would normally use for sidescan data.

The geophysicist is normally only interested in sub-bottom features, so the Apply TVG from
Seabed option is a useful feature to avoid having to amplify noise in the water column.

Depending on the quality of your data, it may not be appropriate to use the Auto TVG function.
Strong multiples or horizons can result in an Auto TVG function that can make the image appear
banded. It is best to experiment, and if the results are not as expected set a manual TVG curve.

7.8.6 Colour Maps
In addition to the various continuous tone colour maps provided through the Image
Enhancement pop-up, there are several colour maps that are specifically targeted to seismic and
Ground Penetrating Rada (GPR) processing.
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Figure 7-25 The Image Enhancement Pop-up

These colour maps are quantised so that they highlight various sub-bottom reflectors and enable
you to quickly distinguish and characterise features in the sub-bottom layers by simply looking
at the colour of the feature.

We have developed these colour maps in consultation with our customers so the data is shown
in a standardised way through a whole suite of seismic processing tools. If you have a
requirement for a particular colour map that is not currently available, please contact Coda
Technologies and we will try to include it in a future release of the software.

7.8.7 Swell Filter Hints
There must be an accurate Fish Height Value available to the system for swell filter to be
effective (see Section 5.5).

Try to set up an automatic swell filter with minimum and maximum frequencies that are appro-
priate to the swell experienced (swell period can range from 0.5 to 30 seconds period). The
maximum swell that can be filtered is a function of the along-track ping frequency. If the value
entered is greater than the along-track nyquist frequency, a warning will appear in the display.

There must be sufficient periodic swell in the search range for the system to detect a swell
frequency. If there is not, the system will report that it cannot detect a swell frequency within the
given range.

If Automatic Swell Filter fails, try to specify a manual filter around the swell frequency. For
example, a Low Cut-Off of 0.1 Hz and a High Cut-Off of 1.0 Hz will attempt to filter out
frequencies in this range (1 second to 10 seconds period).

For deep water seismic operation it may not be feasible to use a frequency based approach as the
effective nyquist frequency in the along-track direction will be very low. In this case, the Along
Track Averaging function may be more appropriate. This function will smooth the data in the
along-track direction, effectively performing a crude low pass filter.
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8 General Display Tools

8.1 Displaying Event marks, Scale Lines and Fix Marks
The DA System has an overlay plane, which displays a set of coloured screen markings that
indicate tag marks and fixes; these markings are displayed over the sonar image, without
affecting the displayed data. You can toggle the display on or off. For details on tagging, see
Section 13.

To display tags:

1. Select the Display menu.

2. Click on the Overlay Data toggle to turn on the overlay plane. The toggle turns green.
Clicking on the toggle again turns off the overlay plane and the toggle turns grey again.

8.1.1 Displaying Fix Information
When the overlay plane is on (see Section 8.1), the DA System displays the Fix Number and an
Easting and Northing pair (E,N) on the fix lines. The Fix Number is not currently affected by
corrected nav files. You can select other data items to appear on the fix lines, using the Fix Data
pop-up. The other data items are: Date, Time, Kp, Speed, Heading, Fish Height, Line Name,
Survey Description and, for Pipeline Inspection software Pipe Offset and Striking Angle.

You can also choose whether to display every fix line or only some fix lines. If you select
Display some fixes, you can specify in the text-entry box how many fixes to display, from 1 in 2
fixes to 1 in 100 fixes.

To set the fix data information to display:

1. If you have not done so already, turn on the Display→Overlay Data toggle.

2. Select Settings→Fix Data.
The Fix Data Setup pop-up appears.

3. In the Fix Data To include frame, click on the items that you wish to display on the fix lines.

4. In the Fix Display Frequency frame, click on Display every fix or click on Display some
fixes and specify the number you wish to display.

5. Click on the OK or Apply button.

8.2 Overlay Data
This menu item toggles On and Off the display of overlay data in the display area. By default,
Overlay Data is switched on; however, by switching the overlay plane off, data can be recorded
or played back without displaying tags or fix lines. This item does not affect the storing of tags;
that is, if overlay data is Off and a tag is marked using the right mouse button, the tag is not be
drawn to the screen but is saved to the database.

8.3 Scale Lines
Scale lines are displayed as vertical red lines on the data, representing either distance or time.
These provide a visual guide to the travel time (either one-way or two-way travel time) or
distance (either true range or slant range) as the survey data is displayed. When the scale lines
are displaying distance, this is either true range or slant range, depending on the toggle selected.
If True Range is selected, a valid Fish Height value must be available to the system (see Section
5.5). Scale lines can be displayed over sidescan data or sub-bottom data.

Note: Scale lines are not recorded with the data, they are only visible in the DA System waterfall display or
on hardcopy output.
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Figure 8-1  The Scale Lines Settings Window: Setup using distance (metres)

Figure 8-2 The Scale Lines Settings Window: Setup using time (msecs)
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Figure 8-3 The Scale Lines Settings Window: Annotation

This pop-up window allows the scale lines options to be set.

• Draw Scale Lines: This button is used to toggle on or off the display of scale lines on the
data display.

• Scale Line Spacing: This field is used to set the space between scale lines in either metres
or milliseconds. By using the scale lines spacing option button, an accuracy of 0.1 metres or
milliseconds may be defined.

• Annotate Scale Lines: This option allows automatic scale line annotation to be On or Off.
When annotation is On, the appropriate distance or time label appears beside each scale line
on the display.

• Position Reference: The type of scale lines to display is selected using the one-of selectors
in this option box. The Relative to Sensor option displays scale lines at Slant Range
Distance. The Relative to Seabed option displays scale lines at True Range Distance.

Note: When displaying metres scale lines over sub-bottom data, only true distances are used. This
is the case even if the Slant Range Distances option is selected, as slant range is equal to true
range in this case.

• Travel Time: These options are only available when displaying millisecond scale lines and
relate to the travel time for each ping of data. The type of millisecond scale lines to display
are selected using the one-of selectors in this option box. A setting of Two-Way Travel Time
displays millisecond scale lines at two-way travel time intervals, while a setting of One-Way
Travel Time displays millisecond scale lines at one-way travel time intervals.

Note: For sub-bottom data the sub-bottom sound velocity is used to calculate the position of the scale lines
(see Section 7.8.3).

8.4 Displaying Fix Information
When the overlay plane is on (see Section 8.1), theDA System displays the Fix Number and an
Easting and Northing pair (E,N) on the fix lines. The Fix Number is not currently affected by
corrected nav files. You can select other data items to appear on the fix lines, using the Fix Data
pop-up. The other data items are: Date, Time, Kp, Speed, Heading, Fish Height, Line Name,
Survey Description and, for Pipeline Inspection software Pipe Offset and Striking Angle.

You can also choose whether to display every fix line or only some fix lines. If you select
Display some fixes, you can specify in the text-entry box how many fixes to display, from 1 in 2
fixes to 1 in 100 fixes. Ensure Display→Overlay Data is switched on.
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8.4.1 Fix Data Setup

Figure 8-4 The Fix Data Setup Pop-up Window

In addition, the Fix Display Frequency options can be used to choose between Display every
fix (the default), where every fix line is displayed to the screen; and Display some fixes, where
a selected number of fixes only are displayed, varying between 1 in 2 fixes and 1 in 100 fixes
according to the selection in the text-entry box.

8.5 Zooming on Screen Features
 key shortcut: <Control-z>

Figure 8-5 The Zoom Mode Pop-up Window

The Zoom function selects a rectangular area of the DA System display to be viewed under
magnification. Using the key short-cut <Control-z> or selecting this menu item causes the zoom
pointer to appear in the Data Display Area. The pointer can then be moved to the position of
either the top left or bottom right corner of the area to be magnified. Pressing and dragging with
the left mouse button defines the zoom area. Releasing the mouse button causes the zoom pop-
up window to appear. It remains on the screen until dismissed by pressing the Done button.

The Processing→Zoom function magnifies a selected area of the display and, by default,
displays the data at full resolution in the zoom pop-up. You can change the setting to zoom to
full screen or zoom to fixed magnification, in the Zoom Mode pop-up. The selected mode is
applied when you select an area to be magnified.
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An area of interest in the display data can be viewed at greater resolutions using the Process-
ing→Zoom menu item. Section 8.5 contains details of how to zoom in on regions of the display
area.

Full Resolution mode displays the true resolution of the data (without sub-sampling). This is
useful for spotting small features in sidescan or sub-bottom data; however, the zoomed image
may appear distorted compared to the screen display, for if the screen display is sub-sampled, the
zoomed image appears stretched in the across-track dimension. (This is because no sub-sampling
is carried out in the along-track dimension by the DA System). Full Screen mode enlarges the
selected area to the size of the display area. If the area of zoom is small, however, the individual
pixels in the zoomed image tend to be more prominent than the magnified feature. Fixed Magni-
fication mode combines the least distortion of the image (compared to the screen display) with
an acceptable magnification. This magnifies the selected area of the screen by a set factor;
usually a setting of 200–400% of the original image size will be found to be satisfactory.

Additional points to remember:

• Zoom to full resolution only has an effect if the display is not already showing the full
resolution data. To display the full resolution of an area of the swathe continuously, adjust
the Left or Right Display Channel setups in the Settings menu (see Section 7.4).

• The fixed magnification and full screen zooms use the full resolution data, not the display
data, as the source for the zoomed image. This gives the highest quality zoomed images.

The selected setting is then applied when Zoom is selected from the Processing menu, or when
the keyboard short-cut <Control-z> is used.

8.6 Making On-screen Measurements
 key shortcut: <Control-s>

The DA System can measure the on-screen distance between two points and the height of an on-
screen feature using the Processing→Measure option. When you select measuring mode and
mark the distance to be measured, the DA System will calculate the distance or height, using the
measurement method selected.

The Data Display Area can be used for measuring distances and heights. Measuring mode is
started by selecting Measure from the Processing menu, or by using the keyboard short-cut
<Control-s>. The ARROW pointer changes to the CROSSHAIR pointer to indicate measuring mode.
To measure the distance between two points on the screen, press and drag the left mouse button
from the starting point to the end point. A blue line is drawn, representing the distance being
measured. When the mouse button is released a pop-up window appears displaying the distance
measured (see Figure 8-7, page 131).

8.6.1 Measurement Method

Figure 8-6 The Measurement Method Pop-up Window

The DA System allows the on-screen measurement of features. Distances can be calculated using
one of two methods: Speed x Time or Difference in E,N pair. The default setting is Speed x
Time calculated using the relative time between pings and the ship’s speed. When this method
is used, the start point is calculated from its geographical ping position; then, using time, ship
speed and speed of sound, the along-track and across-track distances are calculated and used to



DRAFT
130 May 2001 for version 2.1        

U
si

ng
 th

e 
D

A
 

S
ys

te
m

determine the measurement distance. When Measurement Method in the Settings menu is set
to Difference in E, N pair, both start and end points are calculated from their geographical ping
positions and ping heading, using corrected navigation data if necessary. The measurement
distance is then calculated from the difference in the Easting and Northing pairs. 

The Speed x Time method tends to give more accurate results over short distances; raw
navigation data is typically updated only every second and instantaneous headings can change
considerably. This method, however, should only be used if you have an accurate speed over
ground supplied through the navigation string. The Difference is E/N pair method should be
used for long measurements or when corrected navigation data is available.

If the screen is scrolling when the measurement is performed, the measuring start point scrolls
with the data. This allows measurements to be made of features that are larger than the screen
height.

There are a few other points to bear in mind when making on-screen measurements:

• For sidescan data (labelled SS Port and SS Stbd in the Description field of the Open Acqui-
sition menu), the height is also displayed in this pop-up. The height reading is valid only if
a shadow has been measured. This height corresponds to the height of an event that would
cast a shadow corresponding to the across-track distance measured on the screen.

• If the display is paused, the blue measuring line remains on screen until the measurement
pop-up is dismissed.

• An accurate fish height is essential for on-screen measurement (see Section 5.5).

• In acquisition mode, the start and end positions of the measurement line are calculated using
raw navigation data, including towfish heading and velocity; so the measurements are
dependent on the quality of the navigation data.

• In playback mode, corrected navigation data is only used in the calculation if the Nav Data
Type in the Settings menu is set to Corrected.

• The along-track dimension of a measurement is based on either an estimate of the towfish
velocity and heading or the difference between the start and end positions (derived from
incoming navigation data).

• If lat/long co-ordinates are being used by the DA System as part of the nav string, measure-
ments of start and end positions are performed by converting the ping lat/long values to UTM
(that is, Easting, Northing) values, and then calculating the start and end positions from these.
Where necessary, the start and end positions are converted back to lat/long for display.

• True cross-track distances are calculated whether slant-range correction is on or not (see
Section 7.7.2.1).

• To make measurements in the zoom window, the data in the zoom window must still be
visible in the Data Display Area. 
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Figure 8-7 On-screen Distance Measurement

The Measurement Values pop-up, which appears automatically, displays the start and end
Eastings and Northings of the line, start and end Kp and DCC of the line, start and end sample
numbers, across-track pings, cross-track slant distance, and line length (distance) and height in
metres. (If a measurement is made in sub-bottom data the cross-track distance and the height are
not reported, as they have no meaning.)

8.7 Raw A-Scan
This area can also display an A-scan trace of the sample data when the Raw A-Scan toggle on
the Display menu is on. Any adjustments to the main waterfall display are reflected in the A-
scan trace; for example, switching to single channel mode causes the Raw A-Scan window to
display only one channel across the full screen width.

Selecting the Raw A-Scan menu item produces a pop-up window that displays an oscilloscope
or waveform trace of each line as it is displayed to the screen (see Figure 8-8, this page). The
oscilloscope trace is for the top line of data in the Data Display Area. The trace is only updated
when a new line of data is displayed to the screen; therefore the DA System must be scrolling
data before the trace becomes visible.

Note: The presence of the Raw A-Scan pop-up can slow the rate of scrolling in playback. 

Figure 8-8  The Raw A-Scan Oscilloscope Trace

The Raw A-Scan pop-up shows the current position of the bottom tracking line as an orange
vertical line.

8.8 Displaying Survey Data
Display→Survey Data, or clicking on the Display Data for the Survey icon, pops up a window
displaying various survey data parameters as shown in Figure 8-9, page 132. The parameters are
continuously updated as new sonar pings are displayed to the screen. The information displayed
in the Survey Data pop-up corresponds to the last sonar ping drawn to the top of the display, and
for the channel being displayed in the left display channel (usually the Port channel for sidescan
sonar data). The DA System should be scrolling data, otherwise no data will appear in the Survey
Data popup.
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Figure 8-9  The Survey Data Parameters Pop-up Window

• Heading: directional information obtained from the nav input (see Section 5.4.4).

• Ground Speed: obtained from the nav input (see Section 5.4.4).

• Fish Height: the height of the towfish from the seabed. This may either be obtained automat-
ically from the nav input or be entered manually (see Section 5.5).

• Ping Rate: the rate at which the data was acquired (this may differ from the playback rate).

• Line Name: a user-defined label marking specific parts of the survey (see Section 6.6.4).

• Fix No: a reference obtained from the nav input (see Section 5.4.4).

• Kp: the Kilometre post chainage value obtained from the navigation interface which can be
used in place of time as a basis for searches through the data.

• DCC (Distance Cross Course): the across-track distance of the fish from the survey centre line
in metres. This can be entered manually or taken from the RS232 nav input (Section 6.6.4).

• Layback: the along-track distance in metres from the ship position to the fish position, which
can be entered manually or taken from the RS232 nav input (see Section 6.6.4).

• Fish Cross-Track Offset: the across-track distance from the ship position to the fish
position. A positive offset indicates an offset to the right (starboard), and a negative offset
indicates the offset is to the left (port). This may be input manually or taken from the RS232
nav input (see Section 6.6.4).

• Along-track Resolution: the distance between pings in the along-track direction.

• Cross-track Resolution: the distance between samples in the across-track direction.

• Slant Range: the maximum slant range from the sonar transducer (see Section 7.7.2.1).

• Sample Frequency: the rate (in Hz) at which data samples are taken. This is defined while
setting up the acquisition parameters.

• Number of Samples: the total number of samples that have been acquired for this ping. This
is defined while setting up the acquisition parameters (see Section 5.2).

• Input Voltage Range: the voltage setting defined in the acquisition parameters.

• Nav Data: whether raw or corrected navigation data is being used (see Section 5.4.4). This is
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only relevant in playback mode.
• Nav Clock Sync: whether the DA System clock is synchronised with the RS232 nav input

clock (see Section 5.4.4).
• Fish Height Source: whether it has been manually entered (Fixed), or it has come from the

nav data (Auto) or from Telemetry (see Section 5.5).
• Input Position Ref: whether Fish or Ship is being used (see Section 5.4.4).

• Speed of Sound in Water: either the speed of sound entered by the RS232 nav string or the
default value of 1500m/s.

• Water Depth: the depth of water, obtained from the nav string.

You can keep the pop-up open, so that you can monitor changes in the parameters as data scrolls
down the screen. To prevent the pop-up from obscuring part of the Data Display Area, you can
move it about the screen. To do this, press and drag on the title bar.

8.9 Ping Data

Figure 8-10 The Ping Data Pop-up Window

This pop-up gives you information about the data under the current pointer position. Moving the
pointer around the Data Display Area will cause the pop-up to be updated in real time. The values
displayed are the current Ping Number, the Time of the ping in UTC and date/time format, the
Sample Number within the ping and the Intensity, expressed as a percentage of the full-scale
value (FSV) of the analogue input, in addition to True Range and Fish Height, both in metres.
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8.10 Nav Data QC

Figure 8-11 The Nav Parameters QC Pop-up Window

This option can be selected when testing the navigation input with a new RS-232 navigation
string, or when checking that navigation equipment is delivering a correctly formatted navigation
string (see Section 5.4.2).

8.11 General Information Area

Figure 8-12 The General Information Area

The General Information Area (see Figure 8-12, this page) lies near the bottom left of the display
screen. It provides the following information:

• pings/s: the rate (in pings per second) at which the display lines scroll down the screen. In
acquisition mode, the rate is determined by the Open Acquisition→Triggers→Trigger
Period settings (see Section 5.2)

• ping no.: the number of the ping being displayed in the top line of the Data Display Area. It
is continuously updated while data is scrolling. The ping number is assigned to the data
during acquisition and is reset to zero only when the system is restarted. This means that
consecutive tapes or optical disks used during data acquisition have sequential ping numbers.

• date/time: the date and time at which the data was recorded. (The date is displayed as dd-
mm-yy.) During acquisition, if Navigation Input→Sync with Nav Time has been set the date
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and time displayed are those supplied by the RS232 navigation data; otherwise the current
date and time on the DA System are displayed. If the system is not able to synchronise with
the external navigation clock, the time label changes colour from cyan to red.

• fish height: the height the towfish is from the seabed.

• cursor (pointer): the position directly under the cursor on the screen, expressed as Eastings,
Northings and Kp. The position is fully geo-corrected and is calculated using the navigation
data stored with each ping. If the fish height is known, the position is automatically slant-
range corrected. Similarly, if corrected navigation data is available, this can also be used to
provide a further stage of correction.

8.12 Application Specific Area

Figure 8-13 Application Specific Area in Acquisition Mode

Figure 8-14 Application Specific Area in Playback Mode

In playback mode, the Application Specific Area shows three types of information: Tape
Channels or Disk Channels, Position and Display (see Figure 8-13, this page and Figure 8-14,
this page)

• Tape Channel/Disk Channels shows information about the type of survey data on the
current tape or disk. during playback it refers to the data being replayed. Depending on which
drive is being used, this frame of the display is labelled either Tape 1 Channels, Tape 2
Channels, Disk 1 Channels or Disk 2 Channels.

• Position: This section displays the UTM or lat/long co-ordinates of the Ship or Towfish for
the most recent line of data displayed at the top of the Data Display Area. When the waterfall
display is scrolling, these co-ordinates are continuously updated

• Display: This section shows which data channels are being displayed and where they are
displayed, namely the left or right display channel. the number of channels available for
display corresponds to the number of channels being recorded or replayed. Any data channel
can be displayed on either the left or right display channel by clicking on the corresponding
toggle, provided it is on the same trigger as the data in the other channel. For example, data
channel 2 can be displayed as the right display channel by clicking on the selector toggle
under channel 2 in the row which corresponds to the right display channel.

In acquisition mode, the Application specific Area is divided into the following areas: Settings,
Position and Display. The Position and Display area have the same function as in playback
mode.

• Settings: On optical disk systems, this area displays the amount of disk space free when
recording. (Unfortunately, it is not possible to display the amount of space remaining on a
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tape because of the limitations of SCSI tape devices.) It also displays the acquisition system
settings for a specific data channel, as set through the Open Acquisition pop-up under the
File menu. The data channel is selected by clicking on the appropriate one-off selection
switch for Channel. The up and down arrows can then be used to look through all the acqui-
sition settings for the data channel selected.
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9 Data Output

This section explains how to obtain print-outs of acquired data. You can obtain hardcopy by
sending the data to a printer or thermal plotter, or you can save the image displayed on screen in
either a Postscript® format or a TIFF format; images can then be incorporated into reports or
other computer packages. Many common windows applications (for example, word processing
packages and presentation packages) are able to import Postscript® and TIFF graphics.

9.1 Hardcopy Output
The Hardcopy Output option sends digital data via a parallel interface or a GPIB interface to a
printer or thermal plotter; it can be used in acquisition or playback mode, and allows real-time
plotting of survey data.

Lines of data are sent to the printer or plotter as they are displayed at the top of the Data Display
Area or as they reach the bottom of the Data Display Area. The second option allows event tags
to be positioned before the data is printed. However, the rate at which data can be sent to the
printer or plotter may be limited when used with certain types of plotter, preventing the real-time
plotting of data in acquisition mode and slowing the rate of data display.

It is normal for the display to pause when a printer or plotter is selected; this is because a Reset
command is being sent to the printer. This pause has no effect on the recording of data, and the
screen display rapidly catches up with the incoming data from the acquisition system, tape or
disk.

Before using this option, make sure that the printer or plotter to be used is set up correctly and
that the cables are connected correctly to the selected output port.

Figure 9-1 Hardcopy Output Pop-up Window

A hardcopy (printing) device must be connected to the DA System via the parallel port or the
GPIB port (see Section 4.3). To enable output, the appropriate printer or plotter should be chosen
from the list in the Printer/Plotter window (by clicking on its name) to match the connected
hardcopy device. For details of how to set up individual printers, see Appendix J. The Output
Port to which the hardcopy device is connected should also be selected; if the GPIB port is
selected, the GPIB Setup options should be checked (see Section 9.1.1). The GPIB Setup pop-
up appears when the GPIB Setup button is clicked. This displays addresses for the DA System
and the hardcopy output device can be set in this pop-up.
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As coloured hardcopy output is not available through this menu item, the tag colours must be
converted to either black or white. The Tag Colour option allows a one-of choice of either Black
or White in which all tags will be printed. Finally, the Output On toggle in the Hardcopy Output
window should be switched on (green). The pop-up can then be dismissed by clicking OK if the
settings are correct, or Cancel to revert to the previous settings.

The data line is normally drawn from left to right on the hardcopy device. However the line may
be reversed and drawn from right to left by selecting the Reverse Line option. Normally each
line is only printed once. However if it is desirable to stretch the hard copy in the along-track
direction, the lines may be repeated by setting the Repeat Count value. Increasing the repeat
count will generally slow the overall print speed.

When sending data to the printer, the Coda system requires hardware signals to be returned from
the printer. If these are not received (for example, if the printer is busy) the Coda system will stop
scrolling data until it can communicate with the hardcopy device. This ensures that the rate of
Coda system scrolling is not faster than the printer can print out. However, if the printer does not
communicate for a long time (for example, if the printer is off-line or has developed a fault), the
Coda system will time out waiting for the communication. Hardcopy Output will then be
automatically turned off. You can specify the length of Timeout (in seconds) in the text field in
the pop-up.

When output is enabled, you can select for output to the printer or plotter to be either from the
top line of the screen, by selecting Newest in the one-of Print Line choices, or from the bottom
line by selecting Oldest. If you choose Oldest, tags that have been added will appear on the hard
copy. All image enhancement and processing applied to the on-screen data is also applied to the
data sent to the hardcopy device. 

Note: As the data being printed is that at the bottom of the screen, it is important to ensure that the system
keeps acquiring and recording data at the end of a survey line for long enough to cause the whole line’s data
to be output to the printer.

9.1.1 GPIB Setup

Figure 9-2 The GPIB Settings Pop-up Window

Clicking on the GPIB Setup button in the Hardcopy Output window pops-up a window that
defines the GPIB Settings. The DA System Settings frame is used to set the GPIB address for
the DA System. By default this is set to zero. The Hardcopy Device Settings frame is used to
set the external device number; this is usually 6. The two GPIB addresses must be different.

The GPIB Timeout frame enables the time out value used for communications between the DA
System and the GPIB hardcopy device to be set. The default is 3 seconds, and is satisfactory for
most devices. If, however, printing to a device stops repeatedly with the error ‘I/O Operation
Was Aborted’, the timeout value should be increased. Valid values are 1, 3, 10 or 30 seconds.

9.2 Screen Dump
The screen dump menu item allows the current waterfall display window either to be saved as an
image to disk or printed out directly on a connected printer. When the menu item is selected from
the File menu, the following pop-up window appears:
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Figure 9-3 The Screen Dump to Hard Disk Pop-up Window: 

Figure 9-4 The Screen Dump to Floppy Disk Popup Window

Screen dumping must be carried out only in playback mode; it should not be attempted in acqui-
sition mode because it may cause loss of data. It is also a comparatively slow process. It takes
longer if you are generating screen dumps on floppy disk when the system is scrolling. Pausing
the screen display allows the screen dump operation to complete more quickly.

Note: The Printer option applies only to Postscript® images. TIFF images cannot be dumped to a Postscript®
printer.

• Floppy: When prompted, insert a blank, DOS-formatted floppy disk into the floppy disk
drive and enter a filename for the screen dump. When entering filenames, bear in mind that
DOS expects filenames to be a maximum of 12 characters long including the ‘.’ character;
some packages expect Encapsulated Postscript® files to have the ‘.EPS’ extension; some
packages expect TIFF files to have the ‘.TIF’ extension. Click on the OK button. The system
automatically dumps the image to floppy disk and the Screen Dump pop-up disappears.

• Printer: Click on the Printer Setup button. In the Printer Setup pop-up, select the printer
port, the format of the page (portrait or landscape) and the type of file (ASCII or Postscript®),
then click on the OK button. In the Screen Dump pop-up, click on the OK button. This sends
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the screen dump to the printer.

The image ‘dumped’ to disk or printer will include any overlay features (such as tags or fix lines)
as well as the image data. Any image enhancement or processing techniques applied to the
waterfall display will also be reflected in the dumped image.

Within the Screen Dump window, the format, tag colour and destination for the image can be
selected. Image Format provides a one-of choice between PostScript® and TIFF; Tag Colour
allows a choice of Black or White; and Dump To gives the option of Printer or Floppy.

If the Image Format selected is PostScript® and Printer is selected in the Dump To options, a
PostScript® compatible printer is required. Similarly, when Floppy is selected in the Dump To
options, a single PostScript® or TIFF file will be produced on the floppy disk in DOS format.
A prompt will ask for a file name to be entered.

Before attempting to dump the file to floppy, ensure that the floppy disk is a 1.44MB (DSHD)
disk, formatted for DOS. If PostScript® format is selected, the file produced will be an Encap-
sulated PostScript® file, whereas if TIFF is selected a TIFF format file is produced. Both are
suitable for import to many different PC applications.

Tag Colour provides a one-of choice of Black or White. This ensures that the colour for any tags
in the dumped file can be selected to suit a specific purpose.

If the screen image is to be dumped to a printer, click on the Printer toggle. To set up the
particular printer configuration, click on the Printer Setup button. This brings up a pop-up
window that allows printer port and output format selections to be made. Section 9.2.1 explains
the use of the Printer Setup window.

After selecting the appropriate format and printer port, select OK in the Screen Dump window.
The image is then dumped to the printer. Depending on the speed of the attached printer, this may
take between a few seconds and several minutes.

If the image is to be dumped to Floppy, click on the Floppy toggle, first ensuring that a disk has
been inserted in the floppy disk drive. A dialogue box appears asking for the name of the file to
be dumped. When the name has been entered and OK selected, the image is dumped to disk. This
takes several minutes.

Note: The process of dumping the screen image to floppy disk takes much longer if the system is being used
for playback or acquisition at the same time as an image is being dumped. It is not advisable to carry out
screen dumps in acquisition mode (a loss of data to the screen may result, owing to the time taken for the
screen dump to complete); in playback mode, pausing the display allows the screen dump to be completed
more quickly.

The action buttons at the foot of the pop-up include the option to Store the chosen settings for
future use, or to use the Factory setting (see Section 3.3.9).

9.2.1 Printer Setup Window

Figure 9-5 The Printer Setup Pop-up Window

Selection of the appropriate printer port is made by clicking on the port to which the printer is
connected. If the port is a serial port, the Serial Setup button should be clicked to set up the serial
line parameters (see next section).
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Either Portrait or Landscape Format may be selected for PostScript® images by clicking on
the appropriate toggle. For screen dumps the image is scaled to fit the page; landscape format
therefore produces a larger printed image. Where a screen dump is being saved in TIFF format,
this selection does not apply and is therefore ignored. Type allows a choice of ASCII or
PostScript® printer. Only PostScript® is available for screen dumps, selecting ASCII produces
an error message.

When the appropriate selections have been made, clicking on the OK button applies the settings
and dismisses the pop-up, Apply uses the settings without dismissing the pop-up, and Cancel
dismisses the pop-up, ignoring any changes made.

Note: The printer should be connected to the required port of DA System before OK or Apply is clicked (see
Section 4.3 and Appendix J).

9.2.2 The Serial Setup Window

Figure 9-6 The Serial Setup Pop-up Window

The Serial Setup window may be accessed from a number of different menus – for example, the
Navigation Input menu or the Printer Setup window, which itself can be accessed through a
number of different menu selections (for example, File→Screen Dump→Printer Setup,
Tagging→Tag Management→Report Generation).

Selecting the Serial Setup option pops up a window allowing the baud rate, the number of data
bits, the number of stop bits, the parity and the method of flow control to be selected (see Figure
9-6, this page). Click on the appropriate toggles to make the selections. These should correspond
to those of the printer, plotter, computer, etc. to which this serial line of the DA System is
connected. When the serial setup has been completed, select OK.
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10 Tagging & Using the Event Database

The DA System enables you to place tags on the display data in order to mark features of interest
(known as events) on screen. This is done either by using the Tagging menu or by clicking the
RIGHT mouse button over the event. An orange box appears around the event. Tagging can be
performed during both data acquisition and playback.

Only one type of tag can be created in the DA: a single point (or node) non-specific tag, labelled
‘Unknown’; these tags are represented as an orange box in the display. Other tag types and
tagging tools are available with the PI100 and GeoKit.

The DA System maintains a tag database for each file on the tape or disk, so that information on
each screen tag can be stored to hard disk. This allows tags created in acquisition mode, or
previous playback sessions, to be automatically replayed with the accompanying data channel.
The display of tags can be toggled on or off. Tag databases may also be saved to tape or disk,
loaded to the hard disk or copied to disk, so that tag files can be archived.

The tag file database can be used in Goto commands and it can be used to produce an ASCII
format report.

Another type of tag – a fix tag – is generated automatically by the DA System. This tag is based
on incoming navigation data. Whenever the fix number in the navigation data changes, a fix tag
is created. Fix tags are represented on screen as coloured dashed line. The Fix Data Setup option
is used to set the information included on the fixes and the frequency they are displayed as well
as to toggle the display on and off (see Section 8.1.1). Fix tags are only entered into the database
in acquisition mode.

A tag file is created for each data set; the tag files can be stored to the tag database and replayed
with the accompanying data channel as required.

Figure 10-1 The Tagging Menu

A tag must be selected and made the current tag before it can be moved or deleted. A tag is
selected by clicking on it. The selected tag flashes between its normal colour and light blue. It
can then be moved or deleted.

10.1 To Turn on Tag Display
The DA System has an overlay plane, which displays a set of coloured screen markings that
indicate tag marks and fixes; these markings are displayed over the sonar image, without
affecting the displayed data. You can toggle the display on or off, using the Display→Overlay
Data option. You should also turn off the scale line option.

10.2 Creating Tags
Selecting this menu item causes the mouse pointer to change to a pencil (see Section 3.6). If the
pencil is moved within the display area and the left mouse button pressed, a tag is marked. If the
menu item has been selected but no tagging is required, or if no further tags are to be added, re-
selection of the Add Tag Node (s) menu item causes the pencil pointer to be replaced by the
usual mouse pointer; the tagging operation is abandoned.
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To create a tag, do one of the following:

• Select Tagging→Add Tag Node(s). The ARROW pointer changes to a PENCIL pointer, which
indicates that the system is in add mode. Move the pointer to the required part of the display
screen and click with the left mouse button. This marks the event with an Unknown tag, an
orange box.

Repeat the procedure as often as required. When you have finished or when you want to
change to select mode – so that you can delete or move a tag – select Tagging→Add Tag
Node(s) again. This switches off add mode, and the pointer reverts to the arrow type.

• Move the pointer to the required part of the display screen and click the right mouse button
– a much faster method of creating tags.

Tags can also be added without the use of the Tagging menu, by positioning the mouse pointer
as required in the display area and pressing the right mouse button.

10.3 Selecting and Deselecting Tags
A tag must be selected and made the current tag before it can be moved or deleted.

• To select a tag, click on it with the left mouse button. The selected tag flashes between orange
and light blue and the pointer changes from a PENCIL to an ARROW, which indicates that the
system is in select mode. The selected tag can then be moved or deleted.

• To deselect a tag, click on it with the left mouse button or click on another tag. The tag stops
flashing and is no longer the current tag; it must be reselected before it can be moved or
deleted.

The current tag can be deselected by clicking on a tag-free area of the display, or by clicking on
another tag to make it the current selection.

10.4 Deleting Tags
 key shortcut: <Delete> or <k>

Selection of this menu item, or the letter <k> (for kill) or the <Delete> key on the leyboard,
deletes the current tag from both the Data Display Area and the tag database. After deleting the
tag, there is no current tag selected.

1. Select the tag to be moved by clicking on it.
The selected tag flashes between orange and light blue, indicating that it is the currently
selected tag.

2. Select Tagging→Delete Tag Node(s) or press the key short-cut, <Delete> or <k> (for kill).
The tag disappears from the display and is removed from the database.

If Delete Tag Node(s) is selected but there is no current tag selection, a warning appears in the
display area: ‘No nodes currently selected’.

10.5 Moving Tags
Move Tag Node(s) allows you to move a tag to a different position in the display. This function
can be selected from the Tagging menu, or by using the keyboard short-cut <m>.

Tag nodes must be selected before they can be moved. If Move Tag Node(s) is selected but no
tag nodes are selected, a warning will appear in the display area: ‘No nodes currently selected’.

Move Tag Node(s) allows tags to be moved within a data channel, but the DA System does not
permit tags to be moved between channels.

The move operation consists of two stages. First, the current tag is removed from the screen and
the tag database, and the pointer changes to the crossed arrows move tag pointer (see Section
3.6). Then the selected nodes are pasted back into the display area. This is done by moving the
pointer to the required point and clicking with the left mouse button. The tag remains active to
allow further actions (for example, measurements) to be taken. Incomplete moves may be
cancelled by pressing <m> again. 
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1. Select the tag to be moved by clicking on it.
The selected tag flashes between orange and light blue, indicating that it is the currently
selected tag.

2. Select Tagging→Move Tag Node(s) or use the short-cut key <m>.
The current tag disappears from the screen and the pointer changes to the crossed arrows
MOVE pointer. If no tag is selected, an error message appears.

3. Move the pointer to the new position for the tag and click the left mouse button.
The tag is pasted back into the display area. It remains active to allow further actions to be
taken. Incomplete moves may be cancelled by pressing <m> again.

4. When you have finished, deselect the tag by clicking on it or clicking on another tag.

10.6 Options Only Available in PI or GeoKit

10.6.1 Insert/Append Tag Node
This option is available only in PI100 or GeoKit.

10.6.2 Complete Multi-Node Tag
This option is available only in GeoKit.

10.6.3 Annotate Tag Node(s)
This option is available only in the PI100 or GeoKit. 

10.7 Replaying Tags
The DA System system automatically labels each sonar data file on a Coda format data tape or
disk with the file name of its associated tag file. If the selected tag file is in the tag file directory
of the DA System hard disk or optical disk, the tags in the file are automatically replayed along
with the data from the tape or disk during playback. Loading tag files from tape, saving tag files
to tape, and copying tag files to and from optical disk are described in Section 10.9.2.3 and
Section 10.9.3.1.

If the Overlay Data toggle in the Display menu is on, then the tags are overlaid on the sonar data.
If this toggle is off, the tags are still read from the file but are not displayed on the screen.

10.7.1 Using Goto to Replay a Tag
When the DA System is in playback mode the Goto command can be used to move between tags.
Refer to Section 6.7.4 for details of how to use the Goto command.

10.8 Setup Tags
Most of the facilities in this menu item are only useful for PI100 or GeoKit modules. However,
the colour used to display fix lines may be altered in this pop-up. Select the System Tab,
followed by the Fix Line item in the Tag Name list. Change the file line colour by selecting a
colour on the Tag Colour option menu below the Tag Name list. Once this has been applied, all
fix lines will be displayed in this new colour.

10.8.1 Fast Tag Setup
This option is available only in the PI100 or GeoKit.

10.9 Managing Event Database Files
During a long survey, a number of tag database files are created; these can easily be tens, or even
hundreds, of megabytes long. To cope with this, the DA System provides ways to manage the
tag database files; they enable you to load/save, copy and delete tag database files.
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The system automatically updates the list of files in the Tag Management pop-up after a Load/
Save, Copy or Delete operation has been carried out; it also updates the display of the amount
of hard disk space available.

The Rescan option, which forces an update of the list of tag database files and hard disk space,
is only needed when changes are made to the tag database files without the use of the Load/Save,
Copy or Delete options. For example, if you change the data tape or disk that you are playing
back, a tag file for the new tape or disk is created – if it doesn’t exist already. The new file,
however, will not automatically appear on the list of the tag database files if the Tag
Management pop-up is on screen; press the Rescan button to make it appear

Each tag database entry (fix or user-defined tag) uses about 2KB of file space. Keep a check on
the amount of disk space available to ensure that the hard disk does not fill up in mid-survey.

10.9.1 Loading, Saving and Copying Tag Files
Each recording session produces its own tag database file, which is named using the time that the
recording session started. Tag files tend to be very large, so they are stored on tape or disk, as
used for sonar data storage.

We strongly advise you to have a strict set of procedures for recording sonar data and tag
database files. For example, for a dual-drive system, we recommend that Tape 1 or Optical 1 is
used to record data, whereas Tape 2 or Optical 2 is used to store database tag files, using the
procedure listed below.

If a large amount of data is produced by Trackplot, Mosaic or Corrected Nav, the hard disk file
will eventually become full. A pop-up warning will appear warning you that your system is
running short of free disk space. If this warning appears the hard disk needs to be cleared, either
by backing up data to DAT or MO drives and then deleting the files from the hard disk, or by
deleting the files without backing them up. Data which is deleted without backing up will be lost.

10.9.2 Manage Tag Files on a Tape System
The Manage Tag Files menu item allows you to organise the many tag files which are created
during a survey. If you are using a tape system, selecting this menu item produces the Tag
Database Management pop-up shown in Figure 10-2, this page. If you are using an optical disk
system, see Section 10.9.3.

Figure 10-2  Tag Database Management Pop-up Window

DA System automatically names tag files according to the date and time when recording data
began (that is ddmmyy.hhmmss). The file system layout for DA System is discussed in Section
14.

The Database Location option button allows you to select the drive on which to locate the tag
files you wish to save, load or delete; only Hard Disk is currently available.
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When the Tag Database Management pop-up is opened, the default tag file selection is the
current tag file and this is the file highlighted on the list. The scroll bar can be used to move up
or down the list of Tag Files. A tag file can be selected by clicking on it with the left mouse
button. To make a multiple selection, either press and drag the pointer to highlight adjacent files
or hold down <Control> while clicking on specific file name.

The pop-up also displays the amount of space available on the hard disk. Each tag database entry
uses about 2KB of file space.

The Store and Factory buttons currently have no function in the tape system.

10.9.2.1 Saving Tag Files to Tape
Use the following procedure to save tag database files that are on the hard drive to tape.

1. Load a blank ‘tag file’ tape intoTape 2 (or the tape drive to which the sonar data is not being
recorded).

2. Select Tagging→Manage Tag Files.
The Tag Database Management pop-up appears.

3. Select the file or files currently on the hard disk to be save to tape. For one file, click on the
tag file name; for several files either press and drag the pointer to highlight a group of tag
files or hold down <Control> while clicking on the tag file names to make multiple selec-
tions. If necessary, scroll through the list of tag files to find the correct files.
The selected files are highlighted in black.

4. To save the selected tag files, collectively called a batch, click on the Load/Save button.
The Load/Save Tags to Tape pop-up appears.

5. In the Save frame of the pop-up, select Save Batch Overwrite or Save Batch Append either
to overwrite the data on the tape or to add the current batch at the end of the previous data on
the tape.

6. When prompted to load a tape into the appropriate tape drive, do so, if a tape is not already
loaded, and click on the OK button.
The system tells you when all the selected files have been saved to tape and rewinds the tape
to the beginning when the save is completed.

7. When the tag file has been written to tape, click on the Done button to dismiss the Load/Save
Tags to Tape and Tag Database Management pop-ups.

8. Remove the tape and write-protect it by sliding along the plastic tab. 

9. Mark the tape clearly with the tag file name or names.

For single-tape systems, a similar procedure should be followed, though tag files cannot be saved
to tape while the tape drive is being used for data acquisition or tape playback. Tag files can,
however, be saved to the hard drive. You have to eject a data tape from the system before you
can select Load/Save.

10.9.2.2 Loading Tag Files from Tape
When playing back data tapes, you may need to reload a set of saved tag files.

Note: Loading tag database files with the same name as any files currently on the hard disk will cause the
files on the hard disk to be overwritten.

Note: The Load Remote option does not relate to loading tag files from tape. To use this option, contact
Coda Technologies.

To load tag files from tape to hard disk:

1. Select Tagging→Manage Tag Files.
The Tag Database Management pop-up appears.

2. Click on the Load/Save button.
The Load/Save Tags to Tape pop-up appears.

3. In the Load/Verify frame of the pop-up, select List All Batches to find the position of the
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batch that contains the required tag file.

4. In the Load/Verify area of the pop-up, select Load Batch.
The system prompts you to load the tag file tape into the appropriate tape drive.

5. When the tape is loaded, click on the OK button.
The tag file or files from the batch are loaded automatically and the tape is rewound to the
beginning.

• If you have problems loading tag files, eject and reload the tag file tape to make sure that
it returns to the start of the tape.

6. Remove the tag file tape from the drive and store it safely.

Note: If a tag file copied onto the system’s hard drive is updated during playback, remember to re-save the
modified tag file to tape, either on a new tape or at the end of an old tag file tape.

10.9.2.3 Tape Load/Save

Figure 10-3  The Load/Save Tags to Tape Pop-up Window

This pop-up allows you to load tag files from tape to hard disk, save tag files to tape and also to
list tag files which have been saved to tape previously. For single tape systems, tag files cannot
be accessed on tape while the tape drive is being used for any other purpose (that is data acqui-
sition or playback).

Note: Tag files and sonar data should be saved to different tapes to prevent data being accidentally
overwritten.

Saving Batches
When tag files are saved, each separate save writes a batch of tag files to the tape. The batch
contains the highlighted tag files in the Tag Database Management pop-up and can therefore
contain one or more tag files. Batches can be saved to the tape one after another, but tag files can
be loaded only one batch at a time. Thus, if three tag files were saved as three separate batches,
all three files would have to be loaded individually, whereas if they were saved as a batch
consisting of the three files, they could be loaded together using the Load Batch option. There
is no limit to the number of tag files which can be saved as a single batch.

Tag files are selected for Save by clicking the left mouse button on the tag file name in the list
of tag files. If more than one tag file is to be saved, either press and drag the left mouse button to
highlight a group of tags, or hold down <Control> while clicking on the tag file names to add
more tag files to a group.
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Listing Batches

Figure 10-4 : The Batch File List Pop-up Window

Batches are read and written to tape sequentially; after a batch has been saved, the tape is
therefore positioned at the end of that batch. To verify that a batch of newly saved tag files
contains the appropriate files, the List Prev Batch option should be used. All the batches on a
tape can be listed by clicking on the List All Batches button. This is useful for determining which
batch on a tape contains the required tag file.

Note: Listing a batch causes the batch to be read but not loaded. The tape is therefore left at the end of a
batch after a list request.

Tape Movement
The Tape Movement commands in the pop-up can be used to move backwards or forwards
through successive batches.

Loading Batches
A batch of tag files can be loaded from tape using the Load Batch option. If this is selected, a
pop-up appears with the message ‘Insert tape in tape drive 1 and press OK’ (or tape drive 2,
depending on which tape drive is available). DA System then loads a batch of tag files from the
tape drive into the tag file directory on the system hard disk, and indicates that this is taking
place.

Note: If any of the tag files on the tape have the same name as those already in the DA System tag file
directory, they will overwrite the files on the hard disk.

The tag database files are saved in binary, machine-readable format using this command. To
access the database in an ASCII format suitable for import into spreadsheets, databases and word
processing packages, use the Report Generation option (see Section 10.10.2).

Load/Save Command Summary
• Load Batch loads the batch file recorded at the current tape position.

• Load Remote allows a tag file to be loaded from another DA System system on the same
Ethernet network. Contact Coda Technologies for further information.

Figure 10-5 : The Load Remote Tag File Pop-up Window
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• List Batch lists the batches on a tape before loading. Before using this option, the tape must
be rewound. When the tag file details have been checked, the pop-up is dismissed by clicking
on the Dismiss button at the bottom of the pop-up.

• List Previous Batch displays details of the previous batch of tag files on the tape, relative to
the current tape position.

• List All Batches displays details of all the batches of tag files on the tape.

• Save Batch Overwrite saves a batch file, overwriting any data already on the tape. The tape
is automatically rewound to the beginning before saving the batch.

• Save Batch Append saves a batch file to the end of existing data on the tape. The tape is
wound forward automatically to the end of any data on the tape before the batch is saved.

• Rewind rewinds the tag file tape to the beginning.

• Next Batch moves the tape forward by one batch to the start of the next batch.

• Previous Batch moves the tape backward by one batch to the start of the previous batch.

10.9.2.4 Delete
If tag files are no longer required, or if they have been saved to tape, they may be deleted from
the tag file directory on the system hard disk. The selection process is as outlined in Save (see
Section 10.9.2.3).

Make single selections by clicking the left mouse button, and multiple selections by either
clicking and dragging or by clicking with <Control> held down. Once the selection process has
been completed, click on the Delete menu item. A pop-up will appear, to ask ‘Are you sure?’; if
you click on Yes, the highlighted tag files will be deleted. Any tags currently on the screen which
were in the deleted tag files will be automatically removed from the screen.

10.9.2.5 Rescan
Rescan causes the directory entries of the tag file directory on the system hard disk to be re-read,
updating the list of tag files in the Tag Database Management window (see Section 10.9.2).
This should be carried out after loading or deleting tag files, as described above.

10.9.3 Manage Tag Files on an Optical Disk System

Figure 10-6 Tag Database Management Pop-up Window

If you are using an optical disk system, selecting the Manage Tag Files menu item produces the
Tag Database Management pop-up shown in Figure 10-6, this page. It allows you to organise
the many tag files which are created during a survey.

DA System automatically names tag files according to the date and time when recording data
began (that is ddmmyy.hhmmss). The file system layout for DA System is discussed in Section
14.
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The Database Location option selection button displays the drive on which the tag files will be
created. (A list of files on that drive is displayed in the Tag Files window.) It is also the drive
from which files will be deleted and the source for files to be copied. In Figure 10-6, this page,
Database Location is set to Optical 1. Clicking on the option button displays the other options
available: Optical 2 (in a dual drive system) and Hard Disk.

The Tag Files window displays all the tag files that appear on the selected database location. A
tag file can be selected by clicking on it with the left mouse button. To make a multiple selection,
either press and drag the pointer to highlight adjacent files or hold down <Control> while
clicking on specific file name. The scroll bar can be used to move up or down the list.

The pop-up also displays the amount of space available on the hard disk. Each tag database entry
uses about 2KB of file space.

The Store action button at the bottom of the pop-up gives you the option of storing the currently
selected database location as the default location. Clicking on the Factory button will restore the
database location to Hard Disk.

10.9.3.1 Copy Tag Files

Figure 10-7 Copy Tag Files Pop-up Window

The Copy Tag Files pop-up lets you select the target drive for the tag files that you wish to copy
and to direct the system to copy those files from the source database location to the target drive.

To copy tag files, you must first have selected the source drive (Database Location) of the tag
files that you wish to copy and have highlighted the relevant tag files from the list in the Tag
Files window. Clicking on the Copy Tag Files button produces the Copy Tag Files pop-up. The
target drive for the tag files can be selected using the Copy selected files to: option selection
button; the options available are Hard Disk, Optical 1, and Optical 2 (in a dual drive system).
When you click on the OK button, the system automatically copies the files from the source
database location to the target drive. To check that the tag files have been copied to the new
location, you can select the new database location and see that the tag files appear in the Tag
Files window. 

10.9.3.2 Copying Tag Files
The optical disk system has a Copy Tag Files option selection button instead of a Load/Save
button. You can use the copying option to copy tag database files from the hard disk to an optical
disk and vice versa, or from disk to disk.

1. Load a blank ‘tag file’ disk into Optical 2 (or the disk drive to which the sonar data is not
being recorded).

2. Select Tagging→Manage Tag Files.
The Tag Database Management pop-up appears. The name of the current tag database file
is displayed on the title bar.

3. Select the location of the tag database files to be copied: Hard Disk, Optical 1 and Optical 2
(in a dual-drive system).
The names of the files appear in the Tag Files window.

4. Select the files to be saved. For one file, click on the tag file name; for several files either
press and drag the pointer to highlight a group of tag files or hold down <Control> while
clicking on the tag file names to make multiple selections. If necessary, scroll through the list
of tag files to find the correct files.
The selected files are highlighted in black.

5. Click on the Copy Tag Files button.
The Copy Tag Files pop-up appears.
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6. Select the destination of the files: Hard Disk, Optical 1 and Optical 2 (in a dual-drive system)

7. Click on the OK button.

10.9.3.3 Deleting Tag Files
The procedure for deleting tag files is similar to that of copying tag files. First, the source of the
tag files must be selected in the Tag Database Management pop-up, using the Database
Location option selection button. Then, the files that you want to delete must be selected from
the list that appears in the Tag Files window. Clicking on the Delete button then deletes the files
from the database. 

10.9.3.4 Rescan
This button updates the list of files in the Tag Files window and the disk space available either
on the system hard disk or on the selected optical disk. This can be carried out after copying or
deleting tag files, as described above.

10.9.3.5 Unmount
This button directs the optical disk drive to unmount the disk. It must be selected before the
optical disk can be ejected from the optical disk drive.

10.9.4 Deleting Tag Files
You may want to delete tag files from the hard drive – or from an optical disk – either because
you no longer need them or to free up space on the hard disk or optical disk. The Tag Database
Management pop-up displays the amount of free space available.

1. Select Tagging→Manage Tag Files.
The Tag Database Management pop-up appears.

2. Do one of the following:

• If you are using a tape system, scroll through the list of tag files currently on the hard disk.

• If you are using an optical disk system, select the location of the tag database files to be
deleted: Hard Disk, Optical 1 or Optical 2 (in a dual-drive system). Scroll through the list
of tag files available.

3. Select the files to be deleted. Click the left mouse button on a tag file to make an individual
selection; press and hold the <Control> key to make multiple selections; or press and drag
to select a block of tag files.
The selected files are highlighted in black.

4. Click on the Delete button, and press <y> when asked to confirm the deletion.

Figure 10-8 The Tag Setup System Tab
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Figure 10-9 The Tag Setup Single Tab

10.10 Report Setup and Generation

Figure 10-10  The Reporting Menu

This menu allows you to generate text reports in ASCII format from the contents of tag database
files; this is necessary because the tag database files are stored in binary, machine-readable – but
not human-readable – format. The report files generated can then be saved to floppy disk or
output to the screen or a printer.

10.10.1 Generating Tag Database Reports
Tag database files are stored in binary, machine-readable format, which enables them to be read
and interpreted quickly by the DA System. But binary is not a human-readable format, so the
files are put into ASCII form, using the Reporting menu option. The tag database reports that are
generated in ASCII format can then be viewed on screen, printed to the printer defined by the
Printer Setup menu (see Section 9.2.1) or saved to floppy disk. Floppy output of a report
requires a blank DOS-formatted floppy disk to be present in the floppy disk drive, and saves the
report to the disk, which enables it to be imported by charting, CAD, database, spreadsheet or
wordprocessing packages.

To generate a tag database report in ASCII format:

1. Select Reporting→Report Setup.
The Report Setup pop-up appears.

2. Click on the Format tab and select the format required for the report or load a previously
saved setup. When finished click on the OK button.
This tab form allows you to change the columns reported and their order from the default.

3. Click on the Options tab and select the options required for the column separators, report
labels, sort order and text string.
The options for dual tags and multi-node tags do not apply to the DA System.

4. Click on the Contents tab and define the tag types to be included in the report; although the
only tag type which can be created on the DA System is ‘Unknown’, changes to the tag types
may be necessary if the active database is one loaded from GeoKit or the PI100.

5. Select the Reporting→Report Generation option.



DRAFT
154 May 2001 for version 2.1        

U
si

ng
 th

e 
D

A
 

S
ys

te
m

The Report Generating pop-up appears.

6. Select the tag file for which you wish to generate a report.
If a tag file has been created for the data currently in use, this file is automatically highlighted
in the pop-up.

7. Select the report destination: Text Window, Printer or Floppy.

8. Click on the Generate Report button.

10.10.1.1 Report Setup
The Report Setup pop-up provides the options for defining the contents and style of the report.
Each of the aspects of the Report Setup has its own list of options, contained on the appropriate
tab form pop-up: Format, Options, Contents.

At the bottom of the pop-up, you have the option to Load a previous report setup, or Save the
current setup for future use, in addition to Cancel, Apply, and OK. These buttons apply to all
three tab forms in the Report Setup pop-up window, resulting in a single combined report setup.
Section 3.3.11 and Section 3.3.12 describe how to load and save settings.

Note: It is important to realise that within the Report Setup menu are options which do not apply to tag files
created using the DA System, and that changing the setup of these options has no effect on the report
generated. These items are, however, relevant where the tag file being played back using the DA System was
itself created using a Coda module with enhanced tagging features, such as GeoKit or the PI100.

Report Setup Format

Figure 10-11 The Report Setup Format Tab Form

Clicking on the Format tab of the Report Setup pop-up allows you to alter the number of
columns reported and the order in which they are printed. Report column entries may be added
or deleted. To do so, select one of the report columns from the scrolling form by clicking on a
column number. The Add Item or Delete Item button should then be selected.

You may define some or all of the following parameters for each column in the report.

• Label allows you to define the label for each column in the report.

• Width allows you to specify the width of each column.

• Precision allows you to define the number of figures after the decimal point for non-integer
numbers in the report.

Examples of a number of the available column types are listed below.
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• Anomaly Number: the client anomaly ID entered in the Annotate Tag Node pop-up.

• Tag Name: the tag type selected. Tags created using the DA System are always ‘Unknown’.

• Kp: the geo-corrected Kp position of the event tag.

• Easting, Northing: the geo-corrected position of the event tag. If the nav input used is UTM,
then Easting and Northing are given; if the nav input used is lat/long, then latitude or
longitude is given.

• Length, Height and Width: the dimensions of the anomaly entered either using the Annotate
Tage Node pop-up, or by automated measurement by the PI100 module.

• Tag ID: the system’s tag ID. This field can be used with Goto Tag ID to goto this specific tag
on the data tape or disk (see Section 10.7.1).

• Description: text entered in the Annoate Tag Node pop-up of the Tagging menu.

A complete list of the reportable items available, with a brief description of each of them, can be
found in the GeoKit User Manual.

Add Item

Figure 10-12  The Add Item Pop-up Window

Clicking on the Add Item button opens a pop-up window (see Figure 10-12, this page). This
produces an alphabetically sorted list of report column types available in GeoKit and the PI100,
as well as the DA System. It is used to produce reports with the DA System from data collected
using other Coda modules. Thus, the report column types listed are not all available when the
data has been collected using the DA System, and selecting such items results in field entries
such as ‘0.0’ and N/A’.

In this pop-up you can select items from the scrolling list by clicking on the names in the list and
you can specify their position in the report by clicking on either the Before current selection
button or the After current selection button. 

The appropriate action button at the bottom of the pop-up (Add or Done) should be clicked on
when all items have been added. Alternatively, double-click on the item to add it to the report.
Multiple selections may be made by using a press and drag action over the required item in the
list.

Delete Item and Delete All Items
The two delete buttons on the Format tab allow you to delete either the selected entry (Delete
Item) or all the entries in the report (Delete All Items).
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Report Setup Options

Figure 10-13  The Report Setup Options Tab Form

The Options tab allows you to specify how the report is constructed. Figure 10-13, this page,
shows the options available.

Report Separator
The options within this section of the pop-up allow you to select the type of separator for the
columns of the report from the one-of option switches: Tab, Space, and Comma. Tab inserts a
single tab character between columns, Space inserts a single space, and Comma inserts a single
comma with no additional spaces.

Report Headings
This allows you to toggle on or off the labels at the top of the report columns.

Dual Tags
This option is only available when the database in use has been created using the PI100 Pipeline
Inspection module. They have no effect on a database created by DA System.

Multi-Node Tags
This option is only available when the database in use has been created using GeoKit. They have
no effect on a database created by DA System

Sort Order
This option allows you to choose whether to sort by Time, or by Kp, and whether these should
appear in increasing or decreasing order in the report.

Text Strings
You can select either to Enclose text in double quotes, or to Replace spaces with under-
scores. This can be used to ensure that columns whose output contains spaces are not created as
several columns when input to another computer package. You should choose the output best
suited to the software the report will be used with.
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Report Setup Contents

Figure 10-14  The Report Setup Contents Tab Form

This pop-up allows you to define which tag types should be included in the report and the order
in which they should appear (see Figure 10-14, this page). For example, you may wish to exclude
Fix Lines from the report.

This form contains a scrolling list of the active System and User tags, as well as Add Tag, Delete
Tag, Add All Tags and Delete All Tags buttons. The functions of these buttons are described
below. Before tags can be added or deleted using these buttons, they must be selected from the
scrolling list by clicking on their names. Single selections can be made by clicking on the
required tag’s name; multiple selections can be made using a point and drag action on the names
of the required tag types, or by pressing <Control> at the same time as pressing with the left
mouse button. It is not possible to add the same tag name more than once to the report contents
list.

Any changes made in this form will be confirmed or cancelled when one of the action buttons at
the bottom of the pop-up is pressed.

Add Tag
Clicking on this button adds the currently selected tag to the list of tag types which appear in
reports produced using the current tag database.

Delete Tag
Clicking on this button removes the currently selected tag from the list of tag types which appear
in reports produced using the current tag database.

Add All Tags
Clicking on this button adds all of the currently active tag types to the list displayed on the
Contents tab form.

Delete All Tags
Clicking on this button deletes all of the currently selected tag types from the list displayed on
the Contents tab form.

10.10.1.2 Generating Reports Using a Corrected Nav Data File
1. Acquire the data as usual, creating event tags as required.

All the tag database entries contain raw navigation data at this point, so the report files are
uncorrected.

2. With the DA System in playback mode, select File→Corrected Nav Input.
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The Corrected Nav Input pop-up appears (see Section 6.6.1).

3. Select the location of the corrected nav file:

• Floppy: If floppy disk is the source, insert the appropriate floppy disk into the disk drive.

• Hard Disk: If the hard disk is the source, select a file from the File Selection window that
appears.

4. Select Settings and click on the Corrected button in the Nav Data Type area of the pop-up
(see Section 6.6.2).

5. Follow the steps to generate a event database report in Section 10.10.1.

The report generated contains only corrected navigation values, as all the raw navigation data is
corrected automatically.

10.10.2 Report Generation

Figure 10-15  The Report Generation Pop-up Window

The Report Generation pop-up allows you to generate one or more ASCII text reports in the
style defined by the Report Setup (see Section 10.10.1.1). To select a report for output, click on
the appropriate entry in the scrolling list. (The current tag database will always be selected when
the window first pops up.) You can select more than one tag file by pressing and dragging over
the required files or by holding down <Control> while clicking on the tag file names. To generate
the report, click on the Generate Report button. The watch pointer will appear while the report
is being generated. Alternatively, double clicking on the tag file name or pressing <enter> will
automatically generate a report to the selected output device.

The buttons in the Output Report To frame allow you to select the destination for the report file.
The Printer option is available only if a suitable hardcopy device is connected to the DA System
(see Section 4.3)

If Text Window is selected from the output options, a report file is generated by the system and
displayed in a text window which is overlaid on the screen. You can scroll through this window
to view its contents (Figure 10-16, page 159).
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Figure 10-16  Report File Displayed in Text Window

If output to Printer is selected, the report file is sent to the printer, according to the options
selected in the Printer Setup menu (see Section 10.10.2.1). The printing process can be stopped
at any point by pressing the Cancel button.

If the output is to be saved to a floppy disk, Floppy Disk should be selected, and a blank DOS-
formatted floppy disk inserted in the floppy disk drive and a DOS file name given to the disk.
After Generate Report is clicked, a further window will appear asking for the name under which
the report file should be saved to the floppy disk. Once the name has been entered, press OK to
start copying the report file to disk. The report file saved to disk will be an ASCII dump of the
database contents, in exactly the same format as the report sent to a printer, or to the screen. All
files are saved with the extension ‘.rep’.

Note that the size of ASCII file which can be copied to a floppy disk is limited to the formatted
capacity of the floppy disk – normally 1.44 MB.

Note: If the system is being used for data acquisition or playback, the process of saving a report file to floppy
disk will take longer to complete. To speed up the process, pause the display until the report file has been
saved to the floppy disk.

10.10.2.1 Printer Setup Window

Figure 10-17  The Printer Setup Pop-up Window

Selection of the appropriate printer port is made by clicking on the port to which the printer is
connected. If the port is a serial port (one of the Com ports), the Serial Setup button should be
clicked to set up the serial line parameters.

Either Portrait or Landscape Format may be selected for PostScript® printers by clicking on
the appropriate toggle. Where a printout is being saved in ASCII format, this selection does not
apply and will therefore be ignored. Type allows a choice of ASCII or PostScript® printer.
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Once the required selections have been made, the appropriate action button at the bottom of the
pop-up should be clicked on.

Note: The printer should be connected to the required port of DA System before OK or Apply is clicked (see
Section 4.3 and Appendix J).
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11 Making Backup Copies

You will probably want to make backup copies of the data acquired by the DA System. You may
also want to change the recording from Coda format to another format. This section describes
how to make copies of data tapes and disks. 

To make a copy of a data tape or disk, you must have a dual-drive DA System. Note that when
copying tapes or disks, the raw navigation data is always copied, regardless of the presence of
corrected navigation data.

On a tape system, you can select the format in which the target tape is to be copied; that is, you
can copy a tape recorded in Coda, SEG-Y, SDEF or Q-MIPS™ compatible format onto another
tape in any of these formats. Bear in mind, however, that multi-trigger data cannot be copied
from Coda format into other data formats, and that copying from Coda format to another data
format always results in loss of navigation information.

Another point to bear in mind: If you choose to copy the target tape in Coda format, the data is
copied in the current version of Coda format. This means that the target tape may be recorded in
a more recent version than the source tape if the latter was also in Coda format.

On an optical disk system, only Coda format is available.

11.1 Copy Media on a Tape System

Figure 11-1 The Tape Copying Pop-up Window

The File→Copy Media menu option allows you to make backup copies of data tapes and also to
copy the data on tape to a different format; however, it is only possible if you have a dual drive
DA System.

Note: When copying tapes the raw navigation data is always copied, regardless of the presence of corrected
navigation data. You can reapply corrected navigation on the copied data by copying the nav file and
reapplying (see Section 6.6.1, Appendix C).

The Copy Source tape and to Target tape option selection buttons display the drives from
which the data will be copied and to which the data will be written. The default setting is to copy
from Tape 1 to Tape 2, but the setting can be changed by setting the option selection buttons.

The tape operating system automatically detects the data format on the source tape and offers a
choice of formats for the target tape in the Target Data Format frame. A format is selected by
clicking its one-of selection switch.

The Tape Copy Mode one-of selection switches allow you to choose whether to add the data you
are copying to the end of the existing data on the target disk or to rewind the target tape and
overwrite the existing data.
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The Target File Size frame provides the options of limiting the file size when writing to the tape,
by editing the text-entry box under Limit Size to (MB), or by default to keep the file size the same
as the original (Same size as source).

Finally, depending on the format into which you have chosen to copy the data, you can select
whether to copy all triggers or only specific ones with the data, using the Triggers to Copy one-
of selection switches. 

A number of limitations exist when copying data:

• Multi-trigger data cannot be copied from Coda format into other data formats.

• Copying from Coda format to another data format always results in the loss of navigation
information; for example, fix marks are not copied into SDEF format.

• Copying from Coda format to SDEF format results in the loss of channel information, so all
channels subsequently show as PORT when data in this format is played back.

• If copying to Coda format, the data is copied in the current version of Coda format. This
means that the target tape may be recorded in a more recent version than the source tape if
the latter was also in Coda format.

Note: In order to copy part of a tape, goto appropriate start point and then copy from there. Pressing cancel
whilst copying will stop the copy at that point. It will not cancel the complete copy.

Note: No well-defined, universally accepted standards exist for the storing of sidescan and sub-bottom
profiler data to SCSI tape devices. It is therefore possible that data tapes not recorded on the DA System may
not be able to be copied using this facility. If this is the case, contact Coda Technologies for further help.

11.2 Copy Media on an Optical Disk System

Figure 11-2 Copy Media Pop-up Window

This menu option allows you to copy data from optical disk to optical disk; however, it is only
possible if you have a dual drive DA System.

The From Source Device and To Target Device option selection buttons display the drive from
which the data will be copied and to which it will be written. The default setting is from Optical
1 to Optical 2. Clicking on the option buttons displays the other options available.

The Store action button at the bottom of the pop-up gives you the option of storing the currently
selected source and target drives as the default setting. Clicking on the Factory button restores
the source disk drive to Optical 1 and the target disk drive to Optical 2.
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Figure 11-3 Copy Information Pop-up Window

When you start Copy, by pressing OK or Apply in the Copy Media pop-up, the Copy Infor-
mation pop-up window will appear (see Figure 11-3, this page). This pop-up shows which files
have been copied and indicates the progress of the copy. You can stop the copy at any time by
clicking on the Copy Cancel button.

Two scale bars at the top of the pop-up indicate the amount of data transferred for the whole disk
and the current file respectively. Copying is complete when the top scale bar reaches its
maximum value.

Data files are copied first, followed by tag files, setup files, navigation files, corrected nav files,
report files and project files.

To copy an optical disk:

1. Select File→Copy Media.
The Copy Media pop-up appears.

2. Select the source disk drive and the target disk drive, using the option selection buttons.
Files can be copied to: Hard Disk, Optical 1 and Optical 2 (in a dual-drive system).

3. Click on the OK button.

The Store action button at the bottom of the pop-up gives you the option of storing the currently
selected source and target disk drives as the default setting. Clicking on the Factory button
restores the source disk drive to Optical 1 and the target disk drive to Optical 2.
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12  System Maintenance and Testing

12.1 Off-line Testing
When mobilising the DA System on board a vessel, it may be useful to carry out some or all of
the off-line tests described below; they allow the system to be checked for ‘sane’ operation
without the use of external inputs from sidescan units or navigation computers. A minimal
amount of equipment is needed to carry out these tests. The flow chart below indicates the
recommended order for completing the off-line tests.

12.1.1 Test Incoming Data Using A/D Internal Triggering
Set up the DA System for acquisition, using the internal trigger (INT) set to a period of 0.1
seconds. When the Play data control button is pressed, data should begin to scroll down the
screen. The digitised data will be whatever signals are present at the analogue BNC inputs.

12.1.2 Navigation Loopback
Plug a 9-way or 25-way D-type connector with pins 2 and 3 shorted together into the COM2
(navigation data input) connector. This can be done with the system powered up. Click on the
Title Bar with the right mouse button (see Appendix A), and select the Start Loopback Test
menu item. From the second Nav Loopback Menu that this produces, select the Coda format nav
string. Start the DA System in acquisition mode, then open navigation input and select the Coda
data format. Select Nav input on in the Nav Data Input menu, then click on the Nav Format QC
button to make sure that navigation data is being acquired correctly by the system (see Section
5.4.4). The system generates a beep every time a navigation string is output through the serial
port, until the End Nav Loopback Test item in the Title bar menu is selected.

12.1.3 Record/Playback
Having completed the two tests above, insert a blank tape or optical disk into the relevant drive,
and begin recording (see Section 5.2). Allow several minutes of recording to take place, stop
recording. Attempt to play back the data, checking that the time and position are updated
correctly.

12.1.4 Off-line Noise Test
Short the signal input by attaching a 50Ω termination BNC connector to the input channel
Perform the test in Section 12.1.1. The displayed data should be a flat line with noise no greater
than one binary digit on the Input Range of the Scale Display Data pop-up window. Repeat this
for each channel.

12.2 The Title Bar Menu

Figure 12-1 The Title bar Menu

The DA System provides additional commands through its Title Bar menu. You use this pull-
down menu when you want to test navigation loopback data, change the size of the main display
and restart the programme.

The Title bar menu is accessed by clicking and holding the right mouse button on the Title Bar,
which is displayed across the top of the DA System main display, see Section 3.1. 

Having selected the Title bar menu, drag the pointer to the menu item required (see Figure 12-1,
this page).
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12.2.1 Start Nav Loopback Test
When you select Start Nav Loopback Test, the Nav Loopback Menu appears. It lists several
navigation formats (see Figure 12-2, this page). Clicking on one of these formats starts a program
that synthesises navigation data output. When the appropriate loopback connector – a 9-way or
25-way D-type connector with pins 2 and 3 shorted together – is connected to the COM2 port,
the DA System’s navigation interface can be tested, as described in the Off-line Testing section.
Clicking on another format ends the loopback test and starts another one. While the loopback
program is running, the DA System beeps continuously.

Figure 12-2 The Nav Loopback Menu

12.2.2 End Nav Loopback Test
Titlebar Menu→End Nav Loopback Test stops the program generating navigation loopback
data. If the nav loopback program is not running, selecting this menu item has no effect.

12.2.3 Restore
Restore returns the DA System main display to its full size if it has been iconified. This option
is unavailable if the DA System is not iconified.

12.2.4 Minimise
Minimise reduces the DA System main display to an icon displayed on the Coda background
window.

12.2.5 Lower
Lower moves the DA System display window into the background. This menu item has an effect
only when there is more than one window open.

12.2.6 Restart DAx00
This option closes the current DA System display and restarts the DA System. This stops all
recording and automated analysis.

12.3 The Maintenance Menu
The Maintenance Menu contains several commands that are not required for everyday operation
of the DA System. These include installing a software upgrade, loading a navigation library,
backing up tag setup files and changing various system settings.
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You access this menu by iconifying the DA System main display; this is done either by pressing
<Alt-F9> or by clicking on the iconify symbol in the top right corner of the Title Bar (see Figure
3-2, page 21). When the main display is iconified and the background Coda window is revealed,
press <Alt-Shift-m> to bring up the Maintenance Menu.

The commands that appear on the Maintenance Menu differ slightly, depending on whether you
are using a tape system or an optical disk system (see Figure 12-3, this page). The tape system
has an Erase Tape command, whereas the optical disk system has three alternative commands:
Format Optical Disk, Repair Optical Disk and Unmount All Disks.

Figure 12-3 The Maintenance Menu for a tape system (left) and an optical disk system (right)

12.3.1 Install Update

Caution: The DA System system must be shut down – by selecting Shutdown from the
File menu – at the end of installing a software update. Failure to do so may cause the
system to malfunction.

Note: Before selecting this item, make sure that the tape or optical disk drives are not in operation. If you are
unsure about the status of the drives but wish to continue with maintenance, restart the DA System by
selecting Restart from the File menu. 

Note: The default Nav Lib file will be automatically overwritten when the update is installed, so it is important
to remember to save the current Nav LIbrary before installing an update.

This menu item is used to install a software upgrade from DAT or Exabyte tape, floppy disk or
optical disk.

When Install Update is selected, the system asks for the install password. If the password is
typed correctly, the following set of instructions and questions appear in the update window.

‘Do NOT switch off power during installation.
WARNING: During update installation the system will be
restarted and all playback and acquisition will be aborted.
Do you wish to proceed with the installation (default:n)?[y,n]’

Press <y> to start the installation process.

A prompt appears asking for the source of the update:

‘Do you wish to install the update from diskette, tape or optical (default:d)? [d,t,o]’

Press either <d>, <t> or <o> and then press <Return>.

Note: The following example is for installation from a tape. If the update is from floppy disk or optical disk,
similar messages and prompts appear.

When tape is selected, the following prompts appear:
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‘Insert the update tape into a tape drive NOW.’
‘Which tape device do you wish to install the update from (default 1)? [1,2]’

The default is to install from tape drive 1.

Insert the update tape into a tape drive. Press either <1> or <2> and then press <Return>.

The system informs you that the previous DA System software is being saved:

‘Saving previous DAx00...’

A prompt appears asking for the update tape to be inserted:

‘Insert a cartridge into Tape Drive 1.
Type [go] when ready,
or [q] to quit: (default: go)’

Type <go> or press <Return>.

Do not attempt to eject the tape until the update has finished.

The installation process then lists the packages on the tape:

‘The following package(s) are available:
1 UpdToCurr Coda Technologies DA System Update Package
(i386) Tue Jul 02 13:05:41 1998
Select package(s) you wish to process (or ‘all’ to process
all packages). (default: all) [?,??, q]:’

Type <all> or press <Return> to continue, or press <q> to abort the update.

As the update progresses, various messages may be printed to the screen. These are a normal part
of the update installation and require no action by you.

If the update package is a new software version, the system automatically backs up the previous
software configuration on disk.

The system is automatically re-booted to make sure that all of the software modifications in the
update take effect. 

Some packages, however, may require more than one disk or tape, in which case the following
prompt appears:

‘Insert a cartridge into Tape Drive 1.
Type [go] when ready,
or [q] to quit: (default: go)’

Insert the next disk and type <go> to continue the update. The disks should be inserted in the
order indicated on the labels. Follow the instructions above until all the update disks have been
used. When all the disks have been used, press <q> to the above prompt.

The system is automatically re-booted to make sure that all of the software modifications in the
update take effect.

12.3.2 Restore Previous

Caution: The DA System system must be shut down – by selecting Shutdown from the
File menu – at the end of installing a software update. Failure to do so may cause the
system to malfunction.

Note: Before selecting this item, make sure that the tape or optical disk drives are not in operation. If you are
unsure about the status of the drives but wish to continue with maintenance, restart the DA System by
selecting Restart from the File menu.

This menu item is used to restore the previously installed system update, returning the system to
its state before the update was applied.

When Restore Previous is selected, the system asks for the install password. If the password is
typed correctly, the following set of questions appear in the maintenance window:
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WARNING: During update installation the system will be
restarted and all playback and acquisition will be aborted.
Do you wish to proceed with the installation (default:n)?[y,n]’

Press <y> to start the installation process.

The following prompt then appears:

‘Do you wish to retain your current navlib (default: y)? [y,n]’

The default is to retain your current navigation library.

Press <y> or press <Return> to save this file; otherwise press <n>.

A prompt appears asking whether to proceed with restoring the previous DA System as follows:

‘Are you sure you wish to restore the previous DAx00? (default: y) [,n]’

Press <y> to confirm the request.

The restoration proceeds automatically and the operating system of the DA System is rebuilt.

12.3.3 Copy Update Package
This menu item is used to create a backup copy of an update package on tape or optical disk. The
following example is for installation from a tape. If the update is from optical disk, similar
messages and prompts appear.

When Copy Update Package is selected, the system asks for the install password. If the
password is typed correctly, a prompt appears, asking for the source update tape to be inserted
into the tape drive.

‘Which tape device do you wish to copy from (default: 1)? [1,2]’

Insert the update tape into the tape drive. Press either <1> or <2>, and then press <Return>.

‘Insert a cartridge into Tape Drive 1.
Type [go] when ready,
or [q] to quit: (default: go)’

Type <go> or press <Return> to continue.

The system informs you that the update package is being transferred.

‘Transferring <UdpToCurr>. Package instance to
<\home\install\spool>in file system format’.

The package details then appear on screen.

‘Insert the target update tape into a tape drive NOW,
then press any key to continue.’

Insert a blank tape into the tape drive.

‘Which tape drive do you wish to copy to (default: 1)? [1,2]’

Select the tape drive to be used to copy the tape to and press <Return>.

The following message appears on screen.

‘Insert a cartridge into Tape Drive 1.
Type [go] when ready,
or [q] to quit: (default: go)’

Type <go> or press <Return>.

The system transfers the package to the drive specified and exits when it has finished.

12.3.4 Change IP Address
This menu item is used to change the IP address of the system.

When Change IP Address is selected, the system asks for the install password. If the password
is typed correctly a warning appears in the maintenance menu:
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WARNING - After this process has finished the system will be restarted and all playback and
acquisition will be aborted.

“Do you wish to proceed (default: n)? [y,n]”

Press <y> to proceed.

The system then prompts for the name of the system. Enter the name and press <return>.

A message appears giving the current system name and IP address.

Enter the new IP address and press <return>.

A message appears asking for confirmation of the new IP address. Press <return>.

The next message requests the subnet mask. Enter the default <return>.

A message will appear confirming the IP address update and will ask whether another IP address
is to be changed (default n).

Press <return>.

The system will now shut down and re-boot.

12.3.5 Load Navigation Lib
This menu item is used to load a navigation format library from a DOS-formatted floppy disk.

When Load Navigation Lib is selected, the system asks for the install password. If the password
is typed correctly, a prompt appears, asking for a diskette to be inserted into the floppy disk drive.

‘Insert a diskette into Floppy Drive 1.
Type [go] when ready,
or [q] to quit: (default: go)’

Insert a diskette and type <go> or press <Return>.

The diskette is expected to contain a file called NAVLIB.USR which should be your navigation
format library. A prompt asks if the current nav format library is to be overwritten:

‘Are you sure you wish to overwrite your existing navigation library (default:y)? [y,n]’

Press <y> to copy the navigation format library on the diskette to the DA System hard disk.

12.3.6 Save Navigation Lib
This menu item is used to save the current navigation format library to a DOS-formatted floppy
disk.

When Save Navigation Lib is selected, the system asks for the install password. If the password
is typed correctly, a prompt appears asking for a diskette to be inserted into the floppy disk drive.

‘Insert a diskette into Floppy Drive 1.
Type [go] when ready,
or [q] to quit: (default: go)’

Insert the diskette and type <go> or press <Return>.

This copies the current user navigation format library to a file on the diskette called
NAVLIB.USR.

12.3.7 X Terminal
Selecting this option causes a terminal window to appear on the DA System display. This is for
Coda engineers only. No attempt should be made to access this window, which is password
protected.
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12.3.8 Toggle Video Resolution

This menu option toggles the screen between high and low video resolutions. Contact Coda
Technologies before using this option.

12.3.9 Tape Menu
Selecting this menu item brings up the following sub menu:

12.3.9.1 Erase Tape (tape system)

Note: Before selecting this item, make sure that the tape drives are not in operation. If you are unsure about
the status of the tape drives but wish to continue with maintenance, restart the DA System by selecting
Restart from the File menu. 

This menu item enables you to erase tapes, and is only available for tape systems. Do not attempt
to do this if the data on the tape is valuable as ALL data will be lost. Write-protected tapes cannot
be erased.

When this item is selected, the system asks for the install password. If the password is typed
correctly, a prompt appears, asking for the number of the tape drive from which the tape is to be
erased.

‘Which tape device do you wish to use when erasing (default:1)? [1,2]:’

Press either <1> or <2> and then press <Return>.

A prompt asks for the tape that is to be erased to be inserted into tape drive 1.

‘Insert the tape into Tape Drive 1.
Type [go] when ready,
or [q] to quit: (default: go)’

Type <go> or press <Return>.

A prompt appears asking for confirmation.

‘Are you sure you want to erase the tape in Tape Drive 1
(default:n) [y,n]?’

Press <y> to erase all the data on the tape.

12.3.9.2 Backup Setup Files
This menu item is used to store to tape all of the setup files, for example tag setup files.

When Backup Setup Files is selected, the system asks for the install password. If the password
is typed correctly, the following prompt appears:

‘Which tape device do you wish to copy setup files to (default:1)? [1,2]:’

Press either <1> or <2>, and then press <Return>.

A prompt appears asking for a tape to be inserted into tape drive 1.

‘Insert the tape into Tape Drive 1.
Type [go] when ready,
or [q] to quit: (default: go)’

Type <go> or press <Return> to continue.

The setup files are then saved on tape. The following prompt appears:

‘Setup files were successfully backed up to tape drive 1’

12.3.9.3 Restore Setup Files
This menu item is used to restore setup files from tape to the hard drive. 

Note: Existing setup files with the same name on the hard disk will automatically be overwritten.

When Restore Setup Files is selected, the system asks for the install password. If the password
is typed correctly, the following prompt appears:
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‘Which tape devise do you wish to copy setup files from (default:1)? [1,2]:’

Press either <1> or <2>, and then press <Return>.

A prompt appears asking for the tape to be inserted into tape drive 1.

‘Insert the tape into Tape Drive 1.
Type [go] when ready,
or [q] to quit: (default: go)’

Type <go> or press <Return> to continue.

The setup files are then copied from the tape to the hard drive. The following prompt appears:

‘Setup files were successfully restored to tape drive 1’

12.3.10 Optical Menu
This menu item will bring up a sub menu as follows:

12.3.10.1 Format Optical Disk
This menu item formats optical disks for use with the CODA system and creates the necessary
directory structure on the optical disk.

12.3.10.2 Repair Optical Disk
This menu item audits the optical disk and repairs inconsistent conditions on the disk. It is
possible for the data on the disk to become inconsistent if there is a power failure to the CODA
system. In such cases, the Repair Optical Disk function should be used. 

12.3.10.3 Unmount All Disks
Clicking on this menu item unmounts optical disks in both drives. Disks must be unmounted
before they can be ejected. This option should only be used if the disk cannot be unmounted from
the viewer. Before using this menu item, check that the disk is not mounted for Playback, or for
tagging in the Manage Tag Files menu option.

12.3.10.4 Backup Setup Files
When Backup Setup Files is selected, the system asks for the install password. If the password
is typed correctly, the following prompt appears:

“Which optical drive do you wish to copy setup files to (default:1)? [1,2]”

Press either <1> or <2>, and then press <Return>.

A prompt appears asking for a disk to be inserted into drive 1.

“Insert the optical disk into Drive 1.

Type [go] when ready,

or [q] to quit: (default: go)”

Type <go> or press <Return> to continue.

The setup files are then saved on disk. The following prompt appears:

“Finished backing up Setup files.”

12.3.10.5 Restore Setup Files
This menu item is used to restore setup files from an optical disk to the hard drive.

Note: Existing setup files with the same name on the hard disk will be automatically overwritten.

When Restore Setup Files is selected, the system asks for the install password. If the password

is typed correctly, the following prompt appears:

“Which optical drive do you wish to copy setup files from (default:1)? [1,2]:”

Press either <1> or <2>, and then press <Return>.
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A prompt appears asking for the disk to be inserted into drive 1.

“Insert the optical disk into Drive 1.

Type [go] when ready,

or [q] to quit: (default: go)”

Type <go> or press <Return> to continue.

The setup files are then copied from the disk to the hard drive. The following message appears:

“Finished restoring Setup files.”

12.3.11 Network Disk Menu
This option allows the use of a network disks with other unix systems. Contact Coda Technol-
ogies before using this option

12.3.12 Make Clean
This menu item is used to remove all user-specific files from the system.

When Make Clean is selected, the system asks for the install password. If the password is typed
correctly, the following set of questions appear in the cleaning window:

‘Do you wish to clean tag directory (default: n)? [y,n]’

The default is not to clean the tag directory.

Press either <y> or <n> and then press <Return>.

‘Do you wish to clean the log directory (default: n)? [y,n]’

The default is not to clean the log directory.

Press either <y> or <n> and then press <Return>.

‘Do you wish to clean the nav directory (default: n)? [y,n]’

The default is not to clean the nav directory.

Press either <y> or <n> and then press <Return>.

‘Do you wish to clean setup directory (default: n)? [y,n]’

The default is not to clean the setup directory.

Press either <y> or <n> and then press <Return>.

12.3.13 Change Time
This option is used to change the system time. This may be necessary if you wish to use the DA
System time in acquisition and it is set incorrectly.

When this item is selected, the system asks for the install password. If the password is typed
correctly, the system displays the current date and time, and prompts you to update them both.
Enter the current time in hours, minutes and seconds in the format HH:MM:SS (for example,
21:17:05), and the current date (month, day and year) in the format mm-dd-ccyy (for example,
09-17-1997). When these values have been entered, the system clock immediately sets itself to
the time and date requested.

12.3.14 Change Password
Selecting this option allows you to change the install password for the system. The system
prompts you to type the old install password twice, then the new password. The new password
must then be re-typed to ensure that it has been entered correctly.

The system password should consist of at least six characters, and should contain at least two
alphabetic and one numeric characters. It must differ from the old password by at least three
characters.
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Do NOT allow the install password for the system to fall into the hands of those not trained to
carry out system updates or cleaning. Do NOT write the password down.

12.3.15 Screen Saver Option
A screen saver can be turned on or off by pressing <Alt-Shift-S> and <Alt-Shift-Q> respectively.
If the screen saver option is turned on and the screen remains inactive for a period of 5 minutes,
the screen will be blanked. To reactivate the screen, simply move the mouse.
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13 Powering Down & Packing Up

13.1 Shutdown
This option shuts down the Unix operating system of the DA System, to allow the power to be
turned off, or the machine to be rebooted. If this item is selected, a pop-up appears asking for
confirmation that the system is to shut down; if Yes is selected, the shutdown takes place, and
any tapes in the tape drives are ejected. (Eject diskettes from the floppy disk drive prior to
rebooting the machine.) Shutdown cannot be halted at this point.

13.2 Powering Down the System

Caution: Before powering down the system, make sure that no tapes or disks have
been left in the drives. Failure to do so may result in damage to the tapes or disks or to
the drives.

The correct procedure for powering down the system is given below:

1. Select File→Shutdown.

2. When the prompt ‘Are you sure you wish to Shutdown the System?’ appears, click on Yes.
The shutdown procedure begins. If you are using a tape system, any tapes in the tape drives
are automatically ejected.

3. If necessary, remove any diskettes from the floppy drive.

4. When the message ‘Press <CTL><ALT><DEL> to reboot your computer’ appears, turn off
the system power.

Note: The correct sequence for powering down should be followed; however, in the event of an unexpected
power loss, no damage should result to the system. No data previously recorded to tape or disk by the system
will be lost.

13.3 Preparing the System for Transportation
The following steps should be taken to prepare the DA System for transportation between
worksites:

Caution: Before packing the DA System, make sure that no tapes or disks have been
left in the drives. Failure to do so may result in damage to the tapes or disks or to the
drives.

1. Remove any data tapes or disks from the drives.

2. Unplug all cables and connectors, including the keyboard, from the back of the system.

3. Store the cables and the mouse or trackball in the monitor flight case. The trackball should
be placed in a padded bag before being stored in the flight case.

4. Attach the front and back covers to the system flight case.

Follow any other packing instructions that come with your system.
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14 Technical Description of the DA System

14.1 DA System Hardware
The DA System is based on cost-effective, but proven and reliable, PC technology. In recent
years, the processing power available at low cost on a PC platform has developed to the point
where it is now possible to undertake complex real-time signal processing tasks without
resorting to the use of specialised digital signal processing devices.

The DA System uses a high-specification Intel Pentium or compatible processor, with 32MB or
64MB of random access memory (RAM). The industry standard high-bandwidth PCI interface
is used for IO operations where appropriate. All of the components on the PCI and ISA buses in
the DA System are industry standard, cost effective and reliable. A high-bandwidth SCSI-2 bus
interface is provided; this allows the processor to communicate with both the system’s hard disk
(with up to 4.3GB of available storage depending on the system) and the SCSI tape or optical
disk drives at rates of up to 10MB/sec. The system’s easy to use graphic user interface (GUI)
and waterfall display software make use of the graphics capabilities of an S3 graphics card using
2MB or 4MB of video RAM. Analogue data acquisition and A/D conversion is handled by a
high-bandwidth A/D converter, which uses the ISA bus.

Ancillaries such as the RS-232 and parallel interfaces are available directly on the PC mother-
board.

System expansion is straightforward, benefiting from the open architecture of the PC standard.
Ethernet or Token Ring interfaces are available as options, and provide the capability of broad-
casting full resolution raw digitised data to the network with almost no CPU overhead.

The DA System may be supplied with either one or two 4mm DAT DDS2 or 8mm Exabyte SCSI
tape units. Both use high speed SCSI-2 interfaces, and both DAT and Exabyte drives are capable
of data rates up to 500Kbytes/sec. Or, the system may be supplied with either one or two
Maxoptix optical disk drives. They use high speed SCSI-2 interfaces and are capable of data rates
of 2–4MB/s.

The DA System system and keyboard are supplied in 4 and 1U, 19in Rackmount chassis and
drawer. These are enclosed in a 5U floating frame flight case. The system comes with a choice
of trackball or mouse. A free-standing 17in monitor is also supplied with flight case.

14.2 Operating System
The DA System uses SCO UnixWare, a vendor-specific implementation of Unix System VR4.2.
Unix is a true multi-tasking operating system with real-time extensions, allowing pre-emptive
scheduling of real-time processes. It also has support for the X Window system and the Motif
1.2.3 GUI. TCP/IP networking is available as an option.

The DA System uses the Unix SVR4.2 VERITAS (vxfs) file system; this has significant advan-
tages over the file systems used under earlier versions of Unix, and those used by Windows or
MS-DOS. The major benefit is that the file system’s integrity is ensured if there is a power failure
or if the power to the system is inadvertently switched off.

14.3 DA System Software and GUI
The DA System is written in C++ and C, and uses the Motif 1.2.3 GUI for the X Window system.
A device driver for the A/D acquisition system has been developed specifically for this product
by Coda Technologies.

14.4 Data Flow in the DA System
The DA System uses the multi-tasking capabilities of the Unix operating system to process data,
as shown in Figure 14-1, page 180.
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Figure 14-1 Data Flow in the DA System

A single program running as a real-time process in the Unix operating system digitises the
incoming analogue data and reads in RS-232 navigation data. The incoming analogue data is
time stamped with the ping time (in UTC), and the latest navigation data is combined with it.
Note that the navigation data, the acquisition parameters and the ping time are all stored for each
data channel and each ping with the digitised analogue data (see Appendix E for a description
of the data stored in the Coda data format). Once this process of combination has been carried
out, the data is available either within the DA System system (for use by the media IO sub-system
or the display sub-system), or optionally over Ethernet.
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The media IO sub-system is responsible for saving full resolution data to tape or optical disk. If
dual drives are fitted, the recording can be continuous, without the need to pause for tape or disk
changes. Otherwise, a brief gap will appear in the recorded data during the change period. It
should be noted that the media IO and the acquisition sub-systems are independent of the user
interface and display systems.

When the full resolution data has been transferred to the display sub-system, TVG curve compen-
sation can be carried out. This allows compensation for a sidescan sonar’s inbuilt TVG curve, if
required. This compensation is carried out on the 12-bit digitised data, and is controlled by the
user through the TVG Enhancement option in the Processing menu (see Section 7.5). The ideal
at this point is to obtain a signal whose mean and minimum values are constant.

The display sub-system receives a constant stream of full resolution, 12-bit digital data, which
has been time-stamped by the acquisition system and has had navigation data appended to it. The
display resolution, however, is limited to 8 bits, using a colourmap or palette to match incoming
digital values to displayed intensities or colours. Moreover, the data is usually acquired at a line
length which exceeds the display resolution (1024 pixels, or 512 pixels per display channel).
Therefore, the first task of the display sub-system is to decimate or sub-sample the incoming
data. The sub-sampling is carried out according to the values entered in the Left/Right Display
Channel window in the Settings menu; this reduces the incoming pixels in the displayed
channels to a number which can be displayed on the screen.

The 12-bit data is then reduced to 8 bits for screen display, again based on parameters input by
the user in the Scale Display Data window of the Settings menu. This defines a linear mapping
of the 12-bit data to 8 for display; however, the distribution of intensities in the 12-bit data or the
8-bit data derived from it is unlikely to be uniform. Therefore, a final series of adjustments to the
data can be carried out, allowing a non-linear mapping of 8-bit values to displayed intensities or
colours. This LUT or palette selection is carried out by the user in the Image Enhancement
toolkit, accessed through the Processing menu. Hardcopy or screen dump output uses the same
LUT, 12 to 8-bit conversion and line sub-sampling as the screen display. It should be emphasised
that the data saved to tape or disk is always full resolution, 12-bit data with no TVG or image
enhancement corrections applied.

14.5 File Structure of the DA System
All user data is stored on the /home partition of the DA System, ensuring that files loaded by the
user cannot corrupt the system software which is held in the /usr partition. The user data is loaded
into one of the sub-directories of the /home/dp100 directory – either /home/dp100/setup (for user
setup files), /home/dp100/nav (for corrected navigation data), /home/dp100/tag (for tag database
files), /home/dp100/lib (for other system files) or /home/dp100/log (for system log files). No
direct interaction of the DA System user with these directories is permitted by the system; nor
does the DA System create files in any other directories on the system. The Make Clean option
in the Maintenance Menu allows the owner of a DA System system (or any user with access to
the install password) to empty the setup, navigation, lib, and tag directories.
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15 DA System Specifications

15.1 Trigger Input
Trigger type: TTL

Equivalent TTL loads: 1

Overvoltage Protection: ± 40V

Minimum Pulse Width: 40ns

Trigger Type: Positive, edge sensitive

15.2 Trigger Output
Trigger type: TTL

Overvoltage protection: ± 40V

Trigger type: 50% duty cycle clock

15.3 Analogue Input
Voltage Ranges: ±1.25, ±2.5, ±5, ±10V

System Error (±1.25V): ±0.05%FSR

System Error (±2.5, ±5, ±10V): ±0.07%FSR

Overvoltage Protection: ±35V on, ±20V off

ESD Protection: 1.5kV

Throughput: 250KHz 

Resolution: 12 bits

Input Impedance (ON channel): 100MW/100pf

Input Impedance (OFF channel): 100MW/10pf

CMRR: 80dB typ. @ 60Hz

Sample Clock: 5MHz, 15ppm accuracy, divided down to sample frequency

Internal Trigger Clock: 5MHz, 15ppm accuracy, divided down to trigger frequency

15.4 Parallel Output
Bi-directional parallel port with Enhanced Parallel Port support

15.5 Serial Input/Output
Baud rates: 110, 300, 600, 1200, 2400, 4800, 9600, 19200

Handshaking: Xon/Xoff, Hardware or None

Data bits: 7 or 8

Parity: Even, Odd or None

Stop bits: 1 or 2

Connector: 9-way D type (male). Input on pin 2, ground on pin 5; or
25-way D type (male). Input on pin 2, ground on pin 7

15.6 GPIB Output
Data Rate: Up to 1MByte/second.
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Compatibility: IEEE488.1, IEEE488.2 – SH1, AH1, T5, TE5, L3, LE3, SR1, PP1, PP2, RL1, C1,
C2, C3, C4, C5, E1, E2

Connector: IEEE488 standard 24-pin

15.7 Monitor Output
Vertical Refresh Rate: 80Hz

Horizontal Line Rate: 65.5KHz

Display Resolution: 1040x780 pixels

Video Signal: Analogue, 1.0V p-p, 75W, positive
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16 Getting Help

16.1 The Help Menu 
The Help menu gives you access to more information about the DA System and its modules, and
about Coda Technologies.

Figure 16-1  The Help Menu

16.1.1 Key Shortcuts

Figure 16-2 The Key Shortcuts Pop-up Window

Selecting the Key Shortcuts menu item produces pop-up which lists the keys that can be used
to initiate tasks which are otherwise available via the menu bar. The number of short-cut keys
available depends upon the module of the DA System being used. For example, the <s> key
allows span heights to be measured when using the PI100 module. To use a short-cut key,
position the pointer in the display area if it is not there already, and then press the appropriate
key or keys.
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16.1.2 Technical Support

Figure 16-3  The Technical Support Pop-up Window 

The Technical Support menu item provides brief details for contacting Coda’s Technical
Support Team. Full details of this 24 hour service can be found in ‘Technical Support’ inside the
front cover of this manual and in Section 16.

16.1.3 Product Information
The Product Info menu item can be selected to pop up a window describing the modules
available for the DA System system. These are also listed on the inside of the back cover of this
manual.

16.1.4 Coda Technologies Info
Selecting this item from the Help menu pops up a window providing contact information for
Coda Technologies.

16.1.5 DA System Version
Selecting this menu item pops up a window listing the version numbers of the software installed
on the DA System. These can be compared with the version numbers supplied with Coda
Technologies update packages and should be quoted when contacting Coda Technologies about
the DA System.

16.2 24 Hour Technical Support
Coda Technologies operates a 24 hour telephone support service for users with technical queries
or problems. Should you need to use this service, call one of the numbers below. Out of hours
calls are diverted to mobile phones to ensure a swift response.

USA – tel: 1 888 340 CODA
Rest of the World – tel: +44 131 553 7003

When you call, please have the following information available:

1. Your contact telephone (and fax) number.

2. The Coda system serial number. This is stamped on the tamper-proof label at the rear of the
DA System.

3. The version of the software currently running on your DA System. This is listed in the Help
menu under DA System Version (see Section 16.1.3).

Your call will be logged and allocated a technical support reference number which you should
note for future reference.

Less urgent Technical Support matters can also be addressed by e-mail to:
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support@coda.co.uk or support@coda-technologies.com

The following list of common problems should first be reviewed before contacting Coda
Technical Support.

16.3 Troubleshooting the DA System
Image lacks contrast/has too much contrast

• In acquisition mode, check that the input voltage range selected in the Channels 1-4 tab
of the Open Acquisition menu is correct (see Section 5.2).

• Select the Scale Display Data item in the Settings menu. Proceed as outlined in Section
5.3 to ensure the incoming signal is converted to displayed intensities correctly.

• Use the Image Enhancement toolkit under the Processing menu to set a gamma value
which optimises the displayed data greyscale; or select and manipulate the colourmap
used; or modify the graph mapping incoming intensities to colourmap intensities (see
Section 7.5).

Image too dark or bright, across the whole line of data

• see ‘Image lacks contrast/has too much contrast’, above.

Unable to write to a data tape

• Check that the data tape is not write protected (see Appendix H).

Unable to replay data tape

• Does the Open Tape Playback selection produce a meaningful contents list? (See
Section 6.2) If so, the tape should play back without difficulty, unless it is physically
damaged. If not, check that the tape you are trying to play is a valid Coda or SEG-Y
format tape. Note that DAT tapes recorded on commercial DAT data recorders are not
compatible with the DA System.

DAT tapes don’t last as long as expected (10 hours for conventional sidescan)

• Check that 120m DDS2 (DAT) tapes are being used, rather than 60m or 90m DDS DAT
tapes. Although a 90m tape is three-quarters of the length of a 120m tape, it has only half
the capacity.

On-screen measuring gives inconsistent/unreliable results

• Check that the system is using the correct fish altitude value, by turning on the Bottom
Position Line option in the Display menu (see Section 6.5).

• Check that the vessel speed and heading are correct, by checking the Survey Data display
in the Display menu (see Section 8.8).

• If there are problems with either of these in acquisition mode, then there may be a
problem in interpreting the navigation data coming into the DA System.

Slant-Range Correction doesn’t work correctly

• Check that the system is using the correct fish altitude value, by turning on the Bottom
Position Line option in the Display menu (see Section 5.5).

Bottom tracking line not visible or in wrong place

• Check the fish height value coming into the system by looking at the Survey Data
window (see Section 8.8). If this value is incorrect, the incoming telemetry value from the
navigation string is being read incorrectly, or the automated bottom tracking has mistaken
where the first bottom return is, or a nonsensical value has been entered as a fixed fish
height.

• If the automated bottom tracking is not following the bottom correctly, either reset the
search area using the automatic tracking pointer (see Section 3.6), or redefine the
automatic tracking parameters (see Section 5.5). If the automated tracking continues to
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perform badly, it may be that the combination of seabed and water column characteristics
are such that it cannot follow the seabed return accurately. In this case, switch to a fixed
towfish height, or use the telemetry input.

The message ‘No nav updates for xxx seconds’ appears

• Check that the navigation computer is producing output by switching to Nav input off but
view unformatted serial input in the Navigation Input menu (see Section 5.4). If no data
is visible, check that the navigation computer is working correctly, and that the serial
interface setup of the DA System is compatible with that of the navigation computer.

• Check that both ends of the RS-232 cable are properly connected.

• If correctly formatted ASCII raw nav strings can be seen when Nav input off but view
raw serial input menu item is selected, reselect the Nav input on option, and the Nav
Format QC window (see Section 5.4). If the values appearing in the QC window are not
correct, it is probable that the incoming string of serial data is not being interpreted
correctly. Either change the format of the incoming serial string, or modify the navigation
library entry to interpret the incoming serial data correctly, whichever is easiest and
preserves the greatest amount of navigation information.

‘No Tape Detected’ error

• This is a common error caused by the tape being accessed before it has been initialised
by the system. Repeat the Open Tape procedure (see Section 6.2). If, however, this
problem persists, contact the Coda helpdesk.

No input data on display

• Use internal triggering to ascertain that the A/D sub-system is functioning correctly (see
Appendix K).

• Ensure that a TTL level external trigger is connected to the BNC labelled TRIG IN (see
Section 4.3).

Ping rate is half the expected rate

• The usual cause for a ping rate being lower than expected is that the line length that has
been selected in the Open Acquisition window is too long (see Section 5.2). Try
increasing the sampling frequency, or if this is at the maximum value, decrease the line
length.

CPU Overload – for example, very slow display

• Try turning off TVG, Slant Range Correction or Raw A-Scan display (see Section 7.3,
Section 7.7.2.1 or Section 8.7).

Note: TVG, Slant Range Correction and Raw A-Scan display all use relatively large
amounts of computing power, whilst Image Enhancement uses almost none.

Login problems (Maintenance Menu)

• Ensure that the Caps Lock key isn’t on – Unix logins are case sensitive.

Problems saving tags

• If the error ‘Unable to write tag – file system full’ appears, this indicates that the DA
System file system hard disk is full, and that it is not possible to add more tags to the tag
database. To cure this, use the Tag Management item in the Tagging menu to delete
some of the tag files on the system (see Section 10.9). This error will only occur if there
are either a very large number of tag files on the system, a very large number of
navigation correction files on the system, or the tag files on the system are very large.

Problems loading Corrected Nav files

• The file system may be full. See the comments under ‘Problems saving tags’ (above).

‘No tapes detected for playing’ error
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• The DA System system has been unable to find any tape devices on the SCSI bus, and

will be unable to playback or record data. If this message appears, contact Coda Technol-
ogies’ Technical Support in Section 16.2.

‘Unauthorised Software – Contact Coda Technologies Ltd’

• The copy protection mechanism has detected that the software being used is not an
authorised copy. If, having first rebooted the machine and attempted to restart, this
warning continues to appear and the software was obtained from Coda Technologies or
their recognised agents, contact them for rectification of this problem.

• Ensure that the Coda system is NOT connected to a printer which is powered off.

‘Unrecoverable medium error’
This error may appear if a sequence tape control command fails for some reason. The
following steps should be taken:

• Reselect Open Tape Playback from the File menu, and continue tape playback (see
Section 6.2).

• If this fails, eject the tape, re-insert the tape and then select Open Tape Playback again.

• If this fails, re-start the viewer and select Open Tape Playback.

• If all of the steps above fail, shutdown and re-boot the system.

The display does not scroll in acquisition or playback mode

• Ensure that two display channels have been selected (see Section 6.3). The DA System
requires two display channels to be operating before it can scroll the waterfall display

 DA System ‘locks up’ completely
The DA System can only lock up under very unusual circumstances; most users will never
experience this. The following remedies should be attempted

• Check whether the system is still recording (indicated by intermittent flashes of the SCSI
light). If so, the data will still be being written to the tape. You may wish to follow these
next instructions once it is convenient to stop recording.

• If mouse movements cause the pointer on the screen to move and the DA System display
responds, then select the Restart option from the File menu (see Section 13.1).

• If mouse movements cause the pointer on the screen to move, but selection of the File
menu is not possible, activate the Title Bar Menu (see Section 12.2) and select the option
Restart DAx00 from this menu.

• If selection of the Title bar Menu is not possible, then the operating system has crashed.
Remove all tapes from the tape drive units, and use the Reset switch on the DA System
front panel to cause the system to reboot itself (see Section 12.2).

‘Channel X samples for longer than its trigger period’

• This error message can appear if the total time spent sampling by a given channel, plus
the start delay for that channel, add up to more than the trigger period selected (internal
triggering only). Either increase the sampling frequency (to obtain the desired number of
samples in a shorter period), or if this is not possible (for example, the sample rate is at
the maximum value), reduce the start delay (to decrease the overall time from the arrival
of the trigger pulse to the end of sampling) (see Section 5.2).

Hardware fault LED on (DAT tape drive)

• If the right-hand amber LED on a DAT tape drive stays lit, a hardware fault has occurred
on the drive. Shut down and power off the DA System system and re-boot it to cure the
fault. If this has no effect, contact Coda Technologies.

The system does not accept incoming navigation data, even though the correct string format
has been selected.

• Ensure that the format you have selected has not been edited to make it incompatible with



DRAFT
192 May 2001 for version 2.1        

G
et

tin
g 

H
el

p
the incoming navigation data. If a standard string is being used (for example, Coda,
NMEA), select Default Formats in the Navigation Format Editor (accessed as Add New
Format in the Nav Input pop-up in the File menu.

DAT tapes recorded on instrument recorders (for example, TEAC, Sony) will not replay.

• DAT tapes which have been recorded using instrument recorders (for example, TEAC
and Sony recorders) cannot be replayed directly using the DA System. These tapes have
not been recorded in a computer-compatible digital format and must be re-digitised to
replay them using the DA System. The instrument recorder outputs can be connected to
the BNC input channels on the DA System (see Section 4.3). However, navigation infor-
mation will inevitably be missing, resulting in many of the on-screen measurement and
location functions being unavailable.

The keyboard short-cut keys (<Control-c>, menu shortcut keys) stop working.

• Ensure the Caps Lock key is off.

• Shut down the machine using the Shutdown option in the File menu.

• Make sure that the pointer is located in the Data Display Area.

The tape unit LED does not flash continuously during data recording to tape, although the
correct data acquisition procedure has been followed.

• Provided the HDD light on the DA System front panel is flashing continuously, data will
be recording successfully (see Section 4.1.1). The tape drive LED not flashing continu-
ously does not indicate a problem with data acquisition.

‘Write protect’ error message appears during data acquisition.

• If the tape has been write protected (see Appendix H), eject the tape, ensuring it is labelled
correctly, and replace with a blank, unprotected, tape.

• This error message can also be caused by using a non-DDS tape in DAT tape systems.
See Appendix H for details of the correct tape type to use.

Caution: The status of the write-protect tab on the tape must not be changed
while the tape is in the tape drive. Doing so can lead to damage to the tape or
to the tape drive.

The system fails to display the Coda screen when first switched on.

• Ensure that the mouse or trackball is connected to the correct port – COM1 (see Section
4.3).

Fix number, speed of sound and time/date have spurious values when Coda nav format is
used for the nav string.

• Make sure that the line name given to the Coda nav string contains no spaces. Use, for
example, underscore instead (see Appendix B).
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A Example Acquisition Setups

Owing to the constraints of the A/D hardware, some combinations of acquisition settings which
have been selected may not be configurable by the system. If this is the case, two warning pop-
ups will be displayed; the first will warn you that the current settings are not possible and the
second will tell you which particular setting is invalid. Detailed descriptions of valid example
acquisition setups can be found in Appendix A.

The constraints placed on the settings by the acquisition hardware are detailed below.

Note: The sampling frequencies entered in the Open Acquisition pop-up must be integer divisors of the
highest sampling frequency of any of the triggers. (That is, the frequency must divide into the highest sampling
frequency with no remainder.) For example, in an acquisition setup with 3 active channels, valid sampling
frequencies could then be 20KHz, 10KHz and 40KHz respectively, as 20KHz and 10KHz are integer divisors
of 40KHz (the highest of the three frequencies). Invalid frequencies would be 30KHz, 25KHz and 40KHz as
neither 30KHz nor 25KHz is an integer divisor of 40KHz.

1. The sum of all sample frequencies must not exceed 160KHz.

2. All sample frequencies must be an integer divisor of the highest sample frequency.

3. The maximum number of samples for any channel must not exceed 20,480.

4. The maximum number of samples for any trigger must not exceed 32,000.

5. An internal trigger period should always exceed the sweep time for any channel on that
trigger by at least the system dead time.

6. The minimum allowable sample frequencies for sidescan and seismic channels are 14KHz
and 3.5KHZ respectively.

7. The shortest allowable trigger period is 34 msecs.

8. Widescan channels on an internal trigger should not have a trigger period of less than 67
msecs.

Custom Sidescan

• Sample Freq (Hz) determines the number of samples used to represent the incoming data and
can be altered via a text-entry box. The default sample frequency of 40 000Hz (40KHz) per
data channel can be altered by clicking on the text-entry box and edited using the keyboard.
It is very important to ensure that the sampling frequency is high enough to prevent aliasing
or undersampling. Typical suggested sample frequencies are given in Appendix A. The
minimum sampling frequency is 14KHz; the maximum sampling frequency is 160KHz
overall, in other words if four channels are being used, the maximum frequency for each
channel is 40KHz.

• Samples/Ping is the number of samples used for each ping return. It can be altered via the
associated text-entry box. This setting affects the time over which the signal is sampled and
hence the sampled range of the input sidescan signal, or the sampled depth for a seismic
signal. For example, with a sampling frequency of 40KHz and 2560 samples per line, this

gives a sampling time of  seconds. For a typical speed of sound in water of

1500m/s, this will give a distance of  metres. The slant range is therefore

 metres.

Note: If samples per ping is set too high, it may take so long to collect the required number of samples
that the next trigger is missed. This will result in the beginning of the next pulse being displayed as a
continuation of the current ping. The sampled ping rate (indicated by the lines per second in the
General Information Area) will also appear to halve, as every second trigger will be ignored. To
remove this effect, decrease the number of samples per ping.

• Start Delay (ms): the delay in milliseconds between the end of any discarded signal and
starting to acquire data. This can be used (for example) to reduce the length of the sampled
water column. The default start delay is 0 milliseconds, but can be increased for each data

2560
40000
--------------- 0.064=

0.064 1500× 96=

96
2
------ 48=
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channel in the appropriate text-entry box. When a start delay has been entered in the text-
entry box, this will be used in calculations where appropriate.

• Fixed Sweep Time Sonar: a toggle to indicate whether or not the input is from a fixed
sweep-time sonar. If No (the default) is selected, the Fixed Sweep Time Range and
Discarded Signal text-entry box is greyed out. (Most sonar inputs are not of the Fixed
sweep-time type.)

• True Range (m): when Fixed sweep-time sonar is selected this allows the range in metres to
be entered for the Fixed sweep-time sonar. When Fixed sweep-time is not selected, this
displays the calculated range from the sampling frequency and samples per ping.

• Discarded Sig (ms): a text-entry box which is used to enter a value, in milliseconds, for the
amount of signal to be discarded after the trigger is received. The discarded portion of the
signal is not taken into account in any calculations (see Start Delay). Its intended use is for
extracting a single channel from composite sidescan signal, for example, Ultra Widescan. A
discarded signal can only be entered when a fixed sweep time sonar has been selected.

Note: This field should be used with extreme caution – the portion of the signal discarded cannot be
recovered after acquisition.

• Trace Reversed: if this option is selected (by default it is off), the order of the samples in a
ping of data will be reversed before they are recorded or displayed. This option should only
be selected when recording data from sidescans which output their port and starboard
channels as one composite channel of data (for example, Ultra Widescan). In this instance,
both data channels (CH1 and CH2, or CH3 and CH4) should be connected to the composite
signal, and the two channels separated in the A/D conversion process using the Discarded
Sig setting. Due to the nature of the composite ping, one data channel is digitised in reverse
order, so the ping reversed field for that channel should be set. It is easy to establish which
data channel is reversed, as the outgoing pulse and water column will appear at the outer edge
of the display area, rather than the centre.

A.1 Default Setups
The Acquisition pop-up has been designed so that users can use standard settings or more
detailed customised settings. The standard settings allow you to simply input the true range for
sidescan sonars and the Sweep Time and Start Delay for shallow seismic sonars. The only other
parameters that need to be set up for standard settings are Trigger (A or B), Input Voltage Range
(±1.25v, ±2.5v, ±5v, ±10v) and the description (SS port, SS starboard, Seismic) as described in
Section 5.2.

The following example setups describe the more detailed options to allow customised settings to
be used where greater flexibility during acquisition is required.

A.2 Description of Sidescan Parameters for Custom Settings
There are five important parameters in the acquisition pop-up window, each interlinked and
related to the others. The relationship between these parameters governs the setup for data acqui-
sition. The five parameters are:

1. Trigger Period

2. Samples Per Ping

3. Sampling Frequency

4. Slant Range

5. True Range
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1. Trigger Period
This represents another method of presenting the triggering rate, or ping rate. If the DA System
system is triggered externally, this value is computed automatically and can be read from the
General Information Area, as it corresponds to the pings/s. If the sonar is triggered by the DA
System (that is, an internal trigger is output via the Trigger Out connection) this value can be
automatically calculated by the system or computed by the user to ensure that:

• it provides a trigger at the correct rate

• it is not in conflict with the samples per ping and sampling frequency values, as outlined
below.

2. Samples per Ping
The number of samples or pixels (or dots) used to digitise each ping. This corresponds to the
number of pixels which would be drawn across a thermal recorder’s sheet for the channel.

3. Sampling Frequency
The rate at which the digitising hardware samples the incoming analogue data. The sampling
frequency must be high enough to ensure that the required number of samples per ping are
acquired for each successive trigger.

These three parameters are closely related according to the expression:

Therefore, 

 

4. Slant Range
The trigger period, samples per ping and sampling frequency parameters are also related to the
slant range of the survey as this governs the triggering rate. For example, a 50m slant range
sidescan sonar survey would have the following setup:

Range = 50 metres, therefore the time between triggers should allow sound to travel 50m through
the water and 50m back to the transducer – a total of 100m.

Sound travels through water at approximately 1500 metres/s so it would take at most

 seconds for the ping to leave the transmitting transducer and return to the

receiving transducer. So the maximum triggering rate is 15 pings/second. This corresponds to a
sweep time of 67ms (milliseconds).

Now that the triggering rate (ping rate or pings/s) has been established as 15 pings every second
we can determine the best sampling frequency for a desired number of samples per ping.

For high resolution digital data it is desirable to have a high number of samples per ping. The
screen can display a maximum of 1024 pixels at any time, but using the flexibility of the channel
settings of the zoom function, data can be displayed, processed, and interpreted at much higher
resolutions. We recommend that data be acquired and recorded in multiples of 512 (for example,
1024 samples/ping or 2560 samples/ping).

Continuing with our example, if we have a 50m slant range survey and, therefore, a ping rate of
15 pings/second and we decide on 2560 samples/ping, we can calculate the minimum sampling
frequency according to the expression

as described above.

Therefore the minimum sampling frequency is

SamplingFrequency NumberOfPingsPerSecond SamplesPerPing×≥

SamplingFrequency TriggerRate SamplesPerPing×≥

SamplingFrequency
1

TriggerPeriod
------------------------------------- SamplesPerPing×≥

100m
1500ms
------------------- 1

15
------=

SamplingFrequency Sweeptime SamplesPerPing×≥

SamplingFrequency
1

0.067
------------- 2560×≥

SamplingFrequency 38400Hz≥
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This is 38.4KHz which can be increased to 40KHz to allow for very short gaps between the
sampling of successive triggers.

5. True Range
The true range of a sidescan swathe is defined by the slant range and the altitude of the sidescan
towfish. Generally, the towfish is towed at an altitude of 10% of the true range, as illustrated
below:

Figure A-1 Calculation of True Range

If, for example, the towing altitude is 10m and the true range is 100m, then the slant range

required (by Pythagoras) will be . Thus, the towing altitude and the
desired true range are used to define the slant range, which the user can control by altering the
number of samples per ping and the sampling frequency (2. and 3. above).

Note that changing the towing altitude for a given slant range will affect the true range to some
extent – raising the towfish decreases the true range. When automatically deriving the slant range
(and thereby sampling frequency and number of samples per line), the DA System assumes a
towing altitude of up to 40% of the true range. This has the effect that if the fish is at 10% of the
true range, the actual true range obtained is greater than the required true range.

For example, a minimum true range of  maximum towing height:

So the required slant range 

If the actual towing altitude is 10m, with a slant range of 107.7m,

the actual true range of swathe data 

A.2.1 Example Sidescan Setups

A.2.1.1 Typical Sidescan Sonar, 50m True Range

Requirement:
The DA System is required to digitise the two analogue channels of data (Port and Starboard)
from a sidescan sonar operating at a true range of 50 metres. An external trigger is to be used.

Explanation:
Two channels (1 and 2 in this case) will be active, and will be labelled Sidescan Port and
Sidescan Starboard.

The sample frequency is determined as follows:

• It is desirable to collect as many samples as possible from the sidescan signal; where possible,
the number used should be a multiple of 512, as this is the width available per display channel
in the data display area of the screen.

• The minimum sample frequency used should be about 20KHz, to ensure that no aliasing of
the signal occurs.

• Using a maximum towfish altitude of 40% of true range, the required slant range is

. The range is 53.85m, giving a maximum ping rate of approximately

. To fit 1024 samples into a period of ms would give a

Slant Range

A
lti
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de

True Range

100
2

10
2

+ 100.500m=

100m 40m⇒

1002 402+= 107.7m=

107.72 102–= 107.2m=

502 202+ 53.85m=

1500
2 53.85×( )

--------------------------- 13.93Hz=
1

13.93
------------- 71.8=
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sample period of  or a sample frequency of 14.3KHz. Similarly, 1536 samples

would give a sample frequency of 23.1KHz, 2048 samples a frequency of 28.5KHz, and 2560
samples a sampling frequency of 35.7KHz. Therefore, choose 2560 samples per data
channel, and a sample rate of approximately 35.7KHz.

• Allow a ‘dead’ time of at least 2ms before each trigger.

No start delay or line reversal is required (the line reversal toggles are all off), and the range will
be calculated from the elapsed time since the trigger pulse, so range should be set to Auto.

The trigger should be trigger A, which should be set for an external trigger.

The choice of voltage range will depend on the voltage produced by the sidescan, which will in
turn depend on the towing altitude, input gain, TVG curve, and so on. A setting of ±1.25 or ±2.5
volts is usual.

A.2.1.2 Typical Sidescan Sonar, 100m True Range

Requirement:
The DA System is required to digitise the two analogue channels of data (Port and Starboard)
from a sidescan sonar operating at a slant range of 100 metres. An external trigger is to be used.

Explanation:
Two channels (1 and 2 in this case) will be active, and will be labelled Sidescan Port and
Sidescan Starboard.

The sample frequency is determined as follows:

• It is desirable to collect as many samples as possible from the sidescan signal; where possible,
the number used should be a multiple of 512, as this is the width available per display channel
in the data display area of the screen.

• The minimum sample frequency used should be about 20KHz, to ensure that no aliasing of
the signal occurs.

• Using a maximum towfish altitude of 40% of true range, the required slant range is

, giving a maximum ping rate of approximately .

To fit 1024 samples into a period of  would give a sample period of

, or a sample frequency of 7.13KHz. Similarly, 2560 samples would give a

sample frequency of 17.8KHz, 4096 samples a frequency of 28.52KHz, and 5120 samples a
sampling frequency of 35.6KHz. Therefore, choose 5120 samples per data channel, and a
sample rate of approximately 35.6KHz

• Allow a ‘dead’ time of at least 2ms before each trigger.

No start delay or line reversal is required (the line reversal toggles are all off), and the range will
be calculated from the elapsed time since the trigger pulse, so range should be set to Auto.

The trigger should be trigger A, which should be set for an external trigger.

The choice of voltage range will depend on the voltage produced by the sidescan, which will in
turn depend on the towing altitude, input gain, TVG curve, and so on. A setting of ±1.25 or ±2.5
volts is usual.

A.2.1.3 Ultra Widescan, 50m True Range

Requirement:
The DA System is required to digitise data from an Ultra Widescan sonar, operating at 50m true
range. The sweep period of the output from the Widescan is 67ms. An external trigger is to be
used.

71.8
1024
------------ 70.1µs=

1002 402+ 107.7m=
1500

2 107.7×( )
--------------------------- 6.96Hz=

1
6.96
---------- 143.6ms=

143.6
1024
------------- 0.14ms=
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Explanation:
Channels 1 and 2 will be digitised, and are labelled Sidescan Port and Sidescan Starboard.

The sampling frequency is arrived at as follows:

• The sweep time is 67ms, so it is necessary to capture as many samples as possible in that time.
The sweep time allows 33.5ms per data channel, over which the minimum effective sample
rate should be 20KHz (to avoid aliasing of the signal); this implies a minimum actual sample
rate of 40KHz, as 67ms of data per channel has been compressed into 33.5ms per data
channel.

• The number of samples per data channel should be a multiple of 512, to allow each data
channel to occupy half the width of the data display area of the DA System.

• A line width of 1024 samples per data channel requires a sample period of

, or a sample frequency of . Similarly, 1536 samples

implies a sample frequency of 45.9KHz. Therefore, choose a sample frequency of about
45.9KHz

• Allow a ‘dead’ time of at least 2ms at the end of each line.

The discarded signal for the starboard channel should be set to around 33.5ms (but can be
adjusted to ensure that the outgoing pulse of the starboard data channel is aligned with the
beginning of the acquired data for the starboard channel). This is because the delay for the first
data period for the first data channel is 0, but about half the sweep period for the second data
channel.

The line reversed field will be set by default for the Port data channel, as this channel is received
‘backwards’. The line reversed field for the Starboard data channel is not set.

The range setting for both channels is 50m, to ensure that the DA System can calculate measure-
ments correctly, in spite of the fact that the distance of a sample from the start of the line is not
proportional to the speed of propagation of sound through water.

The trigger will be trigger A, and is set to external.

The voltage range output by the Ultra is 0–5V, so the DA System should be set to its ±5V range.

Note: As the Ultra produces output on a single, composite data channel, the output analogue output of the
Ultra should be connected to both CH1 and CH2 BNC connectors.

A.2.1.4 Ultra Widescan, 100m True Range

Requirement:
The DA System is required to digitise data from an Ultra Widescan sonar, operating at 100m true
range. The sweep period of the output from the Widescan is 67ms, although the actual time to
capture a channel of data is 134ms. An external trigger is to be used.

Explanation:
Channels 1 and 2 will be digitised, and are labelled Sidescan Port and Sidescan Starboard.

The sampling frequency is arrived at as follows:

• The sweep time is 67ms, so it is necessary to capture as many samples as possible in that time.
The sweep time allows 33.5ms per data channel, over which the minimum effective sample
rate should be 20KHz (to avoid aliasing of the signal); this would imply a minimum actual
sample rate of 60KHz, as 134ms of data per data channel has been compressed into 33.5ms
per channel.

• The number of samples per data channel should be a multiple of 512, to allow each data
channel to occupy half the width of the data display area of the DA System.

• A line width of 1024 samples per data channel requires a sample period of

 or a sample frequency of . Similarly, 2048

33.5ms
1024

------------------ 0.0327ms=
1000

0.0327
---------------- 30.58KHz=

67ms
2 1024×( )

-------------------------- 0.0327ms=
1000

0.0327
---------------- 30.56KHz=
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samples implies a sample frequency of 61.2KHz. Therefore, choose a sample frequency of
about 61.2KHz.

• Allow a ‘dead’ time of at least 2ms at the end of each line.

The discarded signal should be set to around 33.5ms (but can be adjusted to ensure that the
outgoing pulse of the starboard data channel is aligned with the beginning of the acquired data
for the starboard channel). This is because the delay for the first data channel is 0, but about half
the sweep period for the second data channel.

The line reversed field will be set by default for the Port data channel, as this channel is received
‘backwards’. The line reversed field for the Starboard data channel is not set.

The range setting for both channels is 100m, to ensure that the DA System can calculate
measurements correctly, in spite of the fact that the distance of a sample from the start of the line
is not proportional to the speed of propagation of sound through water.

The trigger will be trigger A, and is set to external.

The voltage range output by the Ultra is 0–5V, so the DA System should be set to its ±5V range.

Note: As the Ultra produces output on a single, composite channel, the output analogue output of the Ultra
should be connected to both CH1 and CH2 BNC connectors.

A.2.2 Default Sidescan Setups
The following table shows the settings used by the DA System system for a Standard Sidescan
data channel.

A.2.3 Default Widescan Setups
The following table shows the settings used by the DA System system for a Widescan data
channel.

True Range 
(m)

Slant 
Range (m)

Trigger 
Period 
(msec)

Trigger 
Rate (pings 

per sec)

Sample 
Frequency 

(Hz)

Samples/
Channel

25 27 38 26.3 42 784 1536

50 54 74 13.5 35 654 2560

100 108 146 6.8 19 609 2816

150 162 218 4.6 19 015 4096

200 216 290 3.4 19 609 5632

400 432 580 1.7 14 000 8042

True Range 
(m)

Slant 
Range (m)

Trigger 
period 
(msec)

Trigger 
Rate (pings 

per sec)

Sample 
Frequency 

(Hz)

Samples/
Channel

50 54 69 14.5 40 000 1340

150 162 69 14.5 40 000 1340

250 270 69 14.5 40 000 1340

350 377 69 14.5 40 000 1340
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A.3 Description of Shallow Seismic Parameters for Custom 
Settings

6. Sample Freq (Hz) determines the number of samples used to represent the incoming
data and can be altered via a text-entry box. The default sample frequency of
40 000Hz (40KHz) per data channel can be altered by clicking on the text-entry box
and edited using the keyboard. It is very important to ensure that the sampling
frequency is high enough to prevent aliasing or undersampling. Typical suggested
sample frequencies are given in Appendix A. The minimum sampling frequency is
3.5KHz; the maximum sampling frequency is 160KHz overall, in other words if
four channels are being used, the maximum frequency for each channel is 40KHz.

7. Samples/Ping is the number of samples used for each ping return. It can be altered
via the associated text-entry box. This setting affects the time over which the signal
is sampled and hence the sampled range of the input sidescan signal, or the sampled
depth for a seismic signal. For example, with a sampling frequency of 40KHz and

2560 samples per line, this gives a sampling time of  seconds. For a

typical speed of sound in water of 1500m/s, this will give a distance of 0.064 x 1500

= 96 metres. The range is therefore  metres.

Note: If samples per ping is set too high, it may take so long to collect the required number
of samples that the next trigger is missed. This will result in the beginning of the next pulse
being displayed as a continuation of the current ping. The sampled ping rate (indicated by
the lines per second in the General Information Area) will also appear to halve, as every
second trigger will be ignored. To remove this effect, decrease the number of samples per
ping.

8. Start Delay (ms): the delay in milliseconds between the start of the trigger and
starting to acquire data. This can be used (for example) to reduce the length of the
sampled water column. The default start delay is 0 milliseconds, but can be
increased for each data channel in the appropriate text-entry box. When a start delay
has been entered in the text-entry box, this will be used in calculations where appro-
priate.

9. Total Sweep Time: a label showing the calculated sweep time for the given input
values.

The important parameters for acquisition of shallow seismic data are similar to those for
sidescan. These parameters are:

1. Trigger Period

2. Samples Per Ping

3. Sampling Frequency

4. Sweep Time (corresponding to range depth)

Again, these parameters are interrelated in a similar way to that described in Section A.2

1. Trigger Period
This represents another method of presenting the triggering rate, or ping rate. If the DA System
system is triggered externally, this value is computed automatically and can be read from the
General Information Area, as it corresponds to the pings/s. If the sonar is triggered by the DA
System (that is, an internal trigger is output via the Trigger Out connection) this value can be
automatically calculated by the system or computed by the user to ensure that:

• it provides a trigger at the correct rate

• it is not in conflict with the samples per ping and sampling frequency values, as outlined
below.

2. Samples per Ping
The number of samples or pixels (or dots) used to digitise each ping. This corresponds to the
number of pixels which would be drawn across a thermal recorder’s sheet for the channel.

2560
40000
--------------- 0.064=

96
2
------ 48=
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3. Sampling Frequency
The rate at which the digitising hardware samples the incoming analogue data. The sampling
frequency must be high enough to ensure that the required number of samples per ping are
acquired for each successive trigger.

These three parameters are closely related according to the expression:

Therefore, 

 

4. Sweep Time
The sweep time selected must be long enough to ensure that the correct range is achieved. In
addition, the sweep time is related to the sampling frequency and the ping rate. The ping rate
should be slow enough or the trigger period should be long enough to ensure that each ping has
enough time to travel through the water, penetrate the correct depth and return to the receiving
transducer. In mathematical terms this means that:

Allow a ‘dead’ time of at least 2ms. In order to calculate the correct sweep time from the custom
settings, one must use the sampling frequency and samples per ping values.

If one wants a sweep time of 50 milliseconds, one must ensure that sweep time is related to the
sampling frequency and samples per ping in the custom settings according to:

In addition, the sweep time determines the range of the ping through water and sediment.

Range = Sweep Time x Velocity of Sound Through Medium

Assuming that all sediments have a speed of sound higher than water, we can calculate the
maximum sweep time required for a specific range using:

So once the sweep time is calculated for the required range, then the sampling frequency and
ping rate can be calculated.

The example which follows should clarify the above theory.

Note: Please note that this theory and the following examples only take into account those parameters for
accurate digital data acquisition. Parameters for the shallow seismic sonar itself e.g., sonar frequency which
determines the sonar range has not been addressed here. These parameters must be determined by the
sonar engineer. As long as the information here is used correctly then the sonar data will be recorded
correctly, at the correct resolution and sampling rate.

A.3.1 Shallow Seismic Custom Settings – Example 1

Requirement:
A range of 50m is required (20 metres water depth and 30 metres through clay).

Explanation:
Typical settings can be derived as follows:

The sweep time can be calculated using the expression derived above:

Therefore, using a velocity of 1500m/s:

SamplingFrequency NumberOfPingsPerSecond SamplesPerPing×≥

SamplingFrequency TriggerRate SamplesPerPing×≥

SamplingFrequency
1

TriggerPeriod
------------------------------------- SamplesPerPing×≥

SweepTime TriggerPeriod DeadTime+≤

SweepTime
SamplesPerPing

SamplingFrequency
------------------------------------------------------≥

SweepTime
PenetrationRequired

VelocityOfSoundInWater
---------------------------------------------------------------------=

SweepTime
PenetrationRequired

VelocityOfSoundInWater
---------------------------------------------------------------------=
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To select the correct sampling frequency and ping rate, the following expression is used:

The number of samples per ping should ideally be a multiple of 512, as this is the width of a
display channel on the DA System.

The sampling frequency should be high enough to prevent aliasing, and so a minimum sampling
frequency of 20KHz should be used.

If this minimum value of 20KHz were used, the number of samples per ping would be defined
by:

So, 

That is, the number of samples per ping should be at least 667.

However, as the number of samples per ping is the maximum number of points visible on the
screen per ping, it would be better to maximise the number. This determines the maximum
resolution of the display in a similar way that dots across the paper trace affect the image on
thermal paper recorders.

In addition, we wish to make the samples per ping a multiple of 512. Therefore, it would be better
to have at least 1024 samples per ping. Doubling (roughly) the samples per ping should double
the sampling frequency to maintain the relationship:

So , or .

These settings are suitable to obtain range of 50m, no aliasing, and good display resolution.

A.3.2 Shallow Seismic Custom Settings – Example 2
There is a requirement to sample the data from a SBP of at least 40KHz. The SBP ping rate is
10Hz, and the master trigger is to be provided by the DA System.

Only the channel with sub-bottom profiler data should be digitised (data channel 1 in this case),
and its Description field should be set to seismic.

The sample rate is arrived at as follows:

• The line length should be a multiple of 1024 (so that the displayed line will fill the data
display area of the screen) – either 1024, 2048, 3072 or 4096 samples.

• The required sample frequency is at least 40KHz, so that would imply that at least

samples would be required. Therefore, use 4096 samples per line.

• Allow a ‘dead’ time of at least 2ms before each trigger.

No start delay or line reversal is required. Range will be on Auto (unused by Seismic type data,
in any case). The trigger will be trigger A.

The trigger setup is straightforward – an internal trigger, with a period of 0.1 seconds, is required.

The voltage range selected will depend on the magnitude of the incoming signal; in this instance,
a signal which varies between -1.25 and +1.25 volts is assumed.

SweepTime
50

1500
------------ 0.033s 33.3ms= = =

SweepTime
SamplesPerPing

SamplingFrequency
------------------------------------------------------≥

0.0333
SamplesPerPing

20000
-------------------------------------------≥

SamplesPerPing 20000 0.0333×≥

SweepTime
SamplesPerPing

SamplingFrequency
------------------------------------------------------≥

0.033
1024
40000
---------------≥ 0.0256= 33ms 25.6ms≥

40000.0
10

------------------- 4000=
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A.3.3 Approximate Sound Velocities Table
As mentioned earlier, the sweep time determines the range of the shallow seismic sonar system.
For convenience, the following table can be used to convert between sweep time in seconds and
range in depth (m). 

The range of the shallow seismic profiler is defined in terms of seconds rather than depth. Some
rough calculations can convert this time to depth for different seabed types as follows:

For example, sound travels through soft mud at a rate of 1500ms, so in 25ms (it must be reflected
and travel back to the receiver) it would travel a distance of (0.25 x 1500) = 37.5metres. If the
same ping were to travel through rock, the range would be (0.025 x 1800) = 45 metres.

A.3.4 Default Sub-Bottom Profiler Setups
The following table shows the settings used by the DA System system for a Standard Sub-
Bottom Profiler data channel.

Material Velocity of Sound
(approximate)

Clay 1600

Soft Mud 1500

Rock 1800

Gravel 1700

Sweep Time 
(msec)

True Range 
(in water, 

m)

Trigger 
period 
(msec)

Trigger 
Rate (pings 

per sec)

Sample 
Frequency 

(Hz)

Samples/
Channel

50 75 50 20 40 960 2048

100 150 100 10 35 840 3584

200 300 200 5 19 200 3840
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B Coda Navigation Data String

To get the most from the Coda-DA System system, you must ensure that the system has access
to the highest quality navigation data available. The following variables should be passed to the
system, if at all possible: towfish easting (UTM or lat/long), towfish northing (UTM or lat/long),
towfish Kp, towfish DCC, water depth, towfish altitude, towfish speed made good, towfish
heading, survey line designation, fix number and system time.

A number of optional navigation string entries are available on the system; new entries can be
edited on the system or can be made up by Coda on request. However, we would encourage you
to use the ‘CODA’ string format, as it has all the fields necessary to ensure that features such as
on-screen measurement and cursor position reporting function correctly. The nav string should
be updated as frequently as possible, though updates at greater than the pulse repetition rate will
be ignored.

The output of an accurate system time is vital if the instantaneous navigation data is intended to
be updated with corrected navigation data. The time input allows the Coda system to synchronise
with the DGPS/nav computer clock, allowing for easy correction of the navigation information
stored with each sonar ping. It should be noted that this time must be the time of transmission of
the navigation string from the nav computer to the Coda system, rather than the time of the fix.
A separate field is provided to allow the delay between obtaining a navigation update and its
transmission to the Coda system to be entered. It is important that the clock source used for the
system is as reliable and consistent as possible; the reliability of the system may be adversely
affected if the incoming time is unreliable or inconsistent.

Two Coda String Formats exist: Coda-Date, which uses a date/time format for the date and time,
and the Coda Format, which uses a UTC format for time.

B.1 Coda Format
The Coda string format is an ASCII string which is started with the key ‘CODA’ followed by
floating point values and strings, separated by the ASCII space character and terminated by a
carriage return and line feed, as follows:

CODA Easting Northing Kp DCC Depth Altitude Speed Heading Line Fix Soundspeed Delay
Time<CR><LF>

The floating point format allows any number of characters before and after the point. The point
itself may be omitted if unnecessary.

• Easting is UTM or lat/long Easting of the towfish in metres.

• Northing is UTM or lat/long Northing of the towfish in metres.

• Kp is along-track kilometre point in kilometres.

• DCC is distance cross course in metres; this is defined to be negative if the towfish is to port
of the survey centreline, and positive if the towfish is to starboard of the survey centreline.

• Depth is water depth in metres.

• Altitude is towfish altitude in metres.

• Speed is towfish speed in knots.

• Heading is towfish heading in degrees (0–360).

• Line is survey line number or name, as a 15 character ASCII string with NO SPACES.

• Fix is last valid fix number.

• Soundspeed is the speed of sound through water in metres per second.

• Delay is the delay between the fix data being obtained and its time of transmission, in
seconds.

• Time is system (DGPS) time in seconds since January 1st 1970 (Co-ordinated Universal
Time, UTC). To convert date and time to UTC, see Appendix C.

Example:

CODA 123.354 33998.005 12.234 77.09 34.5 10.2 4.3 031.8 RFP1002 344 1503.45 1.03
797619096.002<CR><LF>
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This string means: towfish at easting of 123.354m and northing of 33998.005m, at a Kp of
12.234 km and dcc of 77.09m, in a water depth of 34.5m and a fish height of 10.2m, travelling
at 4.3 knots with a heading of 031.8 degrees. The survey line number is RFP1002, and the last
valid fix was number 344; the sound velocity was 1503.45 m/s, the delay between fix and trans-
mission was 1.03 seconds, and the date and time of transmission was 20th April 1994, 15:50 and
2 milliseconds.

B.2 Coda-Date Format
The Coda-Date format replaces the UTC ‘time’ entry with a time entry of the form hh:mm:ss
dd:mm:yy; that is, hours, minutes, seconds followed by day, month, and year (since 1900).

Example:

CODA-DATE 123.354 33998.005 12.234 77.09 34.5 10.2 4.3 031.8 RFP1002 344 1503.45 1.03
15:50:00 20:04:94<CR><LF>

(This string has the same meaning as the Coda string given in the example above).

Note: The on-screen measuring and tag position calculation both rely heavily on the accuracy of the incoming
navigation data. It is particularly important that jitter or noise in the incoming data is eliminated as far as
possible. For instance, the heading information derived from flux-gate compasses (as fitted to towfish) can
vary widely over a short period of time. To increase the accuracy of the measurements obtained from the
instantaneous navigation data, such noisy inputs should be filtered to reduce the extent of fluctuations. The
best quality navigation data, and therefore on-screen positioning, is derived from smoothed or corrected
navigation data (see Section 6.6.1).
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C Corrected Navigation Data Format

Section 6.6.1 discusses the details of how to correct navigation data as it is read from tape by the
DA System system. Correction of the navigation data requires a floppy disk with an appropriate
smoothed or processed navigation file. The format for the corrected navigation file is described
below.

The corrected position at each fix is written in ASCII text to the file, with white space (tabs or
spaces) separating each entry:

time fix easting northing heading kp dcc layback fish_offset fish_height water_depth

The time should be in UTC format – that is, the time in seconds since 1st January, 1970. (The
note at the end of this section shows how to convert a date and time in GMT to UTC.) The
Easting and Northing should be in the same format as the original Easting and Northing – metres
if the navigation basis was UTM, and degrees if the navigation basis was WGS84; in both cases,
the easting or northing should be written as a decimal fraction (for example 59.6543), rather than
in degrees, minutes and seconds of arc. The corrected heading should be in degrees (0 to
359.999), Kp in kilometres and dcc, layback and fish_offset in the same units as those originally
used when the navigation data was obtained, that is, metres. If a field is not relevant or if no value
has been calculated, the character ‘-’, ‘#’ or ‘*’ should be placed in the appropriate column.

Each corrected entry should be on a single line, with entries in ascending time order. If entries
are not in ascending order, nav correction will not be applied correctly.

The system’s basic frame of reference is the time stamp for each ping, which is why it is
necessary for the DA System clock to be synchronised with the navigation clock if navigation
correction is to be carried out.

Example:

800984945.435 2116 332348.99 5757666.95 * * * * * * *

This entry means that the correct position for fix 2116 taken at 800984945.435 was 332348.99
East and 5757666.95 North; no update was made to the heading, kp, dcc, layback or fish-offset
fields.

It should be noted that navigation data can only be corrected if it lies between two points in the
corrected nav file; interpolation to discover actual position and heading is otherwise impossible.

C.1 UTC Time Offsets

UTC Time Offset UTC

00.00.00 1 January 1970 0

00.00.00 1 January 1996 820454400

00.00.00 1 January 1997 852076800

00.00.00 1 January 1998 883612800

00.00.00 1 January 1999 915148800

00.00.00 1 January 2000 946684800

00.00.00 1 January 2001 978307200

00.00.00 1 January 2002 1009843200

00.00.00 1 January 2003 1041379200

00.00.00 1 January 2004 1072915200

00.00.00 1 January 2005 1104537600
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D Editing Navigation Library Strings

The DA System is delivered with a library for interpreting different navigation data string
formats. Users are encouraged to use one of the formats in that library; however, if this is not
possible users may create their own interpretation strings. Alternatively, contact Coda Technol-
ogies at the address in the front of this manual for further help.

Each navigation library entry allows the DA System to read data from ASCII text received
through a serial interface (usually COM2:). The navigation library format is described in the
following sections, using the following symbols:

|  – indicates logical ‘or’.

[ ] – indicates that the entry enclosed by the square brackets is optional.

The format of the library entry is as follows:

ident "identifier"
interpretation_list
endnav

A navigation library entry is defined to consist of a line beginning with the string ‘ident’ followed
by an identifier, delimited by double quotes. The identifier must be unique within the navigation
library file.

Note:  Any of the navigation entries which consists of more than one word should be enclosed in inverted
commas, for example "ASCII Text".

Text may be edited in Edit Nav Formats using the following options:

• Selecting Text: Text may be selected (that is, highlighted on the screen) by pressing the left
mouse button at the start of a section of text and dragging the pointer to the end of the desired
text. Alternatively, double-clicking the left mouse button with the mouse pointer over a word
selects that word. (A word is defined as text delimited by spaces or the beginning/end of a
line.) Triple-clicking the left mouse button with the pointer over a line selects the complete
line of text. Quadruple-clicking selects all the text in the file.

Clicking the left mouse button while text is selected deselects the text.

• Adding Text: Text may be added by clicking the left mouse button at the desired cursor
location. Typing text then inserts the text at that point.

• Deleting Text: Text may be deleted by using the Backspace key, to remove text before the
pointer, or the Delete key to remove text after the pointer. Selected text (see above) may be
deleted by pressing the Backspace key or the Delete key to remove the highlighted selection.

• Copying Text: To copy text, select the text to be copied (as detailed above) and click the
middle mouse button when the pointer is at the position where the selected text is to be
inserted. Clicking the middle mouse button inserts the text.

• Moving Around the File: The screen may be scrolled in the desired direction by selecting the
appropriate arrow in the scroll bar on the border of the screen. Clicking and dragging the
rectangle between the arrows scrolls the screen interactively. A further alternative is to click
the left mouse button in the area between the rectangle and the arrows. This causes the screen
to be scrolled either up or down by a page. Using the Page Up and Page Down keys on the
keyboard, provided the pointer is in the window, produces the same effect. A further option
enables a percentage position in the file to be scrolled by clicking the middle mouse button
in the area between the rectangle and the arrows in the border (that is, clicking the right
mouse button 10% of the way between the two arrows moves 10% of the way through the
data, clicking 90% of the way between the arrows moves 90% of the way through the data).

The Default Formats option in the Navigation Format Editor (accessed by selecting Edit Nav
Format) can be used to reset the user copy of the navigation string library to its default values.

Note: Any changes that you make are discarded when Default Formats is pressed.
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D.1 Navigation Interpretation Lists
A single navigation library entry is composed of an interpretation_list, which is defined to be
composed of a setup_list followed by a value_list. The setup_list contains general definitions
about the incoming navigation data (whether GMT or local time is being sent, for example),
while the value_list is the list of variables which will be updated from the navigation string.

interpretation_list:
setup_list
value_list

setup_list:
setup_entry |  value_entry
[setup_list ]

setup_entry:
setup_field_name value

From the above, it can be seen that a setup_entry in the setup_list is composed of a
setup_field_name followed by a value. The list of setup_field_names and their legal values is
given in the following table.

The value_list defines the variables to be updated by the incoming navigation string, and the
means of interpretation of the incoming value.

value_list:
value_entry
[value_list]

value_entry:
value_field_name interpretation_entry          width_entry        [offset               [gain]]

The value_list is seen to be a list of value_entries, which are themselves made up of a line
beginning with a value_field_name followed by an interpretation_entry, followed by optional
offset and gain values. Note that the order of value_entries within the value_list is the order in
which incoming ASCII characters in the navigation string will be expected to be parsed.

interpretation_entry:
"ASCII Text"|"ASCII Number"|"Binary Integer" – this defines whether the entry is ASCII (text
or value) or a binary integer.

setup_field_name  Value Description Status

key a unique identifier for the string required for group;
otherwise optional

nav basis "LATLONG": incoming values are latitude and 
longitude "METRES": incoming values are 
UTM

required

nav termination The terminator of the string (for example LF, 
CR)
value_entry type 

required for ASCII
optional for binary

separator ASCII character which separates navigation 
string entries
value_entry type

required for ASCII
not valid for binary
multiple separator 
entries are legal

time basis "GMT"  : incoming time is GMT
"LOCAL": incoming time is local

required

update warning time in seconds for the navigation time-out – if 
no new data has been received through the 
RS-232 interface, an error message will appear 
on the screen

optional (defaults 
to 30 seconds)
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width_entry:
"Variable"|[0-9][0-9][0-9]|ascii_string – either the word "variable" to show that the field width
is variable, or the number of bytes in the field. Binary fields may not be of variable length. An
ascii_string is a set of printable ASCII characters, enclosed by quotes if it contains spaces, for
example "CODA DATE". An ascii_string is used to define the contents of a field as well as its
width (for example for the key field).

Offset and gain allow the conversion of the incoming values from one set of units to another (e.g.
conversion of speed made good from metres per second to knots). The offset value in the
value_entry is added to the incoming value; this operation is defined only if the
interpretation_entry contains is "ASCII Number" or "Binary Integer"; it is permissible to set an
offset value if the interpretation_entry contains "ASCII Text", but it will be ignored. The gain
entry is multiplied by the incoming data value before the offset is added; again, the operation is
not defined for character strings, but a gain entry for character strings is legal.

The list of value_field_names is given in the following table.

value_field_name Incoming Value Interpretation Units

altitude altitude of towfish above seabed metres

cable out length of cable deployed to towfish metres

cep heading heading of major axis of the CEP (0 to 360) degrees

cep major length of the CEP major axis metres

cep minor length of the CEP minor axis metres

course course (0 to 360) degrees

data age time from receipt of GPS position data to trans-
mission of RS-232 string from navigation com-
puter

seconds

day day of month 
not required if nav_time is set

days

dcc distance cross course; defined to be positive if 
towfish track is to the starboard of the survey 
centreline

metres

depth depth from sea surface to seafloor metres

easting easting if nav_basis is UTM
longitude if nav_basis is LATLONG

metres
degrees

easting minutes not required if nav_basis is UTM; minutes of 
longitude if nav_basis is LATLONG

minutes of arc

east switch string to match if longitude is East; otherwise 
longitude is West
not required if nav_basis is UTM

ASCII

fix number fix number none

fix valid string to match if this is a valid fix ASCII

gdop geometric dilution of precision none

hdop horizontal dilution of precision none

h flap ROTV horizontal flap. Starboard positive degrees

heading towfish or vessel heading in degrees (0 to 360) degrees

heave instantaneous heave (up is positive) metres
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heave velocity instantaneous heave velocity (up is positive) metres/sec

hours hour of day (0 to 23)
not required if nav_time is set

hours

interrogate dolphin string/binary sequence with which to ask for a 
nav time update

none

interrogation 
period

interval between requests for nav time updates seconds

junk string data to be discarded ASCII

kp kilometre post value kilometre

layback distance from vessel to towfish metres

line name string containing survey line description (maxi-
mum 15 characters)

ASCII

milliseconds number of milliseconds since last integer
second

milliseconds

milliseconds in
minute

number of milliseconds from the start of the 
last minute

milliseconds

minutes minutes of hour (0 to 59)
not required if nav_time is set

minutes

minutes in day number of minutes since 00:00 minutes

month month of year (1 to 12)
not required if nav_time is set

months

nav time UTC time in seconds since 1st January 1970 seconds

nmen valid string to match if nav string is valid ASCII

northing northing if nav_basis is UTM
latitude if nav_basis is LATLONG

metres
degrees

northing minutes not required if nav_basis is UTM
minutes of latitude if nav_basis is LATLONG

minutes of arc

north switch string to match if latitude is North; otherwise 
latitude is South
not required if nav_basis is UTM

ASCII

pdop positional dilution of precision none

pitch instantaneous pitch value; forward rotation is 
positive

degrees

position fish source of position information:
0 – ship
1– towfish
(defaults to towfish if not set)

none

roll instantaneous roll; roll to starboard is positive degrees

seconds seconds in minute (0 to 59.9999)
not required if nav_time is set

seconds

seconds in day number of seconds since 00:00 seconds

smg speed made good knots

value_field_name Incoming Value Interpretation Units
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D.2 Navigation Groups
The purpose of the navigation group_list is to define a set of navigation library entries which are
all legal at the same time – the navigation computer is allowed to send whichever type it prefers
or makes most sense.

For a group to be legal, each of the navigation library entries must be able to be distinguished
from each other when they are received; this means that the key field (see Section D.1) must
uniquely identify each member of the group. It should be noted that all the entries in a navigation
group must have the same termination string.

The format of the library entry for a navigation group is as follows:

ident "identifier"
group_list
endnav

The group_list may be further defined as:

group_list:
group_entry
[ group_list ]

So a group_list is a list of one or more group_entry entities, where the group_entry is defined:

group_entry:
group "identifier"

A group_entry is a line beginning with the word "group", followed by a double quote delimited
string which is the identifier of a navigation library entry. An example of the definition of a
navigation group is given below.

D.3 Navigation Library Explained
An NMEA GGA string is being sent by your navigation computer to the DA System system. An
example string is shown.

$GPGGA,121345.65,5523.45,N,09333.45,E,O,11,0.9,9.3,M,1.3,M,3.2,1022*23<CR><LF>

This string contains the following information:

speed of sound speed of sound in water metres/sec

surge instantaneous surge; starboard positive metres

sway instantaneous sway; starboard positive metres

tdop time dilution of precision none

temperature water temperature degrees Celsius

utm zone UTM zone number (0 to 60).
default is 0 if not set

none

vdop vertical dilution of precision none

v flap ROTV vertical flap setting; up positive degrees

yaw instantaneous yaw; starboard is positive degrees

year year (AD)
not required if nav_time is set

year

121345.65 the fix time - 12:13:45.65 (GMT)

5523.45 Northing coordinate, 55 deg 23.45 min N (Latitude)

value_field_name Incoming Value Interpretation Units
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The first task is to determine the navigation identifier. This is stored against the key word “ident”.
This is the entry that appears in the “Navigation Format” list of the Nav Input Settings pop-up
(see Figure 5-18, page 66). In our example the entry should read: 

ident                                  “NMEA 0183 GPGGA” 

We now need to build our interpretation list. This is made up of two parts. The setup_list and the
value_list. The setup_list contains general definitions. Our setup_list for the example navigation
list would look like the following:

Note: We are not supplying “update” warning as we are happy with a time of 30 seconds. If our separator was
a space we would use the entry separator “ASCII TEXT” “ “.

Some of the common mistakes that lead to an error when accessing your navigation library entry
are:

• spelling separator incorrectly,

• missing closing quotes on strings,

• failing to enclose keys with more than two strings in quotation marks: for example, “Nav
Basis”.

Note: Please check for all of these if you have an error decoding your navigation string.

Now that we have set up the ident and setup, we must set up the value_list. These key words are
used to access data passed in your navigation string. We need to access the values in the order in
which they appear.

09333.45 Easting coordinate, 93 deg 33.45 min E (Longitude)

0 invalid GPS fix

11 11 satellites in view

0.9 horizontal dilution of precision

9.3 antenna altitude, 9.3 m

1.3 geoidal separation, 1.3 m

3.2 differential gps data is 3.2 seconds older

1022 differential ground reference station used was number 1022

23 checksum of 23

<CR><LF> carriage return, line feed, string terminator

“Time basis” GMT

“Nav basis” LATLONG

separator “ASCII TEXT” “,”

key “ASCII TEXT” “$GPGGA”

<All value_list nagivation entries, see below>

“Nav Termination” “Binary Integer” 1 10

endnav

hours “ASCII Number” 2 This will read 12
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None of the navigation entries shown above requires an “offset” or “gain” to be applied. We
could have entered a 0 then a 1 after each entry, but as this is the system default, we have inten-
tionally left “offset” and “gain” blank.

We are not interested in any of the other values in the navigation string so we are going to junk
them. The following does this for us:

Our complete interpretation list for the example navigation string looks like this:

minutes “ASCII Number” 2 This will read 13

seconds “ASCII Number” Variable This will read 45.65

northing “ASCII Number” 2 This will read 55

“Northing Minutes” “ASCII Number” Variable This will read 23.45

“North Switch” “ASCII Text” “N”

easting “ASCII Number” 3 This will read 093

“Easting Minutes” “ASCII Number” Variable This will read 33.45

“East Switch” “ASCII Text” “E”

junk “ASCII Text” Variable

junk “ASCII Text” Variable

junk “ASCII Text” Variable

junk “ASCII Text” Variable

junk “ASCII Text” Variable

junk “ASCII Text” Variable

junk “ASCII Text” Variable

junk “ASCII Text” Variable

junk “ASCII Text” Variable

ident “NMEA 0183 GPGGA”

“Time Basis” GMT

“Nav Basis” LATLONG

separator  “ASCII TEXT” “,”

key “ASCII TEXT” “$GPGGA”

hours “ASCII Number” 2

minutes “ASCII Number” 2

seconds “ASCII Number” Variable

northing “ASCII Number” 2

“Northing Minutes” “ASCII Number” Variable

“North Switch” “ASCII Text” “N”

easting “ASCII Number” 3

“Easting Minutes” “ASCII Number” Variable
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D.4 Example Navigation Library Entry
The following navigation library examples are taken directly from the navigation library on the
DA System.

#
# Coda nav type
# CODA Easting Northing KP DCC Depth Altitude Speed Heading Fix SpeedofSound
# DataAge LineName NavTime
#
#
ident           “CODA”
“Time Basis”            GMT
“Nav Basis”             METRES
“Update Warning”        30
separator               “ASCII TExt”    “ “
key                     “ASCII Text”    CODA
easting                 “ASCII Number”  “variable”      0       1
northing                “ASCII Number”  “variable”      0       1
kp                      “ASCII Number”  “Variable”      0       1
dcc                     “ASCII Number”  “Variable”      0       1
depth                   “ASCII Number”  “Variable”      0       1
altitude                “ASCII Number”  “Variable”      0       1
smg                     “ASCII Number”  “Variable”      0       1
heading                 “ASCII Number”  “Variable”      0       1
“Line Name”             “ASCII Text”    “Variable”      0       1
“Fix Number”            “ASCII Number”  “Variable”      0       1
“Speed of Sound”        “ASCII Number”  “Variable”      0       1
“Data Age”              “ASCII Number”  “Variable”      0       1
“Nav Time”              “ASCII Number”  “Variable”      0       1
# Note - time offsets in seconds for UTC
# these can be used as offsets for the Nav Time string
# e.g. “Nav Time” “ASCII NUmber” “Variable” +820368000 1 - would add the offset
# to the seconds since start of year for 1996
# 00:00:00 1/1/96     820368000
# 00:00:00 1/1/97     851990400
# 00:00:00 1/1/98     883526400
# 00:00:00 1/1/99     915062400
# 00:00:00 1/1/2000   946598400
# 00:00:00 1/1/2001   978220800

“East Switch” “ASCII Text” “E”

junk “ASCII Text” Variable

junk “ASCII Text” Variable

junk “ASCII Text” Variable

junk “ASCII Text” Variable

junk “ASCII Text” Variable

junk “ASCII Text” Variable

junk “ASCII Text” Variable

junk “ASCII Text” Variable

junk “ASCII Text” Variable

“Nav Termination” “Binary Integer” 1 10

endnav
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“Nav Termination”       “Binary Integer” 1      10
endnav
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E Coda Data Format Summary

E.1 Coda Data Information Table
The following data is stored along with the data from each ping by the DA System system. It may
not be a full list of data stored. For more details, contact Coda Technologies directly.

Variable Storage Class Description

channel byte label describing data – sidescan port, sidescan 
starboard, seismic, unknown

channel_count byte number of channels of data arising from this 
trigger event

sync_with byte which channel to synchronise with for display 
purposes

start_delay byte delay from trigger to start of data sampling (as 
a number of samples)

input_channel byte the input data (A/D) channel the data was cap-
tured on

trigger_number byte trigger used

tag_database_id long integer number which corresponds to the start time of 
the recording session, to allow correct database 
to be accessed

ping_number long integer incremented for each trigger event for the chan-
nel

line_time_secs long integer the time the trigger event, in seconds since 
00:00:00, 1st January, 1970 (UTC).

line_time_usecs long integer microsecond fraction of the trigger event time

pixel_time float effective sample period, in seconds

ad_sample_frequency float actual A/D sample frequency

aa_filter_frequency float anti-aliasing filter frequency

sonar_frequency float operating frequency of the sonar, in Hertz.

tx_power_db float the transmission power in decibels

rx_gain_db float the gain applied at the receiver in decibels

zero_offset short integer DC level of data samples

voltage_range byte voltage range used to acquire the data

fish_height float towfish distance from seabed as samples since 
trigger event

water_depth float total depth of water

speed_of_sound float speed of sound in water, in metres per second

temperature float water temperature

time_basis byte whether the time zone is LOCAL or UTC 
(GMT)
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nav_basis byte whether the navigation data is lat/long 
(WGS84), or undefined

utm_zone byte the UTM zone number used (0 to 60)

speed_over_ground float speed of vessel/towfish over ground, in knots

easting double vessel/towfish position E/W (UTM or lat/long)

northing double vessel/towfish position N/S (UTM or lat/long)

corr_easting double corrected vessel/towfish position E/W (UTM 
or lat/long)

corr_northing double corrected vessel/towfish position N/S (UTM or 
lat/long)

course float vessel/towfish course

heading float vessel/towfish heading

corrected_heading float corrected vessel/towfish heading

kp float vessel/towfish kp

corrected_kp float corrected vessel/towfish kp

dcc float vessel/towfish dcc

corrected_dcc float corrected vessel/towfish dcc

roll float vessel/towfish roll

pitch float vessel/towfish pitch

yaw float vessel/towfish yaw

heave float vessel/towfish heave

heave velocity float heave velocity in metres/second

gdop float general dilution of precision

pdop float position dilution of precision

hdop float horizontal dilution of precision

vdop float vertical dilution of precision

tdop float time dilution of precision

cable_out float number of metres of cable deployed

survey_line_name 16 bytes the line designation, as ASCII characters

flags byte flags defining the following:
1. presence/absence of anti-aliasing filtering
2. navigation correction
3. Start delay value to be used/not used in cal-
culating distances.
4. towfish altitude source – altimeter, fixed 
height, automated bottom tracking.
5. DA System clock synched/not synched with 
nav. computer.
6. Position datum – towfish or towing
vessel

Variable Storage Class Description
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Storage classes:

byte 8 bit integer

short integer 16 bit integer

long integer 32 bit integer

float 32 bit IEEE floating point number

double 64 bit IEEE floating point number
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F Filters

Both the low-pass and high-pass filtering options use time-domain implementations of digital
Butterworth filters (see T.W. Parks and C.S. Burrus, Digital Filter Design, Wiley, 1987). Since
the Butterworth filter is an infinite impulse response (IIR) filter, it has the advantage of using
relatively few filter coefficients and therefore consumes less computing power. The Butterworth
filter also has the advantage of a monotonic frequency response that is smooth over the complete
range of frequencies.

F.1 Butterworth Filter
The digital Butterworth filter is completely specified by three parameters: the sampling
frequency of the data, the cut-off frequency, and the roll-off rate. Whilst the sampling frequency
is obtained from the survey data, the values for both the cut-off and roll-off may be selected by
the user. The cut-off frequency marks the transition between the filter’s pass band and stop band.
From analogue filter theory, the cut-off frequency is defined as the point at which the frequency
response is 3dB down and, as such, indicates the point at which the frequency attenuation or
suppression starts to become significant. The cut-off frequency must always be below the
Nyquist frequency (that is, less than half the sampling frequency).

The roll-off rate is a measure of the rate at which frequency attenuation increases after the cut-
off frequency. For high-pass filters, the roll-off rate is always expressed as a positive value,
whereas for low-pass filters, this value is always negative. A roll-off rate with a higher
magnitude results in greater degrees of attenuation for those frequencies closest to the cut-off.
Occasionally, the magnitude of the roll-off rate requested by the user is not sufficient to allow
the required filter to be realised. In this case, the user will be prompted to double the roll-off
magnitude. Band-stop and band-pass filtering can be implemented by combined low-pass and
high-pass filters. A low-pass filter that is combined with a high-pass filter that has the higher cut-
off frequency will result in a band-pass filter, whereas a low-pass filter that is combined with a
high-pass filter that has the lower cut-off frequency will result in a band -stop filter.
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G Data Formats

Tapes can be recorded in both the Coda format and the SEG-Y format; however, we strongly
recommend that they are recorded in the Coda format. This is because the Coda format stores a
greater amount of information than the SEG-Y format, all of which is necessary if the Coda
processing modules are to be applied to the data with complete success. 

Note: Recording in SEG-Y is unavailable for multi-trigger data, due to the restriction in the SEG-Y format. It
is possible, however, to record in SEG-Y format when you are acquiring more than one trigger, provided that
you record only one trigger’s worth of information. If you try to record the channel with another trigger, the
system will pop up a warning and reset to Coda format.

Four tape formats (Coda, SEG-Y, Q-MIPS and SDEF) can be played back through a DA System
system if recorded or copied on a DA System system. However, not all DA System functions and
features can be guaranteed to work unless the format is Coda.

G.1 Copy Tape Format
The Copy Tape option allows tapes to be copied from Coda, SEG-Y, Q-MIPS™ or SDEF to any
of the CODA, SEG-Y, Q-MIPS™ or SDEF formats (see Section 11). This option can also be
used for making backup copies of data tapes.

Note: While Coda Technologies Ltd allow playing of SDEF, SEG-Y and Q-MIPS™ compatible format, we do
not guarantee that tapes of SEG-Y format which have been recorded on other systems will play on the CODA-
DA System.

Although every effort has been made to ensure that tapes in SDEF, SEG-Y and Q-MIPS™
format are compatible with those produced on other systems, no guarantee of compatibility can
be given.

For further details of the SEG-Y format, contact the Society for Exploration Geophysicists, P.O.
Box 3098, Tulsa, Oklahoma 74101, USA.

Note: Some SEG-Y readers cannot read the data recorded or copied in SEG-Y format if the files have
channels of differing line length.
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H Tape Drive Units

The DA System is supplied with one of three tape units: the HP C1533 or the HP C1599A DAT
DDS2 4mm tape drive; or the Exabyte Eliant 820 8mm tape drive unit. The DAT tape drives may
be recognised by the size of the slot for tapes (1 cm x 7.5 cm), which is smaller than that of the
Exabyte unit (1.6 cm x 9.5 cm).

H.1 Hewlett Packard HP C1533/C1599A 4mm DAT Tape Unit

H.1.1 Head Cleaning
Head cleaning should be carried out weekly if the system is being used continuously. The tape
drive indicates that head cleaning is necessary by low flashing of the right (amber) LED on the
tape front panel, as detailed below. Only a DDS head cleaning cartridge should be used; head
cleaning cassettes for audio DAT recorders will not work. The cleaning can be carried out at any
time during the acquisition or playback process. Inserting the head cleaning cartridge in the tape
drive initiates the automatic head cleaning process. When cleaning is completed, the head
cleaning cartridge is automatically ejected from the tape drive.

H.1.2 LED Interpretation
The front panel of the tape unit has two LEDs, the Tape LED (left) and the Clean/Attention LED
(right).

The left-hand green Tape LED shows tape activity as follows:

• Slow flashing green when the tape is being loaded or unloaded.

• Steady green when the tape is loaded.

• Fast flashing green during read/write operations.

The right-hand amber Clean/Attention LED shows the following conditions:

• Slow flashing amber (the Media Caution signal) to indicate head cleaning necessary, or that
the tape cartridge is at the end of its useful life.

• Steady amber to indicate a hardware fault (see Part IV).

Figure H-1, this page shows all the possible combinations for the LEDs:

Figure H-1 LED Combinations for the HP C1533/C1599A

H.1.3 Recommended Tapes
To ensure the best possible results and maximal reliability, we recommend tapes by the
following manufacturers are used: TDK, HP, Verbatim and Fujifilm.

Off
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H.1.4 Environmental Specifications
These specifications are for the HP C1599A tape drive. If a tape is in the drive, these specifica-
tions may be modified by the specifications for the tape, in which case the more stringent figures
apply.

H.1.5 Hints and Precautions
• Always allow the DA System to reach ambient temperature before switching it on. Failure to

do so may damage the tape drive.

• Always remove tapes from the tape drives before powering down the system. Failure to do
so may result in data loss or damage to the tape drive.

Parameter Specifications

Ambient
Temperature

Operating 5°C to 40°C 

Non-Operating (mech.) -40°C to 70°C 

Non-Operating (tape) -40°C to 45°C 

Humidity Operating 20% to 80% RH, non-condensing.
Max wet bulb temperature = 26°C

Non-Operating (mech.) 5% to 95% RH (change RH<30%/h)

Non-Operating (tape) 20% to 80% RH (change RH<30%/h)

Vibration Operating
(3 Axis)

Swept Sine: 0.3 g peak, 5–500 Hz @ 1 octave/
min

Random: 5–350 Hz @ 0.00053 g²/Hz

350–500 Hz @ -6 dB/octave

500 Hz @ 0.000271 g²/Hz 
(= 0.5 g rms)

Non-Operating 
(3 Axes)

Swept Sine: 0.75 g peak, 5–500 Hz @ 1 
octave/min

Random: 5–100 Hz @ 0.02 g²/Hz

100–137 Hz @ -6 dB/octave

137 –350 Hz @ 0.0107 g²/Hz 

350–500 Hz @ -6 dB/octave

500 Hz @ 0.0052 g²/Hz 
(= 2.41 g rms)

Shock Operating (3 Axis) no 
performance change

5.0 g peak for 3 ms – ½ sine

Operating (3 Axes) no 
data loss

8.0 g peak for 11 ms – ½ sine

Non-Operating 
(3 Axes) no damage

90 g peak for 3 ms – ½ sine
30 g peak for 26 ms – trapezoidal

Altitude Operating 0 km to 4.6 km (0 to 15 000 ft)

Non-Operating 0 km to 15.2 km (0 to 50 000 ft)

Suspended 
Particles

Operating and
Non-Operating

Suspended particle environment, 

T∆ 10°C( ) h⁄<( )

T∆ 20°C( ) h⁄<( )

T∆ 20°C( ) h⁄<( )

particles 200µgram( ) m3⁄<
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• Data cartridges may be write protected by sliding open the tab on the right of the cartridge,
so that the coloured tab becomes invisible. Do NOT do this while the cartridge is in the tape
drive.

• Always use DDS Media Recognition System Standard DAT type tapes. Do NOT use audio
DAT tapes under any circumstances; they are not of high enough quality for storage of
computer data.

• For best results, use DDS2 standard 120m tapes, rather than 60m or 90m tapes. The DDS2
standard tapes allow the tape unit to operate with a higher bandwidth, and a 120m DDS2 tape
stores twice as much data (4GB) as a 90m DDS tape (2GB). When recording two channels
of sidescan data, a 120m tape will last for at least 8 hours, a 90m tape will last for a minimum
of 4 hours. The system is unable to read from or write to non-DDS tapes.

• DAT tapes which have been recorded using instrument recorders (for example, TEAC and
Sony recorders) cannot be replayed directly using the DA System. These tapes have not been
recorded in a computer-compatible digital format and must be re-digitised to replay them
using the DA System. The instrument recorder outputs can be connected to the BNC input
channels on the DA System (see Section 4.1.2). However, navigation information will inevi-
tably be missing, resulting in many of the on-screen measurement and location functions
being unavailable.

• As with all other types of magnetic tape, it is recommended that DAT tapes are passed
completely through the tape drive once a year to prevent sticking.

H.2 Exabyte Eliant 820 8mm Tape Units

H.2.1 Head Cleaning
The tape drive should be cleaned regularly. When the tape drive needs cleaning, the top (amber)
and bottom (green) LEDs flash. As soon as posible after the LEDs start flashing, the tape drive
should be cleaned, using an approved Exabyte cleaning cartridge; cartridges for 8mm video
recorders are unsuitable.

H.2.2 LED Interpretation
The tape drive uses three LEDs to indicate its status. The top (amber) LED flashes when the tape
drive has an error or needs to be cleaned. The middle (green) LED flashes to indicate SCSI bus
activity. The bottom (green) LED indicates the presence of a tape in the tape drive, and flashes
when the tape is in motion or when the tape drive needs cleaning.

Figure H-2, this page, shows the various LED combinations that occur during normal tape drive
operation:

Figure H-2 LED Combinations for the Eliant 820
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H.2.3 Environmental Specifications

H.2.4 Hints and Precautions
• Always allow the DA System to reach ambient temperature before switching it on. Failure to

do so may damage the tape drive.

• Always remove tapes from the tape drives before powering down the system. Failure to do
so may result in data loss or damage to the tape drive.

• Data cartridges may be write protected by sliding closed the tab on the right of the cartridge,
so that the coloured tab becomes fully visible. Do NOT do this while the cartridge is in the
tape drive.

• Always use computer data standard cartridges. Do not use 8mm video cartridges, as they are
not of high enough quality for the storage of computer data.

• As with all other types of magnetic tape, it is recommended that Exabyte tapes are passed
completely through the tape drive once a year to prevent sticking.

Operating temperature +5°C to +40°C (+41°F to +104°F)

Operating rel. humidity 20% to 80%, non-condensing
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I Optical Disk Drive Units

Warning! Do not look inside the optical disk drive or use a mirror to look inside
the drive. The laser can cause eye damage

The drive does not require user maintenance. If the drive does not operate properly, do not try to
fix it yourself. Contact Coda Technologies.

I.1 Drive Controls

Figure I-1 Drive Switch and LED

Eject Button

Pressing this button causes the disk to stop spinning and then eject the cartridge. This button
has no function while the Prevent Media Removal command from the host is in effect, or if
a command from the host is being executed.

Activity Light

Shown below are the operating states indicated by the LED.

I.2 Error Conditions

Red flickering The drive detected a Self Diagnostic (CUDG) error. A detailed 
list of error codes is provided in Chapter 5.

Green on The drive is being powered up, the drive is reading data.

Green flickering The drive is executing a command.

Orange on The drive holds write data in the buffer memory.

Orange flickering The drive is executing a command and holds write data in the 
buffer memory or performing of an internal calibration.

Off The drive is not ready

Error Color 
1

Color 
2

Color 
3

Color 
4

RAM TEST FAILURE Orange Orange Orange Orange

SCSI RESET ALWAYS ASSERTED (SEE 
TERMINATION PROBE)

Orange Orange Orange Green

DSP WATCHDOG TIMER FAILURE Orange Orange Green Orange

Activity LIght Shutter Door Manual Eject Eject Disk Button
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I.3 Using Optical Media
Figure I-2, this page shows the location of the write-protection switch on the optical media
cartridge.

Figure I-2 Drive Write-Protection Switch

Observe these precautions when handling and storing optical media cartridges: 

1. Keep cartridges free from dust or dirt. Check the media periodically and clean it when
necessary. Cartridge cleaning kit are available from Maxoptix.

2. Keep cartridges free from moisture. Do not allow condensation on or in the optical disk
cartridge. Do not put cartridges in a damp place or by an air conditioner.

3. Do not expose cartridges to direct sunlight or place them near a heat source.

4. Do not open the shutter of the cartridges.

5. Do not drop cartridges.

6. Place a cartridge in its protective case when not inserted in the drive.

7. Keep the cartridge case horizontal or vertical during storage.

MICROCODE CHECKSUM FAILURE Orange Orange Green Green

SCSI CHIP TEST FAILURE Orange Green Orange Orange

ENDEC CHIP TEST FAILURE Orange Green Orange Green

POWER SUPPLY FAULT Orange Green Green Orange

OVER TEMPERATURE FAULT Orange Green Green Green

DISK BUFFER TEST FAILURE Green Orange Orange Orange

DSP ROM CHECKSUM FAILURE Green Orange Orange Green

DSP RAW R/W TEST FAILURE Green Orange Green Orange

INVALID VALUES FOUND IN NON-VOLA-
TILE MEMORY

Green Orange Green Green

LOADER FAILURE OR EJECT FAULT Green Green Orange Orange

SPIN UP OR SPIN DOWN FAULT Green Green Orange Green

Error Color 
1

Color 
2

Color 
3

Color 
4

Write Inhibited (Side)

Write Enabled (Side “A”)
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8. Do not stack “uncased” cartridges. Do not stack more than five “cased” cartridges.

9. Store media cartridges in an environment with the following specifications

I.4 Recommended MO Disks
To ensure best possible results and maximum reliability, we recommend a 2.6 Gb 1024 bytes per
sector MO disk by the following manufacturers:

• Maxoptix

• Sony

• Verbatim

or any 2.6 Gb 1024 bytes per sector MO disk that conforms to ISO/IEC CD 14517 (RW/WO)

I.5 Formatting Disks
Full details of how to format optical disks listed in Section 12.3.10.1.

I.6 Caring for the Drive
To maintain drive performance, observe these precautions:

1. Remove all media before moving the drive.

2. Avoid a dirty or dusty environment. Maintain the environmental specifications (temperature,
humidity, etc.) shown in section 5.9.

3. Do not use non-standard, non-specified or non-approved media in the drive. Do not use
damaged cartridges.

4. Do not stick objects into the drive (screwdrivers, etc.). Objects can damage internal mecha-
nisms mechanically or through static discharge.

5. Do not turn the drive on or off during cartridge loading or ejection.

6. Do not move, bump, or shock the drive during operation.

Caution: If the drive emits noises or vibrations, immediately eject the media and turn off
the power to the drive.

I.7 Performance Specifications

Temperature 10C to 55C

Relative humidity 3% to 90% RH

Absolute humidity 1g/m3 to 30 g/m3

Atmospheric pressure 60 kPa to 106kPa

Temperature gradient 15C/h max

Relative humidity gradient 10%/h max

2.6 GB (4X) FORMAT

CAPACITY, ON LINE 512 BPS 1024 BPS

1.519 GB 1.318 GB

ROTATIONAL SPEED 3868 rpm

SPINDLE SEQUENCE 4.0/1.9 sec
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** Time includes carriage motion and settling

Note: Loading time includes spin-up time. Loading time is defined as the time in which the START/STOP
UNIT command, using polycarbonate medium, takes to execute. But, in the case of immediate loading after
power on, the drive must perform a self diagnosis of about 6 seconds. If the optical disk cartridge is inserted
during self diagnosis, the loading time will be delayed until the self diagnosis is complete.

UP/DOWN TIME (typical) PLASTIC DISK

SEEK TIME**

Average (1/3 full stroke) <19 msec

Track to track <0.3 msec

Mamimum (full stroke) <55 msec

LATENCY (Average) 7.8 msec

TRANSFER RATE FROM/ TO DISK 24-48 Mbits/sec

AT SCSI (Async), Maximum 5 Mbytes/sec

AT SCSI (Fast Sync), Maximum 10 Mbytes/sec

2.6 GB (4X) FORMAT
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J Hardcopy Devices

J.1 Alden 9315 CTP Series Printers
The DA System can output data in real time during acquisition to the Alden printer via a parallel
interface.

Note: Before connecting the printer to the DA System, both the printer and the DA System must be shut down
and the power supplies to both switched off (see Section 13.1). The DA System should only be powered up
when the printer has been connected to the appropriate port of the DA System (see Section 4.3). The printer
must be switched on before the DA System has been powered up.

J.1.1 Configure the Printer
It is recommended that the Alden Electronics Operator’s Manual is used in conjunction with the
following instructions.

To print successfully from this device, the printer must first be configured correctly before
selecting the Alden printer from the DA System’s list of available printers.

Configuring the printer is only necessary when first setting up the DA System and the Alden
printer or after a hard reset of the printer (that is, switching the power on while the ON-LINE
button is pressed). The configuration is normally retained when the power is switched off.

In default mode the printer can print only about 8 lines per second. Resetting the printer allows
the Alden to achieve a maximum speed of 14 to 15 lines per second. This maximum speed
restricts the ping rate to the speed of the printer in acquisition mode. For best quality output,
therefore, Coda recommends that data is printed when the DA System is in playback mode rather
than in acquisition mode.

To reset the printer to default mode

1. Hold down the ON-LINE button while switching the power to the printer on (see ‘Reset’ in
the Alden Operator’s Manual).

To change the ADDR function (address) from the default (SCSI port) to the Parallel
interface:

1. Press the OFF-LINE button twice.
This puts the printer into Detach mode (as indicated on the printer’s display).

2. Press successively on the ADDRESS button to cycle through the options.
The Parallel interface is selected when ‘----’ appears in the ADDR display (see ‘Address’ in
the Alden Operator’s Manual).

To enable the printer to print at 15 lines per second

1. Switch the HEAD CALIBRATION off.
See ‘Custom Settings’ in the Alden Operator’s Manual.

2. Press and hold the PAPER key and turn the power ON.
The printer prints the CONSTANT test pattern and displays the default printer settings.

3. Switch the Head Calibration OFF by pressing either the TEST or ADDRESS buttons.
These buttons toggle the Head Calibration default between ON and OFF.

4. Press the ON-LINE button to exit test mode.

5. Select the appropriate PAPER TYPE.
See ‘Paper’ in the Alden Operator’s Manual.

6. Press the OFF-LINE key twice to put the printer into Detach mode. Cycle through the paper
options by pressing the PAPER button until the appropriate paper type is selected, ensuring
that the display shows an asterisk after the paper type; this designates high speed. The printer
is now configured correctly for use with the CODA-DA System.

7. Switch the printer on line by pressing the ON-LINE button.
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J.1.2 Select the Printer
Hardcopy Output is described fully in Section 9.1. 

1. Switch on the DA System.
The DA System should be switched on after the printer is switched on.

2. Select File→Hardcopy Output.

3. From the scrolling list of printers/plotters which appears, select Alden 9315 CTP.

4. Select the appropriate parallel port (LPT1 or LPT2), depending on which port the printer is
attached to (see Section 4.3).

5. Select tag colour from the one-of options of Black or White.

6. Toggle Output on.

7. Click on Apply or OK.
This starts printer output. To switch the output off, toggle the Output On button off and press
either Apply or OK. 

J.1.3 Troubleshooting
 see also: ‘Troubleshooting’ in the Alden Electronics Operator’s Manual.

No output

• Check the printer is on-line and ready.

• Check the parallel interface is selected (ADDR display on the printer shows ‘----’).

• Check the parallel cable connection. Note that both the printer and the DA System must
be switched off before removing or connecting a parallel cable.

• Check that the correct printer port has been selected from the DA System
File→Hardcopy Output menu item, and that the Output On toggle is activated in the
Hardcopy Output pop-up. Ensure that either the OK or Apply button has been clicked at
the bottom of the pop-up.

Slow output

• Check the printer HEAD CALIBRATION setting is OFF.

• Check the printer’s paper type setting shows ‘*’ appended to the medium selected.

• Check that the DA System has the correct playback speed selected in the Settings→-
Playback Speed menu item. This should be set to Fast as Possible.

Error message appears when the DA System is powered up

• Shut down the DA System, ensure that both the DA System and the printer are powered
off. Switch the DA System on after switching on the printer.

J.2 EPC 1086-2 Thermal Printer
The DA System can output data in real time during acquisition to the EPC 1086-2 thermal printer
via a parallel interface.

Note: Before connecting the printer to the DA System, both the printer and the DA System must be shut down
and the power supplies to both switched off (see Section 13.1). The DA System should only be powered up
when the printer has been connected to the appropriate port of the DA System (see Section 4.3). The printer
must be switched on before the DA System has been powered up.

J.2.1 Configure the Printer
It is recommended that the manufacturer’s manual is used in conjunction with the following
instructions.
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To print successfully from this device, the printer must first be configured correctly before
selecting the EPC 1086-2 printer from the DA System’s list of available printers.

Configuring the printer is only necessary when first setting up the DA System and the EPC
printer or after a hard reset of the printer (that is, switching the power on while the ON-LINE
button is pressed). The settings can then be saved for future use.

Configure the printer using the following settings:

J.2.2 Select the Hardcopy Device
Hardcopy Output is described fully in Section 9.1. 

1. Switch on the DA System.
The DA System should be switched on after the printer is switched on.

2. Select File→Hardcopy Output.

3. From the scrolling list of printers/plotters which appears, select EPC GSP-1086-2.

4. Select the appropriate parallel port (LPT1 or LPT2), depending on which port the printer is
attached to (see Section 4.3).

5. Select tag colour from the one-of options of Black or White.

6. Toggle Output on.

7. Click on Apply or OK
This starts printer output. To switch the output off, toggle the Output On button off and press
either Apply or OK. 

J.2.3 Troubleshooting
 see also: The manufacturer’s manual.

No output

• Check the printer is on-line and ready.

• Check the parallel cable connection. Note that both the printer and the DA System must
be switched off before removing or connecting a parallel cable.

• Check that the correct printer port has been selected from the DA System
File→Hardcopy Output menu item, and that the Output On toggle is activated in the
Hardcopy Output pop-up. Ensure that either the OK or Apply button has been clicked at
the bottom of the pop-up.

Error message appears when the DA System is powered up.

Shades: 64 data input: parallel

Medium: Film or Paper sweep: reverse

Scale Lines: 10 message user: 1

repeat cal.: 2 margin: 0.0

contrast: 0–10% char size: 2

Lpi: 20.0 Background: data

event: solid Auto event: off

width: 2048 signal: single

data type: 8 bits key rate: 0.125

line repeat: 1 scan rate: 0.1

slope: rising delay: 0.000
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• Shut down the DA System, ensure that both the DA System and the printer are powered
off. Switch the DA System on after switching on the printer.

J.3 EPC HSP100 Printer

Note: Before connecting the printer to the DA System, both the printer and the DA System must be shut down
and the power supplies to both switched off (see Section 13.1). The DA System should only be powered up
when the printer has been connected to the appropriate port of the DA System (see Section 4.3). The printer
must be switched on before the DA System has been powered up. The printer should NOT remain connected
to the DA System if it is powered off.

Configure the Printer
The printer has a set of internal DIP switches which control the printer setup parameters. These
switch settings must be set correctly in order to optimise the printed output when connected to
the Coda system. For the HSP-100 to be in GSP-1086 emulation mode (6 BIT), it is necessary to
have the internal Dip Switch Number 8 turned ON.

Changing to Digital Mode

J.4 Ultra 120, 195 or 200 Printer
The DA System can output data in real time during acquisition to the Ultra 120, 195 or 200
printer via a parallel interface. The following example describes the setup of the Ultra 120
printer; the instruction for the setup of the Ultra 195 and the Ultra 200 are very similar.

The DA System can output data in real time during acquisition to the Ultra 120, 195 or 200
printer via a parallel interface.

Note: Before connecting the printer to the DA System, both the printer and the DA System must be shut down
and the power supplies to both switched off (see Section 13.1). The DA System should only be powered up
when the printer has been connected to the appropriate port of the DA System (see Section 4.3). The printer
must be switched on before the DA System has been powered up. The printer should NOT remain connected
to the DA System if it is powered off.

Note: If the Ultra 120 fails to work, and using the power off/on and reset buttons does not work, there is a
reset button hidden under the unit which must be pressed to get the printer working again.

Configure the Printer
It is recommended that the printer manual is used in conjunction with the following instructions.

To print successfully from this device, the printer must first be configured correctly before
selecting the Ultra 120, 195 or 200 printer from the DA System’s list of available printers.

Configuring the printer is only necessary when first setting up the DA System and the Ultra
printer or after a hard reset of the printer (that is, switching the power on while the ON-LINE
button is pressed). The settings can then be saved for future use.

To prepare the printer, the following steps are necessary:

• Put printer in Digital mode.

• Select the Centronics option.

• Place the printer in Run mode.

This is achieved as follows:

Power up the Ultra printer. 

The following settings will be displayed as in Figure J-1, page 241:
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Figure J-1 Ultra 120 Standard Display

The first line of the display gives an indication of the printer mode; the *120-138 MODE: is a
standard output to the display and will not change. The description after the mode will be
ANALOG or DIGITAL.

The second line contains details of the mode.

A typical Digital mode display is shown in Figure J-2, this page.

Figure J-2 Typical Ultra Printer Digital Mode Display

The display in Figure J-2, this page, represents [Interface Lines per Inch Standby/Run] L-R
Takeup. These settings are described in the following table.

Changing to Digital Mode
Place the printer in Digital Mode. The first line of the display show the current mode of the
printer. If the mode shows Analog then put it into Digital mode by pressing

<CTRL + RS232/ANALOG>

The printer will restart and will now be in digital mode. The display will be similar to the
following figure.

Figure J-3 Typical Display for Ultra Printer in Digital Mode

Analog Mode Display

SBY Standby; The printer is in standby and will not 
print data.

RUN Run; The printer is ready to receive data.

TKUP Take Up (ON/OFF); When ON the paper will be 
wound onto a takeup roller.

Digital Mode Display

232 Interface 232/CEN - Either RS232 or Centronics

200 Lines per Inch 100/150/200 - Number of Lines per inch to be printed

SBY Standby/Run - Whether in Standby or Run mode (Start/Stop printing)

L-R Always Left and Right channel for digital

T Takeup T (or blank)- If T is present then roller will take up paper

SBY TKUP - ON

*120-138 MODE:ANALOG*

*120-138 MODE: DIGITAL*
[232 200 SBY] L-R

*120-138 MODE: DIGITAL*
[232 200 SBY] L-R
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Changing to Centronics Interface
The second line of the display will show the type of interface. If the mode (first three character
after the [) shows 232 then the printer is in RS232 interface mode. This can be changed as
follows:

Firstly, ensure that the printer is in standby mode. This can be checked by examining the three
characters before the ]. If this does not display SBY, the printer is not in standby mode. The
printer can be put into standby mode by pressing the keys

<SHIFT + ON LINE/TEST>

The STANDBY light will be lit and the display will show SBY before the ] character. The display
will be similar to Figure J-4, page 242.

Figure J-4 Typical Display for Ultra Printer in Standby Mode

Change to Centronics interface by pressing the SETUP Key twice

<SETUP ><SETUP >

The display will now show:

Figure J-5 Typical Display for Ultra Printer Interface Setup

Press the Clear/Enter key to change the Interface.

<CLEAR/ENTER>

The display will now show:

Figure J-6 Ultra Printer, Centronics Interface Setup

Now exit the Setup menu by pressing

<SETUP>

The display will now show:

Figure J-7 Ultra Printer, Set up to Receive Centronics Interface

Prepare the printer to receive data by putting it in RUN mode.

<SHIFT + ON LINE/TEST>

*120-138 MODE: DIGITAL*
[232 200 SBY] L-R

INTERFACE SERIAL
[232 200 SBY] L-R

INTERFACE CENTRONICS
[CEN 200 SBY] L-R

CENTRONICS
INTERFACE
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The display will now show:

Figure J-8 Ultra Printer, Set up for Centronics Interface

The printer is now setup to receive data over the Centronics port and can be selected as the
Printer in the Hardcopy Output pop-up (see Section 9.1).

Note: If the Ultra printer has to be powered down or disconnected from the DA System, ensure that the
parallel cable is disconnected first. The printer can the be safely powered down without affecting the DA
System.

*120-138 MODE: DIGITAL*
[CEN 200 RUN] L-R
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K A/D Card DOS Diagnostics Test

K.1 Test Procedure
If a problem occurs with data acquisition and a hardware fault is suspected, the following instruc-
tions should be followed.

1. Shut down the system using Shutdown in the File menu.

2. Insert a DOS boot floppy disk into the DA System floppy disk drive.

3. Press <Control-Alt-Delete> to boot from the DOS boot floppy disk and allow the machine to
re-boot.

4. When the ‘Enter new time:’ prompt appears, press <Return> to get the DOS prompt ‘A:\’.

5. Eject the DOS boot floppy disk and insert the DT31EZ/34EZ Diagnostics floppy disk.

6. Type <diag31> at the command prompt ‘A:\>’ and press <Return>.

7. Select the DT34-EZ menu item using the <Return> key.

8. Respond with <n> to the question about using factory configuration.

9. Press <i> and use the arrow keys to select interrupt level 15 for the A/D card. Press <Return>
when this has been done. Leave this screen by pressing <Return>.

10. In the Main Test Menu select Acceptance Test. Hit <Return>.

11. If the acceptance test passes all steps, ignore the question about the loop test, eject the
diagnostics floppy disk and press the Reset button. Otherwise, note the acceptance test
failure message and contact Coda Technologies.
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L Multiple Windows
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M Mobilisation Checklists

Before starting a survey with the CODA-DA System system, you should check that the
equipment is mobilised correctly. Correct mobilisation procedures ensure that, at the time of
sailing, the system is functioning correctly and is receiving all the data it needs in a form that it
understands.

We recommend that the mobilisation procedures are observed every time a vessel sails, and that
they form the basis of any ISO9000 definition of readiness for use before sailing.

If any of the items in the list below are unclear, feel free to consult our Technical Support staff
at any time. Details are given on the inside front cover of this manual.

Our Technical Support staff may ask about the mobilisation checklist items if technical support
is required during a survey.

M.1 DA System Mobilisation Checklist

DA System Mobilisation Comments Initials

1 System 

1.1 Does the hardware have the correct speci-
fications for the job?

1.2 Have you had enough training to operate 
the system?

2 Trigger Input

2.1 Is an external trigger required?

2.2 Does the system trigger repeatedly?

2.3 Does the pings per second displayed by 
the system correspond to the external trig-
ger rate? (see Section A)

3 Trigger Output

3.1 Is a trigger output required?

3.2 Connect all the systems which will be 
triggered by the DA trigger. Do they
all trigger correctly?

4 Analogue Data Input

4.1 Is the rub test/overside test satisfactory? 
Is the noise level acceptable?

4.2 Is the level of crosstalk between channels 
acceptable?

4.3 Is the ping rate detected by the DA system 
at the desired rate?

4.4 Is the range or sweep time correct? If not, 
reduce the range settings or sweep time.
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4.5 Is there annotator output on the data? 
There should not be.

5 Navigation Data Input

5.1 Is the input coming in to the correct pins?

5.2 Are the baud rate, parity and number of 
stop bits correct? (In other words, is the 
raw nav string arriving correctly?)

5.3 Are you being sent the expected nav 
string? (Look at the raw nav string.)

5.4 Are you using the best possible nav 
string? (In other words, are you using
as many of the Coda string fields as
possible?)

5.5 Is the nav string being interpreted
correctly?

5.6 Is each variable that you expect the nav 
string to update being changed by the nav 
string?

N/A

Make a list below of the variables and tick 
them off:

N/A

5.7

5.8

5.9

5.10

5.11

5.12

5.13

5.14

5.15

5.16

5.17

5.18

5.19 Save your nav string to floppy and reload 
it onto the system.

5.20 Write-protect the floppy and write the file 
name on it.

5.21 Does the system time synchronise with 
the nav time and does it remain so for 
>2 minutes?

DA System Mobilisation Comments Initials
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M.2 GeoKit/PI100 Mobilisation Checklist

6 Hardcopy Output

6.1 Does the printer produce the correct out-
put in playback?

6.2 Does the printer produce the correct out-
put in record/real time?

6.3 Do fix marks appear in the same place on 
annotator output (if used) as they do on 
the DA system?
Note: Switch off annotator output after 
you have checked the fix marks.

6.4 Do you have sufficient printer paper for 
the job?

7 Data Recording

7.1 Does data recorded have the nav and time 
set and is it updated correctly?

7.2 Do the start and end recording pop-ups 
appear at the start and end of recording?

7.3 Does data recorded on one tape/optical 
disk drive play back on another? Are any 
tape/disk drive warning lights active?

7.4 Do you have enough tapes (of the right 
kind)/optical disks for the job?

8 System Security

8.1 Is the system lashed down securely?

8.2 Is the monitor lashed down securely?

8.3 Are all cables tied down, with no direct 
strain possible?

Signed Date

CODA system mobilised for acquisition

GeoKit/PI100 Mobilisation Comments Initials

1 Tag Setup Files

1.1 Are the correct tag types set up? Have you 
included all the tag types required by the 
client?

1.2 Are the start/end codes correct?

1.3 Are the correct tags active?

DA System Mobilisation Comments Initials
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1.4 Are the forced measures set for the
appropriate tags?

1.5 Is the Tag Setup saved on the system hard 
disk/optical disk?

1.6 Has the Tag Setup been saved to
tape/optical disk, using Maintenance 
Menu→Backup Setup Files?

1.7 Has the Tag Setup file name changed on 
the system hard disk/optical disk?

1.8 Has the Tag Setup been reloaded onto the 
system hard disk from tape/optical disk, 
using Maintenance Menu→Restore 
Setup Files?

1.9 Is the tape/optical disk labelled and write-
protected?

2 Fast Tag Files

2.1 Are the Fast Tag Setup files correct for 
the job?

2.2 Is the Fast Tag Setup saved on the
system hard disk/optical disk?

2.3 Has the Fast Tag Setup saved to
tape/optical disk, using Maintenance 
Menu→Backup Setup Files?

2.4 Has the Fast Tag Setup file name changed 
on the system hard disk/optical disk?

2.5 Has the Fast Tag Setup been reloaded 
onto the system hard disk from
tape/optical disk, using Maintenance 
Menu→Restore Setup Files?

2.6 Is the tape/optical disk labelled and write-
protected?

2.7 Has the right mouse button been set up for 
maximum efficiency?

3 System Hard Disk

3.1 Have all previous interpretations and tag 
files been stored to tape/optical disk and 
labelled correctly?

3.3 Have all unwanted tag files on the system 
hard disk/optical disk been deleted?

4 Report Files

GeoKit/PI100 Mobilisation Comments Initials
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M.3 PI100 Mobilisation Checklist

4.1 Are the Report Setup files correct for the 
job?

4.2 Can the Report ASCII output on floppy 
be read by the system the report is 
intended for?

4.3 Is the report format as required and
meaningful?

4.4 Is the Report Setup file saved onto the 
system hard disk/optical disk?

4.5 Have the Report Setup files been
saved to tape/optical disk, using Mainte-
nance Menu→Backup Setup Files?

4.6 Has the Report Setup file name changed 
on the system hard disk/optical disk?

4.7 Has the Report Setup been reloaded onto 
the system hard disk from tape/optical 
disk, using Maintenance Menu→Restore 
Setup Files?

4.8 Is the tape/optical disk write-protected 
and labelled?

Signed Date

CODA system mobilised for Tagging 
& Reporting

PI100 Mobilisation Comments Initials

1 Tagging & Reporting

1.1 Have all the checks in the GeoKit/Pipe-
line Inspection Mobilisation Checklist 
(above) been carried out successfully?

2 Pipeline Inspection

2.1 Is the pipeline external diameter known 
for all the pipelines to be surveyed?

2.2 Is the client spec for touchdown known 
for all the pipelines to be surveyed?

2.3 Is the minimum span length to report 
known for all the pipelines to be
surveyed?

Signed Date

CODA system mobilised for Pipeline Inspection

GeoKit/PI100 Mobilisation Comments Initials
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M.4 TrackPlot/Mosaic Mobilisation Checklist

TrackPlot/Mosaic Mobilisation Comments Initials

1 Start TrackPlot/Mosaic

1.1 Has TrackPlot been switched on in the 
Coda system?

1.2 Is the tape/optical disk ready for
playback?

1.3 Is the seabed being tracked so slant-range 
correction can be applied to TrackPlot/
Mosaic?

1.4 Have you selected the appropriate
corrected nav file(s) in the Survey
Overview window?

1.5 Is the heading correct?

2 Navigation Data

2.1 Have you selected the appropriate
corrected nav file(s) in the Survey
Overview window?

2.2 Is the heading correct?

3 Data Display

3.1 When you start playing the tape/optical 
disk, is the vessel track displayed in both 
the Survey Overview and TrackPlot
windows?

3.2 Are you focusing on the correct Track?

3.3 Have the tags for display been selected in 
both windows?

3.4 Have Object Properties been set in the 
required Tracks of data?

3.5 In Mosaic, has image display been 
switched on in the TrackPlot window?

3.6 Once the Mosaic has built up, has it been 
manipulated to produce the desired 
image?

3.7 Have any required screen dumps been 
generated?

Signed Date

CODA-TrackPlot/Mosaic mobilised
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N On-Line Checklists

The purpose of these checklists is to ensure that the system operator is carrying out all the
required steps when tagging or generating reports with the Coda system.

N.1 Saving Tag Files to Tape/Disk Checklist

N.2 Loading Tag Files to System Hard Disk Checklist

Tape System:

Blank tape loaded into drive 1 1.

Files saved using Tagging→Manage Tag Files→Tape Load/Save. 
(Save Batch Overwrite to overwrite existing data on tape; Save Batch Append 
to write to the first blank section of the tape)

1.

Tag files saved correctly (List Previous Batch showed the appropriate tag files) 1.

Optical Disk System:

Blank optical disk loaded into drive. 1.

Tag files located and selected using Tagging→Manage Tag Files→Database
Location

1.

Tag files copied to target location using Copy Tag Files 1.

Tag files saved correctly (Database Location showed the appropriate tag files) 1.

Tape/Disk Systems:

Tag file tape labelled correctly: 1.

Date and time of recording 1.

Data Source 1.

Client 1.

Kp (start and end) 1.

Tag file name 1.

Tag file tape/optical disk write protected 1.

Tag file stored with data file tape/optical disk 1.

Tag file tape/disk loaded into correct drive 1.

Tag file tape rewound (tape system only) 1.

Tag file copied correctly. Tag filename appears in Tagging→Manage Tag Files
window following Rescan

1.
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O Interpretation Checklist

The purpose of this checklist is to make sure that the same tag and reporting setups are used
throughout the interpretation process, whether onshore or offshore. Problems will occur if the
data is being interpreted on systems which have different setups.

O.1 GeoKit/PI100 Interpretation Checklist

GeoKit/PI100 Interpretation Comments Initials

1 Tag Setup Files

1.1 Are the correct tag types set up? Have you 
included all the tag types required by the 
client?

1.2 Are the start/end codes correct?

1.3 Are the correct tags active?

1.4 Are the forced measures set for the
appropriate tags?

1.5 Is the Tag Setup saved on the system hard 
disk/optical disk?

1.6 Has the Tag Setup been saved to
tape/optical disk, using Maintenance 
Menu→Backup Setup Files?

1.7 Has the Tag Setup file name changed on 
the system hard disk/optical disk?

1.8 Has the Tag Setup been reloaded onto the 
system hard disk from tape/optical disk, 
using Maintenance Menu→Restore 
Setup Files?

1.9 Is the tape/optical disk labelled and write-
protected?

2 Fast Tag Files

2.1 Are the Fast Tag Setup files correct for 
the job?

2.2 Is the Fast Tag Setup saved on the
system hard disk/optical disk?

2.3 Has the Fast Tag Setup been saved
to tape/optical disk, using Maintenance
Menu→Backup Setup Files?

2.4 Has the Fast Tag Setup file name changed 
on the system hard disk/optical disk?

2.5 Has the Fast Tag Setup been reloaded 
onto the system hard disk from
tape/optical disk, using Maintenance 
Menu→Restore Setup Files?
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2.6 Is the tape/optical disk labelled and write-
protected?

2.7 Has the right mouse button been set up for 
maximum efficiency?

3 System Hard Disk

3.1 Have all previous interpretations and tag 
files been stored to tape/optical disk and 
labelled correctly?

3.3 Have all unwanted tag files on the system 
hard disk/optical disk been deleted?

4 Report Files

4.1 Are the Report Setup files correct for the 
job?

4.2 Can the Report ASCII output on floppy 
be read by the system the report is 
intended for?

4.3 Is the report format as required and
meaningful?

4.4 Is the Report Setup file saved onto the 
system hard disk/optical disk?

4.5 Have the Report Setup files been saved to 
tape/optical disk, using Maintenance 
Menu→Backup Setup Files?

4.6 Has the Report Setup file name changed 
on the system hard disk/optical disk?

4.7 Has the Report Setup been reloaded onto 
the system hard disk from tape/optical 
disk, using Maintenance Menu→Restore 
Setup Files?

4.8 Is the tape/optical disk write-protected 
and labelled?

Signed Date

CODA system mobilised for Tagging 
& Reporting

GeoKit/PI100 Interpretation Comments Initials
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Conversion Table

The following tables may be used for conversion from one unit of measurement to another. The
units are grouped under the headings: angle, area, length/distance, temperature, time, velocity/
speed, weight.

An Example of Use of the Tables
To convert a measurement from a unit in the first column (Unit A) to a unit in the fourth column
(Unit B), you multiply the measurement by the multiplier/conversion factor in the second
column (Unit A to Unit B multiplier/conversion). For example, to convert 10 knots to metres per
second: 10 x 0.5145 = 5.145 metres per second.

To convert a measurement from a unit in the fourth column (Unit B) to a unit in the first column
(Unit A), you multiply the measurement by the multiplier/conversion factor in the third column
(Unit B to Unit A multiplier/conversion). For example, to convert 10 metres per second to knots:
10 x 1.944 = 19.44 knots.

Angle

Area

Length/Distance

Unit A Unit A→Unit B
multiplier/conver-

sion

Unit B→Unit A
multiplier/conver-

sion

Unit B

degrees (angle) 57.3 radians

Unit A Unit A→Unit B
multiplier/conver-

sion

Unit B→Unit A
multiplier/conver-

sion

Unit B

acres square feet

acres 4047 square metres 

square feet 10.76 square metres

square miles square yards

square miles 640 acres

square miles 2.59 0.3861 square kilometres

square millimetres 1973 circular mils

Unit A Unit A→Unit B
multiplier/conver-

sion

Unit B→Unit A
multiplier/conver-

sion

Unit B

chain (surveyors’) 66 feet

fathoms 6 0.1667 feet

feet 30.48 centimetres

feet 0.3048 3.281 metres

inches 2.54 0.3937 centimetres

inches 12 feet

1.745 10 2–×

4.356 104× 2.296 10 5–×

2.471 10 4–×

9.290 10 2–×

3.098 106× 3.228 10 7–×

1.562 10 3–×

5.067 10 4–×

1.515 10 2–×

3.281 10 2–×

8.333 10 2–×
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Temperature

Time

inches miles

inches 1000 0.001 mils

inches 36 yards

kilometres 3281 feet

leagues 3 0.33 miles (approxi-
mately)

metres 1.094 0.9144 yards

miles (nautical)* 6076.1 feet

miles (nautical)* 1852 metres

miles (nautical)* 1.1508 0.869 miles (statute)

miles (statute) 1.609 0.6214 kilometres

miles (statute) 5280 feet

yards 3 0.3333 feet

US Survey Feet 0.3048006096 3.2808 metres

Mod Survey Feet 0.3048122530 3.2807 metres

Clarkes Survey Foot 0.3047972651 3.2809 metres

Indian Survey Feet 0.3047876058 3.2810 metres

* Conversion factors for the nautical mile and, hence, for the knot, are based on the Interna-
tional Nautical Mile

Unit A Unit A→Unit B
multiplier/conver-

sion

Unit B→Unit A
multiplier/conver-

sion

Unit B

Centigrade (Celsius) Fahrenheit

Unit A Unit A→Unit B
multiplier/conver-

sion

Unit B→Unit A
multiplier/conver-

sion

Unit B

GMT date & time see Appendix C see Appendix C UTC seconds

UTC seconds see Appendix C see Appendix C GMT date & time

Unit A Unit A→Unit B
multiplier/conver-

sion

Unit B→Unit A
multiplier/conver-

sion

Unit B

1.578 10 5–× 6.336 104×

2.778 10 2–×

3.048 10 4–×

1.646 10 4–×

5.400 10 4–×

1.894 10 4–×

C° 9
5
---× 

  32+ F° 32–( ) 5
9
---×
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Velocity/Speed

Weight

Unit A Unit A→Unit B
multiplier/conver-

sion

Unit B→Unit A
multiplier/conver-

sion

Unit B

knots** 1.688 0.5925 feet per second

knots** 30.87 0.0324 metres per minute

knots** 0.5145 1.944 metres per second

knots** 1.1508 0.869 miles (stat) per hour

metres per minute 3.281 0.3048 feet per minute

metres per minute 0.06 16.67 kilometres per hour

miles per hour 0.4469 2.2374 metres per second

miles per hour 88 feet per minute

miles per hour 1.609 0.6214 kilometres per hour

** Nautical miles per hour

Unit A Unit A→Unit B
multiplier/conver-

sion

Unit B→Unit A
multiplier/conver-

sion

Unit B

kilograms 2.205 0.4536 pounds (avoirdu-
pois)

1.136 10 2–×
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Glossary

A/D conversion the process of converting an analogue signal to a digital one

absolute using a predefined frame of reference (0 Kp, or 0:00 on 1st Janu-
ary, 1970); see also relative

AC Alternating Current; mains supply

acquisition see data acquisition

acquisition mode see data acquisition mode

acquisition parameters the settings used within the acquisition sub-system to determine 
the quality and volume of the digital data obtained

acquisition sub-system the parts of the DA100/DA200 concerned with obtaining a digital 
form of the analogue sonar inputs

across-track at 90° to the towfish or vessel track

across-track resolution the distance across-track covered by each sample of sonar data

active channel a data channel which is currently being digitised

aliasing distortion of the input signal caused by carrying out digitisation 
at too low a sampling frequency

along-track along the line of the towfish or vessel track

along-track resolution the distance along-track covered by each sample of sonar data

altitude (of towfish) the distance above the seabed

ambient temperature the temperature of the surrounding air

analogue conveying information by changes in signal amplitude and phase; 
see also digital

annotation (of sonar records) the practice of using an external device to over-
lay the analogue sonar data with navigation information

Application Specific 
Area

the part of the DA100/DA200 display (in the bottom right of the 
screen) whose functions change in playback and acquisition 
modes

Apply A button which applies the settings or options selected and 
retains the pop-up window on the screen.

ASCII American Standard Code for Information Interchange; the world-
wide standard means of sending alphanumeric characters in a
7-bit format

auto pause release (of the DA100/DA200) a feature which prevents the freezing of 
the screen display by the Pause button if further pausing would 
cause loss of data to the screen

automatic position 
pointer

the pointer type used for resetting the position of automatically 
tracked features during PI100 operation

automatic sub-sample (of the DA100/DA200) the default sub-sample mode; this auto-
matically derives a sub-sample rate which allows the full swathe 
width to be displayed on the screen

batch a group of tag files saved in the same save operation
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baud rate (of RS-232 interfaces) the rate at which raw data bits are sent; 

roughly equivalent to bits/second

bit binary digit; the smallest information unit in a digital system

BNC connector industry-standard bayonet connector for analogue and digital
signals

bottom tracking (of the DA100/DA200) automated location of the seabed first 
return to allow the towfish altitude to be calculated

byte 8 bits

Cancel this button cancels any items or options selected and dismisses a 
pop-up window, retaining the previous settings

case sensitive recognising the difference between lower and upper case letters 
(for example, ‘a’ and ‘A’)

Centronics industry-standard parallel interface for connecting devices such 
as printers and plotters to computer equipment

cleaning cartridge the means of carrying out head cleaning for DAT or Exabyte tape 
drive units; a tape cartridge which holds cleaning tape rather than 
recording tape

click press down and release the appropriate mouse button; if no button 
is specified, the left button should be used

clipped (of analogue input signals) not converting the whole of the input 
range, thus losing some of the signal (for example, the outgoing 
pulse in sonar data); this should only be allowed to happen if the 
information being discarded will NEVER need to be recovered

Coda format Coda Technologies’ format for storing data to a recording media; 
retains more information about the recorded data than other
proprietary data formats

COM1 the name commonly used in DOS systems for the first serial port

COM2 the name commonly used in DOS systems for the second serial 
port

compression (of tape drives) the practice of eliminating redundancy in the data 
being recorded, allowing a larger amount of data to be stored in a 
given space

continuous record (of the DA100/DA200) a facility which allows recording of 
incoming data to carry on continuously, without the need to stop 
recording when changing data tapes or optical disks

contrast the variation in shades of grey or hue within the display

corrected navigation 
data

navigation information which has been smoothed to remove 
spikes or jitter from the positional information

creator node the first node in a multi-node tag

critical length (PI100) the length in metres that an automatically detected span 
must be before it is deemed to be a critical span (user-defined)

cross track at ninety degrees to the direction of travel of the towing vessel

cross-track offset the straight line cross-track distance from the vessel datum point 
to the point where the tow cable passes over the stern of the
vessel
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cross-track slant
distance

the distance measured between two points solely in the cross-
track direction. It is a non-slant corrected measure (i.e. it is 
dependent on fish height)

cross-track smoothing (of sidescan sonar data) low pass filtering of the sonar signal 
from the nearest to the farthest end of the swathe, using a filter of 
fixed frequency response

current tag (of the DA100/DA200) the event marker selected to be active by 
clicking on the appropriate area of the Data Display Area. The 
selected tag flashes between its normal colour and light blue

cursor symbol that shows the position on the display where any typed 
text will be entered

DA100 Coda Technologies’ system for acquiring, processing and
replaying sidescan sonar or sub-bottom data, with single trigger
capability

DA200 Coda Technologies’ system for acquiring, processing and
replaying data from two independently firing sonars, e.g.
sidescan sonar and boomer

DAT Digital Audio Tape; an international standard for the recording of 
analogue data to digital tape; see also DDS and DDS2

data acquisition the process of obtaining data (usually in digital form)

data acquisition mode (of the DA100/DA200) the operation mode in which the DA100/
DA200 is digitising and records data; see also data playback 
mode

data bits the number of bits used to hold the information from each
sample; usually an integer number of bytes (8, 16 or 32 bits)

data channel a flow of data (for example, sonar data) into or within the DA100/
DA200; see also display channel

Data Control Area (of the DA100/DA200) that part of the DA100/DA200 interface 
which controls the operation of the tape or optical disk drive unit 
or units

Data Display Area (of the DA100/DA200) that part of the screen given over to the 
display of data from the acquisition sub-system or from tape or 
optical disk; the upper portion of the screen

data format (of tapes or optical disks) the scheme used to record the digital 
data onto the tape or optical disk. Different formats can result in 
different amounts of data being stored; see also Coda format,
Q-MIPS™ format, SDEF format, SEG-Y format

data playback mode (of the DA100/DA200) the operation mode in which the DA100/
DA200 reads previously recorded data from tape or optical disk 
and displays it on the screen

database a structured means for storing and retrieving data in digital form, 
allowing rapid random access to individual data entries

datum point the point on the towing vessel from which all measurements are 
referenced

DCC Distance Cross Course; the across-track distance of a point from 
the survey line

DDS Digital Data Storage; the standard format for storing computer 
data to DAT tapes
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DDS2 an improvement to the DDS standard, allowing a higher record-

ing density to be used, hence obtaining more storage capacity 
from a given length of magnetic tape

dead time (in digitisation) the time allowed between the end of sampling for 
a given data line (or ping), and the arrival of the next trigger 
pulse

DGPS Differential GPS. A form of GPS which uses a base station to 
send corrections to the satellite derived positions, allowing more 
accurate fixes to be obtained

digital representing information by a sequence of bits, rather than using 
the signal amplitude and phase; see also analogue

digital signal process-
ing

using numerical techniques to carry out signal filtering or ampli-
fication in the digital domain, rather than the analogue domain

digitisation the process of converting an analogue signal’s amplitude and 
phase information into digital form

display channel a data channel which is displayed on the DA100 screen

DOS see MS-DOS

DOS formatted (of floppy disks) formatted on the MS-DOS operating system

double-click press and release the specified mouse button twice in rapid
succession; if no button is specified, the left button should be 
used

dual tape (of DA100/DA200) a system having two tape drive units, rather 
than one

dynamic range that portion of an analogue signal which actually conveys
information; that is, the range of values between the highest and 
lowest encountered

Eastings distance East or West in metres of a given position from the UTM 
or lat/long origin

edge sensitive (of TTL input) reacts to the change in voltage level, rather than to 
the steady-state voltage level

Encapsulated Post-
script®

a form of Postscript® which is suitable for incorporating into 
documents on word processing packages, spreadsheets, and so on

EOT End Of Tape

Ethernet Local Area Network using a coaxial cable with BNC connectors, 
capable of up to 1.25MB/second transfer rate

event (DA100/DA200) a point in the data which the user wishes to mark 
using a database entry

Exabyte 8mm magnetic tape drive unit (based on 8mm video tape technol-
ogy) used for storage of digital computer data

external trigger (DA100/DA200) a TTL trigger which originates outwith the 
DA100/DA200, used by the system to initiate the acquisition for 
each ping

fast tag (PI100/GeoKit) colour-coded keys for accelerated marking of 
events during pipeline inspection
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file a set of data which exists as a distinct entity; on tape, file extents 

are defined by end of file markers; on disk, they are defined by 
the operating system

filtering the alteration of the frequency content of a signal; usually the 
removal of unwanted (noise) frequencies

first return (in sonar data) the first echo which rises above the noise level of 
the water column; the first point of contact of the outgoing pulse 
with the seabed

fish abbreviation for towfish

fish height (PI100) the true height of the sonar transducer (fish) above the 
seabed

fix a reference point (in time and space) for navigation purposes

fix tag the database entry for a given fix; see also tag

floppy disk portable magnetic media. Usually refers to 3½ inch double-sided, 
high density disks with a capacity of 1.44MB (formatted)

flow chart method of breaking down a task into a sequence of actions and 
decisions in diagrammatic form

flow control also known as handshaking

forced measure (following tag operation in PI100/GeoKit mode) a sequence of 
measurements of the tag’s features which may have to be carried 
out manually, rather than automatically by the system. The Tag 
Placement Rules define which measurements are required for a 
given tag

full resolution (zoom) using all the available samples for display; no sub-
sampling of any sort is carried out

gamma (colour mapping) the exponential function used to map incoming 
intensities to greyscale values

gamma correction the process of redisplaying the image data displayed on screen 
using a new gamma value

GB Gigabyte, approximately 1 000 000 000 bytes

General Information 
Area

(DA100/DA200) that area of the screen which holds the current 
ping number, time and cursor position; situated above the Data 
Control Area

GeoKit Coda Technologies’ software module for geophysical interpreta-
tion, which allows the user to tag events and generate ASCII 
report output

goto (DA100/DA200) a command allowing random access to sonar 
data stored on magnetic tape or optical disk

GPS Global Positioning System – a satellite-based navigation system

graphical user interface the means of interaction of the computer user with the programs 
running on the computer; uses the display, the keyboard and the 
mouse/trackball

greyed out (DA100/DA200) menu items which cannot be selected are greyed 
out, written in lighter, grey text

greyscale the range of shades from black to white
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grip see grip point

grip point (DA100/DA200) a point on an interactive graph, signified by a 
small square, which can be moved by users (using the mouse/
trackball) to alter the shape of the graph

GUI Graphical User Interface

half-wave rectify remove those portions of an incoming analogue signal which are 
below some threshold value (usually 0 volts)

handshaking (of RS-232 interfaces) the means by which the starting and
stopping of data transfers is effected; this can be carried out in 
hardware or software

hard disk the magnetic disk which is permanently attached to a computer 
system

hardcopy printed output; the generation of printed output

hardware electronic components

hardware handshaking handshaking carried out by electronic components, without the 
intervention of any computer program

heave compensation 
unit

a piece of equipment external to the sonar which monitors the 
vessel’s heave, and varies the timing of the trigger pulse sent to 
recording equipment (for example, the DA100/DA200), so that 
the effect of vessel heave is largely eliminated; used for sub-
bottom profiling

height trigger (PI100) the minimum height of the bottom of the pipe above the 
seabed that will trigger the pipe span condition (user-defined)

high contrast a large proportion of the available grey is used to display the 
regions of the image the user is interested in

high pass filtering removing the low frequency component of a signal

high resolution (of digital storage) retaining a large proportion of the original 
information content of the signal

hue the shade or tint of a colour

Hz Hertz; the SI equivalent of cycles/second

icon small symbol on the computer screen which represents some 
entity or function within the computer system

image enhancement performing image processing in order to improve the quality of 
an image (for example, the display of sonar data on a screen)

image processing performing manipulations to an incoming digital signal on the 
assumption that the data contained therein has some meaning as 
an image

indented (DA100/DA200) the buttons used to control the functions of the 
DA100/DA200 (for example the data control buttons) have a 
three-dimensional look; when a button has been activated, the 
shading changes and the button appears to have sunk into the 
interface – to have been indented

information window a window which supplies the user with information, but does not 
accept any input from the user (for example, the Survey Data 
window)
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input voltage range the range of voltages which can be digitised by the DA100/

DA200

intensity strength, brightness, magnitude or amplitude of a signal

interface a means of transferring information from one piece of computer 
equipment to another

internal trigger (DA100/DA200) a TTL trigger pulse which is generated by the 
DA100/DA200, allowing it to trigger other equipment (for
example, to trigger the sonar ping)

interpolation the practice of estimating the value of a variable at a point by
setting it between the values of later and earlier samples

invert causing the range of shades (for example, from black to white) to 
be reversed, so that items which were coloured black become 
white, and vice versa

IO Input/Output

ISA Industry Standard Architecture; a type of signal bus used inside 
PCs

jitter the noise present on a signal, causing observations which should 
be identical to differ

KB Kilobytes (1 024 bytes)

Kp Kilometre post (distance along the survey line or pipeline, in kilo-
metres)

Landscape mode (Postscript®) printed so that the bottom of the Postscript®
document is aligned with the long edge of the sheet of paper

layback the along-track distance from the datum point on the vessel to the 
towfish

LED Light Emitting Diode: small coloured light attached to electronic 
equipment

line of data all the data arising from a given sonar ping; for sidescan this 
implies both port and starboard channels

local area network the cabling and interfacing standards which allow a collection of 
computers to be connected to each other to share data and 
resources (for example, Ethernet, Token Ring)

lookup table the rule used to translate incoming digital signals into grey levels 
or colours for display; also known as palette

loopback testing a piece of equipment by using its own output as an input 
signal, thus testing both the input and output functionality

low contrast a comparatively small range of grey levels is used to display all 
the parts of the image the viewer is interested in; see also
contrast, high contrast

low pass filtering removing the high frequency component of a signal

LPT1 the name commonly used on DOS systems for the first parallel 
port

LUT Lookup Table

master trigger a trigger used to start a number of pieces of electrical equipment, 
to ensure their synchronisation
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MB Megabyte; roughly 1 000 000 bytes

Media Recognition 
System

second-generation DDS standard tapes, which have markings 
which allow the length of tape to be determined by the tape drive 
unit

megabyte approximately 1 000 000 bytes; see also MB

menu an area of the display (either a Menu Bar or a window) which 
allows users to choose from a number of options, using either the 
keyboard or the mouse/trackball

Menu Bar an area (at the top of the display in the DA100/DA200) in which a 
number of menu items are permanently displayed

merge length (PI100) the minimum length (or separation) between separate 
pipe events (e.g. spans) that will prevent the events from being 
merged as one single event (user-defined)

Microsoft Windows™ a windowing operating system for IBM-PC compatibles

minimum length (PI100) the minimum length a pipe event (e.g. span) can be
without it being discarded as being too short (user-defined)

Mosaic Coda’s software module for Mosaicing sidescan sonar records

mosaicing the process of geopositioning sidescan sonar records such that an 
image of a large area of the seafloor is built up line by line

Motif™ a library of software routines used for building user interfaces, 
giving a characteristic ‘look and feel’

mouse a pointing device for use with computers. Movement of the 
mouse moves the screen pointer; see also trackball

MS-DOS Microsoft Disk Operating System; see also DOS

multi-node tag an event marker which has several user-positioned points (or 
nodes), used to define a boundary or a layer

multi-resolution capable of displaying or processing data at a number of scales

multi-tasking (of operating systems) able to run several programs simultane-
ously 

nav string abbreviation for navigation string

navigation data any form of navigation information within the DA100/DA200

navigation input any form of navigation input to the DA100/DA200 system

navigation library (DA100/DA200) the reference table which allows the DA100/
DA200 to interpret incoming navigation strings

navigation string an ASCII string holding navigation data

node see tag node

non-interlaced (of computer monitors) displaying all the pixels within the
display in a single pass; interlaced displays take two passes, each 
displaying every second line of pixel data

northings distance North or South in metres of a given position from the 
UTM or lat/long origin

off-line processing which does not take place as data is being acquired, or 
at the rate of acquisition
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offset  (DA100/DA200) the distance of a given sample from a datum 

point; usually the distance of the start of the raw data line to the 
start of the displayed line

OK a button which selects and applies the settings or options selected 
and dismisses the pop-up window from the screen

on-line processing which takes place as the data is being acquired, and at 
the rate of acquisition

on/off toggle a switch on the DA100/DA200 display which turns a system func-
tion on or off; each selection of the switch changes the state of the 
function (if it is ‘on’, selection turns it ‘off’; subsequent selection 
turns it ‘on’ again)

one-of selection a form of switch on the DA100/DA200 display which selects one 
from a number of possible options, where all the possible options 
are displayed

operating system the program which ‘manages’ a computer, allowing the user’s 
programs to run (e.g. Unix, Windows, DOS)

option selection a form of switch on the DA100/DA200 which selects one from a 
number of possible options, where all the options except the one 
selected are hidden

outgoing pulse the pulse of sound energy which is reflected to form sonar 
images; visible on recorded sonar data as the bright stripe at the 
beginning of each line

overlay plane additional coloured graphics which can be displayed on top of 
sonar data; these may be switched on and off without affecting 
the displayed data

overwrite record another set of data over the first, making the first data set 
unrecoverable

palette equivalent to lookup table

parallel port a form of interface which allows a computer to interchange data 
with the outside world in parallel form (that is, passing all 8 bits 
of a byte simultaneously)

parity a form of error checking for each byte of data transferred (for 
example, through a serial or parallel port)

password a collection of letters and numbers which uniquely allows access 
to a computer or a set of programs on a computer

PCI Peripheral Component Interconnect: an advanced, high-speed bus 
system used by PC-compatible computers

PI100 Coda Technologies’ Pipeline Inspection system, which allows 
complete pipeline surveys to be undertaken without the use of 
thermal recorders

ping a single sonar scan, resulting in a line of data being acquired

pipe distance (PI100) the slant distance from the sonar transducer (fish) to the 
front of the pipe

pipe grazing angle (PI100) the angle made between the ensonified pipe, the trans-
ducer and the seabed directly below the transducer

pipe height (PI100) the true height of the bottom of the pipe above the seabed
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pipe striking angle see pipe grazing angle

pixel picture element; the dots on the screen from which an image or 
GUI is built

playback mode see data playback mode

playback speed the rate at which sonar lines are displayed on the screen

pointer the icon which reflects changes in the mouse position, or move-
ments of the trackball. Usually an arrow, but may take other 
forms

pop-up menu a menu which appears as the result of a selection in a previous 
menu

pop-up window any form of window which appears as the result of a mouse/
trackball, or keyboard selection from a menu in the interface

port equivalent to interface; also left – see also starboard

Portrait mode (of Postscript® documents) printed so that the bottom edge of the 
document is aligned with the shorter edge of the paper

positive edge (of TTL inputs) a signal which changes from 0 to 5V

Postscript® a language for describing printed matter (text, diagrams and 
images)

power down the procedure to be observed when turning off the mains power to 
an item of electrical equipment

power up the procedure to be observed when turning on the mains voltage 
to an item of electrical equipment

pre-emptive scheduling allowing one program running in a multi-tasking operating
system to cause other programs to be suspended and only 
restarted once the pre-empting program has completed its tasks

press and drag press down the appropriate mouse button, and without releasing 
it, move the mouse so that the pointer is in the desired position on 
the screen; then release the mouse button

processed navigation 
data

see corrected navigation data

PSU Power Supply Unit: converts mains (AC) voltage to the lower 
voltages required by computer equipment

pull-down menu a menu which appears when a Menu Bar option is selected; items 
within a pull-down menu are selected by pressing and dragging 
to the required menu item

Q-MIPS™ format a format for the storage of sonar data to tape

random access obtaining data from a file or memory in an order which is not the 
same as the order the data was stored in

real-time occurring at the speed of data acquisition, or faster

reboot cause a computer system to completely re-initialise itself, as 
though the power had been turned off, then on again

recording session the time from the start of recording data to the cessation of 
recording
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relative using a local frame of reference (for example, time or distance 

measurements as an offset from the current time or distance); see 
also absolute

resolution the level of detail which may be extracted from a set of data

ROTV Remotely Operated Towed Vehicle. Subsea vehicle on which a 
sidescan sonar or sub-bottom profiler may be mounted

RS-232 an international standard for the interchange of serial data 
between computers

sampling to convert analogue data to digital form, it is necessary to
measure its amplitude at regular intervals; this is known as
sampling the signal

sampling frequency the frequency at which an analogue waveform is sampled to 
allow it to be converted to digital form

saturation (of colours) the depth of a given tint or shade

screen dump producing an image of the screen display, and either printing it or 
saving it to disk

scroll bar the means by which all the items in a list appearing in a menu or 
pop-up window may be examined

scrolling moving gradually up or down the display; one line of data must 
move out of the bottom of the display for every new line which 
appears at the top

SCSI-2 Small Computer Systems Interface, version 2; an improved
version of the SCSI standard for connection of peripheral devices 
(such as tape drives, disks and scanners) to computers

SDEF format Sonar Data Exchange Format: sonar interchange format devel-
oped by Meridian Sciences and US Geological Survey

SEG-Y format Society of Exploration Geophysicists ‘Y’ format; obsolescent 
standard for seismic and sonar data storage

seismic using vibrations to obtain an understanding of the underlying 
geological structure

select click the left mouse button on the appropriate item

serial port a form of interface which allows a computer to interchange data 
with the outside world in serial form (that is, one bit at a time)

shortcut key a single typed character or sequence of keyboard inputs which 
allows the user to carry out interaction with the DA100/DA200 
interface without using the mouse

sidescan sonar a form of sonar which uses twin sideways looking transducers to 
obtain an image of the seabed as it is towed through the water

signal processing see digital signal processing

single tape (of DA100/DA200) a version of the DA100/DA200 which has 
only one tape drive unit

slant range the distance across-track to a point on the seabed from the
towfish position; this is directly proportional to the time from the 
outgoing pulse transmission
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slant-range correction a geometric correction to the incoming sonar signal which

converts the across-track scale of the sonar data so that it is 
directly proportional to distance across-track, rather than to time

slave trigger the incoming TTL trigger pulse which causes a piece of elec-
tronic equipment to start a sequence of operations (for example, 
the digitisation of sonar data)

smart icon an icon which if selected causes a sequence of operations to take 
place on the interface (for example, the inversion of the display)

smoothed navigation 
data

see corrected navigation data

software computer programs

sonar sound navigation and ranging; the use of sound underwater to 
detect objects or make measurements

sonar input the analogue signal output by a sonar processing and control unit 
(for example, EG&G 260) which can be accepted as an analogue 
input by the DA100/DA200

span (PI100) section of pipe that is unsupported by the seabed

spline a function which smoothes the line of a graph through a number 
of points

stacking see trace mixing

starboard right; see also port

stop bits (of RS-232 interfaces) the number of bits following the data bits, 
before the start of the next byte transmission

string (of ASCII data) a collection of valid ASCII alphanumerical
characters

sub-bottom profiler a low-frequency sonar device for obtaining seismic information 
about the geology under the seabed

sub-sampling the practice of missing out data samples at regular intervals, 
allowing a signal to be represented by fewer samples

substrate the material which makes up the seabed or sub-bottom

swathe the area of the seabed covered by a sidescan sonar trace

tab form a form which contains a number of related items of information 
or selections and has a labelled tab at the top. As tab forms
overlap, the required tab form may have to be brought to the front 
of the pile by clicking on its tab

tag (of the DA100/DA200) a group of one or more interconnected tag 
nodes

tag node (of the DA100/DA200) a unique database entry defining a point 
within the data, or the screen graphic associated with it

tape cartridge the plastic cartridge containing the magnetic tape medium

tape drive see tape unit

tape head that part of the tape drive which is in contact with the tape 
medium, and causes the data to be written to the tape
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tape unit (or tape drive unit) that part of the DA100/DA200 mechanism 

which contains the tape head, and into which the tape cartridge is 
loaded

TCP/IP Transmission Control Protocol/Internet Protocol; an interface 
standard for local area networks

tear-off menu a pull-down menu which can be detached from the Menu Bar to 
allow it to be displayed permanently on the interface

telemetry measurements carried out at a distance (for example of the
towfish altitude)

text-entry box an area in a window which allows the user to type input using the 
keyboard, thus changing system parameters

thresholding the act of setting a level (for example, a greyscale intensity level, 
or a voltage), above and below which different actions are taken 
on the incoming signal

TIFF Tag Image File Format – a common, industry standard format for 
storing and exchanging binary image data

time varying gain see TVG

titlebar (of the DA100/DA200) the area at the top of the DA100/DA200 
screen which holds copyright information

toggle a form of switch which if pressed once is on, and if pressed again 
is off

Token Ring the IBM Token Ring protocol for local area networking

toolkit a set of tools or functions accessed through a single pop-up
window

topology the shape of a surface

towfish the vehicle towed by a surface vessel in which the sonar trans-
ducers are mounted

trace mixing adding (or subtracting) the data from succeeding sonar pings to 
remove along-track noise; also known as stacking

track the path of the vessel or towfish over the seabed

trackball a pointing device for use with computers; movement of the track-
ball moves the screen pointer; see also mouse

TrackPlot Coda’s software module for displaying vessel and towfish track 
information

TrackPlot Plus a version of Trackplot which allows the user to modify the
tagging carried out in a given survey area

transducer a mechanism which transforms energy from one form into 
another (for example, a sonar transducer converts electrical 
energy to sound energy)

trigger either an input which causes a piece of electronic equipment to 
start a sequence of operations, or an output generated by one 
piece of equipment, which others will use in this way; see also 
slave trigger and master trigger

trigger source the piece of electronic equipment from which the trigger pulse 
originated
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TTL Transistor-Transistor Logic; an electrical interfacing standard for 

digital signals

TVG Time Varying Gain: an amplification applied to sidescan sonar 
signals which compensates for the spreading loss of the signal, 
which is roughly proportional to the log of the range in metres

TVG enhancement (of the DA100/DA200) a set of facilities which allow users to 
alter the time varying gain applied to the incoming sonar signal

undersampling sampling at too low a sampling frequency, so that aliasing occurs

Unix a multi-user, timesharing operating system, with real-time
facilities; uses the X Window graphical user interface

update a revision to the DA100/DA200 software, incorporating new
features and/or bug fixes

user-specific (of files) the files in the DA100/DA200 system which are placed 
there by users (for example, database files, smoothed navigation 
data files)

UTC Coordinated Universal Time; the world time standard; equivalent 
to GMT

UTM Universal Transverse Mercator; a form of geographical projec-
tion which allows positions to be measured relative to each other 
in metres, over a restricted area

watch pointer the pointer which appears on the display screen when the DA100/
DA200 is waiting for an operation to complete

water depth the depth of water input into the system; the user may define this 
relative to a datum on the vessel, as the depth under the keel, or as 
the depth under the echo-sounder transducer

waterfall display a scrolling display of image data

window an area of the graphical user interface set aside for a specific 
operation, often disappearing when that operation has been
completed

Windows see Microsoft Windows, X Window

write protect (of disk or tape cartridge) set so that it cannot be written to, only 
read from

X Window a graphical user interface standard for the Unix operating system

zoom the process of selecting an area of the display to be redisplayed in 
greater detail

zoom mode defining the type of zoom operation to be carried out (for exam-
ple, full resolution, fixed magnification)
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Software Defect Report Form

Coda Technologies has made every effort to ensure that its software is reliable and performs
satisfactorily at all times. However, as with any software-based product, some defects may still
be present. If you encounter unexpected, undocumented or illogical behaviour by the system,
please complete this form and fax or mail it to:

Coda Technologies Ltd
Admiral House
29-30 Maritime Street
EDINBURGH
EH6 6SE
Tel: +44 131 553 1380
Fax: +44 131 554 7143

On receipt of this form, Coda Technologies will contact you and issue a reference number for
this report and describe the remedial action to be taken.

User

Company

Unit Type
(rental/sale)

Date

Time

System Type
(e.g. DA100/PI100)

Software Version 
Number

Serial Number

Mode in which fault 
occurred (playback/
acquisition)

Description of Fault 
(please be as specific as 
possible)

Was recovery possible? 
How?

For Coda office use only: Reference Number:
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Product Feedback

We at Coda value your opinion. Please give us your opinion of our products, in each of the
following areas. We’ll send you a free mousemat on receipt of your form.

Product Name

Excellent Good Fair Poor

Ease of Use: is the product easy to use? r r r r

Hardware: is the hardware reliable? r r r r

Software: is the software reliable? r r r r

Range of Facilities: are there enough tools? r r r r

Appearance: Do you like the format of the dis-
play?

r r r r

Physical: Is the product ergonomically 
designed?

r r r r

Suitability: Is the system suited to your applica-
tion?

r r r r

Automation: Do you rely on automated interpre-
tation?

r r r r

Does the product meet your need? Why, or why not?

What’s the single most important improvement we could make to the product?

Please complete the following information:

Name (optional):

Job Title or Function

Organisation

Address

Phone

If we need more information, may we contact you? Yes  r    No r  Thank You
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Manual Feedback

We at Coda value your opinion. Please give us your opinion of this manual, in each of the
following areas. We’ll send you a free mousemat on receipt of your form.

Please complete the following information:

Manual Title

Excellent Good Fair Poor

Accuracy: Is the information correct? r r r r

Completeness: Is information missing? r r r r

Organisation: Is the information easy to find? r r r r

Clarity: Do you understand the information? r r r r

Examples: Are there enough? r r r r

Illustrations: Are there enough? r r r r

Appearance: Do you like the page format? r r r r

Physical Binding: Do you like the cover and bind-
ing?

r r r r

Does the manual meet your need? Why, or why not?

What’s the single most important improvement we could make to the manual?

Name (optional):

Job Title or Function

Organisation

Address

Phone

If we need more information, may we contact you? Yes  r      No  r Thank You
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Index
A
A/D card DOS disgnostics test 
245
About this Manual 16
Acquiring Data from a Digital 
Sonar 52
Acquiring Survey Data 19
acquisition

acquisition mode 80
see also triggers
see data channels

acquisition mode. See data 
acquisition mode
acquisition setups

default setups 196
default sidescan setups 201
default sub-bottom profiler 

setups 205
default widescan setups 201
examples 195
parameters for custom 

settings 196
shallow seismic custom 

settings described 202
shallow seismic custom 

settings example 1 203
shallow seismic custom 

settings example 2 204
shallow seismic useful table 

205
sidescan setups 100m true 

range 199
sidescan setups 50m true 

range 198
ultra widescan setups 100m 

true range 200
ultra widescan setups 50m 

true range 199
acquisition. See data acquisition
Adaptive Limits 71
Alden 9315 CTP printers

configuring the printer 237
selecting the printer 238
troubleshooting 238

analogue input 183
Application Specific ARea 135
Application Specific Area

Coda systems 21
in acquisition mode 80

Application Specific Area in 
Acquisition Mode 1 80
Application Specific Area in 
Acquisition Mode 2 81
Application Specific Area in 
playback mode 98
Applications menu 99–??
Apply button 26
Automatic Tracking Hints 
(Seismic) 78

B
backing up setup files 171
Backup Setup Files 172
Bottom Tracking 67, 75
Bottom Tracking, setting up 68
Butterworth filters 225
buttons. See particular buttons

C
Cancel button 26
Change IP Address 169
Change Password command 173
Change Time command 173
Checking the Format of 
Incoming Nav Data 63
checklists

for interpreting data 259–260
for mobilising GeoKit/PI100 

253–255
for mobilising the DA200 

251–253
for mobilising the PI100 255
for mobilising TrackPlot/

Mosaic 256
for saving/loading tag files 

257
Coda data format summary 221
Coda navigational data string

Coda format 207
Coda-date format 208

Coda systems
main display 21–??
menu features 24–25
pointer types 31–32
security device 3

Coda Technologies information 
188
Colour Coding 23
Colour Maps 122
Common Funcitonality 72
connecting the system 43
Control Area in Playback Mode 
79, 93
Controlling Playback Speed 88
Conventions Used in this Manual 
17
conversion table 263–265
copying

data tapes 161
update package 169

copying data tapes 161
corrected navigation data

incorporating 89–91
corrected navigational data

Corrected Nav Input pop-up 
89

File Selection window 27
format 209

cross-track smoothing 111

D
DA200

applications 15
back panel 39
connecting 43
data flow 179
file structure 181
front panel 37, 40
hardware 179
operating system 179
powering down 175
powering up 44
preparing for transportation 

175
restarting 33
setting up 44
shutting down 175
software and GUI 179
specifications 183
version 188

data acquisition
See also data acquisition 

mode, acquisition 
parameters, acquisition 
setups

data acquisition mode 49, 50
data channels

Channels1-4 tab form 47
other channels 51
seismic channels 50
sidescan channels 49

Data Display Area 21
Data Display Window 
Identification 23
data playback

incorporating corrected 
navigation data 89–91

starting 85
stopping 96

deleting
tag files 150, 152
tags 144

display channels
adjusting the channels 60, 87

display data
scaling 101

displaying
A-scan trace 131
overlay data 125
survey data 131
Swell Filtered Outout 118
tags 125, 143

displaying fix data 125, 127
displaying scale lines 125

E
Edgetech ACI 53
Edgetech FSUI Common 
Features 59
Edgetech FSUI Sidescan 57
Edgetech FSUI Sub-bottom 58
Editing Navigation Library 
Strings 211
Ejecting Tapes and Disks 96
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End Nav Loopback Test 166
EPC 1086-2 thermal printers

configuring the printer 238
selecting the printer 239
troubleshooting 239

EPC HSP1000 Printer 240
EPC HSP1000 Printer, Change 
to Digital Mode 240
erasing tapes 171
event marking. See tagging
Exabyte Eliant 820

environmental specifications 
232

head cleaning 231
hints and precautions 232
LED interpretation 231

F
Factory button 26
filters 225
Fish Height 67
Fish Height alarms 73
Fish Height Source 68
Fish Height Source, method 
properties 70
Fish Height, additional options 
74
Fish Height, play back fish 
height file 74
Fish Height, recomputed file 73
fix data

displaying fix data 125, 127
Fix Data Setup pop-up 128

fix lines, see fix data
Format of Incoming Nav Data 63
Formatting Optical Disks 235

G
General Information Area 21, 96, 
134
General Information Area in 
Acquisition Mode 81
General Information Area in 
Acquisition Mode 1 81
General Information Area in 
Acquisition Mode 2 82
General Information Area in 
Playback Mode 1 96
General Information Area in 
Playback Mode 2 97
getting help

technical support 188
troubleshooting 189

Getting High Quality Data, 
Bottom Tracking 67
glossary 267–280
Goto a Specific KP/Chainage 95
Goto command

Goto pop-up 80, 93
moving between tags 145
moving to a specific position 

95–??

moving to a specific tag 94, 
145

Goto File command 85
Goto Specific Fix Number 95
Goto Specific Ping Number 95
GPIB output 183
GPIB setup 138

H
hardcopy devices

Alden 9315 CTP series 
printer 237

EPC 1086-2 thermal printer 
238

hardcopy output
GPIB Settings pop-up 138
Hardcopy Output pop-up 137

Help
Help menu 187
see also getting help

HP C1533/C1599A
environmental specifications 

230
head cleaning 229
hints and precautions 230
LED interpretation 229
recommended tapes 229

I
Image Enhancement 106

toolkit 108
Incoming Nav Data, Format 63
install password 173
installing updated software 167
interpretation checklist 259–260

K
key shortcuts 33, 187

L
left channel

channel settings 105
Load button 26
Load Remote button 149
loading

navigation lib 170
pop-up settings 27–28
report setups 154
tag files 149
tag files from tape 147

Lower command 166

M
main display, Coda systems 21–
??
Make Clean command 173
Make Default button 29
Manage Tag Files

optical disk system 150–152
tape system 146–150

measurements
making on-screen 

measurements 129
Measurement Values pop-up 

131
Measuring Setup pop-up 129

Menu Bar 21
Menu Bar Options 23
menu features 24–25
menus

See also particular menus
detaching from Menu Bar 22

Message Window 29
Method Properties, smoothing 72
Minimise command 166
mobilisation checklists

for GeoKit/PI100 253–255
for the DA200 251–253
for the PI100 255
for TrackPlot/Mosaic 256

monitor output 184
Multi Windows, Colour Coding 
23
Multi Windows, Window Polling 
24
Multiple Windows, Menu Bar 
options 23
Multiple Windows, opening 
display 23
Mutiple Windows 22

N
Nav Data QC 134
Nav Data Settings pop-up 91
Nav Data, Format of Incoming 
63
nav loopback test 166
navigation input

Nav Input Settings pop-up 66
Navigation Input, Setting Up 64
navigation library

adding strings 211
examples 218
interpretation lists 212
loading 170
navigation groups 215
saving 170

Navigation Library Explained 
215
Navigation Parameters Settings 
pop-up 66, 92
Network Disk Menu 173
Networking to Edgetech FSUI 
Interface System 55
Networking to Reson Seabat 
8125 Interface 59
Noise Reduction 72
Numerical Text Field/Spin Box 
24

O
Off-line Testing 165
off-line testing

navigation loopback 165
of data using A/D internal 

triggering 165
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off-line noise test 165
tape record/playback 165

OK button 26
on/off switch 24
one-of selection switch 24
on-line checklists

loading tag files 257
saving tag files 257

Open Tape Playback pop-up 85
Opening a Data Display Window 
23
Optical Disk, Drive Controls 233
Optical Disk, Error Conditions 
233
Optical Disk, Using Optical 
Media 234
optical disks

replaying data disks 85–96
optical disks, recommended 
brand 3
Optical Menu 172
option selection button 24
outputting hardcopy 137
Overlay Data

displaying 125

P
parallel output 183
playback

incorporating smoothed 
navigational data 27, 89

Playback Speed Settings 
pop-up 88

using the Goto command 145
playback mode 85
playback mode. See data 
playback mode
playback. See data playback
Playing Back Data 85
Playing Back Survey Data 20
pointer types 31–32
pop-up action buttons 26–29
pop-up selector 26
powering down the system 175
powering up the system 44
preparing the system for 
transportation 175
Printer Setup window 140

Serial Setup window 141
printers

see hardcopy devices
printing, text reports 159–160
production information 188
Properties, smoothing 72

Q
Quick Start 19
quick-start procedure 19–20

R
Raw A-Scan

displaying 131
reducing noise 111

Refresh Display command 111
Release Status 44
Report Generation 158–160
Report Setup 154–157
report setup

adding columns 154–155
adding tag types 157
deleting columns 154–155
deleting tag types 157
loading a previous setup 154
multi-node tags 156
report headings 156, 157
report separators 156
reportable items 155
saving the current setup 154
setting column parameters 

154
sort order 156
text strings 156

Reporting menu 153–160
reports, generating

displaying in text window 
158

printing hardcopy 159
saving to floppy disk 159

Rescan button 150, 152
Reson Seabat 8125 Interface, 
networking 59
Restart command 166
restarting the system 33
Restore command 166
Restore Setup Files 172
restoring

previous software version 
168

setup files 171
RS232, setting up 
communication 62

S
Save button 26
saving

navigation lib 170
pop-up settings 28–29
report setups 154
tag files 148

scale lines
displaying 125

scaling display data 101
Screen Dump pop-up 139
screen dumps 138

Printer Setup window 140
screen saver option 174
scroll bar 25
Scrolling Option List 25
Seabat 8125 Interface, 
networking 59
Seabed Position 74
Seabed Tracking 67
seismic channels 50
Seismic TVG 122
Select Default button 28

Select Factory Default button 28
serial input/output 183
Serial Setup window 141
setting up

the system 44
Setting up Bottom Tracking 68, 
75
Setting Up Navigation Input 64
Setting Up RS232 
Communication 62
Setting up Sub Bottom Profiling 
74
Setting up Sub-bottom profiling 
79
Setting up the DA200 19
settings, pop-up

loading 27–28
resetting to factory default 26
saving 28–29
storing as the default 26

setup files
backing up 171
restoring 171

Showing the Seabed Position 74
shutting down the system 175
Side Panel 41
Side Panel of DA50 Showing 
DAT Drive Bay 42
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